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ВВЕДЕНИЕ 

 

 

Итак, дорогой читатель, добро пожаловать в мир компьютерной верстки. 

Что же вас ожидает на страницах этой книги? 

Сегодня уже практически никого не надо убеждать в том, что офисные пакеты с 

поддержкой сложного форматирования (например, Microsoft Word) хороши для 

ведения деловой переписки, а для создания качественного полиграфического про-

дукта нужны специализированные издательские системы. Издательская система, в 

отличие от сколь угодно мощного текстового редактора, ориентирована на типо-

графское (или качественное экранное для электронных публикаций) воспроизведе-

ние результата. Следовательно, они снабжены инструментами, обычно не востре-

бованными в офисных задачах: системами управления цветом, средствами тонкой 

настройки характеристик шрифта (точный, заказной и ручной кернинг и трекинг), 

треппинга, возможностью произвольно, с высокой точностью располагать элемен-

ты макета на странице и т. д. 

Все это хорошо известно, и специальных пояснений не требует. Нам же остается 

самая приятная и интересная задача: разобраться, как именно создавать публикации 

своей мечты с помощью новейшей версии одного из лучших на сегодня издатель-

ских пакетов — InDesign CS5. 

Для кого эта книга? 

 Вы давно мечтали научиться создавать красивые страницы, буклеты и целые 

книги, но не знали, как к этому подойти? Тогда эта книга — для вас! Подробные 

описания всех основных инструментов, команд, настроек и алгоритмов позволят 

шаг за шагом пройти от первого знакомства до уверенной работы в программе. 

Пошаговое выполнение заданий и работа с проектами позволят набрать необхо-

димые навыки, а постоянное упоминание горячих клавиш для часто используе-

мых команд поможет научиться действовать быстро и эффективно. 

 Вы неплохо владеете программами компьютерной графики (Photoshop, 

Illustrator и т. д.) и хотели бы расширить свой профессиональный диапазон, до-

бавив к нему навыки верстальщика? Тогда эта книга — для вас! Многие элемен-

ты интерфейса Adobe InDesign похожи на то, что вам знакомо по другим паке-

там, поэтому здесь вы будете чувствовать себя, как дома. Тем не менее InDesign 

ни в коей мере не "близнец" любой из этих программ. Важные отличия есть как 
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в интерфейсе, так и в задачах и инструментах. Например, InDesign имеет бога-

тейший набор средств контроля подготовки макета к печати, исключительно 

удобную организацию работы с многостраничными документами и т. д. Освоив 

InDesign и сравнив процесс и готовый макет с версткой, например, в пакете 

Adobe Illustrator, вы обнаружите, что результат стоил затраченных усилий. 

 Вы опытный верстальщик, работавший до сих пор в других программах верст-

ки (Adobe PageMaker, QuarkXPress и др.)? Тогда эта книга — для вас! Освоив-

шись в новом интерфейсе и приятно удивившись многим симпатичным и облег-

чающим работу новинкам, вы сможете использовать эту книгу как надежного 

проводника и консультанта в процессе знакомства с пакетом и как справоч-

ник — потом. Кроме обычных пояснений, что и как выглядит и действует в про-

грамме, здесь приводятся различные интересные алгоритмы и подходы, позво-

ляющие заметно оптимизировать работу и добиваться интересных результатов 

с минимальной затратой сил. 

Что нужно знать, чтобы эффективно освоить 

программу с помощью этой книги? 

Разумеется, прежде всего, нужно знать графический интерфейс используемой опе-

рационной системы. InDesign CS5 работает как с ОС Windows XP и выше, так и с 

MacOS. Горячие клавиши и клавиатурные сочетания для всех основных действий 

будут указываться для обеих платформ. 

Естественно, предполагается, что вы умеете работать в каком-либо текстовом  

редакторе, например Microsoft Word. Базовые знания и навыки работы с текс- 

том заметно упростят задачу освоения многих инструментов и возможностей 

InDesign CS5. 

Для выполнения практических заданий необходимо иметь на компьютере установ-

ленную программу Adobe InDesign CS5. В процессе мы для удобства будем исполь-

зовать системные и широко распространенные шрифты, а в дальнейшем вы сможе-

те при желании пополнить свои шрифтовые наборы. 

 Заменяет ли эта книга обучение на соответствующих курсах? Строго говоря, 

конечно, нет. На курсах есть возможность попросить разъяснения, получить 

комментарий преподавателя, задать вопрос. Эффективность усвоения материала 

на курсах обычно выше, чем при самостоятельном изучении. Но книга построе-

на на основе "привязки" прочитанного к увиденному в окне программы и пред-

полагает пошаговую проработку проектов на основе материалов с компакт-

диска и выполнение самостоятельных заданий на предложенные темы. В ре-

зультате вы по окончании работы с книгой будете вполне готовы к работе в ка-

честве верстальщика полиграфических или интерактивных публикаций. Разуме-

ется, очень желательно работать с книгой последовательно, в порядке изложе-

ния материала, поскольку каждый следующий проект в той или иной мере 

использует знания и навыки, полученные при работе с предыдущим. 
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 Возможно ли изучать InDesign с помощью этой книги, имея на компьютере 

программу одной из предыдущих версий (CS2, CS3, CS4)? К сожалению, нет. Во-

первых, запись из версии CS5 в формат более старых версий невозможна, в этом 

пакете есть совместимость только "снизу вверх". Во-вторых, самые элементар-

ные действия и основные палитры, конечно, мало меняются от версии к версии, 

но программа в целом изменилась даже относительно версии CS4 очень заметно. 

Многие возможности, рассматриваемые в книге, в старых версиях программы 

попросту недоступны. 

 Какие вопросы рассматриваются в книге? Прежде всего, это интерфейс про-

граммы, ее инструменты, команды и другие возможности. Каждый элемент про-

граммы рассматривается в привязке к остальным ее частям и практическим за-

дачам, выполняемым с его помощью. По мере необходимости даются некоторые 

сведения о компьютерной графике вообще и работе с ней. Также приводится не-

обходимая терминология, связанная с предпечатной подготовкой макетов. 

У книги нет задачи подготовить специалистов по пре-прессу, поэтому сложные 

вопросы, связанные с тонкостями цветоделения, треппинга и других сугубо тех-

нических процессов, не рассматриваются. 

 Как организуется практическая работа с книгой? Каждое практическое задание 

представляет собой проект — набор действий и материалов, позволяющий 

пройти путь от создания файла публикации с заданными параметрами до гото-

вого документа. Все материалы проекта находятся на диске в папке с соответст-

вующим названием, например "Project1_City". Описание действий приводится в 

тексте книги, в разделе, посвященном проекту. В первых главах пошаговые ин-

струкции максимально подробны, в дальнейшем они становятся более сжатыми, 

обозначая действия, но не детализируя их вплоть до нажатия на отдельную кла-

вишу. Предполагается, что в проектах, рассматриваемых в последних главах, вы 

используете навыки, полученные ранее. 
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Глава 1 
 

 

ЧТО НОВОГО В ПРОГРАММЕ? 

 

 

 

 
 
Эта глава настоятельно рекомендуется к прочтению пользователям предыдущих 

версий, которые хотят легко и безболезненно перейти на версию CS5 и сразу на-

чать активно пользоваться ее преимуществами. 

Версия InDesign CS5 значительно отличается от прежних, и не только по внешнему 

виду, характерному для всего пакета CS5. Появились новые инструменты и воз-

можности, изменилось расположение многих команд, которые теперь размещены  

в более естественных для них разделах меню. Заметно расширены разделы, связан-

ные с разработкой электронных публикаций, многое сделано для автоматизации и 

повышения комфортности работы. 

Дизайн  

и работа с публикациями 

InDesign — прежде всего, программа для подготовки макетов печатных публика-

ций, и больше всего новинок мы найдем именно в этой области. 
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Использование разных форматов страниц в одном документе 

Теперь можно определить несколько форматов страницы в пределах одного доку-

мента. Эта возможность очень полезна, например когда идет работа над целым 

блоком небольших документов в рамках единого проекта: если, скажем, нужно от-

форматировать в едином стиле деловое письмо, открытку, конверт и т. д. Теперь не 

требуется создавать отдельную публикацию для каждого из этих документов. 

Для создания специфического формата страницы достаточно выделить эту страни-

цу инструментом Page Tool (Страница) и настроить нужный формат в контрольной 

панели (рис. 1.1). 
 

 

Рис. 1.1. Изменение формата отдельной страницы 

 

Новая палитра Layers (Слои) 

Палитра Layers (Слои) стала значительно удобнее и функциональнее (рис. 1.2). 

Появились такие же, как в Illustrator, треугольные маркеры раскрытия/свора-

чивания содержимого слоя, возможность скрыть/показать или заблокировать/ 

разблокировать как слой целиком, так и отдельные его элементы. Действия по ре-

шению этих задач, как и изменение порядка расположения слоев и элементов внут-

ри слоя, в InDesign теперь совершенно аналогичны применяемым в Illustrator, что 

заметно облегчает и ускоряет работу при параллельном использовании этих двух 

программ. 

Расширение списка доступных форматов при создании нового документа 

Если вы часто используете формат страницы, отсутствующий в списке доступных 

форматов нового документа, его теперь можно быстро и легко добавить. Для этого 

просто при создании нового документа выберите в выпадающем списке форматов  
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Рис. 1.2. Новая палитра Layers 

Custom page size (Задать новый формат) и в соответствующем диалоговом окне 
определите новый элемент списка, задав ему имя и размеры. 

Новые возможности трансформации 

Заметно изменились инструменты трансформации, приблизившись к аналогичным 

инструментам в программах Adobe Photoshop и Adobe Illustrator. Например, нако-
нец-то появилась возможность поворачивать объекты в режиме Bounding Box (Га-

баритный контейнер), не вызывая для этого инструмент поворота; появились новые 
интересные возможности у инструмента Free Transform; скругление углов геомет-

рических форм теперь тоже можно задать прямо в режиме габаритного контейнера. 

"Захват содержимого" 

Эта функция внешне отображается как полупрозрачный круг, появляющийся в цен-
тре импортированной картинки при наведении на нее инструмента Черная стрел-

ка (рис. 1.3). Щелчком по этому кругу активизируются возможности трансформа-
ции содержимого фрейма, прежде доступные только при использовании Пустой 

стрелки. Таким образом, можно работать с самим фреймом или с его содержимым, 
не меняя инструмента. 

При желании эту функцию можно отключить, выбрав в главном меню View > 

Extras > Hide Content Grabber (Вид > Дополнительно > Скрыть захват содержи-
мого). 

Двойной щелчок мышью 

Двойной щелчок левой кнопкой мыши по импортированному изображению теперь 
не создает перехода с инструмента Selection (Черная стрелка) на инструмент Direct 

Selection (Пустая стрелка), а переключает фокус выделения с фрейма на его содер-
жимое и обратно. Аналогично, если нужно выделить объект в группе, достаточно 
двойного щелчкa на этом объекте. Для возврата к выделению группы нужно сде-
лать двойной щелчок на границе любого входящего в группу объекта. 
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Рис. 1.3. Изображение в режиме "захвата содержимого" 

Преимущество нового подхода в том, что при всех этих действиях активным инст-

рументом остается Черная стрелка, и по окончании работы с содержимым фрейма 

или элементом группы не требуется смена инструмента. 

Подсветка границ фрейма 

В режиме "скрытых границ" (Hide frame edges) при наведении курсора на тот или 

иной объект его границы временно подсвечиваются (рис. 1.4), что дает уверенность 

в том, что вы собираетесь выделить именно тот объект, который нужен, и при этом 

позволяет не загромождать экран разноцветной сеткой из границ объектов. Цвет 

подсветки определяется цветом, присвоенным слою, на котором находится объект. 

 

Рис. 1.4. Подсветка контуров в режиме скрытых границ 
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Подсветка контуров и точек 

При наведении на объект инструмента Пустая стрелка подсвечиваются сегменты 

и точки, составляющие его контур, что заметно упрощает выбор элементов для ре-
дактирования формы объекта. 

Трансформация нескольких объектов одновременно 

Теперь не нужно (наконец-то!) создавать группу всякий раз, когда требуется изме-

нить размер или повернуть несколько объектов одновременно. Просто выделите 
все необходимые объекты и пользуйтесь их общим габаритным контейнером. Схе-

ма действий обычная: простое перемещение маркеров изменяет размер фрейма или 

поворачивает его, применение клавиши <Shift> позволяет изменять размер с сохра-
нением пропорций или поворачивать объект на углы, кратные 45°, <Alt> — произ-

водить трансформацию "от центра". Применение клавиши <Ctrl> позволяет транс-
формировать не только фрейм, но и его содержимое. 

"Живая" прорисовка экрана 

При перемещении содержимого фрейма его новое расположение относительно 

фрейма и соседних объектов отображается "на лету" (рис. 1.5), позволяя вам кор-
ректировать свои действия без дополнительной паузы. 

 

Рис. 1.5. Перерисовка экрана в процессе работы с изображением 

"Живое" распределение объектов 

Иногда бывает необходимо изменить расстояние между элементами страницы, не 
изменяя их собственных размеров. Теперь для этого достаточно выбрать нужные 

объекты и начать масштабирование, удерживая клавишу <Пробел>. 

Инструмент Gap Tool (Просвет) 

Новый инструмент, позволяющий быстро настроить расстояние между двумя или 

более объектами и управлять внешним видом страницы на основе "пустого про-
странства", что сейчас является весьма популярным подходом к построению стра-

ниц. 
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Новое в работе с текстом 

Текст — основа любой публикации. Усовершенствованные средства работы с тек-

стом заметно облегчают и ускоряют процесс создания макета. 

Абзацы с разнообразным делением на колонки 

Теперь можно работать с многоколоночными структурами, не создавая отдельных 

текстовых фреймов для каждой колонки. В пределах одного текстового фрейма 

можно для каждого абзаца создать его собственную структуру — в одну, две или 

более колонок (рис. 1.6). 
 

 

Рис. 1.6. Абзац сложной структуры 

 

Связка с предыдущим абзацем 

В диалоговом окне Keep Options (Параметры связки) теперь появилась команда 

Keep With Previous (Связка с предыдущим), позволяющая запретить отрыв первой 

строки текущего абзаца от последней строки предыдущего. 

Баланс колонок 

Новая установка в диалоговом окне Text Frame Options (Параметры текстового 

фрейма) позволяет автоматически создать равномерное распределение текста в 

многоколоночном фрейме. 

Вертикальное выравнивание текста во фреймах сложной формы 

До сих пор размещение текста во фрейме сложной формы означало, что установки 

вертикального выравнивания будут проигнорированы. Теперь можно задавать вер-

тикальное выравнивание текста во фреймах любой формы. 
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Новое в работе с объектами 

Небольшие, но удобные усовершенствования окажут ощутимую помощь в повсе-

дневной работе. 

Вызов палитры образцов из контрольной панели 

В новой версии чрезвычайно изящно решена проблема поиска баланса между необ-

ходимостью иметь под рукой палитру образцов и высвобождением максимального 

пространства для работы. Теперь палитру Swatches (Образцы) для каждого атрибу-

та можно вызвать из контрольной панели (рис. 1.7). Кстати, при этом снимается 

необходимость помнить, какой атрибут активен, обычно отвлекающая внимание от 

основного процесса: для каждого атрибута — своя кнопка вызова палитры, которая 

разворачивается тут же, от контрольной панели, и сворачивается после выбора об-

разца. 

 

Рис. 1.7. Вызов образцов для каждого атрибута из контрольной панели 

Кроме того, текущий образец можно присвоить любому объекту на странице про-

стым перетаскиванием (но тут уже надо следить за атрибутом: при перетаскивании 

образца внутрь объекта он будет присвоен заливке, если же подтащить его к грани-

це — обводке). 
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Автоматическое "табличное" размещение импортированных изображений 

При импорте нескольких изображений их теперь можно автоматически разместить 

"табличкой", чтобы все они одновременно оказались в поле зрения (рис. 1.8). Для 

этого определите с помощью мыши область размещения и, удерживая клавишу 

<Ctrl>, клавишами-стрелками на клавиатуре задайте количество строк/столбцов 

(клавиши < >, < > управляют столбцами, < >, < > — строками). 

 

Рис. 1.8. "Табличное" размещение импортированных изображений 

Опция Auto-Fit (Автонастройка) 

Новая опция, позволяющая автоматически подгонять размер импортированной 

картинки при изменении размера фрейма. Удобна, прежде всего, тем, что в этом 

режиме не требуется удерживать <Ctrl> при трансформировании импортированных 

изображений. 

 "Табличное" размещение группы фреймов в процессе их создания 

При создании фрейма (текстового или обычного) можно задать сразу целую группу 

однотипных фреймов и разместить их "таблично" (колонками и рядами). Для этого 

достаточно во время использования любого подходящего инструмента задать об-

ласть размещения группы и, не отпуская мышь, клавишами-стрелками на клавиату-

ре задать количество строк/столбцов (клавиши действуют так же, как при размеще-

нии импортированных картинок). 
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Подписи на основе метаданных 

InDesign CS5 позволяет создавать подписи под рисунками на основе метаданных, 

причем тут есть несколько способов. 

Можно дать команду на создание подписей прямо в процессе импорта, активизиро-

вав установку Create Static Captions (Создать подписи) в диалоговом окне коман-

ды Place (Импорт) (рис. 1.9). 
 

 

Рис. 1.9. Установка Create Static Captions в диалоговом окне Place 

 

Можно создавать подписи к уже импортированным изображениям. Для этого сна-
чала в контекстном меню объекта нужно выбрать Captions (Подписи) > Caption 

Setup (Настройка подписи) и задать шаблон подписи, в том числе выбрать необхо-
димые метаданные. Следующий шаг — Captions (Подписи) > Generate Live 

Caption (Создать активную подпись) или Generate Static Caption (Создать стати-
ческую подпись). 

Активная подпись отличается от статической тем, что она жестко привязана к изо-

бражению. При попытке отодвинуть ее в текстовом поле появляется надпись 
Nonintersective link (Нет пересечения с изображением). При изменении исполь- 

зуемых метаданных подпись тоже изменяется. Статическая подпись после созда- 
ния уже не меняется и позволяет любое перемещение относительно "своей" кар-

тинки. 

Mini Bridge 

Mini Bridge — часть приложения Adobe Bridge, выделенная в отдельный блок и 

доступная в пределах InDesign CS5 в виде палитры (рис. 1.10). В ней, как и в 

"большом" Bridge, отображается файловая система с традиционным "деревом  

папок", файлы показываются в виде миниатюр, размер и взаимное расположение  
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которых можно настраивать. Работают основные функ-

ции Bridge, вроде вызова по двойному щелчку мыши 

"родной" программы для редактирования того или ино-

го файла. В результате работа с внешними файлами 

(текстами, изображениями) становится такой же лег-

кой, как при использовании "большого" Bridge, но про-

исходит это "не выходя из дома" (т. е. из пакета 

InDesign). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

Рис. 1.10. Mini Bridge 

 

Дополнительная интеграция  
с Adobe Bridge 

InDesign CS5 и Adobe Bridge CS5 получили дополнительные возможности взаимо-

действия. 

Миниатюры страниц 

Новая команда File Handling (Управление файлами) в меню Preferences (Предпоч-

тения) позволяет задать разное количество страниц публикации (вплоть до "всех") 

для отображения в Bridge в виде миниатюр. Это заметно облегчает поиск нужной 

публикации среди похожих документов. При этом надо помнить, что чем больше 

страниц выбрано для показа, тем дольше будет сохраняться файл публикации. 

Лучше найти разумный компромисс. 

Возможность просматривать миниатюры импортированных в документ 

InDesign изображений прямо в Bridge 

Bridge теперь позволяет просматривать импортированные в INDD-документ изо-

бражения без необходимости открывать документ в InDesign. Соответственно, ста-

новятся доступными метаданные этих изображений. 
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Кросс-медиа дизайн 

Интерактивные документы и презентации 

Чем дальше, тем больше становится значение интерактивных (и вообще электрон-
ных) публикаций. Расширение возможностей InDesign в данном направлении отра-

жает этот процесс. 

Импорт файлов форматов FLV и MP3 

В электронную публикацию теперь можно импортировать файлы в форматах Flash 
Video (FLV и F4V), сжатое видео (например, MP4) и SWF. К поддерживаемым  

аудиоформатам добавился MP3. Сохраняется поддержка старых медиаформатов — 
QuickTime (MOV), AVI, WMV. Однако использование FLV, F4V, MP4 и MP3 пред-

почтительно, поскольку обеспечивает наилучший результат при просмотре готовых 
материалов в последних версиях программ Acrobat, Adobe Reader и Adobe Flash 

Player. 

Палитра Media (Мультимедийные материалы) 

Палитра Media (Мультимедийные материалы) позволяет просматривать материалы 

в форматах SWF, FLV, F4V, MP4 и MP3 прямо в InDesign. Для файлов FLV, F4V и 
MP4 можно выбрать любой кадр и назначить его "основным" (отображаемым во 

время работы в качестве индикатора содержимого файла). Здесь же можно задать 
настройки проигрывателя для будущего интерактивного документа, создать меню, 

определить тайм-коды начала каждого эпизода и т. д. 

Палитра Animation (Анимация) 

Эта палитра позволяет настроить разнообразные эффекты движения и "оживления". 
Параметры, для которых можно задать изменения, традиционные: Position (Поло-

жение), Scale (Размер), Rotate (Поворот), Opacity (Непрозрачность). Можно ис-
пользовать готовые наборы настроек или создать свои собственные и сохранить их 

для дальнейшего использования. 

Здесь же задаются условия проигрывания каждой анимации — например, загрузка 
определенной страницы или щелчок в определенном месте. 

Готовые элементы анимации 

Готовые наборы настроек анимации привязаны к палитре Animation и позволяют 

быстро применять к страницам и их элементам часто используемые эффекты. Точ-
но такой же список эффектов можно найти в программе  Adobe Flash CS5 

Professional. Кроме того, в InDesign можно импортировать эффекты, созданные  
в Adobe Flash, что позволяет дополнительно усилить взаимодействие этих двух 

программ. 

Палитра Timing (Установка времени) 

Служит для настройки порядка проигрывания анимированных элементов публика-
ции. 

Палитра Object States (Версии объекта) 

Служит для создания нескольких версий одного и того же объекта. Например: 

можно создать один фрейм, имеющий 20 разных версий ("состояний"), каждая из 
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которых содержит новое изображение. При открытии пользователем конечного 

PDF- или SWF-файла он сможет с помощью кнопок "вперед" и "назад" просматри-

вать фотогалерею. 

Палитра Preview (Предпросмотр) 

Эта палитра позволяет проверить поведение интерактивных элементов публика-

ции — отдельного элемента, страницы или публикации в целом. 

Пикселы как поддерживаемая единица измерения 

До сих пор InDesign, как полиграфически ориентированный пакет, поддерживал 

единицы измерения, связанные с печатью: миллиметры, сантиметры, дюймы, пунк-

ты и т. д. Теперь, с усилением интереса к электронным публикациям, появилась 

возможность использовать, в том числе, и пикселы. Можно задать их как одну  

из единиц измерения в документе с помощью команды Preferences > Units & 

Increments (Предпочтения > Единицы измерения), можно (для конкретного объек-

та) явным образом прописывать их в поле единиц измерения контрольной панели, 

в диалоговых окнах различных команд и инструментов и т. д. 

При этом цифровые значения в соответствующих полях будут приводиться к це-

лым числам. 

Преобразование интернет-адресов в гиперссылки 

Команда Convert URLs To Hyperlinks (Преобразовать интернет-адреса в гипер-

ссылки) позволяет в выделенном фрагменте или во всем текстовом массиве нахо-

дить интернет-адреса и автоматически преобразовывать их в гиперссылки. К этой 

команде можно также привязать специальный стиль для оформления создаваемых 

ссылок. 

Улучшенный экспорт в формат SWF 

Операция экспорта в формат SWF теперь не только обрабатывает анимацию, видео, 

аудио и реакцию на действия пользователя, но и позволяет более тонко настраивать 

параметры готового SWF файла. 

Улучшенный экспорт в формат FLA (Flash Professional) 

В новой версии InDesign публикацию можно экспортировать напрямую в формат 

FLA для дальнейшего редактирования в Flash Professional. 

Дополнительные возможности экспорта в интерактивный формат PDF 

InDesign CS5 позволяет формировать два типа PDF файлов: интерактивный и для 

печати. Для экспорта в каждую из версий существует своя собственная команда и 

группа настроек. 

Все медийные составляющие публикации при экспорте из InDesign CS5 в интерак-

тивный PDF собираются на специальном слое, что обеспечивает наилучшее проиг-

рывание готового файла в Adobe Reader. Лучше всего, если исходные видеофайлы 

имеют формат FLV или F4V, а аудиофайлы — MP3. 

Дополнительные опции экспорта позволяют настраивать "изображение-заставку", 

параметры показа презентации, эффектные переходы между страницами и т. д. 
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Экспорт в XHTML формат 

Расширенные возможности экспорта в формат XHTML позволяют сделать более 
тесной интеграцию между InDesign CS5 и программами интернет-верстки (напри-
мер, Dreamweaver), что позволяет создать интернет-публикацию из INDD докумен-
та с максимально точным воспроизведением особенностей дизайна каждой стра- 
ницы. 

Новые возможности экспорта в формат JPEG 

Диалоговое окно Export JPEG получило новые возможности настроек — напри-
мер, выбор цветового пространства, возможность учесть припуски под обрез и т. д. 

Новые возможности совместной работы 

Подготовка крупной публикации — чаще всего коллективный процесс. Версталь-
щик работает с макетом, редактор вносит правки в содержание — от координации 
их действий в значительной степени зависит результат. Новая версия InDesign пре-
доставляет дополнительные возможности в этой области. 

On-line просмотр и комментарии 

В новой версии InDesign появился инструмент on-line просмотра и комментирова-
ния CS Review. С помощью палитры CS Review вы можете прямо в процессе вер-
стки размещать превью документа в сообществе Acrobat.com и получать коммента-
рии к своей работе. 

Отслеживание текстовых изменений 

Включив эту опцию (Track Text Changes), вы можете в режиме текстового редак-
тора (Story Editor) проследить основные изменения в тексте — вставку, удаление 
или перемещение текстовых фрагментов. 

Интеграция с редактором Buzzword 

InDesign позволяет работать с документами, созданными в программе Buzzword — 
популярном интернет-редакторе текстов. 

Режим презентации 

В версии CS5 появился новый режим просмотра — Presentation Mode (Режим пре-

зентации). Он близок к режиму Preview (Предпросмотр), но в нем полностью скры-
ты все элементы управления программой (меню и палитры), и на экране отобража-

ется одновременно только один разворот. Перемещение между разворотами проис-

ходит с помощью клавиш-стрелок. 

Цветная подсветка иконок страниц 

Палитра Pages позволяет задавать цветную подсветку иконкам страниц, тем самым 
облегчая их поиск. 

Комфорт и эффективность 

Кто не мечтал о том, чтобы работа над макетом шла легко, быстро и доставляла 
удовольствие? Команда Adobe многое сделала для воплощения этой мечты. 
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Фоновые задачи 

До сих пор при выполнении программой долгих задач — например, записи боль-
шого файла или экспорта документа в PDF — приходилось ждать окончания про-
цесса. Теперь же можно параллельно продолжать работать с документом, не тратя 
времени на ожидание. Кроме того, можно выстроить очередь из нескольких задач 
по экспорту в фоновом режиме и отслеживать их выполнение с помощью палитры 
Background Tasks (Фоновые задачи — Window > Utilities > Background Tasks). 

Клавиатурные сокращения для временной активизации инструментов 

Возможность, известная со старых версий (например, клавиша <Пробел> для вре-
менного вызова инструмента Рука), теперь расширена. Нужный инструмент вызы-
вается соответствующей клавишей и активен, пока эта клавиша нажата. Например, 
удерживание клавиши <U> позволяет временно переключиться с текущего инстру-
мента на инструмент Gap (Просвет), а отпуск ее снова вернет нас к текущему инст-
рументу. 

Палитра Tool Hints (Подсказки инструментов) 

Палитра Tool Hints (Window > Utilities > Tool Hints) показывает весь набор кла-
виш-модификаторов и результат их действия для текущего инструмента (рис. 1.11). 

 

Рис. 1.11. Палитра Tool Hints 
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Произвольный номер первой страницы 

При создании документа можно присвоить первой странице произвольный номер, 

не обязательно № 1. При этом если выбранный номер будет четным, то в режиме 

показа разворотов документ будет начинаться сразу с разворота, а не с одной стра-

ницы, как это всегда было до сих пор. 

Редактирование оригиналов для нескольких объектов сразу 

Применение команды Edit Original (Редактировать оригинал) к нескольким объек-

там активизирует соответствующие программы для каждого из них. 

Новые возможности работы с заблокированными объектами 

Заблокировать и разблокировать объект можно как в палитре Layers (Слои), так и в 

меню Object (Объект): Object > Lock (Объект > Заблокировать) и Object > Unlock 

All On Spread (Объект > Разблокировать все на развороте) соответственно. 

Новая опция Запрет выделения блокированных объектов в разделе Preferences 

(Предпочтения) меню Edit (Редактирование) позволяет разрешить или запретить 

выделение заблокированных объектов. 

Замена импортированных файлов на основе расширения 

Команда Relink file extension (Заменить по расширениям) контекстного меню па-

литры Links (Связи) позволяет заменить все файлы, имеющие определенное рас-

ширение, на аналогичные с другим расширением. Например, заменить все файлы 

JPEG на файлы TIFF. 

Скрытые объекты 

При необходимости можно скрыть часть объектов на странице с помощью команды 

Object > Hide (Объект > Скрыть). Скрытые объекты не печатаются, не экспор- 

тируются и не могут быть выделены. Для восстановления отображения объектов 

служит команда Object > Show All On Spread (Объект > Показать все на разво- 

роте). 

Фиксация режима Preview (Предпросмотр) в диалоговых окнах 

Теперь InDesign запоминает, был ли установлен для диалогового окна режим 

Preview, и автоматически восстанавливает выбранную установку при очередном 

открытии окна. 

Курсор импорта для перетаскивания файлов из Adobe Bridge 

В прошлых версиях при импорте перетаскиванием из Adobe Bridge или других 

файл-менеджеров изображение размещалось на странице с автоматическим созда-

нием фрейма по исходному размеру картинки. Теперь в процессе импорта создает-

ся Place cursor (Курсор импорта), позволяющий сразу задать необходимый размер 

фрейма. Пропорции фрейма фиксируются и соответствуют пропорциям изобра- 

жения. 

Округление значений CMYK-составляющих до целых чисел 

При перемещении бегунков в палитре Colour (Цвет) полученные значения автома-

тически округляются до ближайшего целого числа. 
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Очистка от направляющих 

В меню View > Grids & Guides (Вид > Направляющие и сетки) появилась новая 

команда Delete All Guides On Spread (Убрать все направляющие на развороте), 

позволяющая очистить экран от всех направляющих одним действием. 

Изменение масштаба документа при работе с диалоговыми окнами 

Теперь клавиатурные команды изменения масштаба <Ctrl><+>, <Ctrl><-> действу-

ют не только при основной работе с документом, но и при открытых диалоговых 

окнах. 

Новый шрифт по умолчанию 

Шрифт по умолчанию изменен с Times (Mac) и Times New Roman (Windows) на 

кросс-платформенную OpenType версию Minion Pro Regular. 

Фиксированное расположение окна текстового редактора 

InDesign запоминает заданные вами размеры и местоположение окна текстово- 

го редактора и при очередном открытии восстанавливает его в том же месте и со-

стоянии. 

Метки сгиба 

Если в установках печати выбрано Выводить обрезные метки, то метки сгиба пе-

чатаются сплошными линиями. 

Изменения в именах и расположении команд 

Некоторые команды меню изменили названия и переместились в другие разделы — 

см. приложение 1. 

Полезные ресурсы 

 Домашняя страница Adobe InDesign CS5: www.adobe.com/products/indesign; 

 Adobe TV: http://tv.adobe.com — видеоуроки по самым разным разделам про-

граммы и алгоритмам работы с ней; 

 Adobe Design Center: www.adobe.com/designcenter — статьи, уроки, галереи, 

дискуссии; 

 для тех, кто изучает продукты Adobe: www.adobe.com/education — подготовка 

к сертификации; 

 Adobe Forums: http://forums.adobe.com — обсуждение любых продуктов Adobe; 

 Adobe Labs: http://labs.adobe.com — обсуждение технологических тонкостей 

программных пакетов со специалистами из команды Adobe. 
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ПЕЧАТНЫЕ И ЭЛЕКТРОННЫЕ 

ПУБЛИКАЦИИ: СХОДСТВО И РАЗЛИЧИЕ 

 

 

 

 

Почему мы рассматриваем печатные и электронные публикации как отдельные, 

самостоятельные задачи, решаемые в рамках одного пакета? Дело в том, что воз-

действие готовой публикации на пользователя (читателя, зрителя) очень сильно 

зависит от того, к какому типу она принадлежит. Конечно, основа любой публика-

ции — текст. Пользователь, держащий в руках печатное или электронное изда-

ние, — прежде всего — читатель. Тем не менее физическая оболочка, в которую 

заключен этот текст, имеет огромное значение. 

Печатная публикация (иначе говоря, всем хорошо знакомые листовки, плакаты, 

буклеты, брошюры, журналы, книги) имеет одно важнейшее свойство: материаль-

ность. У книги или газеты, журнала или буклета есть формат, количество страниц, 

качество бумаги, вес, наконец. Физическое ощущение от перелистывания стра-

ниц — непременный элемент общения с печатной публикацией. Забота о сохранно-

сти печатного издания, работа с закладками, поиск и маркировка необходимой ин-

формации — все это необходимые читательские навыки, привычные настолько, что 

мы их обычно даже не замечаем. Более того, любое печатное издание посылает нам 

множество нетекстовых сигналов, которые мы улавливаем почти автоматически. 
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Глянцевая или матовая бумага? Плотная белая или рыхлая желтая, газетная? Мяг-

кий или твердый переплет у книги? Цветное или черно-белое оформление? Какое 

качество печати? Каков размер — можно ли читать это в транспорте, в толпе, на 

ходу, или необходимо разложить на подходящей поверхности? Сколько времени 

это должно быть актуально? И множество других вопросов, ответы на которые оп-

ределяют наше отношение к публикации, ее авторам и сообщению, которое она 

несет. Невозможно напечатать годовой отчет солидного банка на газетной бумаге 

расплывающимися красками в плохом переплете: статусные потери при этом будут 

многократно превышать экономию средств на издание. С другой стороны, нет 

смысла печатать на высококачественной бумаге газету ежедневных объявлений: 

уже завтра она превратится в макулатуру, и это приходится учитывать при выборе 

печатного материала. 

Поэтому при создании макета печатной публикации учитывается дальнейшее со-

трудничество с типографией. В зависимости от предполагаемого качества бумаги и 

используемой техники выстраивается работа с цветом; необходимость подрезки 

печатного блока до заданного формата накладывает определенные ограничения на 

расположение элементов макета; особенности полиграфических технологий дик-

туют использование команд и инструментов, применяемых только для подготовки 

макета к печати и ни для чего более. 

InDesign CS5 предоставляет множество возможностей для максимально полной и 

аккуратной подготовки макета к печати. Здесь и управление цветоделением, и учет 

требований типографии, и корректная работа с импортированными изображениями, 

и т. д. Этой задаче посвящена отдельная глава книги и проект, который позволяет 

разобраться во всех необходимых деталях процесса. 

Рассмотрим теперь публикацию электронную. 

Очевидно, главная ее особенность — абсолютная виртуальность. Все, что вы пред-

ложите вниманию читателя (зрителя), будет выведено на экран, будь то монитор 

компьютера, дисплей коммуникатора или электронная книга. Никакой бумаги, ни-

каких красок, никакой заботы о правильной обрезке по формату и подходящем пе-

реплете. Никаких сигналов, посылаемых внешним видом и материальной состав-

ляющей публикации: будь то "Гамлет" или сборник анекдотов, в руках у читателя 

все тот же электронный прибор. 

Но зато у нас появляются широчайшие возможности по использованию виртуаль-

ных средств воздействия. В электронную публикацию можно встроить аудио- и 

видеоролики; гиперссылки, позволяющие переходить к блокам нужной информа-

ции за один шаг; кнопки, формы и другие интерактивные элементы. Можно на-

строить существование публикации во времени, чтобы определенные медиа-

материалы появлялись и проигрывались в заданный момент; можно определить 

реакцию публикации на конкретные действия читателя или на результат работы 

других частей публикации. Словом, электронная публикация — своеобразный вир-

туальный мир, созданный для передачи информации "в чистом виде", но зато зна-

чительно расширяющий способы ее восприятия читателем. 
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Разумеется, подготовка макета для такой публикации требует совсем иных навыков 

и инструментов, чем работа для полиграфии. Здесь совсем другая работа с цве-

том — прежде всего, используются другие цветовые модели; не требуется знание 

особенностей работы с бумагой и печатными красками; отсутствуют полиграфиче-

ские ограничения. Но зато надо уметь располагать свое творение не только в про-

странстве, но и во времени. Нужно понимать, как готовая публикация поведет себя 

на экранах разных размеров и разрешений, ориентироваться в основах web-верстки 

и даже отчасти web-программирования. Очень важно представлять себе взаимодей-

ствие различных медиаформатов и воздействие их на пользователя в сочетании 

с текстом, оформлением и другими элементами макета. 

Соответственно, специфические инструменты, используемые для подготовки элек-

тронной публикации, больше похожи на то, с чем имеют дело специалисты по ви-

деомонтажу и компьютерной анимации. В InDesign эти инструменты представлены 

ровно настолько, насколько это необходимо для выполнения задач верстки, но те, 

кто ими заинтересуется, могут потом продолжить свое профессиональное развитие 

в сторону таких программ, как Adobe Flash Professional или Adobe AfterEffects. 

Именно поэтому мы будем рассматривать печатные и электронные публикации как 

отдельные направления верстки, в разных главах, после того, как разберемся  

с основными возможностями программы, применимыми при подготовке любых 

макетов. 

Итак, приступим к знакомству с программой. 
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Глава 3 
 

 

ЗНАКОМСТВО С ПРОГРАММОЙ 

 

 

 

 

 

В этой главе вы узнаете: 

 как организовано окно программы; 

 как работать с палитрами; 

 как создать и сохранить свое собственное рабочее пространство; 

 как работать с панелью инструментов; 

 как перемещаться по документу и изменять масштаб просмотра. 

Окно программы —  
что мы видим при запуске 

Запустим программу (Пуск > Программы > Adobe InDesign CS5), откроем доку-

мент Chapter3\Working.indd и рассмотрим открывшееся нам окно (рис. 3.1). 

Окно программы традиционно для пакетов Adobe и имеет панельную структуру, 

т. е. состоит из панелей или палитр. 
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Рис. 3.1. Окно программы 

 

Главное меню содержит все команды, необходимые для работы с программой.  

Организовано оно традиционным образом: 

 File (Файл) — управление файлами, импортом, экспортом и выводом на печать; 

 Edit (Редактирование) — все, что связано с общими изменениями документа; 

здесь же расположены команды для изменения настроек программы; 

 Layout (Макет) — настройка страниц, перемещение по макету, управление об-

щими элементами публикации; 

 Object (Объект) — управление объектами (фрагментами текста, картинками, 

формами и т. д.), расположенными на странице, и их взаимодействием; 

 Table (Таблицы) — все, что связано с созданием, форматированием и редакти-

рованием таблиц; 

 View (Вид) — настройка отображения макета на экране; 

 Window (Окно) — управление окном программы, в частности отображением и 

расположением палитр; 

 Help (Помощь) — вызов справки. 

Панель приложений расположена выше главного меню и обеспечивает быстрый 

доступ к некоторым настройкам окна (например, основные настройки отображения, 

размещение документов в окне и основные конфигурации рабочего пространства); 

отсюда же можно быстро вызвать программу Adobe Bridge, предназначенную для 

просмотра, обмена и синхронизации изображений, созданных в разных программах 

Adobe. 

Панель инструментов объединяет все основные инструменты, используемые в 

программе. 
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Контрольная панель содержит основные настройки, связанные с любым объектом, 

такие как размер, расположение, цвет и т. д.; поля контрольной панели слегка отли-

чаются для разных инструментов. 

Палитры обеспечивают быстрый доступ к развернутым настройкам основных  

команд и инструментов программы. 

Окно документа содержит рабочую область документа и основную информацию 

о нем. 

Рабочая область и страницы — часть окна программы, непосредственно предна-

значенная для работы над макетом; именно здесь мы располагаем все тексты, кар-

тинки, мультимедийные материалы и т. д., формируя публикацию. 
 

Рабочее пространство программы (Workspace).  
Обзор, настройка, сохранение 

Все элементы окна программы в совокупности называются Рабочим пространст-

вом. Рабочее пространство можно изменять в соответствии с решаемыми задачами. 

Например, можно оставить на экране только часто используемые палитры, пере-

группировать их, свернуть или развернуть, изменить взаимное расположение окон 

документов и т. д. Настроенное по своему вкусу рабочее пространство можно со-

хранить и вызывать при необходимости. 

Для сохранения своего рабочего пространства вызовите команду Window > 

Workspace > New Workspace (Окно > Рабочее пространство > Новое рабочее про-

странство), задайте имя и установки (запоминать ли только расположение панелей 

или еще и дополнительные настройки главного меню). Обычно предлагается со-

хранить "все" (рис. 3.2). 

 

 

  

При желании вы можете определить, какие команды главного меню будут отображаться при разворачи-
вании соответствующего подменю. Для этого служит команда Edit > Menus (Редактирование > Настрой-

ка меню). 
 

 

Можно также выбрать одну из готовых конфигураций рабочего пространства: 

Typography (Работа с текстом), Printing and Proofing (Предпечатная подготовка) 

и т. д. 

Для наших учебных задач мы будем использовать конфигурацию Advanced (Рас-

ширенное). Если нужно восстановить стандартную конфигурацию после неких 

сиюминутных изменений, вызовите Window > Workspace > Reset Advanced (Ок-

но > Рабочее пространство > Восстановить выбранное рабочее пространство). 

Заказное рабочее пространство можно удалить, выбрав Window > Workspace > 

Delete Workspace (Окно > Рабочее пространство > Удалить рабочее пространство). 
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Рис. 3.2. Сохранение рабочего пространства 

Работа с палитрами 

Палитры обеспечивают быстрый доступ к основным инструментам и настройкам. 
Обычно палитры собраны в группы, составленные по тематическому признаку. На-

пример: Stroke (Обводка) / Swathes (Образцы) / Gradient (Градиент). Группы соб-
раны в стек в правой части экрана напротив инструментальной панели, замыкая 

"рамку" из элементов интерфейса (инструментальная панель слева, контрольная 
панель и главное меню сверху или снизу, палитры справа). Это позволяет легко на-

ходить нужный элемент интерфейса и минимизировать занятую им площадь. Стан-
дартный набор палитр различен в зависимости от выбранного рабочего простран-

ства (рис. 3.3). Каждое рабочее пространство, стандартное или заказное, включает  
в себя не только список отображаемых палитр, но и их расположение и состояние. 

Все палитры могут отделяться от группы и стека, сворачиваться и разворачиваться, 

присоединяться к другим группам или располагаться в окне программы отдельно. 

Для того чтобы переместить палитру, нужно навести курсор на область заголовка 
палитры, нажать левую кнопку мыши и перетащить палитру на новое место 

(рис. 3.4). При подведении палитры к другой палитре, группе или стеку линия 
предполагаемого присоединения подсвечивается голубым цветом. 

Для экономии места палитры, не используемые в данный момент, можно свернуть. 

Для этого используется двойная стрелка Expand Panels (Развернуть палитры) 
в правом верхнем углу каждой палитры (рис. 3.5). 



Знакомство с программой 37 

 

Рис. 3.3. Стандартное расположение палитр 

 

Рис. 3.4. Перемещение палитры 

Стандартным образом палитра сворачивается до пиктограммы и названия. При не-

обходимости освободить дополнительное место на экране можно сузить палитру до 

одной пиктограммы (рис. 3.6), передвинув ее границу курсором. 

В дальнейшем щелчок по пиктограмме в стеке или по двойной стрелке отдельно 

лежащей палитры будет разворачивать палитру до рабочего состояния. Щелчок по 

двойной стрелке развернет все палитры в стеке (рис. 3.7). Разумно разворачивать 

палитру только на время использования, а потом снова закрывать. 
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Рис. 3.5. Развернутая палитра  
в стеке 

 

  

Рис. 3.6. Сворачивание палитры до пиктограммы Рис. 3.7. Разворачивание всех палитр в стеке 
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Палитры, которых нет в стеке, можно вызвать на экран с помощью меню Window 

(Окно). При необходимости добавить палитру в стек ее надо подтянуть к нижней 

границе стека или "перекрыть" ею группу, к которой ее предполагается присоеди-

нить. При этом соответствующая граница стека или группа целиком подсвечивают-

ся голубым цветом. 

Палитра, отделенная от стека и группы и расположенная отдельно в окне програм-

мы, называется "плавающей палитрой". Для отделения палитры от группы доста-

точно переместить ее на свободное место. Например, можно разгруппировать па-

литры Character (Символ) и Paragraph (Абзац), чтобы в процессе работы с тек-

стом иметь к ним доступ одновременно (рис. 3.8). 

 

Рис. 3.8. Разгруппировка палитр 

Любая палитра содержит либо наборы, либо настройки. В зависимости от этого 

строение палитры слегка различается. 

Все без исключения палитры имеют область заголовка, в которой, кроме названия, 

имеется кнопка отображения опций (позволяет свернуть палитру до минимально-

го, чаще всего используемого содержимого или развернуть в полный размер); кноп-

ка разворачивания/сворачивания (двойная стрелка) и кнопка вызова контекстного 

меню (рис. 3.9). 

Контекстное меню — список дополнительных команд и опций для выбранной па-

литры, объекта или группы объектов. Контекстное меню палитры вызывается 

кнопкой в ее правом верхнем углу. Для объектов вызывается щелчком правой 

кнопкой мыши на объекте (группе) и зависит от активного инструмента. 

 

Рис. 3.9. Общие элементы всех палитр 
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Палитра настроек обычно имеет несколько степеней раскрытия опций, что позво-
ляет разумно регулировать занимаемую ею площадь (рис. 3.10). Максимальный 
размер палитры настроек фиксирован и определяется количеством настраиваемых 
параметров. 

 
Рис. 3.10. Палитра настроек 

Палитра-набор состоит из своего рода "ячеек", содержащих элементы набора, все-
гда имеет кнопку создания нового элемента и "корзину" — кнопку удаления эле-
мента (рис. 3.11). Размер палитры-набора может меняться, для этого достаточно 
потянуть за ее боковой или нижний край. 

Для того чтобы скрыть все палитры и макси-

мально освободить место для работы, нажми-

те клавишу <Tab>. Повторное нажатие вернет 

палитры обратно. Для скрытия или отображе-

ния всех палитр, кроме панели инструментов, 

нажмите <Shift>+<Tab>. 

 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Рис. 3.11. Палитра-набор 

 

 

 

Панель инструментов 

На инструментальной панели (рис. 3.12) расположены все основные инструменты, 
необходимые для работы в программе. Подобно палитрам, они собраны в темати-
ческие группы: отдельно средства выбора объектов, отдельно — для работы  
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с текстом и рисования, далее — редактирование объектов, в том 
числе трансформация и управление заливками, и последняя группа 
инструментов — служебная: навигация, масштаб просмотра и бы-
строе копирование атрибутов. 

По умолчанию панель инструментов закреплена в левой части ок-

на программы. С помощью двойной стрелки в верхней части пане-

ли ее можно развернуть и выстроить инструменты в два ряда 

(удобно для сравнительно небольших экранов, например при ра-

боте с ноутбуком, чтобы все инструменты были видны в окне) или 

свернуть до одного ряда, что освобождает дополнительное рабо-

чее пространство (рис. 3.13). 

При необходимости инструментальную панель можно перемещать 

по экрану, ухватив за двойной пунктир в области заголовка. Сме-

щение панели с ее обычного места и возвращение назад происхо-

дят так же, как и для всех прочих палитр. В "плавающем" состоя-

нии дополнительный щелчок по двойной стрелке располагает ин-

струментальную панель горизонтально (рис. 3.14). 

 
 
 
 
 
 
 

 

 

Рис. 3.13. Свернутый и развернутый вид  
инструментальной панели 

 
Рис. 3.14. Перемещение инструментальной панели; перевод в горизонтальное положение 
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При наведении курсора на пиктограмму инструмента появляется 

подсказка: название инструмента и клавиатурное сокращение для его 

вызова (рис. 3.15). 

Обратите внимание, что в нижней части некоторых кнопок имеется 

маленький черный треугольник. Это значит, что под этой кнопкой 

расположено еще несколько инструментов. Для отображения скры-

тых элементов нужно либо повторно нажимать на кнопку при нажа-

той клавише <Alt>, либо нажать и задержать кнопку мыши, пока не 

появится выпадающий список инструментов, в котором и выбирается 

нужный. Выбранный инструмент остается отображенным, пока вы не 

выберете другой из того же списка. 

 

 

 

 

 

 
 
 

 

Рис. 3.15. Подсказка  
инструментальной панели 

Контрольная панель (Управляющая палитра) 

Контрольная панель (Window > Control (Окно > Контрольная панель)) обеспечива-

ет быстрый доступ к основным настройкам и командам, связанным с отдельным 

объектом. В зависимости от выбранного инструмента она может содержать общие 

настройки и основные трансформации (для большинства инструментов) или  

команды текстового форматирования для инструмента Текст (рис. 3.16, 3.17). 

 

Рис. 3.16. Контрольная панель для большинства инструментов  
(объект выделен инструментом Selection Tool) 

 

Рис. 3.17. Контрольная панель для инструмента Текст  
(текстовый фрагмент выделен инструментом Text Tool) 
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Обычно она закреплена в верхней части окна (Dock at 

Top), но при желании ее можно закрепить в нижней 

части окна (Dock at Bottom) или сделать "плавающей" 

(Make Floating) с помощью соответствующих команд 

контекстного меню (рис. 3.18). 

 
 
 

 

 

Рис. 3.18. Вызов контекстного меню  
контрольной панели 

 

Окно документа 

Окно документа содержит все страницы публикации. Каждая страница или разво-

рот имеет свою собственную рабочую область, служащую для временного хране-

ния объектов, еще не нашедших своего места в макете. 

Объекты, расположенные в рабочей области за пределами страницы, не печата- 

ются. 

Кроме того, рамка окна документа содержит основную информацию о нем. В об-

ласти заголовка отображается имя документа и масштаб; в левом нижнем углу — 

поле быстрого перехода на нужную страницу (рис. 3.19, 3.20). 
 

   

Рис. 3.19. Область  
заголовка документа 

Рис. 3.20. Поле быстрого перехода  
между страницами 

Рис. 3.21. Поле  
Preflight 

 

Здесь же расположено окно оперативной проверки ошибок верстки Preflight (Про-

верка верстки). Зеленый маркер и надпись No Errors (Ошибок нет) показывает, что 

все в порядке (рис. 3.21). Если где-то образовалась проблема — потерян шрифт, 

текст не помещается в отведенную ему область и т. д. — в поле Preflight появляет-

ся красный маркер и надпись Error (Ошибка). 

Двойной щелчок по этому полю вызывает диалоговое окно Preflight (рис. 3.22), 

позволяющее локализовать и исправить ошибку. 

Обычно окно документа прикреплено к верхнему краю окна программы, но при 

желании его можно открепить, потянув за область заголовка, как любую палитру.  

В "плавающем" состоянии к обычной кнопке закрытия файла добавляются кнопки 

сворачивания окна и разворачивания его во весь экран. Если одновременно откры-

то несколько окон документов, то переключение между ними производится клави-

шами <Ctrl>+<Tab>. Взаимное расположение окон регулируется командами меню 

Window > Arrange (Окно > Размещение).  
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Рис. 3.22. Диалоговое окно Preflight 

 

Окна можно расположить следующим образом (рис. 3.23): 

 Cascade (Каскад) — окна перекрывают друг друга; 

 Tile (Плитка) — окна документов раскладываются в окне программы рядом, как 

кафельная плитка на стенах; 

 Float in Window (Сделать плавающим) — выбранное окно отделяется от "груп-

пы" и свободно перемещается в окне программы; 

 Float All in Windows (Сделать все плавающими) — то же самое для всех окон 

документов; 

 Consolidate All Windows (Собрать все окна) — все окна документов снова за-

крепляются в окне программы. 

Ни один из этих режимов не универсален, каждый полезен для своего круга задач и 

выбирается по мере необходимости. Например, режим Tile (Плитка) очень удобен, 

когда нужно сравнить содержимое разных файлов или перенести материал из одно-

го файла в другой методом Drag&Drop (перетаскиванием). Но для работы с боль-

шим увеличением или для просмотра всего макета в целом он не подходит, по-

скольку каждый файл получает в свое распоряжение слишком малую часть окна 

программы. 

У остальных режимов также есть свои особенности, в зависимости от которых мы и 

выбираем для разных работ разный способ размещения окон. 
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Рис. 3.23. Расположение окон в режимах Tile и Float in Window 

Изменение масштаба просмотра  
и перемещение по документу 

InDesign позволяет просматривать макет в масштабе от 5% до 4000%. Такой диапа-
зон обеспечивает нам возможность как окинуть взглядом весь макет, вплоть до 
большого газетного разворота, так и редактировать очень мелкие детали иллюстра-
ций или отслеживать тончайшие изменения настроек текста. 

Изменить масштаб отображения можно несколькими способами. 

 Воспользоваться полем масштаба, расположенным на панели приложения в 
верхней части окна программы, выбрав нужный масштаб в выпадающем списке 
(рис. 3.24). 
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Рис. 3.24. Список 
уровней масштаба 

просмотра  
документа 

 

Рис. 3.25. Действие инструмента Лупа 

 

 

 Воспользоваться командами меню View (Вид) или их клавиатурными сокраще-

ниями: 

 Zoom In (Увеличить) — <Ctrl>+<+> 

 Zoom Out (Уменьшить) — <Ctrl>+<–> 

 Fit Page in Window (Страница во все окно) — <Ctrl>+<0> 

 Fit Spread in Window (Разворот во все окно) — <Ctrl>+<Alt>+<0> 

 Actual Size (Реальный размер — 1:1) — <Ctrl>+<1> 

 Entire Pasterboard (Вся рабочая область) — <Ctrl>+<Alt>+<Shift>+<0> 

Каждое применение команды или клавиатурного сокращения Zoom In/Zoom 

Out изменяет масштаб на один уровень выпадающего списка в панели прило- 

жения. 

 Выбрать в инструментальной панели Zoom Tool (Лупу). Для увеличения нужно-

го фрагмента макета обведите его лупой "в рамку" (рис. 3.25). После отпускания 

кнопки мыши выбранный фрагмент будет показан во весь экран. Щелчки лупой 

при нажатой кнопке <Alt> будут уменьшать масштаб на один уровень за одно 

действие. 

Самый распространенный способ работы с масштабом — временный вызов лупы 

при использовании любого другого инструмента нажатием клавиш <Ctrl>+ 

+<Пробел>. После того как все клавиши будут отпущены, в нашем распоряжении 

снова окажется активный инструмент. Этот метод хорош тем, что не требует пере-

ключать инструменты через панель, чем экономит время и позволяет не прерывать 
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работу активного инструмента, что порой бывает очень важно, например при рисо-

вании инструментом Pen (Перо). 

Для перемещения по окну программы используется инструмент Hand (Рука), также 

расположенный в инструментальной панели (рис. 3.26). Как и лупу, его можно вы-

звать с клавиатуры, нажав клавишу <Пробел> при работе с любыми инструмента-

ми, кроме текстового, и <Alt> на фоне инструмента Text Tool (Текст). 

 

Рис. 3.26. Инструмент  
Hand 

Вспомогательные элементы интерфейса: 
направляющие и сетки 

Для упрощения работы по точному размещению объектов на странице InDesign 

предоставляет нам дополнительные средства: базовую сетку и направляющие. 

Базовая сетка (Document Grid) — что-то вроде знакомой нам миллиметровки, по-

зволяющая расставлять объекты "по клеточкам" и привязывать ("приклеивать") их 

к линиям сетки. Сетка отображается и скрывается командой View > Grids & 

Guides > Show Document Grid (рис. 3.27) (Вид > Сетки и направляющие > Пока-

зать сетку) — <Ctrl>+<’>. 

 

Рис. 3.27. Документ с видимой сеткой 
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Сетка настраивается в разделе меню Edit > Preferences > Grids  (Редактирование > 

Предпочтения > Сетки), где можно задать цвет сетки, сочетание толстых и тонких 

линий и расстояние между ними (рис. 3.28). 

 

Рис. 3.28. Окно настройки сетки 

 

Для точного размещения объектов на странице 

используются направляющие (Guides). Для рабо-

ты с ними нужно предварительно вызвать линейки 

(Rules) — <Ctrl>+<R>. Линейки размечаются в 

тех единицах измерения, которые использовались 

при создании документа (сантиметры, миллимет-

ры, дюймы и т. д.). Изменить единицы измерения 

для документа можно, сделав щелчок правой 

кнопкой мыши на линейке и выбрав нужное из 

выпадающего списка (рис. 3.29). 

 
 
 

 

 

Рис. 3.29. Замена единиц измерения 

 

 

 

Линейки также служат для изменения положения начала координат. Обычно точка 
(0;0) расположена в левом верхнем углу страницы (или в центре верхней границы 
разворота), но иногда бывает нужно начать отсчет в какой-либо другой точке.  
В этом случае нужно нажать левую кнопку в пустом квадрате на пересечении лине-
ек и тянуть появившееся перекрестие в точку, где предполагается новое начало ко-
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ординат (рис. 3.30). Возврат начала координат на прежнее место производится 
двойным щелчком по тому же пустому квадрату. 

 

Рис. 3.30. Изменение положения начала координат 

Самое частое применение линеек — в качестве источника направляющих линий 

(Guides). Для создания направляющей линии нужно нажать левую кнопку мыши в 

пределах линейки и вытянуть из нее линию. Горизонтальные направляющие вытя-

гиваются из верхней линейки, вертикальные — из боковой (рис. 3.31). Для того 

чтобы направляющая проходила через весь разворот, ее нужно вытягивать при на-

жатой клавише <Ctrl>. 

 

Рис. 3.31. Создание направляющих 

Направляющие можно отображать и скрывать, блокировать и разблокировать. 

Отображение и скрытие направляющих вызывается командой View > Grids & 

Guides > Show Guides (Вид > Сетки и направляющие > Показать направляю-

щие) — <Ctrl>+<4>. 
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Блокировка направляющих устанавливается и снимается командой View > Grids & 

Guides > Lock Guides (Вид > Сетки и направляющие > Заблокировать направляю-

щие) — <Ctrl>+<Alt>+<4>. 

Привязка к направляющим устанавливается и снимается командой View > Grids & 

Guides > Snap to Guides (Вид > Сетки и направляющие > Привязать к направляю-

щим) — <Ctrl>+<Shift>+<4>. 

Активное использование направляющих за-

метно ускоряет работу над любым макетом и 

совершенно необходимо в газетной и жур-

нальной верстке, при создании модульной 

сетки (разметки страницы с учетом соедине-

ния статей, иллюстраций и рекламных моду-

лей). 

Дополнительные возможности точного раз-

мещения объектов на странице предоставляет 

режим Smart Guides (Умные направляющие), 

в котором программа предлагает различные 

варианты выравниваний и привязок, которыми 

можно воспользоваться как при перемещении 

объектов, так и при других трансформациях 

(рис. 3.32). 
 

 

 

 

 

Проект "Разметка делового письма" 

В этом проекте мы сформируем разметку с помощью направляющих бланка дело-

вого письма, задав место для фирменных элементов, область реквизитов фирмы, 

область обращения, пространство основного текста. Для работы нам потребуются 

линейки и направляющие. 

1. Откройте файл Chapter3\Project_letter.indd. 

2. Проверьте, чтобы в списке конфигураций рабочего пространства было выбрано 

Advanced (Расширенный). 

3. Включите линейки (<Ctrl>+<R>). 

4. Ориентируясь на разметку-образец, расставьте направляющие по странице, вы-

тягивая их из линеек; обратите внимание, что внешние поля документа уже обо-

значены розово-лиловыми линиями. Эти линии — особый вид направляющих, 

которые задают Margins (отступы) — поля документа и, при необходимости, 

расстояние между колонками (рис. 3.33). 

5. Вызовите на экран палитру Layers (Слои) — Window > Layers (Окно > 

Слои) — <F7>. 

 

Рис. 3.32. Перемещение  
в режиме Smart Guides 
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6. Нажмите на пиктограмму "глаз" рядом со 

слоем "Образец разметки". Глаз пропадет, и 

образец станет невидимым. 

7. Щелкните мышью в таком же квадрате рядом 

со слоем "Письмо". Включится видимость 

слоя ("глаз"), и мы сможем увидеть, как вы-

глядит макет, построенный по нашей раз- 

метке. 

 
 
 
 
 
 
 
 

 

 

Рис. 3.33. Линии Margins,  
задающие внешние поля 

 

 

Итоги 

Мы рассмотрели основные элементы интерфейса программы и выяснили, куда 

смотреть, как перемещаться, чем пользоваться в первую очередь и на что обращать 

особое внимание. Теперь можно переходить  к работе с программой, не боясь что-

то ненароком испортить или в чем-то запутаться. 

Для начала попробуем немного... порисовать. 

 

 

 

 



  

 

Глава 4 
 

 

ОБЪЕКТЫ. ГЕОМЕТРИЧЕСКИЕ ФИГУРЫ. 

ТРАНСФОРМАЦИЯ 

 

 

 

 

В этой главе вы узнаете: 

 какими инструментами можно пользоваться для создания геометрических  

фигур; 

 как изменять форму, размер и другие характеристики фигур по мере надоб- 

ности; 

 как раскрасить фигуры в нужные цвета; 

 как создать сложные формы из простых и как отредактировать готовую фигуру 

по своему усмотрению; 

 как создать и разместить на странице нужное количество копий одной и той же 

фигуры; 

 как воспользоваться этими фигурами для интересного оформления страницы. 

Для работы с этой главой откройте файл Chapter4\working.indd и в инструменталь-

ной панели переключите значения в блоке управления цветом, нажав на скруглен-

ную стрелку, чтобы впереди оказался черный квадрат (рис. 4.1). 
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Рис. 4.1. Переключение значений  
в блоке управления цветом 

Рис. 4.2. Инструменты создания  
геометрических фигур 

Инструменты создания  

геометрических фигур 

Геометрические фигуры  основной оформительский элемент любого макета.  

В публикации может совсем не быть иллюстраций, она может быть предельно про-

стой и лаконичной, но хотя бы линеечка над номером страницы, квадратная метка, 

перекликающаяся с маркерами списка, какой-то другой легкий акцент — и макет 

сразу приобретет законченный вид, некую собственную "изюминку". Если же гово-

рить о журнальной верстке, о рекламе, о справочных материалах, то они никогда не 

обходятся без всевозможных цветных или черно-белых плашек, рамок и другой 

"геометрии", подчеркивающей структуру изложения материала и привлекающей 

дополнительное внимание. 

InDesign CS5 не может похвастаться разнообразием геометрических инструментов, 

но это с лихвой компенсируется богатством возможностей по модификации гото-

вых фигур (рис. 4.2). 

Инструменты создания фигур "на глаз" 

Rectangle Tool (Прямоугольник) (<M>) рисует прямоугольники; обычный способ 

рисования — нажать левую кнопку мыши в предполагаемом левом верхнем углу и 

тянуть по диагонали, пока не получится фигура нужного размера и пропорций. 

При нажатой клавише <Shift> получается квадрат, при нажатой клавише <Alt> ри-

сование происходит от центра объекта (рис. 4.3). 

 

Рис. 4.3. Клавиши-модификаторы геометрических инструментов 
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Если в процессе рисования нажимать клавиши < >, < >, < >, < >, обведенная 
мышью область будет равномерно заполняться одинаковыми прямоугольниками, 
расположенными, соответственно, в столбик или в строчку. Очень удобно для соз-
дания элементов оформления страницы — например "пунктира" по всей ширине 
или длине страницы. 

1. Выберите инструмент Прямоугольник и нарисуйте длинную горизонтально 
вытянутую фигуру; удерживая клавишу мыши, нажимайте на клавиатуре стрел-

ку < >, пока весь нарисованный прямоугольник не заполнится маленькими 
квадратиками (рис. 4.4). 

2. Повторите операцию для вертикального прямоугольника и стрелки < >. 

 

Рис. 4.4. Размещение одинаковых элементов в области рисования  
с помощью клавиатурных стрелок 

Ellipse Tool (Эллипс) (<L>) рисует эллипсы. Клавиши-модификаторы те же,  
<Shift> создает круг, <Alt> рисует его из центра. Клавиатурные стрелки работают 
для эллипсов так же, как и для прямоугольников. 

Polygon Tool (Многоугольник) рисует многоугольники, по умолчанию — шести-
угольники. Количество сторон можно отредактировать в настройках инструмента. 
Клавиши-модификаторы те же, что и для остальных инструментов. 

Line Tool (Линия) (<\>) создает прямые отрезки. При нажатой клавише <Shift> от-
резки получаются строго горизонтальными, строго вертикальными или под 45°. 

Рисование геометрических фигур  
с заданными параметрами 

Во многих случаях требуется нарисовать геометрические фигуры точно заданных 
размеров. Здесь можно было бы построить в большом количестве направляющие, 
установить привязку (<Ctrl>+<U>) и таким образом получить нужный результат. 
Но гораздо быстрее будет воспользоваться диалоговыми окнами инструментов. 

Диалоговое окно инструмента рисования вызывается щелчком мыши по рабочему 
пространству при выбранном инструменте (рис. 4.5). 

Окно каждого инструмента содержит характерные для него настройки: для прямо-
угольника и эллипса — длину и ширину, для многоугольника — дополнительное 
количество сторон и "звездность" (рис. 4.6). 

1. Выберите инструмент Polygon Tool (Многоугольник), щелкните мышью по лис-
ту и в диалоговом окне задайте длину и ширину по 50 мм, количество сторон — 
16, степень "звездности" — 10. Нажмите ОК. 
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2. Повторите несколько раз с разными настройками. 

3. Поэкспериментируйте с окнами инструментов Прямоугольник и Эллипс. 

Теперь, зная, как создаются базовые фигуры, можно рассмотреть способы их изме-

нения и создания на их основе новых, сложных и интересных форм. 

  

Рис. 4.5. Диалоговое окно  
инструмента Эллипс 

Рис. 4.6. Диалоговое окно  
инструмента Многоугольник 

Коррекция формы геометрических объектов 

Основной инструмент модификации формы объектов — палитра Pathfinder (Обра-

ботка контуров) (рис. 4.7). 

 

Рис. 4.7. Палитра Pathfinder 

 

Верхняя секция палитры предназначена для работы с отдельно взятым контуром. 

Команды верхней секции: 

 Join Path (Соединение) соединяет две концевых точки одного или разных кон-

туров; 

 Open Path (Размыкание) размыкает замкнутый контур (рис. 4.8); 

 Close Path (Замыкание) замыкает разомкнутый контур; 
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Рис. 4.8. Точка размыкания контура в команде Open Path 

 Reverse Path (Изменение направления) меняет направление контура на проти-
воположный. Очевидный результат применения этой команды: если линия име-
ет на концах стрелки или другие концевые элементы, они меняются местами 
(рис. 4.9). 

 

Рис. 4.9. Результат применения команды Reverse Path к контуру с концевыми элементами 

Палитра Pathfinder (Обработка контуров) позволяет создавать составные объекты. 
Несколько фигур можно объединить или вычесть друг из друга и получить таким 
образом новую форму. Палитра Pathfinder способна обрабатывать следующие объ-
екты: рисованные объекты; текстовые фреймы; текст, переведенный в кривые. 

Режимы работы палитры Pathfinder: 

 Add (Добавление) создает новую форму по общему контуру массива объектов 
(рис. 4.10); 
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Рис. 4.10. Команда Add 

 Subtract (Вычитание верхнего объекта из нижнего) вычитает из самого нижнего 
объекта все расположеные выше (рис. 4.11); 

 

Рис. 4.11. Команда Subtract 

 Intersect (Пересечение) удаляет все, кроме области пересечения объектов 
(рис. 4.12); 

 

 

  

Команда работает только в случае, если существует хотя бы небольшая область, где пересекаются все 
выбранные объекты. В противном случае выдается сообщение о невозможности выполнить команду. 
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Рис. 4.12. Команда Intersect 

 Exclude Overlap (Вычитание области пересечения) действует на всех участках, 

где пересекаются хотя бы два объекта (рис. 4.13); 

 

Рис. 4.13. Команда Exclude Overlap 

 Minus Back (Вычитание нижнего объекта из верхнего) вычитает из самого 

верхнего объекта все расположенные ниже (рис. 4.14). 

Нарисуйте три пересекающихся фигуры. Рассмотрите действие всех команд, каж-

дый раз возвращаясь в исходное состояние клавиатурным сочетанием <Ctrl>+<Z>. 

В палитре Pathfinder имеется дополнительная секция Convert Shape (Преобразо-

вание фигур). 
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Рис. 4.14. Команда Minus Back 

Ее можно условно разделить на три части: 

 обработка углов; 

 преобразование фигур; 

 преобразование точек. 

Первая позволяет придать нестандартную форму углам фигур: не только обычное 

скругление, но и скосы, и выемки разного вида (рис. 4.15). 
 

 

Рис. 4.15. Оформление углов 



Объекты. Геометрические фигуры. Трансформация 61 

Вторая преобразует любую форму в любую другую. То есть можно превратить  

эллипс в треугольник, произвольную форму в прямоугольник и т. д. 

Третья изменияет тип точек на контуре: например, преобразует острый угол в 

скругление и наоборот (рис. 4.16). 

 

Рис. 4.16. Преобразование точек 

Следует помнить, что палитра Pathfinder не работает со сгруппированными объек-
тами, т. е. с объектами, которые объединены командой меню Object > Group (Объ-

ект > Группировка) в единое целое. Это значит, что для работы с палитрой 
Pathfinder нужно сначала объекты разгруппировать: Object > Ungroup (Объект > 

Разгруппировать). В частности это касается текста, переведенного в контуры. Дело 

в том, что при переводе текста в контуры из бывших строк образуются блоки, 
сгруппированные между собой. Это один из случаев, когда необходима разгруппи-

ровка перед использованием палитры. 

Атрибуты объекта 

У каждого объекта в InDesign есть два обязательных атрибута: Stroke (Обводка) и 

Fill (Заливка). 

Обводка — внешняя граница объекта, а заливка — его "тело", наполнение. Объек-
тов без этих атрибутов не бывает: даже если они "пустые", они все равно есть 

(рис. 4.17). 

Цвета заливки и обводки показываются в блоке управления цветом инструменталь-

ной панели. Тот атрибут, который находится на переднем плане, называется актив-

ным, и к нему применяются все изменения цвета и прочее оформление. 

По умолчанию (устанавливается клавишей <D>) обводка у объекта черная, а за-

ливка "пустая" (отсутствует) (рис. 4.18). 
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Рис. 4.17. Заливка и обводка объекта 

 

Рис. 4.18. Блок управления цветом и установка стандартных параметров 

Для того чтобы изменить цвет атрибута, щелкните по нужной пиктограмме (по об-

водке или по заливке) и выберите цвет (например, из палитры Swatches (Образцы)). 

Двойной щелчок по атрибуту вызовет окно подбора цвета, с которым мы познако-

мимся подробно в главе 5. 

В особенном положении находятся текстовые фреймы (области размещения тек-

ста). С одной стороны, текст, который находится внутри фрейма, имеет собствен-

ные обводку и заливку. С другой стороны — фрейм, внутри которого расположен 

текст, тоже имеет обводку и заливку. Именно поэтому в процессе работы можно 

переключаться между обводкой и заливкой фрейма и обводкой и заливкой текста 

внутри фрейма. Для этого предназначены кнопки под пиктограммами, обо-

значающими Fill и Stroke. Щелкая по кнопке в виде квадрата, вы видите атрибуты 

фрейма, а выбирая кнопку в виде буквы Т, вы работаете с атрибутами самого текста 

(рис. 4.19). 
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Рис. 4.19. Переключение между фреймом и его содержимым 

Для настройки обводки существует специальная палитра Stroke (Обводка). Здесь 
можно настроить ее толщину и цвет, тип линии, пунктир, способ оформления углов 
и концевые элементы. 

1. Нарисуйте любую геометрическую фигуру. Задайте ей атрибуты по умолчанию 
("пустую" заливку и черную обводку толщиной 1 pt). 

2. С помощью команды Open Path (Разомкнуть контур) палитры Pathfinder (Об-
работка контуров) превратите замкнутый контур в открытый. 

3. Поэкспериментируйте с разными значениями параметров обводки. 

4. Задайте контуру концевые элементы (например, кружок в точке Start и стрелку 
в точке End). 

5. Командой Reverse Path (Изменить направление) палитры Pathfinder поменяйте 
местами начало и конец контура и оцените результат. 

При желании можно создать свой собственный стиль обводки, воспользовавшись 
командой Stroke Style (Стиль обводки) из контекстного меню палитры Stroke. 
В открывшемся окне нажмите на кнопку New (рис. 4.20). 

 

Рис. 4.20. Окно создания стиля обводки 
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В новом окне вы можете детально настроить пунктирную обводку, обводку, со-

стоящую из точек и состоящую из параллельных линий. 

Заливка по своему строению гораздо проще: она бывает однотонной или градиент-

ной. Подробнее с этими видам заливок мы познакомимся в главе 5. 

Доступ к основным настройкам атрибутов объекта возможен также из контрольной 

панели, что позволяет в любой момент работать с каждым атрибутом в отдельно-

сти, не заботясь о том, какой из них активен (рис. 4.21). 

 

Рис. 4.21. Блок управления атрибутами в Контрольной панели 

Трансформация объектов "на глаз"  
и с заданными параметрами 

Работа над публикацией всегда предполагает поиск оптимального размера, распо-
ложения и формы каждого элемента макета. Для этого служат, в первую очередь, 
инструменты и команды трансформации. 

Трансформация объекта — это его перемещение, изменение размера, поворот, на-
клон и зеркальное отражение относительно какой-либо оси. 

Простейший, но наименее точный способ трансформации — использование 
Bounding Box (Габаритного контейнера), маркеры которого позволяют перемещать 
объект, поворачивать и изменять его размер, но не дают возможности наклонять и 
зеркально отображать объект (рис. 4.22). Для эскизного макетирования этого обыч-
но достаточно. Но для окончательной верстки лучше пользоваться точными пара-
метрами трансформации, доступ к которым предоставляют специальные диалого-
вые окна. 

Доступ к этим окнам в InDesign CS5 обеспечен несколькими путями. 

 Группа команд Transform (Трансформация) меню Object (Объект). Она доступ-

на также из контекстного меню объекта (вызывается правым щелчком мыши  
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Рис. 4.22. Габаритный контейнер объекта 

при выделенном объекте). Из этой строки меню мы получаем доступ к четырем 

основным действиям (рис. 4.23): 

 Move — перемещение; 

 Scale — изменение размера; 

 Rotate — поворот; 

 Shear — наклон. 

Выбор команды вызывает диалоговое окно с ее настройками (рис. 4.24). Для 

лучшего контроля процесса всегда имеет смысл устанавливать режим Preview 

(Просмотр). 

В полях диалогового окна задаются параметры выполняемого действия (угол 

поворота, величина и направление сдвига, степень наклона и т. д.). 

В каждом окне имеется кнопка Copy (Копировать), которая позволяет скопиро-

вать трансформируемый объект (при этом появляется измененная копия, и оста-

ется неизменный оригинал). 

 Диалоговые окна трансформации можно вызвать также с помощью инструмен-

тов трансформации на инструментальной панели: 

 Rotate Tool — Поворот (<R>); 

 Shear Tool — Наклон (<O>); 

 Scale Tool — Изменение размера (<S>). 

Инструменты работают только с объектами, выделенными инструментом 

Selection (Черная стрелка). 

Обычный щелчок по инструменту активизирует его для трансформации  "на 

глаз", как при работе с габаритным контейнером, а двойной вызывает диалого-

вое окно для точного ввода значений. 
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Рис. 4.23. Команды группы Transform меню Object 

 

Рис. 4.24. Диалоговое окно команды Scale 

 Совершенно особый инструмент — Free Transform Tool (Свободная трансфор-

мация) (<E>). Этот инструмент объединяет в себе все перечисленные инстру-

менты.  Однако с тех пор, как габаритный контейнер получил основные функ-

ции трансформации (перемещение, размер, поворот), в его особом ведении ос-

тался только наклон. Вызов функции наклона инструмента Free Transform 

требует определенных усилий и внимания: нужно зажать мышью маркер, кото-

рый предполагается сдвинуть; не отпуская мышь, нажать клавишу <Ctrl>, и в 
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таком сочетании добиваться результата. В противном случае действие инстру-

мента Free Transform ничем не будет отличаться от работы с габаритным кон-

тейнером. 

В целом, надо признать, что на сегодня инструменты трансформации используются 
сравнительно редко, в основном для быстрого вызова диалоговых окон. 

При выполнении трансформации, которую следует многократно повторять, можно 

воспользоваться командой, хорошо известной пользователям Adobe Illustrator, но в 
InDesign появившейся сравнительно недавно, — Transform Again (Повторить 

трансформацию). Сразу после любой трансформации вы можете повторить ее, вы-
звав команду из главного меню Object > Transform Again > Transform Again 

(Объект > Повтор трансформации > Повтор трансформации). 

1. Нарисуйте любой геометрический объект. 

2. Переместите его при нажатой клавише <Alt>: появится перемещенная копия. 

3. Несколько раз подряд выберите команду Object > Transform Again > 

Transform Again (Объект > Повтор трансформации > Повтор трансформации). 
Появится ряд копий объекта, смещенных относительно друг друга одинаковым 

образом. 

Еще один способ задать параметры трансформации — вызов палитры Transform 

(Трансформация) (<F9>). Эта палитра дает доступ ко всем командам сразу и может 

использоваться как источник информации о положении и размерах объекта 

(рис. 4.25). 
 

 

Рис. 4.25. Палитра Transform 

 

Для изменения объекта с помощью палитры Transform нужно просто ввести же-

лаемые значения в соответствующие поля. Пиктограмма в левой части палитры по-

зволяет назначить центр трансформации — точку, относительно которой будут 

происходить все изменения. Центр трансформации обозначается на пиктограмме 

черным цветом. 

При работе с палитрой Transform точное указание высоты или ширины в соответ-

ствующих полях приводит к изменению только одного параметра, того, значение 

которого вы вводили. Второй параметр при этом не меняется, что может привести к 

искажению пропорций объекта. Для того чтобы одновременно с изменением шири-

ны менялась и высота (и наоборот), необходимо ввести значение параметра и на-
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жать <Ctrl>+<Enter>. Если же задавать изменение размера в процентах, то, включив 

"режим связки" ("цепочку"), вы получите пропорциональное изменение. 

Наконец, самое популярное средство параметрического задания трансформаций  — 
Контрольная панель (рис. 4.26). 

 

Рис. 4.26. Блок трансформации в Контрольной панели 

Здесь расположены уже знакомые нам поля местоположения, размера (обратите 
внимание, здесь можно установить режим связки и для точных значений размера, и 
для процентного изменения), поворота и скоса. Кроме того, здесь же находятся 
кнопки для часто используемых команд: поворот на 90° по часовой стрелке и про-
тив, зеркальное отражение по горизонтали и вертикали. Это позволяет заметно  
ускорять подобные операции, поскольку не требуется специально вводить значения 
в соответствующие поля. 

Группировка объектов 

Часто бывает необходимо, чтобы несколько разных объектов во время работы вос-
принимались программой как единое целое. Например, несколько объектов состав-
ляют иллюстрацию, и их взаимное расположение должно всегда оставаться неиз-
менным. В этом случае нужно выделить все объекты, которые требуется объеди-
нить, и вызвать команду из меню Object > Group (Объект > Группировка) или 
нажать клавиши <Ctrl>+<G>. С этого момента при выделении любого из сгруппи-
рованных объектов будет появляться общий габаритный контейнер, включающий в 
себя все объекты группы. Для отмены группировки служит обратная команда глав-
ного меню Object > Ungroup (Объект > Разгруппировать) — <Ctrl>+<Shift>+<G>. 

Порядок следования объектов 

В рабочей области InDesign объекты располагаются "стопкой" в порядке их созда-
ния. Ранее созданные объекты лежат внизу стопки, последние — вверху. Чтобы 
поменять порядок следования, нужно выделить объект и применить команду меню 
Object > Arrange (Объект > Порядок) или щелкнуть правой кнопкой мыши и вы-
брать команду Arrange (Порядок) в контекстном меню объекта. В зависимости от 
положения объектов в стопке вам может быть предложено: 

 Bring to Front (Перенести вперед) — <Ctrl>+<Shift>+<]>; 

 Bring Forward (Перенести на 1 шаг вперед) — <Ctrl>+<]>; 
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 Send Backward (Перенести на 1 шаг назад) — <Ctrl>+<[>; 

 Send to Back (Отправить назад) — <Ctrl>+<Shift>+<[>. 

Если несколько объектов закрывают друг друга, а вам нужно выделить нижний из 

них, щелкайте по стопке объектов, удерживая <Ctrl>. Постепенно передвигаясь по 

стопке, вы сможете выделить тот, который нужен. Если вы хотите выделять и те 

объекты, которые перебираете, удерживайте еще и <Shift>. 

1. Нарисуйте четыре перекрывающихся фигуры. 

2. С помощью блока управления атрибутами в контрольной панели раскрасьте их 

в разные цвета. 

3. С помощью команд перемещения в стопке поменяйте порядок их расположения. 

4. Скопируйте стопку перемещением с нажатой клавишей <Alt>. 

5. Задайте другой порядок в стопке, используя клавиатурные сокращения команд. 

Копирование и размещение объектов  
во время трансформации 

Во время работы часто требуется создавать копии объектов, будь то текстовые 

фреймы или рисунки. Для этого существуют различные способы. 

Самый простой — уже знакомое нам копирование с помощью клавиши <Alt>. Ес-

ли при этом действии нажимать еще и <Shift>, копии объектов будут двигаться 

строго по вертикали, горизонтали или под углом 45°. 

 

 

  

Если у объекта, который вы копируете с <Alt>, нет заливки, это означает, что у объекта нет "тела", он 
пустой внутри. Его можно скопировать описанным способом, только подведя курсор к обводке или цен-
тральной точке объекта. 
 

 

Второй способ — копирование через буфер обмена. 

Эта операция, как и в большинстве знакомых нам программ, производится клави-

шами <CtrI>+<C> и <Ctrl>+<V>. 

Если нужно поставить содержимое буфера обмена точно на то же место, откуда 

данные были скопированы, используется команда меню Edit > Paste in Place (Ре-

дактирование > Вставить на то же место) — <Ctrl>+<Alt>+<Shift>+<V>. 

Третий способ используется для создания массива объектов: из исходного объекта 

получается сколько угодно копий, которые вставляются с заданным шагом смеще-

ния. Делается это командой меню Edit > Step and Repeat (Редактирование > По-

вторять с заданным шагом). 

1. Нарисуйте квадрат 10 10 мм. 

2. Скопируйте его (<Ctrl>+<C>). 

3. Вызовите окно Step and Repeat (рис. 4.27). 
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Рис. 4.27. Окно команды Edit > Step and Repeat 

 

В этом окне необходимо указать: 

 сколько копий объекта вы хотите получить (в данном случае — 5). 

 шаг смещения копий по горизонтали и вертикали. 

Для того чтобы вставить 5 копий, расположенных по горизонтали, шаг смещения 

по вертикали устанавливается равным нулю. Для построения объектов в столбец — 

нулевой шаг по горизонтали. При этом шаг смещения должен быть больше ширины 

или высоты объекта, иначе копии будут накладываться друг на друга. 

1. Задайте 5 копий с шагом смещения 15 мм по горизонтали. Нажмите ОК. 

2. Повторите операцию для шага смещения 15 мм по вертикали. 

3. Повторите еще раз с указанием шага смещения по обеим осям по 15 мм. 

В результате получится стрелка, составленная из квадра-

тов, — неплохой элемент оформления макета для привле-

чения внимания к справочным материалам или какой-либо 

еще важной информации (рис. 4.28). 

 
 
 

 

 

Рис. 4.28. Результат использования  
команды Step and Repeat 

 

 

 

 

Выравнивание и распределение объектов 

Безусловно, выравнивание объектов на странице очень важно при создании акку-

ратных страниц. Поэтому в InDesign для этого существует отдельная палитра Align 

(Выравнивание) — <Shift>+<F7>. 

У этой палитры существует 3 режима работы: выравнивание объектов, распределе-

ние объектов и распределение расстояний между объектами (рис. 4.29). 
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Рис. 4.29. Палитра Align 

Для того чтобы воспользоваться палитрой, нужно выделить объекты, с которыми 
вы собираетесь вести работу (их должно быть как минимум два, а в некоторых слу-
чаях и как минимум три). Пиктограммы подскажут вам, как будет происходить вы-
равнивание (Align Objects), т. е. какие края объектов выстроятся в одну линию. 
Распределение объектов (Distribute Objects) выполняется путем расстановки краев 
объектов не в одну линию, а на одинаковое расстояние. В этом случае регулируется 
именно расстояние от края одного объекта до такого же края другого объекта. 
И, наконец, в случае распределения интервалов (Distribute Spacing) выравнивают-
ся интервалы между объектами. 

Обычно выравнивание и распределение происходит в пределах границ выделенно-
го массива объектов, и все внутренние расстояния подбираются в зависимости от 
общей занятой площади. 

 

Рис. 4.30. Результат применения команды Distribute Spacing 
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Для команд распределения можно включить флажок Use Spaсing (Задать расстоя-

ние), и тогда объекты будут разнесены так, чтобы расстояние между ними (или  

между заданными их краями) стало равным назначенному. 

1. Создайте и выделите несколько геометрических фигур (4—5). 

2. Проверьте, чтобы в выпадающем списке способов выравнивания стояло Align to 

Selection (Выровнять по выделению). 

3. Включите флажок Use Spacing для распределения расстояний. 

4. Укажите в поле Use Spacing расстояние, на котором объекты должны находить-

ся друг от друга. 

5. Щелкните по одной из двух пиктограмм, отвечающих за распределение интер-

валов (рис. 4.30). 

Работа со слоями 

Слои в программе InDesign — средство организации материала в макете, позво-

ляющее быстро найти, выбрать и обработать любой объект, собрать вместе темати-

чески связанные элементы, отобразить или скрыть, заблокировать или освободить 

часть объектов в любой нужный момент. Слои можно представить как прозрачные 

листы, лежащие "стопкой" (рис. 4.31). Любой объект непременно находится на ка-

ком-нибудь слое  — том, который был активен в момент его создания. Объекты, 

лежащие на разных слоях, могут отчасти перекрывать друг друга. При необходимо-

сти объекты можно перенести со слоя на слой. 
 

 

Рис. 4.31. Схема слоевой структуры документа 
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По умолчанию каждый новый документ InDesign содержит один слой. Стандартное 

имя слоя — Layer 1, Layer 2  и т. д. Для удобства работы лучше переименовывать 

слои, давая им значимые имена — например, "Оформление", "Лакировка", "Ценни-

ки" и т. д. 

Управление слоями происходит с помощью палитры Layers (Слои) (рис. 4.32). 
 

 

Рис. 4.32. Палитра Layers 

 

Палитра Layers (Слои) — Window > Layers (Окно > Слои) отображает список сло-

ев документа и позволяет создавать, перемещать и удалять слои, управлять их ото-

бражением и печатью. В версии CS5 она приближена к аналогичной палитре  

в Adobe Illustrator и отображает имена всех объектов слоя, позволяя и настроить 

отображение любого объекта, выделить его, блокировать или освободить для рабо-

ты. Для разворачивания списка объектов достаточно нажать на треугольник слева 

от названия слоя. 

Видимость слоя включается и выключается щелчком по пиктограмме "глаз" сбоку 

от имени слоя. Щелчок при нажатой клавише <Alt> сделает невидимыми все  

остальные слои, оставив только выбранный. 

У каждого слоя есть подсветка своего цвета, что позволяет легко определять при-

надлежность объекта к тому или иному слою при выделении его на рабочем поле. 

Для выделения через палитру Layers объекта, до которого трудно добраться прямо 

в макете, служит контурный квадратик справа от имени объекта. Теперь объект 

можно выделить, даже если он полностью перекрыт другими (например, лежит под 

текстом). 

Поле рядом с "глазом" в строке слоя предназначено для метки блокировки ("зам-

ка"). Заблокировать можно как слой целиком, так и отдельный объект. 

Все настройки слоя (имя, видимость, печать, блокировка, подсветка и т. д.) одно-

временно можно задать в окне опций слоя, вызываемом двойным щелчком на стро-

ке слоя (рис. 4.33). 
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Рис. 4.33. Окно опций слоя 

Использование слоев позволяет управлять отображением и печатью содержимого 
макета. Например, можно иметь в одном документе несколько версий текста для 
разных адресатов, или несколько вариантов цветового решения, или разные версии 
вывода на печать — "легкую" (с текстом и основными оформительскими элемента-
ми для проверки и коррекции) и "тяжелую" (со всеми импортированными картин-
ками и эффектами для окончательного утверждения). 

Проект "Клоун" 

В этом проекте мы рассмотрим, как создать простую, но стильную иллюстрацию, 
используя только геометрические инструменты и средства редактирования формы 
объектов. 

1. Откройте файл chapter4\project_clown\ project_clown.indd. 

2. Ориентируясь на образец, нарисуйте правильный круг (инструмент Эллипс при 
нажатой клавише <Shift>). Это будет голова. 

3. Добавьте по бокам два маленьких эллипса — уши. Поверните правое ухо на  
–10°, а левое — на 10°. 

4. Примените к этим трем объектам команду Add (Добавление) палитры 
Pathfinder (Обработка контуров) (рис. 4.34). 

 

Рис. 4.34. Создание головы клоуна 

5. Разверните палитру Swatches (Образцы) и при выделенном объекте "Голова" 
выберите подходящий цвет. 

6. Нарисуйте белый круг (белок глаза) и внутри него черный (зрачок). Сгруппи-
руйте их (<Ctrl>+<G>). Перемещением при нажатой клавише <Alt> скопируйте 
глаз. 
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7. Нарисуйте горизонтальный эллипс — нос. 

8. Создайте улыбку: нарисуйте два пересекающихся эллипса и примените к ним 

команду Subtract (Вычитание) (рис. 4.35). 

 

Рис. 4.35. Создание улыбки 

9. Сгруппируйте голову и элементы лица (<Ctrl>+<G>). 

10. Инструментом Многоугольник в режиме точных параметров (щелчок инстру-

ментом по рабочему полю) нарисуйте треугольник: 

 Polygon Width = 25 mm 

 Polygon Height = 30 mm 

 Number of Sides = 3 

 Star Inset = 0 

11. Это будет клоунский колпак. На его вершине нарисуйте круглое завершение 

диаметром 10 мм. 

12. В пределах колпака нарисуйте круглую "пуговицу" диаметром 4 мм. 

13. Скопируйте ее (<Ctrl>+<C>). 

14. Командой Edit > Step and Repeat (Редактирование > Повторить с заданным 

шагом) размножьте пуговицы, задав смещение по горизонтали равным 0, по 

вертикали — 6 мм (рис. 4.36). 

 

Рис. 4.36. Ряд пуговиц на колпаке 
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15. Раскрасьте элементы колпака, выбирая цвета в палитре Swatches. 

16. Сгруппируйте колпак, поверните его на –10° и расположите поверх головы. 
Сгруппируйте голову и колпак. 

17. Нарисуйте эллипс размером 50 105 мм. Это будет тело. 

18. Поверх эллипса-тела нарисуйте узкий прямоугольник (1,5 60 мм) и располо-
жите его по образцу. Примените команду Subtract. 

19. Нарисуйте прямоугольник размерами 4 6 мм. С помощью желтого квадратного 
маркера на габаритном контейнере скруглите его углы. 

20. Скопируйте его в буфер обмена (<Ctrl>+<C>). 

21. Командой Step and Repeat задайте 6 копий со смещением по вертикали, рав-
ным 0, по горизонтали 4,5 мм. Залейте фигуры белым или светло-серым цве-
том. Сгруппируйте получившийся ряд. 

22. Нарисуйте два эллипса: 17 35 мм и 17 45 мм. Первый поверните на 35°, вто-
рой — на –35°. 

23. Наложите их нижними частями друг на друга и примените команду Add (Доба-
вить) (рис. 4.37). Это будут руки клоуна. 

 

Рис. 4.37. Объединение деталей рук 

24. Выделив получившуюся фигуру, щелкните по кнопке горизонтального зер-
кального отображения Контрольной панели при нажатой кнопке <Alt>. Полу-
чится зеркально отображенная копия. 

25. Пристройте руки к туловищу и выровняйте все части тела (команды Align to 
Top (Выравнивание верхних границ) и Distribute Spacing (Распределение рас-
стояний) палитры Align) (рис. 4.38). 

 

Рис. 4.38. Соединение рук и туловища 
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26. Выделив все три объекта, примените к ним команду Add. 

27. Для того чтобы раскрасить половинки тела в разные цвета, создайте дополни-

тельную половинку: 

 скопируйте тело клоуна; 

 вставьте на то же место (Edit > Paste in Place); 

 нарисуйте сверху прямоугольник, левый край которого пройдет через сере-

дину тела клоуна (его вертикальную ось симметрии); 

 выделите верхнюю копию тела клоуна и прямоугольник и примените к ним 

команду Intersect (рис. 4.39). 

 

Рис. 4.39. Создание дополнительной половинки тела клоуна 

28. Раскрасьте половинки, выбирая заливку из палитры Swatches. 

29. Нарисуйте эллипс 25 13 мм. Сверху нарисуйте пересекающийся с ним прямо-

угольник со скругленными углами. Примените к ним команду Subtract. Скопи-

руйте щелчком по кнопке зеркального отображения на Контрольной панели 

при нажатой клавише <Alt>. Это будут ладони. Залейте их тем же цветом, что и 

лицо. 

30. Соедините все детали клоуна (голову, тело, руки, воротник) и сгруппируйте их. 

31. Добавим клоуну ботинки (рис. 4.40). 

 Основная форма ботинка — три эллипса, пересекающихся друг с другом. 

Нарисуйте их, ориентируясь на образец, выделите и примените к ним  

команду Add. 

 Положите сверху прямоугольник, чтобы он перекрыл нижнюю часть полу-

чившейся фигуры. Выделите оба объекта и примените команду Subtract. 

 Для того чтобы образовать подъем подошвы около каблука, создайте сверху 

еще один эллипс, выделите его вместе с готовой частью ботинка и снова 

примените команду Subtract. 
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 Добавьте два длинных узких прямоугольника — подошву и каблук. 

 Выделите все части ботинка и примените команду Add. 

 

Рис. 4.40. Этапы создания ботинка 

 Залейте ботинок черным цветом (<Shift>+<X> — цвет обводки меняется 

местами с цветом заливки). 

 Добавьте и залейте белым цветом эллиптический блик на носке ботинка и 

круглые дырочки для шнурков. 

 Скопируйте ботинок щелчком по кнопке зеркального отображения на Кон-

трольной панели при нажатой клавише <Alt>. Присоедините ботинки к ос-

тальным частям клоуна. 

32. Добавим пуговицы на костюме. 

 Нарисуйте круг диаметром 8 мм. 

 Поверх него нарисуйте еще два, каждый раз уменьшая диаметр. 

 Для создания абсолютно симметричной пуговицы выровняйте все три круга 

по центру (по обеим осям), если же хочется некоторой динамики, располо-

жите их примерно как на образце. Залейте желтым цветом, выбрав его в па-

литре Swatches и установив параметр Tint (Оттенок) для самого большого 

круга равным 100%, для среднего — 60%, для малого — 30%. 

 Сгруппируйте их и расположите на костюме клоуна чуть ниже воротника. 

 Скопируйте пуговицу. Командой Step and Repeat задайте 3 копии со сме-

щением по вертикали 10 мм, по горизонтали — 0. 

33. Осталось создать барабан и кольца с шариками. 

 Основа барабана — три прямоугольника: 84 35 мм и два по 88х4 мм. 

 Для оформления боковинок барабана создайте инструментом Многоуголь-

ник треугольник размером 14 35 мм. Распределите его командой Step and 

Repeat (5; 14 мм; 0). 

 Для верхнего и нижнего края создайте ряд треугольничков размером 4 4 мм 

и также разместите командой Step and Repeat (21; 4 мм; 0). 

 Раскрасьте части барабана, сгруппируйте их и присоедините к клоуну. 

34. Создайте шарики и кольца и разместите их по своему усмотрению. Для созда-

ния шарика кладите белый круглый или овальный блик поверх кружка основ-

ного цвета; для создания кольца положите один круг поверх другого, выделите 

оба и примените команду Subtract. 
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35. Раскрасьте шарики и кольца. 

36. Соберите все детали картинки вместе. При необходимости перемещайте объек-

ты и группы в стопке командами группы Object > Arrange (Объект > Порядок). 

37. С помощью блока управления атрибутами Контрольной панели подберите для 

всех элементов картинки подходящие обводки (в образце в качестве основной 

принята обводка толщиной 0,5 pt). 

38. Сгруппируйте все части иллюстрации. 

Наша картинка готова. Поскольку геометрические инструменты InDesign создают 

объекты, нечувствительные к изменению размера (не теряющие качество при уве-

личении или уменьшении), нашу картинку теперь можно использовать, например, 

для плаката с репертуаром цирка на ближайший сезон или для рекламной открыт-

ки, изменяя размер в зависимости от выбранного формата. 

Итоги 

Теперь вы знаете, как создаются элементы страницы, не связанные с текстом или 

готовыми картинками. К геометрическим фигурам и их сочетаниям мы будем воз-

вращаться еще не однажды, поскольку они — полноправные участники всех этапов 

процесса верстки. Приемы создания, трансформации и копирования фигур, их раз-

мещения на странице и внешнего оформления действуют и для других объектов. 

Рассматривая текстовые фреймы или импортированные изображения, мы не раз 

увидим, что технологии работы с ними во многом похожи на то, что было освоено 

при изучении этой главы. Поэтому перед переходом к следующей главе книги 

очень полезно придумать и реализовать свой собственный небольшой графический 

проект — например "Городской силуэт" или "Звери из геометрических фигур". 

1. Откройте файл Chapter4\working.indd. 

2. Сохраните его под новым именем. 

3. Создайте композицию на интересную вам тему. 

Тема проекта может быть любая, лишь бы она давала возможность создавать, дви-

гать, трансформировать и выравнивать фигуры, определяя их взаимодействие и до-

биваясь максимальной выразительности. 

Удачи! 
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Глава 5 
 

 

РАБОТА С ЦВЕТОМ 

 

 

 

 

 

Вы этой главе вы узнаете: 

 какие бывают цветовые модели, для каких документов каждая из них подходит; 

 какие инструменты InDesign позволяют нам работать с цветом; 

 какие дополнительные возможности дает нам палитра Swatches; 

 что такое градиент и как его использовать для украшения вашего документа. 

Цветовые модели и их назначение 

Цветовая модель (или цветовое пространство) — это способ цифрового описания 

цвета. 

Цветовая модель определяет отношения между основными цветами, а цветовое 

пространство — их абсолютные значения. В некоторых цветовых моделях (напри-

мер, CIE L*a*b) цветовое пространство фиксированное, т. к. в этих моделях учиты-

вается только восприятие цвета человеческим глазом, независимо от техники выво-

да. Такие модели принято называть аппаратно-независимыми. В других цветовых 
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моделях (RGB, HSL, HSB, CMYK и т. д.) может быть множество разных цветовых 

пространств, зависящих от технических особенностей выводных устройств. По-

скольку результирующий цвет в этих моделях различен для разных цветовых про-

странств и устройств, их называют аппаратно-зависимыми. 

Цвета могут воспроизводиться по-разному при выводе документов на разных уст-

ройствах. Причин тут много: различия между источниками изображения, разные 

программные способы определения цвета в приложениях или разная бумага (газет-

ная бумага допускает намного меньший цветовой охват, чем журнальная) и другие 

факторы, например конструкция монитора или его возраст. 

Цветовая модель RGB 

Модель RGB основана на световых лучах. Добавляя друг к другу лучи R (красный), 

G (зеленый) и B (синий), можно создать белый цвет — луч, содержащий в себе все 

цвета. Отсюда следует, что эта модель лучше всего подходит для любого рода из-

лучающих устройств — мониторов, КПК, игровых приставок, рекламных экранов  

и т. д. Для нас это означает, что цветовую модель RGB мы будем использовать 

только для работы над интерактивными и другими электронными документами. 

При смешении основных цветов результат осветляется: из смешения красного 

и зеленого получается желтый, из смешения зеленого и синего — голубой, синий и 

красный дают пурпурный. В целом, чем больше присутствие каждой составной 

части, тем светлее результирующий цвет. Исходные цвета добавляются к общей 

освещенности (изначально — нулевой, т. е. черному цвету), поэтому модель назы-

вается аддитивной (от слова Add — добавлять). 

Поскольку в модели используется три независимых значения, ее можно предста-

вить в виде трехмерной системы координат. Каждая координата соответствует од-

ному из базовых цветов и отражает его вклад в то, что мы видим на экране. Оси 

цветового пространства называются каналами, и на каждый канал обычно прихо-

дится 256 градаций цвета. 

В результате получается некий куб, 

внутри которого и "располагаются" все 

цвета, образуя цветовое пространство 

модели RGB. Любой цвет, который 

можно выразить в цифровом виде, вхо-

дит в пределы этого пространства. 

Объем такого куба (количество цифро-

вых цветов) легко рассчитать: посколь-

ку на каждой оси можно отложить  

256 значений, то 256 в кубе (или 2 в 

двадцать четвертой степени) дает число 

16 777 216 (рис. 5.1). 
 

Рис. 5.1. Схема цветовой модели RGB 
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Цветовая модель CMYK 

Модель RGB зависит от источника освещения, применяемого для создания цвета, 

а модель CMYK основана на светопоглощающих свойствах краски, напечатанной 

на бумаге. Чистый лист отражает весь падающий на него свет и выглядит белым. 

Участки, покрытые краской, поглощают часть света; то, что остается, отражается и 

воспринимается глазом как определенный цвет. Таким образом, цвет в модели 

CMYK — это результат вычитания (Subtract) поглощенной части спектра из бело-

го. Поэтому модель CMYK называют субтрактивной. Чем больше присутствие 

одной из составляющих, тем темнее итоговый цвет. 

Основные цвета модели CMYK — голубой (C — Cian), пурпурный (M — Magenta) 

и желтый (Y — Yellow). В идеале их смешение в максимально возможном количе-

стве должно давать нейтрально-черный цвет, как смешение световых лучей дает 

белый. Но в реальности этого не происходит из-за взаимодействия красок, особен-

ностей бумаги и т. д.: получается некий темно-бурый оттенок. Для того чтобы ис-

править это положение, добавляется четвертая краска (K — Key Color), обычно 

черная, которая и компенсирует недостающие цвета (рис. 5.2). 

 

Рис. 5.2. Схема цветовой модели CMYK 

Поскольку эта модель изначально привязана к бумаге и полиграфическим краскам, 
она естественным образом лучше всего подходит для работы с бумажными и т. п. 

твердыми носителями. Мы будем использовать ее для макетов печатных публи- 
каций. 

Важно помнить, что, поскольку часть цветов модели CMYK — это замещен- 

ные цвета (смесь трех красок заменяется четвертой), общее количество воспроиз-
водимых цветов (цветовой охват) у этой модели гораздо меньше, чем у модели 

RGB. 

Перевод изображения из модели RGB (в которой работают сканеры и фотоаппара-

ты) в CMYK (для печати в типографии) происходит по разным алгоритмам в зави-

симости от цветового профиля — набора настроек, определяемого свойствами  



84 Глава 5 

печатной машины, используемых красок и т. д. Цветовой профиль нужно получить 

в типографии и с помощью команды Edit > Colour Settings (Редактирование > На-

стройки цвета) настроить на него все программы, участвующие в проекте. 

Цветовая модель HSB 

Mодель HSB основана на восприятии цвета человеческим глазом, и описывает 

три основополагающие характеристики цвета. 

Hue (Цветовой тон) — собственно то, что мы привыкли называть цветом, точка 

спектра. Он определяется как точка на стандартном цветовом круге и выражается 

в градусах, от 0° до 360°. Обычно цветовой тон описывается названием цвета: 

красный, оранжевый, зеленый и т. д. 

Saturation (Насыщенность) — интенсивность или чистота цвета (иногда называется 

цветностью). Насыщенность показывает степень приближенности цвета к "чисто-

му" оттенку и измеряется от 0% (серый) до 100% (полная насыщенность). 

На стандартном цветовом круге насыщенность возрастает от центра к краю. 

Brightness (Яркость) — относительная величина светлого и темного, обычно выра-

жается в процентах от 0 (черный) до 100 (белый). 

Цветовая модель Lab 

Цветовая модель L*a*b была разработана Международной комиссией по освеще-

нию (Commission Internationale de l'Eclairage — CIE) для преодоления недостатков 

описанных моделей: в частности, она задумана как аппаратно-независимая модель 

и для определения цвета без оглядки на особенности устройства (сканера, монито-

ра, принтера, печатного станка и т. д.). 

Lab — это аббревиатура трех используемых компонентов пространства: 

L — освещенность (Lightness) — насколько цвет является ярким; 

a — положение цвета между пурпурным (magenta) и зеленым (green); 

b — его положение между желтым (yellow) и синим (blue). 

Плашечные цвета 

Плашечный цвет — это особая, заранее созданная смесь красок, которая применя-

ется вместо триадных цветов CMYK или в дополнение к ним и которая при печати 

требует использования собственной печатной формы. 

Плашечные цвета следует применять в том случае, когда используется немного 

цветов, и достоверность цветопередачи имеет очень большое значение. Краски 

плашечных цветов могут точно воспроизводить цвета, не охватываемые цветовой 

гаммой триадных цветов. То, как именно будет выглядеть плашечный цвет, опре-

деляется сочетанием заранее смешанной краски и бумаги, на которой он будет на-

печатан, а не координатами цветов или системой управления цветом. 



Работа с цветом 85 

Инструменты для работы с цветом 

Adobe InDesign располагает множеством палитр и инструментов, предназначенных 
для работы с цветом. С их помощью вы можете копировать, смешивать и сохранять 

цвет, а также получать различную служебную информацию. InDesign предназна-
чен, в первую очередь, для подготовки документов к печати, поэтому чаще всего 

вы будете использовать в своих публикациях цветовую модель CMYK. 

 

 

  

Понятие "цветовая модель документа" в InDesign отсутствует. Цвет зависит от того, в какой цветовой 
модели вы его смешали, а цветовая модель размещенной в рабочей области графики определяется 
в программе, где она была создана. 
 

 

1. Откройте файл Chapter5\Working.indd. 

2. Создайте несколько геометрических фигур — это будут наши объекты для экс-
периментов. 

Окно Colour Picker (Цветоподборщик) 

Colour Picker (Цветоподборщик) вызывается двойным щелчком по образцу в блоке 
управления цветом инструментальной панели. 

Как и в других программах Adobe, он состоит из собственно подборщика — облас-
ти визуального выбора — и блока координат в разных моделях (рис. 5.3). 
 

 

Рис. 5.3. Окно Colour Picker 

Установка флажка в одной из строк цветовой модели определяет ключевую коор-
динату — тот канал, который будет представлен в узком прямоугольнике в визу-

альной области. Остальные координаты представлены в большом квадрате слева. 
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Выбор цвета происходит передвижением бегунков в полосе ключевой координаты 

и щелчком в нужной точке квадрата. В момент выбора цвета во всех полях коорди-
нат выставляются цифровые значения цвета для каждой модели. 

Малый квадрат рядом с визуальной областью, как обычно, отображает исходный и 

новый цвета. 

 

 

  

В отличие от цветоподборщиков в Adobe Illustrator и Adobe Photoshop, здесь нет возможности выбирать 
цвет в модели HSB или определять HTML-код выбранного цвета. В окне представлены только "рабочие" 
модели, применяемые в InDesign. 
 

 

По умолчанию цвет смешивается в модели RGB. Если нужно, чтобы результирую-

щий цвет оказался задан в другой модели, достаточно поставить курсор в одно из 

координатных полей этой модели. Убедитесь, что это так, выбрав в подборщике 

ярко-синий цвет и поставив курсор в одно из полей CMYK. Цвет станет более 

блеклым, что совершенно нормально для модели CMYK, и после нажатия кнопки 

ОК будет всюду отображаться как созданный в этой модели. 

Выбранный цвет можно сохранить, чтобы в следующий раз не пришлось подбирать 

его заново. Для этого его надо добавить в палитру образцов (Add Swatches). В за-

висимости от того, какая модель выбрана, надпись на кнопке будет меняться: Add 

CMYK Swatches, Lab или RGB. 

Палитра Colour (Цвет) 

Эта палитра применяется для смешивания новых цветов с помощью координатных 

бегунков (рис. 5.4). Вызывается она командой Window > Colour (Окно > Цвет) — 

<F6>. 

Если у вас в документе активен какой-либо образец в палитре Swatches (Образцы), 

то в палитре Colour вы будете видеть всего один бегунок, а цветовая шкала будет 

представлять собой градиент между выбранным цветом и белым. Для того чтобы 

увидеть бегунки базовых цветов, выберите в контекстном меню палитры Colour 

желаемую цветовую модель, например CMYK. 

 

Рис. 5.4. Палитра Colour 
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Управляя бегунками на каждой из осей, вы получите любые цвета, возможные в 

выбранной вами модели. Другой способ получения цвета в этой палитре — щел-

кать курсором по цветовой шкале нижней части палитры. Там же расположены 

черный и белый цвет и "пустой" атрибут. 

Есть очень удобный прием получения оттенков выбранного цвета. Предположим, 

вы нашли подходящий для ваших целей цвет и теперь хотите создать набор свет-

лых/темных оттенков для создания общей гаммы документа. Для этого достаточно, 

удерживая <Shift>, двигать любой из четырех бегунков. 

1. Нарисуйте прямоугольник и покрасьте его с помощью палитры Colour в синий 

цвет (75; 61; 0; 0). Получилось? 

2. Теперь попробуйте получить описанным выше способом сначала голубой цвет, 

а затем темно-синий. 

Цвет, смешанный в палитре Colour, можно добавить в палитру образцов для даль-

нейшего использования. Для этого достаточно ухватить мышью образец цвета 

в палитре Colour и перетащить его в палитру Swatches (рис. 5.5). 
 

 

Рис. 5.5. Добавление цвета из палитры Colour в палитру Swatches 

 

Палитра Swatches (Образцы) 

Палитра Swatches (Образцы) используется для хранения всех видов заливок: одно-

тонных цветов, оттенков и градиентов (рис. 5.6). 

Вызывается она командой Window > Swatches (Окно > Образцы) — <F5>. 

В палитре можно включить режим отображения всех образцов, только цветов и от-

тенков или только градиентов, в зависимости от того, что вам на данном этапе ра-

боты нужно чаще. 

В самой палитре мы видим образец цвета, его имя (обычно это координаты цвета в 

выбранной цветовой модели), метку типа цвета (триадный или плашечный) и метку 

цветовой модели. Создать новый цвет можно, нажав на кнопку создания нового 

элемента. 
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Рис. 5.6. Палитра Swatches 

 

 

  

При этом происходит дублирование активного цвета. Для того чтобы задать новый цвет, нужно вызвать 

окно свойств образца  (рис. 5.7) — как обычно, двойным щелчком по строке образца. Появится окно  

с бегунками и списком цветовых моделей. Следите, чтобы параметр Name with Color Value (Называть 
по цветовым координатам) был включен. После изменения положения бегунков имя образца изменится 

автоматически. 
 

 

В палитре Swatches изначально имеется некоторое количество образцов. Обратите 

внимание, что это CMYK-цвета, готовые к использованию. Кроме того, в списке 

готовых образцов есть несколько необычных: Paper (Бумага), Black (Стандартный 

черный), Registration (Служебный). 

Цвет Black имеет координаты (0; 0; 0; 100), и это черный, который рекомендуется 

использовать для текста и контуров, поскольку он не содержит примесей других 

цветов, что позволит избежать ухудшения читаемости текста и появления цветной 

обводки у объектов в случае несовмещения печатных форм. Редактирование этого 

цвета запрещено. Если для работы нужен другой вариант черного (например, со-

ставной цвет для сравнительно больших областей, который будет выглядеть более 

плотным и глубоким, чем обычный 100%-й Black), его нужно создать как отдель-

ный образец. Составной черный цвет создается как сумма примерно одинаковых 

значений бегунков по всем четырем осям (например, 75; 68; 67; 90). Необходимо 
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следить, чтобы сумма красок составного черного цвета не превышала максимально 

допустимый предел, указанный в технических требованиях типографии. 

Цвет Registration имеет координаты (100; 100; 100; 100) и не используется в работе 

над макетом. Он применяется только для типографских пометок: например, для 

нанесения печатных меток на пленки. 

 

Рис. 5.7. Окно свойств образца 

Цвет Paper — это вовсе не белый, как может показаться на первый взгляд. Это цвет 

бумаги (по умолчанию предполагается, что бумага белая). Но если вы готовите до-

кумент к печати на цветной бумаге, то можно изменить цвет Paper с белого на ре-

альный цвет бумаги с помощью окна свойств образца. Для того чтобы увидеть, как 

будут выглядеть краски на цветной бумаге, надо включить опцию Overprint 

Preview (Просмотр наложения цветов) в меню View (Вид). 

Белый цвет в CMYK получается при нулевом значении всех компонентов (0; 0; 

0; 0). 

Если вы регулярно используете в своей публикации какой-либо цвет, имеет смысл 

сохранить его в палитре образцов, чтобы не приходилось каждый раз смешивать 

этот цвет заново. 

Параметр Tint (Оттенок) позволяет плавно осветлить любой цвет, добавленный 

в Swatches, и сохранить его как отдельный образец. 

Рассмотрим контекстное меню палитры Swatches. В нем собрано множество полез-

ных команд (рис. 5.8). 

New Color Swatch / New Tint Swatch / New Gradient Swatch (Создать новый обра-

зец) позволяет добавить в конец списка образцов новый цвет, смешанный в специ-

альном окне. Эта команда удобна тем, что нет необходимости обращаться к другим 

средствам и палитрам для того, чтобы смешать новый цвет и затем сохранить его. 

Load Swatches (Загрузить содержимое палитры Swatches другого документа). 

Очень удобная команда при работе с чужими документами, на основе которых вы 
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должны создать собственную публикацию. Чтобы не искать похожие цвета, вы мо-

жете просто загрузить в свой документ содержимое палитры Swatches из другого 

документа. 

 

Рис. 5.8. Контекстное меню палитры Swatches 

Загрузите палитру Swatches из документа, лежащего на диске (Chapter5\ 
Swatches.indd). В палитре Swatches добавятся образцы из выбранного документа. 

Select All Unused (Выбрать все неиспользованные образцы). Очень полезная  
команда, освобождающая документ от нагромождения лишних, неиспользуемых 
образцов. Выделенные этой командой образцы перетаскиваются в корзину. 

Add Unnamed Colors (Добавить использованные цвета) — добавляет в палитру все 
цвета, которые существуют в документе, но не добавлены в палитру (например, 
созданы с помощью палитры Colour (Цвет) или Цветоподборщика). Все вновь соз-
даваемые цвета имеет смысл добавлять в палитру Swatches. Во-первых, это позво-
ляет использовать действительно одинаковый цвет там, где это требуется, во-
вторых, сильно упрощает работу с градиентами, в-третьих, дает дополнительные 
возможности, которые мы рассмотрим ниже. 

Присвоение цвета объектам и тексту 

Для присвоения цвета объектам и тексту существует несколько способов. 

Во-первых, очевидный: выделить объект и щелкнуть по образцу в палитре 
Swatches (Образцы) или смешать в палитре Colour (Цвет) или подобрать в окне 
Color Picker (Цветоподборщик). 

Другой путь — выбрать цвет в одной из этих палитр и перетащить на объект, кото-
рый может быть и невыделенным. 



Работа с цветом 91 

 

  

В обоих случаях цвет присвоится активному атрибуту! 
 

 

Если все рабочие цвета добавлены в палитру Swatches, можно воспользоваться 

блоком управления атрибутами объекта в контрольной панели. В этом случае нет 

нужды беспокоиться об активности атрибута: каждый из них имеет свою собствен-

ную палитру образцов, которая изменит только его цвет. 

Отдельный способ работы с цветом объектов — инструмент Eyedropper (Пипетка). 

Она позволяет присвоить найденное оформление любому количеству объектов. Для 

этого достаточно щелкнуть пипеткой по объекту-образцу, а потом — по объектам, 

на которые требуется перенести оформление. 

Глобальный и неглобальный цвет 

Глобальный цвет — это цвет, который меняется одновременно во всем документе 

при изменении исходного образца. При этом перекрасятся все объекты, окрашен-

ные в этот цвет, независимо от их выделенности. 

Неглобальный цвет реагировать на изменения исходного образца не будет. Для то-

го чтобы цвет стал глобальным, его достаточно поместить в палитру Swatches. 

1. Нарисуйте два объекта и покрасьте один из них в цвет (75; 5; 100; 0) из палитры 

Swatches, а другой — в цвет с такими же координатами, созданный в палитре 

Colour. Снимите выделение. 

2. Двойным щелчком по образцу в палитре Swatches вызовите окно Swatch 

Options (Свойства образца). 

3. Включите флажок Preview (Просмотр) и поменяйте цвет исходного образца, 

двигая бегунки. 

4. Обратите внимание, что один из объектов изменил цвет, а другой остался неиз-

менным. 

Таким образом, добавляя цвет в палитру Swatches и превращая его тем самым  

в глобальный, мы создаем себе возможность оперативно редактировать цвета объ-

ектов во всем документе, что заметно ускоряет работу. 

Добавление плашечных цветов 

Зачем нужен дополнительный плашечный (Spot) цвет? 

Для понимания этого давайте вспомним, в чем заключается печатный процесс. 

Краски, цвета которых соответствуют основным цветам модели CMYK (триадные 

краски), наносятся на бумагу последовательно (сначала голубая, потом пурпурная, 

потом желтая, потом черная) в виде набора очень мелких близко расположенных 

точек — растра. Смешиваясь в глазах зрителя, они создают полноцветный печат-

ный оттиск. 
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Однако, во-первых, не все цвета можно выразить через триадные краски, во-
вторых, не все публикации задумываются как полноцветные. Иногда предполагает-
ся печать в две или три краски (прогона). Для таких случаев есть краски, смешан-
ные заранее, до печати. В англоязычной литературе их именуют spot color. В рус-
ском языке есть термины "плашечные цвета", "дополнительные цвета", "заказные 
цвета" "смесевые" и т. д. Они позволяют напечатать нужный цвет сразу, за один 
прогон. Spot-краски обеспечивают точное воспроизведение цвета, поскольку он 
подготовлен заранее и не зависит от результата цветоделения. Печатать такими 
красками можно как отдельно (в рамках одно-, двух- или трехкрасочной печати), 
так и вместе с триадными красками. 

Можно выделить три основных применения spot-цвета. 

 Печать фирменного цвета, искажение которого поставит под сомнение узнавае-
мость бренда. 

 Печать цветов, которые не попадают в цветовой охват модели CMYK. Как уже 
отмечалось ранее, эта цветовая модель имеет сравнительно небольшой цветовой 
охват: многие яркие, сочные цвета в нем отсутствуют. Такие цвета можно напе-
чатать с помощью дополнительных красок. 

 

Рис. 5.9. Список плашечных цветов в окне свойств образца 
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 Печать специфических цветов. Например, белый рисунок на цветной бумаге 

можно напечатать с помощью spot-краски (в CMYK белый имеет координаты (0; 

0; 0; 0), т. е. краска просто не наносится на белую бумагу). Сюда же можно отне-

сти золото, серебро, лак и т. д. 

Важно помнить, что spot-краски печатаются отдельным прогоном, поэтому для пе-

чати каждой из них выводится отдельная пленка и создается печатная форма. Если 

перед вами стоит задача в буклете использовать фирменный цвет в виде spot-крас-

ки, это автоматически означает, что печать будет выполняться в пять красок:  

четыре стандартные краски для печати содержимого буклета и пятая краска только 

для фирменной символики. 

Плашечные цвета для полиграфии хранятся в специальных цветовых библиотеках и 

выбираются в поле Color Mode (Цветовая модель) окна свойств образца (рис. 5.9). 

Чаще всего используются цветовые библиотеки фирмы PANTONE. Нужная биб-

лиотека выбирается исходя из используемой бумаги — Coated (Мелованная) или 

Uncoated (Немелованная); из специфики выбираемых цветов — Process (Имеющий 

триадный аналог) или Spot (Смесевый); из особенностей достигаемого эффекта — 

Pastel (Пастельный), Metallic (Металлический) и т. д. 
 

Создание и применение градиентов 

Градиент — это плавный переход между двумя и более цветами. 

В Adobe InDesign для создания градиента служит палитра Gradient (Градиент) 

(рис. 5.10). 
 

 

Рис. 5.10. Палитра Gradient 

 

Градиент может быть назначен для: 

 заливки или обводки любого графического объекта; 

 заливки или обводки текста. 

Для назначения объекту градиентной заливки достаточно выделить объект и убе-

диться, что заливка активна (в панели инструментов ее пиктограмма находится на 

переднем плане). Если теперь щелкнуть по градиентной растяжке в палитре 

Gradient (Градиент), объект получит градиентную заливку. Тип градиента выбира-
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ется в поле Туре. Возможны два варианта градиента (рис. 5.11) — линейный и ра-

диальный. 

Для того чтобы изменить цвет градиента, выделите бегунок на градиентной шкале 

(его верхний край должен стать черным) и дважды щелкните по пиктограмме за-

ливки в панели инструментов. Откроется Colour Picker (Цветоподборщик), и вы 

сможете выбрать нужный цвет. Другой способ изменения цвета бегунка — вызвать 

палитру Colour (Цвет) и изменить цвет передвижением бегунков этой палитры. 

При необходимости нужно предварительно выбрать в контекстном меню палитры 

подходящую цветовую модель (например, сменить характерную для черно-белого 

градиента модель Grayscale (градации серого) на модель CMYK). 

 

Рис. 5.11. Линейный и радиальный градиент 

 

 

  

Щелчок по образцу в палитре Swatches (Образцы) при выделенном бегунке палитры Gradient (Гради-

ент) приведет к отмене градиентной заливки и окрашиванию объекта в цвет образца. 
 

 

Новые бегунки добавляются щелчком по нижнему краю шкалы градиента в палит-

ре. Другой способ добавления бегунков — выбрать образец в палитре Swatches и 

перетянуть его на выбранную точку на шкале (рис. 5.12). Удалить лишний бегунок 

можно, сдернув его вниз с градиентной шкалы. 

Быструю замену порядка цветов в градиенте обеспечивает кнопка Reverse. Напри-

мер, если у вас черно-желтый градиент, то он станет "желто-черным". 
 

 

Рис. 5.12. Добавление бегунков на градиентную шкалу с помощью палитры Swatches 
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Палитра Gradient (Градиент) интересна в паре с инструментом Gradient Tool 

(Градиент) (<G>) (рис. 5.13). Этот инструмент имеет два основных назначения: 

 перераспределение цветов в градиентной заливке или обводке объекта; 

 применение одного общего градиента к нескольким объектам. 

 

Рис. 5.13. Использование инструмента Gradient Tool 

5. Нарисуйте несколько геометрических фигур и присвойте им одинаковую гради-

ентную заливку. Инструментом Gradient Tool проведите несколько раз по од-

ному из объектов линии разной длины и в разных направлениях. Обратите вни-

мание на изменение вида заливки. 

 

Рис. 5.14. Использование сквозной заливки 
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6. Теперь выделите все нарисованные объекты и проведите инструментом линию 

поверх них, от края до края. Весь массив объектов получит общую градиентную 

заливку (рис. 5.14). Этот способ действий бывает очень полезен, когда нужно, 

например, залить общим градиентом все части оформительского элемента стра-

ницы. 

InDesign CS5 предоставляет еще одну интересную возможность работы с градиен-

том: инструмент Gradient Feather Tool (Градиентная растушевка) — <Shift>+ 

+<G> — градиентный переход от назначенной заливки к прозрачности. Градиент-

ная растушевка может применяться как к заливке цветом, так и к градиентной 

(рис. 5.15). 
 

 

Рис. 5.15. Инструмент Gradient Feather Tool 

Проект "Монгольфьеры" 

Попробуем создать иллюстрацию, используя инструменты создания геометриче-

ских фигур, коррекцию формы, простые и градиентные заливки. 

1. Откройте файл chapter5\project_mongolfierre\project_mongolfierre.indd. 

2. C помощью геометрических инструментов создайте городской силуэт по об- 

разцу или придумайте свой собственный. В образце крыша башни, крыша  

дома и шпиль созданы инструментом Многоугольник с параметром Number of 

sides =3, бойницы и кирпичики скопированы перемещением при нажатой кла-

више <Alt>, зубцы башен выстроены командой Step and Repeat с перемещени-

ем только по горизонтали, башня с часами собрана из отдельных элементов, со-

единенных командой Add. 
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Придадим башням объем. Цилиндрические поверхности лучше всего имитиру-
ются линейным градиентом с тремя бегунками — темным, светлым и снова 
темным. 

3. Выберите в палитре Swatches градиент Linear_grey. Двойным щелчком на его 
образце вызовите окно свойств. Подвигайте бегунки градиента и поэкспери-
ментируйте с их цветами для достижения наибольшей выразительности. Обрати-
те внимание, что для каждого бегунка градиента цвет настраивается отдельно. 
При желании можно для каждого градиентного бегунка задать свою цветовую 
модель, но делать это не следует: разные модели в одном макете будут восприня-
ты программой как ошибка верстки и приведут к ухудшению качества печати. 

4. Залейте этим градиентом башни и конусообразную башенную крышу. Кругло-
му навершию присвойте градиент Grey (радиальный). 

5. Присвойте градиент Linear Grey зубцам башен. Обратите внимание, что в ре-
зультате каждый зубец стал миниатюрной "башенкой". Нам же нужно, чтобы 
все зубцы вместе образовали "цилиндрическую" поверхность. Для этого выде-
лите все зубцы одной из башен, выберите инструмент Gradient (Градиент) и 
проведите им через весь ряд зубцов насквозь. Повторите операцию с зубцами 
на второй башне. 

6. Для бойниц использован градиент yell_white, для часов на башне — wb_round. 
Воспользуйтесь ими и при желании отредактируйте для получения более выра-
зительного изображения. 

7. Сгруппируйте все элементы городского силуэта. 

8. Перейдем к собственно воздушным шарам (монгольфьерам). Каждый шар со-
стоит из надутой оболочки, корзины с подвешенным к ней балластом и горел-
ки, с помощью которой надувается шар. 

9. Сначала создадим оболочку. 

10. Нарисуйте эллипс размером 45 90 мм. С помощью блока Convert Point палит-
ры Pathfinder превратите нижнюю точку в управляемую угловую (рис. 5.16). 

11. Инструментом Direct Selection (Белая стрелка) измените форму объекта, пере-
двигая по надобности его точки и управляющие линии. 

12. Залейте получившуюся фигуру градиентом White_blue или другим из этой 
группы, по своему усмотрению. 

13. Скопируйте готовый сегмент воздушного шара, поместите на один уровень ни-
же в стопке (<Ctrl>+<[>) и поверните на 15°. Придвиньте к первому сегменту 
так, чтобы он образовал второй клин, "выглядывающий" из-за первого. При не-
обходимости измените размер для получения более достоверного сочетания 
двух клиньев. Задайте ему другой радиальный градиент, выбрав его в палитре 
Swatches или создав свой собственный. 

14. Повторите всю операцию для создания еще одного клина. 

15. Выделите два последних клина и скопируйте щелчком по кнопке зеркального 
отражения в Контрольной панели при нажатой клавише <Alt>. Разместите но-
вые клинья так, чтобы завершить рисунок шара. 
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Рис. 5.16. Изменение типа точки 

16. Сгруппируйте все элементы шара (<Ctrl>+<G>). 

17. Для создания корзины нарисуйте прямоугольник и залейте его градиентом 
Korzina. Скопируйте основной прямоугольник дважды (перемещением при на-
жатой клавише <Alt>) и измените пропорции копий так, чтобы они образовали 
боковинки корзины. Инструментом Direct Selection переместите точки внеш-
них сторон боковых прямоугольников для имитации перспективы. Инструмен-
том Gradient измените направление градиента на боковых сторонах так, чтобы 
светлая часть растяжки была ближе к зрителю, темная — дальше. 

18. При желании можно задать "плетение" корзины: покрыть всю переднюю сто-
рону маленькими прямоугольниками с таким же градиентом. Распределите их 
по поверхности любым удобным для себя способом (командой Step and 
Repeat, многократным перемещением при нажатой кнопке <Alt> или повтором 
копирующего перемещения командой Transform Again). 

19. Тем же способом, которым мы рисовали клинья шара (эллипс > преобразование 
точки > коррекция формы Белой стрелкой), создайте мешки с балластом. За-
лейте их градиентом Grey. 

20. Разместите мешки по поверхности корзины. Вдоль верхнего края корзины ин-
струментом Линия проведите линии, изображающие веревку, на которой висит 
балласт. 

21. Сгруппируйте все элементы корзины. 

22. Создайте соединение корзины и шара: нарисуйте "точки привязывания кана-
тов" на поверхности шара (маленькие черные эллипсы) и проведите от них 
прямые линии к углам корзины. 

23. Создайте горелку: нарисуйте узкий прямоугольник, разместите его в стопке 
ниже корзины (повтор <Ctrl>+<[>, пока он не окажется в нужной позиции) и 



Работа с цветом 99 

нарисуйте эллипс — это будет огонь. Залейте горелку градиентом Linear_grey, 
а пламя — градиентом Fire. 

24. Сгруппируйте все элементы монгольфьера. 

25. Сделайте две копии, уменьшите их и разместите так, чтобы создать впечатле-
ние их расположения в перспективе. 

26. Усильте ощущение перспективы с помощью инструмента Gradient Feather 
(Градиентная растушевка) — выделив каждую копию в отдельности, проведите 
по ней инструментом Gradient Feather от центра иллюстрации к краю так, 
чтобы края градиентной растяжки находились за пределами шара (рис. 5.17). 

 

Рис. 5.17. Использование инструмента Gradient Feather для создания воздушной перспективы 

При желании можно сделать больше копий, задать каждой из них свой набор 
градиентных заливок и расположить их в более замысловатом ритме. 

27. Создайте небо: нарисуйте прямоугольник, полностью охватывающий все эле-
менты картинки, поместите его в самый низ стопки (<Ctrl>+<Shift>+<[>) и за-
лейте градиентом Sky. 

Итоги 

Цвет — очень важный элемент оформления публикации, и пользоваться им надо 
аккуратно и вдумчиво. Зная, как подготовить цвета для каждого типа документов, 
вы сможете эффективно управлять вниманием зрителя с помощью цветовых акцен-
тов, концентрируя его на самом главном. 

В последующих главах мы рассмотрим некоторые интересные алгоритмы, осно-
ванные на правильном использовании инструментов управления цветом для дости-
жения особенно эффектных результатов — например, задания областей для лаки-
ровки. 
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Глава 6 
 

 

РАБОТА С ТЕКСТОМ 

 

 

 

 

 

В этой главе вы узнаете: 

 как создать документ и на что при этом обратить внимание; 

 что такое фреймы; 

 как вставить текст во фреймы и как его отформатировать; 

 как распределить текст по нескольким страницам; 

 как быстро найти и заменить букву, слово или целую фразу; 

 как красиво и правильно соединить на странице текст и картинки; 

 как перевести текст в контуры и зачем это нужно. 

Создание и настройка документа 

До сих пор мы при рассмотрении разных инструментов и средств программы поль-

зовались заранее созданными документами, которые оставалось только открыть. 

Разберемся теперь, как создать свой собственный документ. 
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Новый документ, как обычно, создается командой File > New (Файл > Создать) 

(<Ctrl>+<N>). Открывается диалоговое окно создания документа (рис. 6.1). 

 

Рис. 6.1. Окно создания документа 

Основные поля и параметры, на которые нужно обратить внимание: 

 Document Preset (Предустановки документа) — поле позволяет использовать 

созданный и сохраненный ранее набор параметров, не настраивая его каждый 

раз заново; 

 Intent (Назначение) — здесь мы выбираем тип нашей публикации: печатная 

(Print) или электронная (обобщенно — Web); 

 Number of Pages (Количество страниц) — поле для указания желаемого количе-

ства страниц в документе. Для начала давайте поставим 3, а в процессе работы 

можно будет их добавить или убрать; 

 Facing Pages (Показывать развороты) — разрешение компоновать страницы в 

документе попарно (как в книгах). Отключенный флажок создает документ со 

страницами, показываемыми по одной на экране; 

 Master Text Frame (Текстовый фрейм на шаблоне) задает готовую область для 

текста, которая окажется для нас очень полезной, когда понадобится быстро 

разместить текст на многих страницах. Пока можно эту установку не включать. 

Выпадающий список стандартных размеров содержит готовые варианты пе-

чатных размеров. В поля Width (Ширина) и Height (Высота) вводятся их значе-

ния и выбранные единицы измерения — обычно миллиметры. Если ваша публи-

кация имеет нестандартный размер, нужно просто ввести значения высоты и 

ширины, а потом при желании сохранить установки (Save Preset). 
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 Orientation (Расположение страницы) — ориентация документа: портретная или 
альбомная; 

 Columns (Колонки) — настройка количества колонок (Number) и расстояния 
между ними (Gutter); 

 

 

  

Заданные здесь параметры будут применены ко всем страницам документа. Если планируется делать 
публикацию с разным количеством колонок, то лучше оставить здесь единицу, а потом уже в документе 
настраивать разные страницы по отдельности. 
 

 

 Margins (Величины полей) — размеры всех полей публикации. Если вы разре-
шили использовать развороты, при настройке будут фигурировать названия 
Outside и Inside — внутреннее и внешнее поля, а если разворотов в документе 
нет, то Left и Right — левое и правое. 

Рассмотрим теперь, что нам открывает кнопка More Options (Дополнительные на-
стройки). Здесь мы находим поля для ввода величины Bleed (припуски под обрез) 
(рис. 6.2). 

Зачем они нужны? Дело в том, что при подготовке файла необходимо учитывать 
погрешность устройства обрезки документа. Обычно нож может сдвинуться бук- 
 

 

 

Рис. 6.2. Поля Bleed и Slug 
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вально на 2—3 миллиметра, но при этом он либо отрежет часть страницы (и хоро-
шо бы, чтобы под обрез не попало что-нибудь важное), либо выйдет за ее край, то-
гда в этом месте образуется неровная белая полоса. Именно от появления такой по-
лосы нас и спасает припуск под обрез — увеличение реального размера публика-
ции на те самые несколько миллиметров со всех сторон (обычно на 2—5 мм); при 
обрезке лишнее уходит. При этом все элементы, которые по замыслу примыкают к 
самому краю страницы (фотографии, цветные плашки), должны выступать за край 
и доходить до границы припуска (в окне документа показана синей линией). Все, 
что расположено за областью Bleed, на печать выводиться не будет. Увидеть, как 
будет выглядеть документ после печати и обрезки (т. е. без направляющих и при-
пуска на обрезку), можно, нажав клавишу <W>. 

Параметр Slug (Отступ под обрез) — внутреннее поле, внутри которого должны 
поместиться все важные элементы макета — тексты, детали орнаментов, номера 
страниц. Если для документа заданы широкие поля, параметр Slug не столь важен, 
и его можно не задавать. 

Нажав ОК, мы попадаем в окно документа. Что теперь делать, если понадобится 
изменить те основные настройки, которые мы видели в окне создания документа? 

Создайте документ со следующими настройками: 

 Intent = Print; 

 Size = A4; 

 Number of pages = 3; 

 Facing Pages; 

 Number of Columns = 2; 

 Gutter = 5 mm; 

 Margins Inside = Outside = Top = Bottom = 20 mm; 

 Bleed = 5 mm. 

После создания документа рассмотренные настройки разбиваются на две группы. 
Одни теперь находятся в диалоговом окне Document Setup (Настройки документа) 

меню File, а другие — в Margins and Columns (Колонки и поля) меню Layout. 

В окне File > Document Setup (Настройки документа) остались все настройки, кро-
ме тех, что отвечают за количество колонок и размер полей (рис. 6.3). При необхо-

димости можно в процессе работы изменить и значение припусков (Bleed), нажав 
уже знакомую нам кнопку More Options. 

Количество колонок и размер полей настраиваются отдельно (рис. 6.4). Доступ  

к значениям этих параметров обеспечивается командой Layout > Margins and 

Columns (Макет > Колонки и поля). 

При этом те значения, которые вы вводите в этом окне, применяются только к вы-

бранной странице. Это создает сложности при работе с многостраничным докумен-
том: на каждой странице для настройки колонок придется обращаться к этому окну 

заново. Упростить задачу можно: надо воспользоваться мастер-шаблоном, о кото-
ром мы поговорим чуть позже. 
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Рис. 6.3. Окно Document Setup 

 

Рис. 6.4. Окно Margins and Columns 

Текстовый фрейм 

Что такое текстовый фрейм и зачем он нужен? 

В программе InDesign фрейм — это контейнер, в котором хранится любой матери-
ал, так или иначе помещенный в документ (текст и импортированная графика). Ма-
териал такого рода без фрейма существовать в документе не может. Обычный 
фрейм — это просто рамка с габаритными маркерами и меткой скругления угла, 
позволяющая перемещать и трансформировать объект по мере надобности 
(рис. 6.5). 

Текстовый фрейм имеет свои особенности и дополнительные метки на габаритном 
контейнере — метку входа (в левом верхнем углу) и выхода (в правом нижнем). 
Эти маркеры играют довольно важную роль, которую мы со временем рассмотрим 
(рис. 6.6). 

Для создания текстового фрейма: 

1. Выберите инструмент Туре Tool (Текст) на панели инструментов. 

2. Поместите курсор на страницу. Курсор примет вид инструмента Туре. 
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Рис. 6.5. Обычный фрейм 

 

Рис. 6.6. Текстовый фрейм 

3. Протянув мышь по диагонали, нарисуйте прямоугольник. 

4. Отпустите кнопку мыши. На экране появится фрейм с текстовым курсором, ука-
зывающим на то, что внутри фрейма можно набирать текст. 

 

 

  

Инструмент Туре всегда создает прямоугольные фреймы. Для получения фреймов другой формы ис-
пользуйте инструменты для создания других геометрических фигур. 
 

 

Ввод текста. Импорт текста 

Текст вводится во фрейм с клавиатуры, как в любом текстовом редакторе. Длина 
строки ограничена рамками фрейма, поэтому переход со строки на строку происхо-
дит автоматически. 
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Для того чтобы разместить в файле текст из внешнего источника, нужно: 

1. Вызвать команду File > Place (Файл >  Поместить) (<Ctrl>+<D>). 

2. Найти файл, который надо импортировать. 

3. Включить флажок Show Import Options (Показать настройки импорта), чтобы 

отобразить специальные настройки импорта для выбранного формата текстового 

файла. 

Для замены содержимого выделенного текстового фрейма новым текстом включа-

ется флажок Replace Selected Item (Вместо выделенного текста). 

После нажатия кнопки Открыть откроется диалоговое окно Import Options (На-

стройки импорта). 

Программа InDesign дает возможность импортировать файлы, созданные в различ-

ных текстовых редакторах. Обычно это Microsoft Word или редакторы более низко-

го уровня — WordPad или Блокнот. От редактора зависит формат импортируемого 

файла. 

Для последующего импорта в InDesign лучше всего сохранять текстовый документ 

в формате RTF (Rich Text Format — расширенный текстовый формат). Он позволя-

ет сохранять большую часть оригинального форматирования и импортируется  

в программу InDesign без изменений. Форматы DOC/DOCX (Microsoft Word)  

и XLS/XLSC (Microsoft Excel) тоже допустимы, но сложное форматирование  

с "надписями" (вставками) и прикрепленными иллюстрациями будет потеряно. 

Можно также импортировать текст в формате TXT (самый простой электронный 

текстовый формат). Он очень хорош для сохранения текста без форматирования, 

чтобы все настройки делать уже прямо в InDesign, и для сохранения материалов из 

Интернета, но при импорте возможны трудности с кодировкой. 

Для каждого типа файлов имеется свой набор опций: 

Опции для файлов Microsoft Word (рис. 6.7): 

 Include (Включить) — выбор частей документа, которые нужно включить в до-

кумент: 

 Table of Contents (Оглавление); 

 Index (Предметный указатель); 

 Footnotes и Endnotes (Сноски и пояснения); 

 Use Typographer’s quotes (Использовать типографские кавычки) — замена ха-

рактерных для простых текстовых редакторов симметричных кавычек на типо-

графские (в русской типографике — "елочки"); 

 Formatting — отношение к форматированию текста в исходном документе: 

 Remove Styles and Formatting from Texts and Tables (Удалить стили и фор-

матирование текста и таблиц); 

 Preserve Styles and Formatting from Texts and Tables (Сохранить стили и 

форматирование текста и таблиц). 
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Рис. 6.7. Окно опций импорта для формата Microsoft Word 

Остальные настройки касаются воспроизведения страниц, разрешения стилевых 

конфликтов и работы с внутритекстовой графикой. Они бывают нужны заметно 

реже, чем описанные выше. 

Диалоговое окно Import Options для файлов RTF содержит аналогичные опции 

импорта. 

Опции для файлов Microsoft Excel рис. 6.8. 

 Выбор листов таблицы и ячеек, которые нужно импортировать. 

 Выбор варианта форматирования ячеек при импорте. 

 Количество десятичных знаков после запятой. 

 Уже знакомая нам замена кавычек. 

Опции для файлов TXT приведены на рис. 6.9. 

 Выбор кодировки — чаще всего нам нужна кодировка Windows Cyrillic. 

 Выбор платформы (Windows / Macintosh). 

 Выбор языка позволит обеспечить правильное воспроизведение специальных 

символов. 

 Обработка переходов на новую строку. Дело в том, что при наборе текста в 

простых редакторах часто каждая строка рассматривается как отдельный абзац 

(аналог нажатия на клавишу <Enter>); то же бывает и со многими материалами, 
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импортируемыми из Интернета. В этом случае нормальное дальнейшее форма-

тирование текста сильно затруднено. Для снятия этой проблемы можно прямо 

при импорте задать очистку текста от лишних переводов строки. 

 Преобразование группы пробелов в символ табуляции: чаще всего серия из не-
скольких пробелов ставится наборщиками именно с целью имитации табулиро-
ванного текста. 

 Замена кавычек. 

Сравнительно небольшие фрагменты текста можно переносить из текстового  
редактора прямо во фрейм командой копирования: <Ctrl>+<C>/<Ctrl>+<V>. 

 

Рис. 6.8. Окно опций импорта для формата Microsoft Excel 

 

Рис. 6.9. Окно опций импорта для формата TXT 
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Форматирование текста 

Что такое форматирование текста? 

Текст, набранный в текстовом редакторе, — это только информация, содержание, 
еще не имеющее формы. Размещая его на странице публикации, мы определяем, 

как он будет выглядеть, какие акценты в нем будут расставлены, будет ли он чи-
таться легко и незаметно или, наоборот, привлекать внимание, не заботясь о легко-

сти чтения. Придать нашему тексту форму и разнообразие нам помогут две основ-
ных палитры: Character (Символ) и Paragraph (Абзац). 

Выделение текста  
с помощью комбинаций клавиш 

При работе с текстом часто бывает нужно выделить точное количество символов, 
строк или абзацев. В этом деле нам помогут клавиши-модификаторы: 

 <Shift> + <  > / <  > — выделение отдельного символа; 

 <Shift> + < > / < > — выделение отдельной строки; 

 <Ctrl>+<Shift> + < > / < > — выделение отдельного слова и следующего за 

ним пробела; 

 <Ctrl>+<Shift> + < > / < > — выделение абзаца; 

 <Shift> + <Ноmе> / <End> — выделение всего текста до начала или конца строки; 

 <Ctrl>+<Shift> + клавиши <Ноmе> / <End> — выделение всего текста до начала 

или конца текстового фрейма или текстового блока; 

 <Ctrl>+<A> — выделение всего текста в пределах текстового фрейма или тек-

стового блока. 

Работа с палитрами Character (Символ)  
и Paragraph (Абзац) 

1. Создайте текстовый фрейм. 

2. Правой кнопкой мыши вызовите контекстное меню фрейма и выберите команду 

Fill with Placeholder Text (Заполнить замещающим текстом). 

3. Выделяя отдельные слова, строки и абзацы текста во фрейме, экспериментируй-
те со значениями полей в рассматриваемых палитрах. 

Рассмотрим палитру Character (Символ) — <Ctrl>+<T> (рис. 6.10). 

 Гарнитура (рисунок шрифта): здесь собраны названия всех шрифтов, установ-
ленных в системе и распознаваемых программой. Перемещаться по списку мож-

но с помощью стрелок в палитре или (предварительно поставив курсор на ка-

кой-то шрифт) клавиатурными стрелками < > и < >. Если вам известно назва-

ние искомого шрифта, можно начать вводить его с клавиатуры — по мере ввода 
будет происходить перемещение по списку, пока не появится нужный шрифт. 
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Рис. 6.10. Палитра Character 

Что же такое гарнитура? Это параметр, который отвечает за общий рисунок 

шрифта, его отличие от всех прочих шрифтов. В просторечии часто именно гар-

нитуру именуют шрифтом. 

Шрифты делятся на наборные (для ввода длинных текстов — они должны быть 

легко читаемыми и ненавязчивыми, создавая единое "серое поле" текста, не 

утомляющее читателя) и акцидентные (для заголовков, слоганов и т. п. корот-

ких надписей, которые могут быть и не слишком читабельными, но обязательно 

должны привлекать внимание). Диапазон акцидентных шрифтов чрезвычайно 

широк, от псевдорукописных до плакатных, от орнаментальных до пиксельных. 

Отнесение шрифта к той или иной категории зависит от многих причин (хотя в 

первую очередь, конечно, от читабельности). Например, готические шрифты 

Текстура и Фрактура, несмотря на свою трудночитаемость, в Германии очень 

долго использовались в качестве наборных, хотя на современный взгляд их ак-

цидентность очевидна; а многие наборные шрифты в крупном размере вполне 

достойно смотрятся в заголовках, играя таким образом роль акцидентных 

(рис. 6.11). 

 

Рис. 6.11. Наборный и акцидентный шрифты 

Другой способ классификации шрифтов — по общему стилистическому призна-

ку: антиква и гротеск (рис. 6.12). 

Антиква — рисунок шрифта, уходящий корнями в античность, к шрифтам древ-

неримских надписей. Для антиквы характерна отточенность формы и наличие 

засечек на концах. Засечки, кроме собственно придания завершенности рисунку 
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буквы, выполняют еще одну важную задачу: они подчеркивают линию строки. 

Взгляд читателя движется по ним как по рельсам, и в результате читать стано-

вится легче и приятнее. Не зря даже сегодня, при всем разнообразии сущест-

вующих шрифтов, большинство книг набирается именно различными варианта-

ми антиквы. 

 

Рис. 6.12. Антиква  
и гротеск 

 

Как следует из ее названия, антиква несет в себе дух традиционности, солидно-

сти и некоторой старомодности, поэтому в качестве акцидентной ее чаще при-

меняют для академических изданий, солидных газет и печатных материалов 

фирм, апеллирующих к истории и традициям — например, банков и страховых 

компаний. 

Гротеск (grotesque — забавный) — стиль шрифтов, разработанный в XIX веке и 

названный так в противоположность антикве. Это шрифт без засечек; в русском 

языке его часто называют "рубленым". За счет отсутствия засечек этот шрифт 

гораздо более компактен, что делает его чрезвычайно популярным для исполь-

зования в Интернете и в наружной рекламе. На стилистической базе гротеска 

разработаны многочисленные и очень интересные акцидентные шрифты. В от-

личие от антиквы, этот тип шрифтов несколько хуже "держит" строку, в боль-

шой массе читать его тяжелее, поэтому в качестве наборного его нужно приме-

нять с осторожностью, скорее для электронных публикаций, чем для бумажных 

(рис. 6.13). 

 

Рис. 6.13. Примеры использования антиквы и гротеска 
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 Начертание. Если гарнитура задает общий рисунок шрифта, то начертание оп-

ределяет его вариации. Некоторые шрифты (обычно акцидентные) имеют всего 
одно начертание, другие — до сотни и более. Среднестатистический наборный 

шрифт обычно имеет как минимум 4 начертания: базовое (regular), полужир-
ное/жирное (semibold/bold), курсивное (italic) и полужирное/жирное курсивное 

(semibold/bold italic). Более разработанные шрифты предлагают больше вариан-
тов. Например, у шрифта Myriad Pro мы видим 10 начертаний (рис. 6.14). 

  

Рис. 6.14. Варианты начертаний  
для шрифта Myriad Pro 

Рис. 6.15. Список значений  
кегля 

В общем случае, чем шире предполагаемая область использования шрифта (на-
пример, шрифт для газеты или корпоративный шрифт), тем разнообразнее его 
начертания. 

 Кегль. Следующее интересующее нас поле — выбор размера шрифта (кегля).  
В это поле вы можете вводить значения вручную или выбирать готовые из вы-
падающего списка (рис. 6.15). Установив начальное значение кегля, можно кор-

ректировать его с помощью клавиатурных стрелок < > и < >. 

Кегль определяется по высоте прописной буквы. Это создает небольшую труд-
ность при расчете размещения текста, поскольку у разных гарнитур разный раз-
мер строчных букв, и при одном и том же кегле в строке одной и той же длины 
поместится разное количество букв. Поэтому, рассчитывая наполнение публи-
кации текстом, нужно обязательно учитывать не только кегль, но и гарнитуру. 
Кегль всегда задается в пунктах, поэтому даже если рабочие единицы измерения 
в документе — скажем, миллиметры, это не влияет на шрифтовые единицы. 

 Интерлиньяж (Leading). Рядом с полем кегля находится поле, где указывается 
интерлиньяж (рис. 6.16) — расстояние между строками, измеряемое от одной до 
другой базовой линии шрифта (базовая линия — это воображаемая линия, вдоль 
которой выстраиваются буквы в строке). 

По умолчанию интерлиньяж равен 120% от размера шрифта. То есть при кегле, 

равном, например, 10 pt, интерлиньяж будет равен 12 pt (120% для 10). Интер-
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линьяж можно и нужно варьировать в зависимости от рисунка шрифта: напри-

мер, если у шрифта крупные строчные буквы, интерлиньяж можно слегка уве-

личить, если мелкие — уменьшить. В книжной, газетной и журнальной верстке 

существует такой способ организации теста, как сетка базовых линий — мощное 

средство вертикального выравнивания. Далее мы познакомимся с ней поближе, 

а сейчас важно запомнить, что для ее корректного определения нужно вручную 

задавать конкретный размер интерлиньяжа. Для средних наборных кеглей (10–

14 pt) можно примерно принять правило "Кегль + 2 pt". На более мелких и более 

крупных кеглях определение интерлиньяжа — дело более творческое. В любом 

случае, нужно добиваться того, чтобы строка, с одной стороны, не сливалась  

с соседними, оставаясь отчетливо отдельной, а с другой — не воспринималась 

как совершенно обособленный объект, никак не связанный с остальным текстом. 

Установите тексту кегль 10 pt, интерлиньяж 12 pt, а первому абзацу — интер-

линьяж 14 pt. 

 
 

Рис. 6.17. Поля для ввода 
значений кернинга и трекинга Рис. 6.16. Интерлиньяж 

 

 Кернинг и трекинг (рис. 6.17). 

Кернинг используется для изменения межсимвольного расстояния в парах сим-

волов, которые из-за своей формы смотрятся стоящими слишком плотно или, 

наоборот, далеко друг от друга. Собственно, кернинг — это смещение букв в 

слове так, чтобы нивелировать "дыры" и уплотнения, чтобы текст выглядел оп-

тически равномерным (рис. 6.18). Кернинговые пары прописываются дизайне-

ром шрифта, так что от нас требуется всего лишь в установках кернинга выбрать 

Optical (Оптический). 

Трекинг — изменение расстояния между буквами (рис. 6.19). Изменяет все меж-

символьные интервалы одинаково, на заданную величину. Его удобно использо-

вать для подгонки длины строки (небольшого удлинения или, наоборот, укора-

чивания) и для повышения читаемости текста. Общее правило состоит в том, что 

строчные символы можно сохранять на своих местах или слегка приближать  
 



Работа с текстом 115 

 

Рис. 6.18. Кернинг 

 

Рис. 6.19. Трекинг 

друг к другу, а надписи из одних прописных, наоборот, раздвигать для улучше-

ния различимости отдельных букв. 

 Масштабирование символов по вертикали и горизонтали. Это одна из тех на-

строек, которые, по словам знаменитого типографа Джеймса Феличи, "сделали 

возможности создания действительно уродливого набора поистине безгранич-

ными" (рис. 6.20). Изменение высоты или ширины шрифта относительно его из-

начальных пропорций ведет к искажению его рисунка и ухудшению как читае-

мости, так и общего вида текста. Поэтому общее правило для этих настроек: не 

использовать. При острой необходимости подогнать длину строки к определен- 

ному размеру можно незначительно (в пределах 3—5%) изменить ширину букв. 
 

 

 

Рис. 6.20. Поля масштабирования символов 
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Но при больших значениях искажение рисунка шрифта станет уже заметным. 

Если нужно, чтобы шрифт был узким или, наоборот, широким, лучше использо-
вать гарнитуру, в которой есть подходящее начертание. 

 Сдвиг базовой линии. С помощью этого поля можно часть текста приподнять над 

остальной строкой или, наоборот, опустить. 

 Наклон символов — средство имитации курсивного начертания при его отсутст-

вии (рис. 6.21). Строго говоря, при этом текст будет не курсивным, а наклонным, 
рисунок курсива обычно отличается от рисунка прямого шрифта. Разница осо-

бенно заметна у антиквенных гарнитур, где курсив гораздо больше похож на ру-

кописную надпись, чем на печатный текст. У гротесков разница между накло-
ном и курсивом меньше, но искажение рисунка наблюдается и там. Поэтому на-

клоном следует пользоваться очень осторожно. 

  

Рис. 6.21. Поле для ввода значения наклона символов Рис. 6.22. Выбор словаря 

 Выбор словаря. Это очень важная настройка, позволяющая производить провер-
ку орфографии в тексте и автоматически расставлять знаки переноса. Словарь 
выбирается с учетом основного языка макета — в нашем случае это, как прави-
ло, русский (рис. 6.22). Если словарь не соответствует рабочему языку, перено-
сы не расставляются и проверка орфографии не выполняется. Правильность на-
стройки словаря легко проверить: если поставить курсор в текст, в поле должно 
быть написано Russian. 

На этом мы заканчиваем знакомство с палитрой Character (Символ) и переходим 
к палитре Paragraph (Абзац) — <Ctrl>+<Alt>+<T>. 

 Выравнивание текста (Justify — Выключка) (рис. 6.23). 

Обратите внимание: выравнивание по ширине (или выключка по формату) мо-
жет выполняться с разным положением последней строки. Чаще всего использу-
ется выключка по формату с последней строкой, выровненной влево. Другие ва-
рианты можно встретить обычно в журнальной верстке. 

 Поля для определения отступов. 

Боковой отступ (рис. 6.24). Adobe InDesign считает отступами слева (Left 

indent) и справа (Right indent) расстояние от текста до границы фрейма. Так как 
отступ — атрибут абзаца, ввод значений в эти поля приводит к перемещению 
текста всего абзаца на заданное расстояние. 
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Рис. 6.23. Кнопки выравнивания текста 

 

Рис. 6.24. Настройка боковых отступов 
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Абзацный отступ (красная строка). Абзацный отступ применяется для указания 

начала нового абзаца (рис. 6.25). Эта настройка влияет только на первую строку. 

Отступ для красной строки обычно делают примерно равным удвоенному кег-

лю, хотя возможны варианты. В книгах абзацный отступ делают шире, в газетах, 

для узких колонок, у́же, но обычно все же не менее 5 мм. В последнее время 

красную строку часто вообще не устанавливают, поскольку появлению нового 

абзаца обычно предшествует неполная последняя строка предыдущего абзаца, и 

новый абзац на странице заметен и так. Тем не менее абзацный отступ проявляет 

структуру страницы и тем самым улучшает ее читаемость, поэтому лучше от не-

го все-таки не отказываться. 
 

 

Рис. 6.25. Поле для указания красной строки 

 

Есть довольно распространенные способы выполнения абзацного отступа, при-

шедшие из времен механических пишущих машинок и непригодные для созда-

ния качественного макета в InDesign. 

Во-первых, нажатие клавиши <Таb>. Табулированный текст предназначен для 

работы с таблицами, а не с абзацными отступами. 

Во-вторых, многократная вставка пробелов (в том числе неразрывных). Размер 

пробела зависит от гарнитуры и может меняться, что приведет к рассогласован-

ности документа. 

Оба эти способа часто встречаются в текстах, набранных во внешних текстовых 

редакторах, поэтому импортированный текст надо очищать от ненужных табу-

ляций и лишних пробелов. 

Отбивка используется для выделения определенных элементов текста свобод-

ным пространством — например, отделение абзаца от заголовка. Для того чтобы 

между заголовком и абзацем появилось некоторое свободное пространство, 

можно указать либо отбивку перед абзацем, либо отбивку после заголовка. Вы-
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бор зависит от конкретных параметров текста. На пиктограммах стрелкой пока-

зано, какая из них отвечает за отбивку после, а какая за отбивку перед абзацем. 

Вообще, постарайтесь привыкнуть любые свободные пространства вокруг фраг-

ментов текста задавать с помощью отбивок, а не вставкой строк. Это позволит 

сохранять величину этих пространств независимо от изменения гарнитуры, кег-

ля и других параметров шрифта. 

Общее правило состоит в том, что расстояние над заголовком должно быть 

больше расстояния от заголовка до определяемого им текста (рис. 6.26). 
 

 

Рис. 6.26. Правильное и неправильное расположение отбивок при заголовке 

 

 Привязка к сетке базовых линий. Эти две кнопки позволяют установить или от-

менить строгое вертикальное выравнивание текста (рис. 6.27). Для лучшего по-

нимания механизма их работы вызовем сетку базовых линий шрифта — специ-

альные направляющие, предназначенные для работы с текстом: View > Show 

Baseline Grid (Вид > Показать сетку базовых линий). 

При этом хорошо видно, что строки текста в соседних колонках находятся на 

разных уровнях. Это получилось из-за разницы интерлиньяжа в первом и после-

дующих абзацах. Для того чтобы правильно выровнять текст по сетке 

(рис. 6.28), ее нужно настроить. 

Шаг сетки базовых линий устанавливается равным интерлиньяжу, который мы 

задали при форматировании текста. Именно поэтому было так важно задать соб-

ственное значение в пунктах, а не в процентах. По умолчанию сетка базовых 

линий рассчитана для шрифта размером 10 pt с межстрочным расстоянием 12 pt. 

Если требуется задать сетку для другого кегля и интерлиньяжа (межстрочного 

расстояния), необходимо изменить настройки в меню Edit > Preferences > Grids 

(Редактирование > Предпочтения > Сетки). В поле Increment Every (Линии че-

рез...) введите нужное значение. 
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Рис. 6.27. Текст при включенной сетке базовых линий шрифта 

 

Рис. 6.28. Текст, привязанный к сетке базовых линий 

 

Самое главное при настройке сетки базовых линий — ввести собственное значе-

ние интерлиньяжа, а не то, которое используется по умолчанию программой. 

Вводить его нужно в поле Increment Every (Линии через...). 

Зачем вообще нужно такое выравнивание? Дело в том, что часто при работе  

с несколькими колонками текста появляются ошибки в расчетах отбивки и ин-

терлиньяжа, и тогда строки в колонках оказываются на разном уровне. Один из 

способов решения проблемы — использование кнопок выравнивания по сетке. 

Вам нужно просто поставить курсор в абзац, в котором строки не совпадают  
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с сеткой базовых линий, и нажать на кнопку Align to Baseline Grid (Выровнять 

по сетке базовых линий). 

 

 

  

Вводить значение можно хоть в миллиметрах, хоть в пунктах, хоть в пиках: главное — написать латин-
скими буквами сокращение используемой единицы измерения. Например, если вы задаете интерлиньяж 
14 pt, то удобнее всего будет так и написать: 14 pt. 
 

 

Если вы не видите сетку базовых линий после включения ее показа в главном 
меню View (Вид), это значит, что у вас слишком мелкий масштаб просмотра. По 
умолчанию сетка показывается при масштабе от 75%. Для изменения этой вели-
чины используйте настройки Edit > Preferences > Grids (Редактирование > 
Предпочтения > Сетки). 

 Буквица (рис. 6.29) — это украшающий элемент в виде декоративно оформлен-
ных букв в начале абзаца. 

В InDesign у пользователя есть возможность настроить высоту и ширину букви-
цы. При настройке высоты буквицы вы указываете, скольким строкам она будет 
равна. При настройке ширины — сколько символов будет относиться к буквице. 
Результат применения буквицы заметен при вводе как минимум цифры 2 в поле 
высоты. Если же указана цифра 1, буквица равна по высоте одной строке, т. е. 
выглядит как обычная буква. 

 

Рис. 6.29. Буквица 

 Hyphenate (Переносы). Включив этот флажок, вы даете согласие на автомати- 
ческую расстановку переносов (рис. 6.30). Именно здесь мы воспользуемся  
настройкой словаря, которую сделали в палитре Character (Символ). Если  
в вашем тексте нет переносов даже после установки флажка Hyphenate, про-
верьте, какой словарь вы используете. И, наоборот, если установлен правиль- 
ный словарь, но переносы отсутствуют, проверьте, установлен ли флажок 
Hyphenate. 
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Рис. 6.30. Расстановка переносов 

Все поля обеих рассмотренных палитр продублированы в Контрольной панели. 

При выбранном инструменте Type (Текст) она подразделяется на две части: на-

стройки символа и настройки абзаца (рис. 6.31). 

 

Рис. 6.31. Выбор режима работы Контрольной панели 

В режиме настройки символа мы видим все поля, знакомые нам 
по палитре Character (Символ), но в дополнение к ним здесь есть 
еще и так называемые псевдостили — вариации написания от-
дельных символов для конкретных задач (рис. 6.32). 

В верхней строке: 

 все прописные; 

 верхний индекс; 

 подчеркнутый текст. 

В нижней строке: 

 малые прописные (капители) — способ оформления текста, когда буквы выгля-
дят как прописные, а размер имеют как у строчных; 

 нижний индекс; 

 зачеркнутый текст. 

Дополнительные поля текстовой контрольной панели — блок управления атрибу-
тами (обводкой и заливкой) и доступ к основным настройкам абзаца, позволяющий 
не переключаться постоянно в режим настройки параграфа. 

 

Рис. 6.32. 
Пиктограммы 
псевдостилей 
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В режиме настройки абзаца (рис. 6.33) мы, аналогично, видим все уже знакомые 
поля из палитры Paragraph и доступ к основным настройкам символа, но, кроме 
того, — кнопки создания списков и поля разбивки текста во фрейме на колонки. 
Последняя опция позволяет настроить колонки прямо внутри фрейма, не создавая 
отдельных фреймов для каждого типа разделения текста. 

 

Рис. 6.33. Дополнительные настройки абзаца в Контрольной панели 

Создание связанных текстовых фреймов 

Обычно, создав текстовый фрейм, мы сразу видим его характерный габаритный 
контейнер с дополнительными маркерами. Но бывает так, что фрейм создан, но не 
виден. Это значит, что вы работаете в режиме скрытых границ объектов. Этот ре-
жим вызывается нажатием клавиш <Ctrl>+<H>. 

Поэкспериментируйте с переключением режимов, повторно нажимая <Ctrl>+<H>. 

Какой бы природы ни был ваш текстовый фрейм, он всегда будет иметь следую-
щую структуру (рис. 6.34). 

Бывает, что текст не помещается в предназначенный для него текстовый фрейм, 
тогда маркер выхода заменяется красным плюсом. 

 

Рис. 6.34. Структура текстового фрейма 
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Измените размер текстового фрейма, потянув его нижнюю границу вверх инстру-

ментом Selection (Черная стрелка) и обратите внимание на появление метки пере-

полнения фрейма ("вытесненного" текста). 

В этом случае самое правильное решение — создать второй фрейм, где разместится 

все, что не поместилось в первый. Такие фреймы будут называться связанными. 

Для его создания нужно щелкнуть по значку переполнения фрейма (красному плю-

су) (курсор изменит вид), и после этого щелчком по рабочему полю создать сле-

дующий фрейм (он автоматически получит те же форму и размер, что и первый). 

Для того чтобы увидеть связь между фреймами, включите команду меню View > 

Extras > Show Text Threads (Вид > Дополнительно > Показать связи текстовых 

фреймов). Теперь, если выделить текстовый фрейм, показывается голубая нить свя-

зи между блоками с текстом (рис. 6.35). 

 

Рис. 6.35. Связанные фреймы 
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Обратите внимание, что после появления связанного фрейма маркеры входа и вы-
хода выглядят иначе. Теперь у первого фрейма маркер выхода имеет треугольник-
указатель, который показывает, что у фрейма есть продолжение, он не единствен-
ный. У второго фрейма изменился, наоборот, маркер входа. Там такой же треуголь-
ник-указатель — у фрейма есть начало в другом текстовом фрейме. 

Что дает связь между текстовыми фреймами? 

Во-первых, благодаря ей вы можете распределять текст между фреймами: при 
уменьшении размера первого фрейма вы увидите, как лишний текст перетекает в 
следующий фрейм. 

Во-вторых, в связанных между собой фреймах удобно производить различные из-
менения. Например, если нужно поменять какие-то настройки во всей статье разом, 
вы можете сделать это очень быстро, даже если текст размещен в разных фреймах 
или на разных страницах. На этом свойстве фреймов основан прием анонсирования 
в газетах: на первой странице печатается начало статьи с пометкой "Продолжение 
на стр. такой-то", а на другой странице само продолжение (рис. 6.36). Представьте, 
что вы работаете как раз над таким материалом, и в последний момент оказывается, 
что он должен быть набран другим кеглем или другим шрифтом! Связанные тек-
стовые фреймы позволяют одновременно внести изменения во весь текст незави-
симо от его расположения. 

 

Рис. 6.36. Начало статьи в газете с отсылкой на внутренние страницы 

Текст, находящийся в цепочке связанных между собой фреймов, называется мате-

риал. Кроме описанных выше преимуществ, связь текстовых фреймов имеет еще 

одно достоинство, оценить которое вы сможете после изучения работы с режимом 
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текстового редактора: весь материал показывается в режиме текстового редактора 

как единый текстовый блок. 

Как связать несвязанные фреймы и развязать связанные? 

Если у вас в документе есть текстовые фреймы, которые изначально не были связа-

ны между собой, вы можете в случае необходимости сами создать связи. Эта опе-

рация в InDesign выполняется очень просто: нужно щелкнуть мышью по выходно-

му маркеру выбранного фрейма и входному маркеру того фрейма, который требу-

ется связать (рис. 6.37). 

 

Рис. 6.37. Связывание фреймов 

В каком случае может возникнуть такая необходимость? Например, при вставке 

текста из разных текстовых файлов. Даже если это логически связанный материал, 

физически такой текст не будет связан, и для "сквозной" работы нам понадобится 

собрать его воедино. 

Давайте рассмотрим противоположную ситуацию, когда вы хотите избавиться от 

связи текстовых фреймов (например, автор учебника решил поменять местами па-

раграфы; если сохранить связь фреймов в первоначальном виде, вам будет очень  
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Рис. 6.38. Связь переставленных 
текстовых фреймов 

Рис. 6.39. Опустевший оторванный фрейм 

 

трудно уследить за перемещением текста по фреймам (рис. 6.38); да и прослежи-

вать связи длиной в десятки страниц не слишком удобно). 

Для "развязывания" фреймов достаточно дважды щелкнуть по выходному маркеру 

первого фрейма. Но здесь есть одна тонкость: после разрыва связи "оторванный" 

фрейм пустеет, а его текст собирается в предыдущем фрейме (рис. 6.39). 

Обычно такой ход событий нам не подходит. Что делать, если хочется получить 

независимые фреймы, но так, чтобы не потерять размещение текста? В этом случае 

придется пойти на хитрость. Если, удерживая клавишу <Alt>, по очереди скопиро-

вать текстовые блоки, копии уже не будут ни с чем связаны (рис. 6.40). Их теперь 

можно связать с другими так, как нам требуется. 
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Рис. 6.40. Фреймы, разорванные с помощью копирования 

Добавление и удаление текста 

Иногда в процессе работы выясняется, что в материале не хватает какой-то важной 
части. Например, вы работали над версткой учебника, и вдруг вам прислали допол-

нительный параграф, который по логике изложения нужно поставить в середину 

публикации. Как быть, если текст уже распределен по текстовым фреймам? Допол-
нительный блок с текстом вы можете вставить даже внутри цепочки связанных 

фреймов. 

1. Удалите экспериментальный фрейм с "замещающим" наполнением. 

2. Импортируйте файл Chapter6\Blanding Castle.doc и распределите его по несколь-

ким фреймам. 

3. Откройте в текстовом редакторе файл Chapter\Blanding Castle_incert.doc и ско-
пируйте имеющийся в нем текст. Найдите фрейм, в котором между абзацами 

проведена пунктирная линия. 

4. Щелкните по маркеру выхода этого фрейма. Изменившийся курсор покажет, что 
имеется готовый к размещению текст. Щелчок по рабочему полю создаст новый 

фрейм той же формы и размера, что и исходный. Разумеется, он будет заполнен 
продолжением текста. Выделите текстовым инструментом пунктир и вставьте 

текст (<Ctrl>+<V>). 

Теперь давайте рассмотрим противоположную ситуацию: удаление лишнего тек-
стового фрейма. Если просто выделить этот фрейм и нажать клавишу <Delete>, 
удалится только сам фрейм, но не его содержимое. Текст никуда не пропадет, а пе-
реместится в предыдущий фрейм. У предыдущего фрейма тут же появится значок 



Работа с текстом 129 

переполнения, поскольку он к такому повороту событий не был готов: места для 
текста, перемещенного из другого фрейма, нет. Поэтому нужно действовать в два 
приема: сначала удалить текст из фрейма, выделив его инструментом Туре (Текст) 
и нажав <Delete>, а потом уже удалить опустевший текстовый фрейм. 

Если выделить текстовый фрейм черной стрелкой и щелкнуть правой кнопкой мы-
ши, в контекстном меню можно выбрать команду Text Frame Options (Параметры 
текстового фрейма) (рис. 6.41). 

 

Рис. 6.41. Диалоговое окно Text Frame Options 

 

 

  

Это окно можно вызвать также из меню Object > Text Frame Options (Объект > Параметры текстового 
фрейма). Обратите внимание, что, хотя речь идет о параметрах текста, фрейм воспринимается как 
обычный объект, и доступ к этим настройкам происходит из меню Object. 
 

 
Здесь можно определить сложное размещение текста внутри фрейма. 

Основные настройки: 

 Columns — разбиение текста на колонки внутри текстового фрейма. Иногда бы-
вает удобно создать колонки прямо во фрейме, не привязываясь к колоночному 
делению страницы. Поле Number (Количество) задает количество колонок, 
Width (Ширина) — ширину каждой колонки, Gutter (Средник) — расстояние 
между колонками; 

 Inset Spacing — внутренние отступы от краев фрейма до текста. В некотором 
смысле эти настройки похожи на абзацные отступы, однако это только внешнее 
сходство. Абзацные отступы действуют на абзац (или на несколько выделенных 
абзацев), а внутреннее пространство до краев фрейма — на весь текст, находя-
щийся внутри выбранного фрейма; 

 Vertical Justification — вертикальное выравнивание строк с текстом внутри 
фрейма (рис. 6.42). 
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Рис. 6.42. Пример использования разных настроек текстового фрейма 

Размещение  

набранного текста в макете 

Теперь, зная, как разместить текст во фреймах и как его отформатировать, можно 

приступить к процессу размещения в публикации длинного текста. Существуют 

три режима, в которых вы можете вставлять текст, используя команду File > Place 

(Файл > Поместить): ручной, полуавтоматический и автоматический. 

 Ручной режим используется по умолчанию. Его характерные особенности: текст 

заливается только в первую колонку (если их несколько; если одна — то только 

на одну страницу). Даже если текста хватит на целую книгу, он займет только 

первый фрейм, и внизу появится знак переполнения текстового фрейма. Для 

продолжения заливки нужно самостоятельно щелкнуть по красному плюсу, а 

потом в левом верхнем углу следующей колонки или страницы. Неплохой  

режим для полностью контролируемого размещения сравнительно коротких 

текстов, но очень неудобный, когда речь идет о "Войне и мире". 

 Полуавтоматический режим включается, если при заливке текста нажать кла-

вишу <Alt>. В этом случае текст по-прежнему занимает только одну колонку, но 

у вас появляется не значок переполнения текстового фрейма, а курсор, готовый 

к загрузке текста. Словом, все выглядит так, будто вы уже щелкнули по красно-

му плюсу переполнения фрейма и готовы загружать текст в рабочую область. 

 Автоматический режим включается, если при заливке текста нажать клавишу 

<Shift>. Этот режим предполагает полную самостоятельность программы. Вы 

больше ничего не делаете, a InDesign сам заполняет колонки текстом и при не-

обходимости сам добавляет новые страницы. 

Завершите размещение текста Blanding_Castle в автоматическом режиме. 
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Редактирование текста 

Не секрет, что текст, импортированный в публикацию, часто требует правки. Мы 
уже говорили о необходимости убирать лишние пробелы, знаки абзаца или табуля-
ции. К таким же необходимым операциям относится замена дефисов на длинные 
тире и т. п., не говоря уже о простой корректуре орфографических ошибок. 

Редактирование  
в режиме Story Editor (Текстовый редактор) 

Текст, размещенный во фреймах и отформатированный, не слишком удобен для 
такой работы: переход по страницам отвлекает, отображение форматирования за-
медляет перерисовку экрана. Для упрощения работы с текстом как таковым мы и 
используем режим текстового редактора (Story Editor) — альтернативный ре-
жим, предназначенный исключительно для правки текста (рис. 6.43). 

Он удобен по целому ряду причин: 

 в режиме текстового редактора страницы листать вообще не нужно, т. к. весь 
текст показывается вместе, если он находится в цепочке связанных между собой 
текстовых фреймов; 

 

Рис. 6.43. Режим Story Editor 
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 графические элементы не отображаются в режиме текстового редактора — сле-

довательно, не отнимают время на прорисовку и не отвлекают внимание; 

 текст в режиме текстового редактора показывается простым шрифтом, без деко-

ративных элементов, графики, таблиц, деления на текстовые блоки и колонки: 

при таком максимальном упрощении отображения он прорисовывается практи-

чески мгновенно; 

 режим текстового редактора открывается в отдельном окне, как новый доку-

мент. 

Таким образом, в режиме текстового редактора мы имеем дело с текстом в удобном 

для чтения и правки представлении. Для вызова текстового редактора нужно выде-

лить текстовый блок инструментом Selection (Черная стрелка) или поставить кур-

сор в текст. После этого вызвать Edit>Edit in Story Editor (Редактирование > Тек-

стовый редактор) (<Ctrl>+<Y>). Как уже отмечалось, этот режим открывается в но-

вом окне, поэтому вы сможете видеть свою публикацию одновременно в двух 

представлениях. 

Возврат в режим макета происходит повторным нажатием клавиш <Ctrl>+<Y> или 

выбором в меню Edit команды Edit in Layout (Режим макета). 
 

Работа с автозаменой 

Одна из самых востребованных команд при работе в режиме текстового редакто-

ра — автозамена (Find/Change). Основное ее назначение — поиск и замена от-

дельных символов или их последовательностей. 

При работе с автозаменой пользователь может выполнять поиск и замену следую-

щих типов символов: 

 обычных текстовых символов, набираемых с клавиатуры; 

 текстовых символов, отсутствующих на клавиатуре, набираемых с помощью 

специального кода; 

 непечатаемых символов. 

Команду автозамены можно вызвать и в режиме макета (Layout), и в режиме тек-

стового редактора (Story Editor). По рассмотренным выше причинам второй вари-

ант предпочтительнее. 

Продолжим работу с нашим импортированным файлом Blandings Castle. 

Поставьте курсор внутрь текстового фрейма и перейдите в режим текстового ре-

дактора (<Ctrl>+<Y> или Edit > Edit in Story Editor (Редактирование > Текстовый 

редактор). 

Команда автозамены (рис. 6.44) вызывается горячими клавишами <Ctrl>+<F>  или 

через меню Edit > Find/Change (Редактирование > Автозамена). 
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Рис. 6.44. Окно автозамены 

Поиск и замена  
обычных текстовых символов 

Для поиска обычных текстовых символов нужно поставить курсор в поле Find 

what (Найти) и вписать слово или символ для поиска. Потом в поле Change To 

(Заменить на...) вписать желательный результат. 

Давайте заменим сильно русифицированную фамилию хозяина замка Эмсворт на 

более близкое к английскому произношению Эмсуорт. 

1. Впишите в поле Find what "Эмсворт". 

2. Впишите в поле Change to "Эмсуорт". 

3. Нажмите кнопку Change All. 

4. Появится сообщение о количестве произведенных замен. 

Диалоговое окно автозамены позволяет управлять параметрами поиска. 

 Word — искать в строгом соответствии с написанием. Возможно, вы обратили 

внимание, что заменены слова не только в именительном падеже. То есть 

InDesign не просто выполняет поиск слова "Эмсворт", а ищет все слова, в кото-

рых встречается такая последовательность символов. Если включить флажок 

Word, при поиске будет учитываться только полное совпадение. 

 Case Sensentive — чувствительность к регистру. Если включен этот флажок, 

поиск и замена выполняются в точном соответствии с расположением строчных 

или заглавных букв (слово "Эмсворт" будет найдено и заменено, а "эмсворт" — 

нет). 
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Поиск и замена текстовых символов,  
которые отсутствуют на клавиатуре 

С текстовыми символами, набираемыми с клавиатуры, все более или менее понят-

но, но что делать с символами, отсутствующими на клавиатуре, — знаками абзаца, 

значками авторских прав и т. д.? Как  их набирать и искать в тексте? 

Такие символы делятся на печатаемые, набираемые с помощью специального ко-

да, и непечатаемые (невидимые). 

Рассмотрим первый случай. Символы, имеющие специальный код, можно посмот-

реть в Таблице символов (Системное меню Пуск > Все программы > Стандарт- 

ные > Служебные > Таблица символов). Выбирая символ, вы в окне таблицы види-

те код для ввода с клавиатуры (рис. 6.45). 

 

Рис. 6.45. Таблица символов 

Например, вам нужно набрать в тексте символ "зарегистрированный товарный 

знак" (®) или длинное типографское тире (—). Для этого надо найти нужный сим-

вол в таблице и набрать код, соответствующий ему. 

Для ввода символа с помощью кода нужно поставить курсор в текст (или в любое 

поле автозамены) и, удерживая клавишу <Alt>, набрать на дополнительной циф- 

ровой клавиатуре (справа от буквенной) четырехзначный код, начинающийся  

с нуля. 

Например, заменим дефисы, поставленные вместо тире, на "правильное" длинное 

типографское тире: 

1. Find what: < -- > (нажатие клавиши "Пробел" отображается как пустое про-

странство размером в один пробел). 
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2. Change to: <Alt>+0151. 

3. Появится сообщение о количестве замен. 

Для надежности старайтесь копировать символы, которые собираетесь заменить, 
прямо из текста (<Ctrl>+<C>). Это позволит избежать случайных опечаток и в ре-
зультате — невыполнения замены. 

 

 

  

В режиме автозамены InDesign не работает код <Alt>+0187 (правая кавычка-"елочка"). Ее надо скопиро-
вать в окно автозамены прямо из таблицы символов. 
 

 

Поиск и замена непечатаемых символов 

Непечатаемые символы — те, которые становятся видны при включении показа 
непечатаемых символов (Type > Show Hidden Characters). Это символы, исполь-
зующиеся для разметки и форматирования текста. К сожалению, периодически 
приходится исправлять ошибки форматирования, допущенные при наборе текста. 
Прежде всего, это знаки табуляции, использованные в качестве абзацных отступов, 
и знаки конца параграфа в каждой строке, характерные для многих материалов, по-
лученных из Интернета. 

Для замены таких знаков рядом с каждым полем в окне автозамены имеется кнопка 
@ — вызов списка непечатаемых символов (рис. 6.46). 

 

Рис. 6.46. Выпадающий список непечатаемых символов 

В нашем тексте про Блэндингский замок имеются традиционные ошибки формати-
рования текстовых файлов: знак абзаца в конце каждой строки и дополнительные 
пробелы вместо абзацного отступа. Зададим ему правильное форматирование. 
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1. Сначала обеспечим сохранение разделения на абзацы. В поле Find What выбе-
рите из списка знак абзаца и введите пять пробелов. В поле Change To выберите 
знак табуляции (можно выбрать любой знак, гарантированно отсутствующий 

в тексте — например,  или №). 

2. Нажмите Change All. 

3. Теперь надо убрать лишние знаки абзаца. В поле Find What выберите знак аб-
заца. В поле Change To введите пробел. 

4. Нажмите Change All. 

5. Возвращаем абзацам нормальное деление: в поле Find What выберите знак та-
буляции (или тот знак, который вы выбрали в качестве временного). В поле 
Change To выберите знак абзаца. 

6. Нажмите Change All. 

7. По этому же алгоритму уберите лишние пробелы (в поле Find What введите два 
пробела. В поле Change To введите пробел; повторяйте операцию, пока не по- 
явится сообщение, что произведено 0 замен). 

Готово! 

Таких небольших алгоритмов в процессе работы накапливается много, их имеет 
смысл запоминать, записывать и использовать для ускорения рутинных операций. 

Огибание объектов текстом 

Text Wrap (Огибание текстом) — это очень важный прием, который используется 
практически в любой верстке. Он определяет взаимоотношения объекта и текста. 
Текст располагается вокруг объекта определенным образом, на заданном расстоя-
нии, не пересекая его и не перекрываясь им. В качестве огибаемого объекта может 
выступать графика, созданная в программе, импортированное изображение или 
другой текст (рис. 6.47). 

Для всех настроек этого эффекта используется специальная палитра Text Wrap: 
Window > Text Wrap (Окно > Огибание текстом). 

1. Скопируйте одну из башен проекта "Монгольфьеры" и поместите поверх текста. 

2. Выберите одну из кнопок режимов огибания в палитре Text Wrap. Текст рас-
пределится вокруг фигуры. 

 

 

  

Эта операция привязана к объекту! Для ее выполнения нужно выделить только объект. Любой текст, 
оказавшийся в области ее действия, будет "выдавлен" из этой области и начнет перераспределяться, 
поэтому нужно предусмотреть место для размещения "выдавленной" части текста. 
 

 

Режимы огибания текстом: 

 No Text Wrap (Перекрывание) — огибание отсутствует. 

 Wrap around Bounding Box (Огибание по периметру) — независимо от формы 
объекта текст будет огибать его габаритный контейнер (рис. 6.48); 
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Рис. 6.47. Пример огибания объекта текстом 

 

Рис. 6.48. Вариант огибания текстом по периметру объекта 

 Wrap around Object Shape — огибание по форме объекта. Какой бы замысло-

ватой формы ни был ваш объект, текст попытается повторить его форму; 

 

 

  

Если огибаемый объект располагается внутри страницы (огибается со всех сторон), он должен нахо-
диться между колонками текста (рис. 6.49). Разрыв строки огибаемым объектом на две части недопус-
тим: читатель никогда не "перепрыгнет" взглядом объект и не доберется до конца строки. 
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Рис. 6.49. Правильное и неправильное расположение огибаемого объекта внутри текстовой полосы 

 Jump Object — "перепрыгивание" объекта, текст распределяется выше и ниже 

объекта, не размещаясь по бокам; 

 Jump to Next Column — "перепрыгивание" сразу на другую колонку, текст рас-

полагается только сверху. Удобно для газетной верстки и для вставки заставок 

в конце глав в книгах. 

Любое растровое изображение имеет форму прямоугольника, поскольку состоит из 

фиксированного количества точек по высоте и ширине. Поэтому нет смысла пы-

таться создавать фигурное обтекание вокруг растрового объекта. Это возможно 

только с использованием обтравочного контура или альфа-канала (эти вопросы 

мы рассмотрим в главе 9). 

Как мы выяснили, любой текст, попавший в область действия команды Text Wrap, 

ей подчиняется. Что же делать, если нужно разместить текст прямо поверх картин-

ки — например, поставить подпись в границах импортированного изображения? 
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Рис. 6.50. Текстовый фрейм с установкой Ignore Text Wrap 

Для этого нужно в настройках этого фрейма (Text Frame Options) установить  

Ignore Text Wrap (Игнорировать обтекание текстом) (рис. 6.50). 

Перевод текста в контуры 

Операция перевода текста в контуры обычно применяется на финальном этапе ра-
боты перед сдачей макета в печать. Она необходима, если вы не уверены в качестве 

используемых шрифтов и не можете гарантировать, что при печати не будет сбоя. 
К тому же, перевод текста в контуры избавляет от необходимости отправлять вме-

сте с макетом в типографию набор шрифтов. 

Команда превращения текста в набор контуров вызывается из меню Type > Create 

Outlines (Текст > Преобразовать в контуры) (<Ctrl>+<Shift>+<О>). Для ее приме-

нения нужно инструментом Selection выделить текстовый фрейм. 

Как правило, перевод текста в контуры происходит сразу для всех текстовых фрей-

мов на странице. Для быстрого выделения всех объектов на странице используются 
горячие клавиши <Ctrl>+<A> (Edit > Select All (Редактирование > Выделить все). 

Если теперь вызвать команду Create Outlines, можно быть уверенным, что все объ-

екты на странице будут преобразованы в контуры. 

 

 

  

Команда Select All выделяет все объекты только на активном развороте. 
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В InDesign есть особенности преобразования текста в контуры, которые нужно 
учесть во избежание появления ошибок при печати. 

 Текст, находящийся в группе (объединенный командой Object > Group (Объ-
ект > Сгруппировать)), не переводится в контуры. Прежде, чем выполнять пре-
образования, удостоверьтесь, что ни один текстовый фрейм не сгруппирован. 

 При преобразовании фрейма, выделенного инструментом Selection (Черная 
стрелка), теряются атрибуты фрейма (вы помните, что у текстовых фреймов две 
группы атрибутов — относящиеся к собственно тексту и к фрейму). Поэтому, 
если какой-то текст вам необходим лежащим, к примеру, на цветной плашке, 
лучше либо выделять текст для преобразования инструментом Type (Текст), ли-
бо (что предпочтительнее) рисовать плашку отдельно и размещать сверху текст 
в обычном прозрачном фрейме. Это позволит вам преобразовывать текст в кон-
туры быстро и удобно, не заботясь о возможной потере цветовых плашек или 
граничных линеечек. 

Проект "Пресс-релиз" 

Весьма распространенная практическая задача, связанная с версткой, — создание 
пресс-релизов фирмы для раздачи на выставках. Обычно это одно- или двухстра-
ничная листовка формата А4. 

Рассмотрим процесс создания такой листовки. 

При желании для контроля результатов своих действий можно пользоваться фай-
лом chapter6\project_press-release\press_sample.indd. С помощью клавиши <W> пе-
реключайтесь из режима макета (со всеми направляющими, сетками и прочими 
вспомогательными элементами) в режим предпросмотра и обратно. 

1. Создайте документ со следующими настройками: 

 Intent = Print; 

 Size = A4; 

 Facing Pages = Off; 

 Master Text Frame = Off; 

 Number of Columns = 2; 

 Gutter = 5 mm; 

 Margin-top = 50 mm; 

 Margins left, right = 20mm; 

 Margin-bottom = 25 mm; 

 Bleed = 5 mm. 

В открывшемся окне документа сформируем "шапку". 

2. Нарисуйте прямоугольник 220 40 мм и расположите вдоль верхнего края стра-
ницы так, чтобы его верхний, правый и левый края совпали с метками припус-
ков под обрез (Bleed). Залейте его цветом C = 100 M = 70 Y = 0 K = 0. 



Работа с текстом 141 

3. Задайте дополнительные направляющие: горизонтальные на расстоянии 10 мм 
и 35 мм от верхнего края страницы, вертикальные — по линиям Margins (по-
лей) — по 20 мм с каждой стороны страницы. 

4. Вдоль второй горизонтальной направляющей (35 мм от верхнего края) через 
всю страницу инструментом Line (Линия) проведите линию белого цвета тол-
щиной 1 pt. 

5. Запустите Adobe Bridge и откройте в нем папку chapter6\project_press-release. 
Выберите файл epson-logo.eps и перетащите его мышью в документ. 

6. Разместите его так, чтобы верхний край совпал с верхней горизонтальной на-
правляющей, а правый край буквы N лег на правую вертикальную направляю-
щую (рис. 6.51). 

 

Рис. 6.51. "Шапка" пресс-релиза 

"Шапка" сформирована, теперь сформируем нижний колонтитул — оформи-
тельский элемент с "подписью" компании. 

7. Задайте еще две горизонтальных направляющих: на 2 мм ниже нижнего края 
текстовой полосы и еще на 2 мм ниже. 

8. Вдоль верхней из этих направляющих проведите линию черного цвета толщи-
ной 0,5 pt и длиной, равной ширине текстовой полосы. 

9. От нижней вниз создайте текстовый фрейм 82 5 мм и выровняйте его по пра-
вому краю текстовой полосы. 

10. Наберите в нем текст "SEIKO EPSON Inc. 2010" и с помощью палитр Character 
и Paragraph или Контрольной панели отформатируйте со следующими пара-
метрами: 

 Font Family = Arial; 

 Font Style = Regular; 

 Font Size = 12 pt; 

 Justification = Right. 

 Остальные установки оставьте стандартными. 

Нижний колонтитул готов (рис. 6.52). 

Теперь можно перейти к основному тексту. 

11. Импортируйте файл chapter6\project_press-release\epson_press-release.doc с уста-

новкой импорта Remove Styles and Formatting for Type and Tables (Удалить 

исходное форматирование) и разместите его в первой колонке. 
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Рис. 6.52. Сформированный нижний колонтитул 

12. В ситуациях, когда нужно по-разному отформатировать разные фрагменты тек-
ста, общее правило таково: сначала весь текст оформляется с настройками для 
основной его части, потом задаются особые установки для отдельных фрагмен-
тов. В нашем тексте три по-разному оформленных части. 

13. Щелкните инструментом Type (Текст) внутри фрейма и выделите весь текст 
(<Ctrl>+<A>). При этом не поместившаяся во фрейм и потому невидимая часть 
текста тоже выделится и будет доступна для форматирования. 

14. Задайте следующие установки: 

 Font Family = Arial; 

 Font Style = Regular; 

 Font Size = 10 pt; 

 Leading = 12 pt; 

 Justification = Left Justify (выравнивание в оба края с левым расположением 
последней строки); 

 Align to Grid (привязка к сетке) = On. 

Задав точный интерлиньяж, мы можем выровнять текст по сетке, предваритель-
но настроив ее: Edit > Preferences > Grids > Increment Every > 12 pt. 

Теперь можно задать форматирование особым фрагментам текста. 

15. Текст от слов "Знаете ли вы, что..." до "... в Книгу рекордов Гиннеса" — это 
врезка, специальный текст, который вводит читателя в курс содержания основ-
ного материала. Сделаем ее чуть крупнее, курсивной и выделенной цветом: 

 Font Family = Arial; 

 Font Style = Italic; 

 Font Size = 11 pt; 

 Leading = 12 pt; 

 Justification = Left Justify (выравнивание в оба края с левым расположением 
последней строки); 

 Align to Grid (Привязка к сетке) = On; 

 Color (выбирается в блоке управления цветом текста в Контрольной панели) 
C = 100 M = 70 Y = 0 K = 0. 

Обратите внимание, что, хотя текст стал чуть крупнее, интерлиньяж сохранился 
прежним, и выравнивание по сетке все так же актуально. В целом эта часть тек-
ста выглядит несколько плотнее и "увесистее", чем основной набор. 
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Наконец, переходим к оформлению заголовка. 

16. Задайте ему следующие настройки: 

 Font Family = Arial; 

 Font Style = Bold; 

 Font Size = 24 pt; 

 Leading = 28 pt; 

 Justification = Left; 

 Align to Grid (Привязка к сетке) = Off; 

 Color C = 100 M = 70 Y = 0 K = 0. 

Заголовки обычно не выравниваются по сетке, поскольку их размер редко  

в точности вписывается в расстояние, кратное интерлиньяжу основного текста. 

Наш текст отформатирован, и можно продолжить его размещение. В данном 

случае будет разумно воспользоваться ручным режимом. 

17. Задайте новую горизонтальную направляющую на расстоянии 63 мм от верхне-

го края страницы. 

18. Укоротите фрейм так, чтобы видимым остался только заголовок. 

19. Щелкните по знаку переполнения фрейма ([+]) и изменившимся курсором сде-

лайте щелчок на уровне новой направляющей. Новый фрейм заполнит колонку 

до конца. 

20. Повторите операцию, на этот раз щелкнув курсором размещения во второй ко-

лонке на уровне направляющей. 

21. Растяните фрейм с заголовком на всю ширину полосы. 

22. Проверьте, на одном ли уровне находятся верхние края фреймов, и при необхо-

димости выровняйте их с помощью палитры Align (Выравнивание). 

23. Задайте масштаб "Страница целиком" (<Ctrl>+<0>), перейдите в режим 

Preview (<W>) и оцените результат. 
 

Итоги 

Теперь вы знаете о работе в программе самое главное: как размещать на странице, 

редактировать и форматировать текст. Рисовать можно было бы и в других про-

граммах, но выстраивать взаимодействие текста и других частей страницы, свобод-

но и точно настраивая множество параметров для создания стройного, красивого и 

легко читаемого макета — в этом InDesign на сегодня не имеет себе равных. 

Имея в своем распоряжении материал этой и предыдущей глав, вы можете доста-

точно уверенно приступать к листовкам или буклетам, не требующим настройки 

многих страниц. 
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Для дополнительной практики будет очень полезно сделать двусторонний буклет 

евроформата (см. файл Chapter6\eurobooklet.indd) на тему "Самопрезентация": рас-

скажите о себе потенциальному заказчику или новым знакомым, используя собст-

венный текст и оформительские элементы, основанные на геометрических фигурах. 

1. Откройте файл Chapter6\eurobooklet.indd и используйте его в качестве основы 

своего буклета. 

2. Разместите текст во фреймах подходящей формы и размера и отформатируйте 

с помощью палитр Character (Символ) и Paragraph (Абзац). 

3. Добавьте оформление, которое покажется вам необходимым. 

При желании распечатайте и проверьте результат на друзьях и знакомых. 

Удачи! 

 



  

 

Глава 7 
 

 

МНОГОСТРАНИЧНЫЙ ДОКУМЕНТ 

 

 

 

 
 
В этой главе вы узнаете: 

 как создать документ из нескольких страниц; 

 как переходить со страницы на страницу и видеть целые развороты; 

 как настроить мастер-шаблоны, чтобы ускорить и упростить работу с доку- 

ментом; 

 как изменить элементы шаблона на отдельной странице; 

 как добавить, удалить, изменить размер страницы. 
 

Настройка многостраничного документа 

при создании 

Вы уже знаете, как создавать новый документ. Теперь слегка уточним это действие 

применительно к длинному (многостраничному) документу (рис. 7.1). 
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1. Создайте документ формата А4, в одну колонку, с полями по 20 мм с каждой 

стороны. 

2. Установите исходное количество страниц равным 10. Это даст определенный 

простор для наших учебных действий. 

3. Включите флажок в поле Master Text Frame (Текстовые фреймы на шаблоне). 

Это упростит операцию размещения в документе больших массивов текста. 

4. Сохраните файл на жестком диске под именем Working.indd. 
 

 

Рис. 7.1. Окно создания нового документа 

 

Палитра Pages (Страницы) 

В главе 6 мы говорили о том, что настройка каждой отдельной страницы через па-

литру Layout > Margins and Columns (Макет > Поля и колонки) занимает слишком 

много времени и сил, и хорошо бы его как-то автоматизировать. 

Такое средство есть, и реализуется оно с помощью основного инструмента работы 

со страницами в InDesign — палитры Pages (Страницы) (рис. 7.2). 

Эта палитра отображает все страницы документа, позволяет добавлять, удалять и 

перемещать их, обеспечивает переход между страницами, но главное — в ней со-

держатся мастер-шаблоны. 
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Рис. 7.2. Палитра Pages 

Мастер-шаблоны:  
создание, настройка, иерархия 

Мастер-шаблоны — одно из основных средств оптимизации работы над много-

страничным документом. На них размещаются повторяющиеся элементы макета. 

Что обычно располагается на мастер-шаблонах? Например, колонтитулы, колон-

цифры (номера страниц), направляющие или просто графические элементы, укра-

шающие внешний вид полосы — словом, любые объекты, которые повторяются 

в вашей публикации снова и снова и не меняют своего положения на странице. 

Мастер-шаблоны существуют только в электронном представлении публикации (на 

печать они не выводятся, хотя мастер-объекты, которые мы видим на обычных 

страницах, конечно же, печатаются). Это дополнительные страницы документа,  
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к которым обращаются обычные страницы, чтобы показать объект, который на са-

мом деле располагается только на мастер-шаблоне. 

На первый взгляд, все это кажется довольно сложным, но на самом деле мастер-

шаблоны — основное средство облегчения работы, поскольку, однажды создав 

мастер-шаблон со всей разметкой, направляющими линиями и повторяющимися 

объектами, можно больше не волноваться за их отображение на всех обычных 

страницах. 

В документе может быть несколько мастер-шаблонов. Это нужно в том случае, ес-

ли в нем есть диапазоны страниц, отличающихся друг от друга внешним видом. 

Например, в товарном каталоге для каждого вида продукции предусмотрена своя 

окраска оформительских элементов, свои пиктограммы для данного вида товаров, 

свои колонтитулы. Соответственно, у вас будет столько мастер-шаблонов, сколько 

видов продукции вашем каталоге. Или, скажем, в учебнике по-разному оформлены 

страницы с изложением теории и с описанием практических упражнений. 

По умолчанию мастер-шаблоны именуются буквами 

английского алфавита. Первый мастер-шаблон —  

A-master, следующий — B-master и т. д. (рис. 7.3). 

 
 
 

 

 

 

Рис. 7.3. Мастер-шаблоны  
в палитре Pages 

 

Создание мастер-шаблонов 

Вся работа по настройке мастер-шаблонов и обычных страниц ведется из палитры 

Pages (Страницы) (<F12>). Как и все палитры, ее можно вызвать из меню 

Window > Pages (Окно > Страницы). 

В верхней части палитры Pages располагается информация о мастер-шаблонах, а 

внизу — об обычных страницах. В нашем примере десятистраничный документ 

имеет три мастер-шаблона. 

Переход на нужную страницу или мастер-шаблон производится двойным щелчком 

по пиктограмме нужной страницы в палитре (один щелчок по пиктограмме страни-

цы выделяет ее, но не обеспечивает перехода). Переход на мастер-шаблон происхо-

дит так же — двойным щелчком. 

Активная страница или шаблон (т. е. та, где в данный момент идет работа) выделя-

ется в палитре Pages инверсной подписью (белой на черном фоне). Находясь на 

мастер-шаблоне, мы, независимо от масштаба, видим только один разворот, а на 

обычной странице по мере уменьшения масштаба становится видна вся публика-

ция. Кроме того, дополнительный индикатор нашего положения в документе — 

поле в левом нижнем углу, где пишется номер активной страницы или название 

мастер-шаблона (рис. 7.4). 
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1. Откройте файл Chapter7\Diver.indd и перейдите на мастер-шаблон A-master это-
го документа. 

2. Скопируйте пузырьки воздуха, расположенные на полях документа. 

3. Вернитесь в рабочий файл. 

4. Вставьте пузырьки на разворот шаблона, применив команду Paste in Place 
(Вставить на то же место) (<Ctrl>+<Alt>+<Shift>+<V>). 

5. Вызовите правой кнопкой мыши контекстное меню. 

6. Выберите команду Apply Мaster to Pages (Применить шаблон к страницам) и  
в открывшемся диалоговом окне задайте диапазон 2—8. 

Пузырьки появятся на всех страницах диапазона. 

 

Рис. 7.4. Активная страница и активный шаблон 

Другой способ применить шаблон — перетащить его из области шаблонов прямо 

на пиктограмму страницы, но этот способ существенно медленнее, приходится ра-

ботать с каждой страницей отдельно; при этом заметно повышается вероятность 

ошибки. 

Работа с несколькими мастер-шаблонами 

Как уже отмечалось ранее, иногда в документе используется несколько мастер-

шаблонов, чтобы по-разному оформить разные диапазоны страниц. В этом случае 

нам понадобится добавлять в документ новые мастер-шаблоны, а затем закреплять 

их за определенным диапазоном страниц. 

Как это сделать? 

Сейчас у нас в палитре Pages есть пиктограммы страниц двух видов: одни пустые 

(пустой шаблон — непременная и нередактируемая часть палитры Pages, он нужен 

для создания страниц, не обремененных никакими оформительскими элементами), 

другие подписаны буквой "А" — это значит, что к ним ко всем применен мастер-

шаблон A-Master. 
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Добавим новый шаблон. 

В контекстном меню палитры Pages (Страницы) надо выбрать команду New Master 

(Новый шаблон) (рис. 7.5). 

 

Рис. 7.5. Вызов команды и окно создания нового шаблона 

Что мы видим в окне? 

 Prefix — первая часть названия мастер-шаблона. По умолчанию для подписи 

используются буквы английского алфавита. Поскольку буква A уже занята, имя 

нашего нового шаблона будет начинаться с B. 

 Name — вторая часть названия мастер-шаблона. Обычно это слово "Master", но 

лучше давать ему значимое название — например, если речь идет об учебнике, 

"Теория" или "Практика". 

 Based on Master — указание иерархии шаблонов. Эту тему мы подробно рас-

смотрим ниже. 

 Number of Pages — количество страниц в развороте — одна или две. 

Пока оставим настройки по умолчанию. В верхней части палитры Pages появится 

еще один мастер-шаблон, называющийся B-master. Поскольку на нем нет никаких 

элементов, а в документе нет ни одной страницы, осно-

ванной на этом мастер-шаблоне, никаких других пере-

мен мы пока больше не увидим (рис. 7.6). 

 
 

 

 

 

Рис. 7.6. Новый мастер-шаблон  
в палитре Pages  
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Настроим наш новый шаблон. 

1. На расстоянии 10 мм от верхнего края страницы проведите темно-серую лине-

ечку толщиной 1,5 pt через всю страницу. Повторите для второй страницы. 

2. На расстоянии 8 мм от верхнего края и 8 — от наружного на обеих страницах 

расположите черные квадратные плашки размером 4 4 мм. 

3. С помощью команды Edit > Step and Repeat (Редактирование > Копировать  

с перемещением на заданное расстояние) разместите на листе вертикальный ряд 

квадратиков: 

 Count = 25; 

 Offset Vertical = 6 мм; 

 Offset Horizontal = 0. 

4. Задайте всему ряду градиентную растяжку от черного к белому, сверху вниз. 

5. Скопируйте ряд на вторую страницу, чтобы разворот стал симметричным. 

6. Теперь можно применить этот шаблон к нескольким страницам. Пусть это будут 

все страницы документа. Вызовите команду контекстного меню палитры Apply 

Master to и в списке шаблонов выберите B-master, а в поле страниц поставьте 

"1-10" (рис. 7.7). 

 

Рис. 7.7. Результат применения нового мастер-шаблона 
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Изменение элемента мастер-шаблона на странице 

Если нужно отредактировать какой-либо повторяющийся элемент страницы, это 

следует делать на мастер-шаблоне, чтобы все страницы получили это изменение. 

1. Перейдите на мастер-шаблон. 

2. Перекрасьте линеечки, например, в красный цвет. 

3. Вернитесь в документ и посмотрите, как изменятся страницы. 

Тем не менее иногда бывает нужно изменить отдельные мастер-элементы на от-

дельной странице — например, убрать линейку там, где ее перекрывает иллюстра-

ция на странице. Для этого нам нужна возможность отредактировать мастер-

объект, стоя на обычной странице документа. Такая возможность есть: щелкнуть по 

объекту, удерживая клавиши <Ctrl>+<Shift>. При этом мастер-объект копируется 

на текущую страницу, и с ним можно работать как с обычным объектом. 

Если позже выяснится, что правки оказались неуместными (например, иллюстра-

ция переместилась на другую страницу), вы можете в любой момент отказаться от 

частичного редактирования. Для этого используется команда Remove All Local 

Overrides (Восстановить мастер-элементы) из контекстного меню палитры Pages 

(Страницы) (рис. 7.8). 

 

Рис. 7.8. Команда Remove All Local Overrides 

Действие этой команды распространяется на ту страницу, которая активна в мо-

мент ее вызова. Если в момент вызова команды будет выделен объект, который 

раньше был мастер-объектом, название команды изменится на Remove Selected 

Local Overrides (Восстановить выбранный мастер-элемент). Действие этой коман-
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ды отличается тем, что в исходное состояние вернется только выделенный объект, 

а не все отредактированные бывшие мастер-объекты. 

Теперь, разобравшись, как создаются, редактируются и применяются шаблоны, по-

пробуем оптимизировать работу с похожими друг на друга шаблонами. 

Иерархия мастер-шаблонов 

Один мастер-шаблон может быть родительским для другого мастер-шаблона (т. е. 

его элементы перейдут в новый шаблон и станут его основой). Используя связь 

мастер-шаблонов, вы можете не тратить время на заполнение разных мастер-

шаблонов одинаковыми элементами (рис. 7.9). 

Мастер-шаблон А содержит элементы, которые 

также используются на мастер-шаблоне В, поэтому 

А назначен родительским мастер-шаблоном для В. 

При этом мастер-шаблон В имеет собственные уни-

кальные объекты, чем и отличается от А. 

Фактически родительский и дочерний мастер-шаб-

лоны находятся в таком же подчинении, как обыч-

ная страница и мастер-шаблон. 

Что из этого следует? 

Прежде всего, редактировать общие элементы нуж-

но на родительском мастер-шаблоне, тогда измене-

ния автоматически будут внесены как в дочерний 

шаблон, так и в основанные на этих двух шаблонах 

страницы. 
 

 

 

 

Рис. 7.9. Пример использования  
иерархии мастер-шаблонов 

 

Щелчок с нажатыми клавишами <Ctrl>+<Shift> позволяет вносить локальные из-

менения в объекты родительского мастер-шаблона, лежащие на дочернем. 

Мастер-шаблон можно назначить дочерним (основанным на другом) в диалоговом 

окне настроек этого мастер-шаблона. Для этого надо: 

1. В палитре Pages (Страницы) выделить обе странички (удерживая <Shift>) разво-

рота в пиктограмме мастер-шаблона. 

2. В контекстном меню палитры Pages вызвать команду Master Options for  

В-master (Параметры мастер-шаблона B). В открывшемся диалоговом окне ука-

зать в поле Based on Master (Основан на шаблоне) тот мастер-шаблон, который 

должен стать родительским (рис. 7.10). 

Таким образом, основывая дочерние шаблоны на родительских, а обычные страни-

цы — на шаблонах, мы получаем возможность во много раз ускорить процесс ра-

боты над макетом, сведя к минимуму количество точек редактирования. 
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Рис. 7.10. Диалоговое окно настройки иерархии мастер-шаблонов 

Нумерация страниц 

Чаще всего мастер-шаблоны применяются для нумерации страниц. Для этого на 

мастер-шаблоне размещается специальный маркер нумерации, а на всех остальных 

страницах, закрепленных за  мастер-шаблоном, в этом же месте появляется номер. 

Маркер нумерации на мастер-шаблоне обозначается буквой, используемой в назва-

нии мастер-шаблона. 

1. Перейдите на мастер-шаблон B-master. 

2. В контекстном меню палитры Pages (Страницы) выберите команду New Master 

(Новый шаблон). 

3. В окне создания шаблона укажите имя C-master, в поле Based on выберите  

B-master. Появится новый шаблон, пока еще в точности подобный шаблону  

B-master. 

4. На этом шаблоне нарисуйте у нижнего края левого градиентного пунктира чер-

ный квадрат размером 8 8 мм (рис. 7.11). 

5. Инструментом Туре создайте текстовый фрейм поверх квадрата, курсор должен 

мигать внутри фрейма. Задайте тексту белую (Paper) заливку. 

6. Щелкните правой кнопкой мыши и из выпадающего списка выберите команду 

Insert Special Character > Markers > Current Page Number (Добавить специ-

альный символ > Маркер > Номер страницы). В текстовом фрейме появится бу-

ква C — префикс шаблона. На обычной странице она заменится номером. 
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Рис. 7.11. Новый элемент шаблона C-master 

7. Поправьте форму и размер текстового фрейма и отформатируйте символ так, 

чтобы номер лежал посередине подложки (гарнитура по желанию, кегль = 14 pt, 

выравнивание по центру, текстовый фрейм лежит симметрично относительно 

подложки). 

8. Скопируйте текстовый фрейм вместе с подложкой на правую страницу разворота. 

9. Примените шаблон к страницам 2—9 (рис. 7.12). 

 

Рис. 7.12. Разворот с пронумерованными страницами 
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Номер страницы называется колонцифра и может находиться в любой части стра-

ницы за пределами основного текстового фрейма. Чаще всего колонцифру распола-

гают в верхнем или нижнем внешнем углу, но возможно размещение и в центре 

стороны. Внутреннее поле для размещения колонцифры не подходит: ее там по-

просту не видно. 

Разного рода сопроводительные надписи, которые часто выносятся на мастер-

шаблон, — имя автора, названия глав, для журналов — рубрики, для газет — дата  

и т. д., вместе с гафическими элементами шаблона — называются колонтитул и 

размещаются также по внешнему, верхнему или нижнему полю страницы. 
 

 

Сменная информация в мастер-шаблонах 

При верстке крупных произведений (книг, толстых журналов, каталогов, справоч-

ников) часто возникает необходимость периодической смены информации в колон-

титуле при общей неизменности шаблона. Например, у книги на каждой левой 

странице может быть обозначено имя автора и название книги, а на правой — на-

звание главы. Теоретически в такой ситуации можно для каждой главы сделать 

свой шаблон, основанный на общем (первом). Но практически разбираться с длин-

ным списком почти совершенно одинаковых шаблонов неудобно. Есть более про-

стой путь настройки сменной информации в колонтитулах: команда Numbering & 

Sections Options (Нумерация и настройка раздела) из контекстного меню палитры 

Pages (Страницы) (рис. 7.13). 
 

 

Рис. 7.13. Диалоговое окно Numbering & Sections Options 
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С помощью этого окна можно: 

 начать нумерацию с определенной страницы; 

 сменить стиль нумерации (арабскими, римскими циф-

рами, строчными или прописными буквами); 

 добавить префикс к номеру страницы (например, А-8); 

 создавать "плавающие" (меняющиеся) колонтитулы. 

Для того чтобы обеспечить работу со сменной информа-

цией, документ делится на разделы (Sections). Каждый 

раздел (секция) может иметь собственное название, кото-

рое и отражается в колонтитуле (рис. 7.14). 

 
 
 
 
 
 
 
 
 

 

 

 

 

Рис. 7.14. Принцип деления документа  
на секции 

 

 

 

Нумерация документа  
с определенной страницы 

При работе с большими публикациями, особенно с книгами, часто возникает необ-

ходимость начать нумерацию не с первой, а с какой-то из внутренних страниц — 

например, потому, что первые страницы заняты обложкой, информацией об изда-

нии и т. д. 

Для этого нужно: 

1. Активизировать нужную страницу документа двойным щелчком по ее пикто-

грамме в палитре Pages (Страницы). 

2. В контекстном меню выбрать команду Numbering & Sections Options (Нумера-

ция и настройка раздела) и в открывшемся окне установить переключатель на 

пункт Start Page Numbers at и ввести номер, с которого надо начинать нумера-

цию (рис. 7.15). 

С помощью этой настройки можно сделать нумерацию не сквозной (такой, где все 

страницы последовательно пронумерованы от первой до последней), а начинаю-

щейся внутри каждого раздела заново. 
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Рис. 7.15. Установка новой стартовой страницы 

Стили нумерации 

Деление документа на секции, у каждой из которых своя нумерация, особенно ха-

рактерно для разного рода справочников, руководств и т. п. технической и деловой 

литературы. В таких изданиях уместно использовать разные стили нумерации или 

префиксы — кроме всего прочего, их использование снижает вероятность появле-

ния конфликтов настроек и наглядно структурирует инфорамцию в документе. 

Давайте предположим, что в нашем рабочем документе первые три страницы про-

нумерованы римскими цифрами, а с пятой страницы нумерация начинается заново, 

с номера 1, но уже арабскими цифрами (рис. 7.16). 

1. Активизируйте первую страницу документа. 

2. Вызовите команду Numbering & Sections Options (Нумерация и настройка раз-

дела) и в диалоговом окне выберите из списка Style желаемый вариант стиля 

нумерации (для первой секции это римские цифры). 

3. Перейдите на пятую страницу. Она станет стартовой для нового отсчета нуме-

рации. 

4. Снова вызовите диалоговое окно настройки нумерации. В верхней части диало-

гового окна установите переключатель на пункт Page Numbering at и в поле 

введите 1, а из выпадающего списка Style выберите вариант "арабскими циф- 

рами". 
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Рис. 7.16. Нумерация страниц в разных стилях 

 

 

  

Если нужно начать нумерацию новой секции именно с № 1, надо в качестве стартовой выбирать нечет-
ную страницу. 
 

 

Добавление префикса к номерам страниц 

Рассмотрим ситуацию, когда нужно добавить к номерам страниц документа пре-

фикс. Предположим, мы готовим инструкцию для инспекторов ГИБДД о порядке 

экзаменов на права разных категорий. 

Нам понадобятся префиксы A, B, C, D. 

1. Добавьте к рабочему документу 15 страниц: щелчком правой кнопкой мыши в 

свободном поле палитры Pages вызовите команду Insert Pages (Вставить стра-

ницы), в диалоговом окне выберите в поле количества — 15, в поле точки встав-

ки — At End of Document (В конце документа), в поле шаблона — C-master. 

2. Активизируйте страницу № 5. Она станет стартовой для секции с префиксом A, 

где будут собраны задания для экзамена на категорию A. 

3. Вызовите диалоговое окно Numbering & Section Options (Нумерация и на-

стройка раздела). 

4. В поле Section Prefix введите обозначение префикса — А-. 
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5. В нижней части диалогового окна поставьте флажок Include Prefix when 

Numbering Pages (Добавлять префикс при нумерации страниц) (рис. 7.17). 

6. Повторите операцию на странице 11 для префикса B, на странице 15 — для C и 
на странице 21 — для D. 

 

Рис. 7.17. Нумерация страниц с префиксом 

Таким образом, мы сформировали внешнее оформление страниц на уровне графики 
и нумерации, и теперь осталось только получить текст и разместить его. 

Создание меняющихся колонтитулов 

Здесь мы создадим "плавающие" колонтитулы — такие, информация в которых по 
мере необходимости меняется — например, при неизменном названии книги меня-
ются названия глав. 

Для создания меняющихся колонтитулов на мастер-шаблоне задается специальное 
поле, в котором на обычных страницах появляется то, что пользователь укажет  
в настройках окна Numbering & Section Options, например номер или название 
нужной главы. 

Прежде всего, создадим специальное поле на мастер-шаблоне. 

1. Двойным щелчком по пиктограмме в палитре Pages (Страницы) перейдите на 

мастер-шаблон С-master. 
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2. На левой странице разворота инструментом Туре (Текст) создайте текстовый 
фрейм длиной во всю ширину текстовой полосы и разместите его так, чтобы  
базовая линия шрифта оказалась на 1 мм выше линейки колонтитула. 

3. Введите во фрейм текст "Экзамен на получение водительских прав" и отформа-
тируйте по своему усмотрению (рис. 7.18). 

 

Рис. 7.18. Постоянный колонтитул 

4. Скопируйте фрейм на правую страницу разворота, выделите весь текст в нем и 
щелчком правой кнопкой мыши вызовите команду вставки спецсимвола Insert 
Special Character > Markers > Section Marker (Вставить специальный символ > 
Маркеры > Маркер секции). 

5. В текстовом фрейме появится слово Section. Это значит, что вы пометили спе-
циальную область, в которую на обычных страницах будут помещаться данные, 
указанные в настройках окна Numbering & Section Options (рис. 7.19). 

Если сейчас перейти на любую обычную страницу публикации, мы увидим пус-
тое поле. Нужно определить, что и когда вписывать в это поле. 

6. Активизируйте страницу № 5. 

7. Вызовите команду Numbering & Section Options и в открывшемся окне в поле 
Section Marker введите "задания для водителей категории A" (рис. 7.20). 

8. Повторите операцию на странице 11 для категории B, на странице 15 — для C и 
на странице 21 — для D. 

В документе на всех страницах в том месте, где на мастер-шаблоне вставлен сим-
вол Section, появится информация, вписанная в поле Section Marker окна 
Numbering & Section Options. 
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Рис. 7.19. Поле Section для сменной информации 

 

Рис. 7.20. Ввод значения в поле Section Marker 
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Рис. 7.21. Плавающие колонтитулы и стартовые страницы секций в палитре Pages 

Стартовая страница каждой секции помечается черным треугольником над верхним 
краем ее пиктограммы (рис. 7.21). 

Изменение размера страницы 

Для изменения размера и ориентации отдельной страницы достаточно выделить ее 
в макете инструментом Page и задать новый размер в Контрольной панели 
(рис. 7.22). 

 

 Рис. 7.22. Изменение размера страницы 
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Добавление и удаление страниц 

Для вызова вставки страниц существует несколько путей: 

 выбрать команду Insert Pages (Вставить страницы) в контекстном меню палит-

ры Pages; 

 выбрать эту же команду в выпадающем списке, вызываемом щелчком правой 

кнопки мыши на свободном поле палитры Pages (Страницы); 

 нажать на кнопку создания нового элемента в нижней части палитры Pages 

(Страницы). 

В любом случае появится диалоговое окно создания новой страницы (рис. 7.23). 

 

Рис. 7.23. Окно создания новой страницы 

Здесь нужно задать: 

 количество вновь создаваемых страниц; 

 точку вставки (перед/после какой страницы или в какой части документа долж-

ны разместиться новые страницы); 

 мастер-шаблон, на котором будут основаны новые страницы. 

 

 

  

Если мы размещаем текст автоматически с помощью клавиши <Shift> или мастер-фрейма, добавление 
страниц происходит автоматически на основе активного шаблона. 
 

 

Для удаления страниц из документа достаточно выделить их в палитре Pages 

(Страницы) и нажать на кнопку "Корзина" в нижней части палитры Pages. Если на 

страницах есть какое-либо содержимое, будь то элементы шаблона или материал 

обычных страниц, появится предупреждающее сообщение: "На странице есть со-

держимое. Вы все равно хотите ее удалить?" Нажатие кнопки ОК подтвердит уда-

ление (рис. 7.24). 

 

Рис. 7.24. Предупреждение команды удаления страницы 
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Проект "Гончие Бафута" 

Наша задача — сделать базовую (предварительную) верстку книги. Потом можно 
будет проверить, хорошо ли лежит текст, не появилось ли ошибок в расположении 

и взаимодействии абзацев, все ли в порядке с переносами слов и т. д. Но пока нам 
важно сделать основу: создать шаблоны и расположить текст на страницах. 

Создайте документ со следующими настройками: 

 Intent = Print; 

 Size = A5; 

 Number of Pages = 10; 

 Facing Pages = On; 

 Master Text Frame = On; 

 Number of Columns = 1; 

 Margin-top = 16 mm; 

 Margin-inside = 12 mm; 

 Margin-outside = 20 mm; 

 Margin-bottom = 24 mm; 

 Bleed = 5 mm. 

Поскольку мы собираемся сделать простую литературную раскладку, где на всех  
страницах только текст, без иллюстраций и прочих особенностей, нам необходимо 

активно пользоваться тем, что есть в нашем распоряжении. 

Что же это? 

Во-первых, основной мастер-шаблон, где будут располагаться автор и название 

книги (обычно эта информация размещается на левой стороне разворота), название 
главы (сменная информация на правой странице разворота) и номера страниц. 

Во-вторых нам понадобится отдельный шаблон для начальной страницы каждой 

главы. Начальная страница главы, так называемая спусковая полоса, отличается от 
прочих наличием заголовка и заметного отступа между заголовком и основным 

текстом. 

Таким образом, нам необходимо создать два шаблона, один из которых станет ро-
дительским для другого. 

Кроме того, нужно вычистить от наборного мусора и отформатировать импортиро-

ванный текст. 

Отсюда определяем последовательность действий: 

1. Определить родительский шаблон. 

2. Определить дочерний шаблон. 

3. Импортировать текст. 

4. Предварительно разместить текст на страницах документа. 



166 Глава 7 

5. Обработать текст в режиме Story Editor (Текстового редактора). 

6. Задать форматирование основного текста и заголовков. 

7. Добавить недостающие или удалить лишние страницы. 

Итак, приступим. Для контроля своих действий можно пользоваться файлом 
chapter7\project_bafoot\bafoot_sample.indd. 

Создадим шаблоны. 

1. В контекстном меню шаблона A-master выберите команду Master Options for 
A-master и в открывшемся окне переименуйте его в A-основной шаблон.  Это 
будет шаблон для большинства страниц, родительский для шаблона спусковых 
полос. 

2. На развороте шаблона создайте разметку: 

 вызовите линейки (<Ctrl>+<R>); 

 при нажатой клавише <Ctrl> вытяните горизонтальные направляющие и  
установите их на высоте 10 мм, 14 мм, 15 мм, 190 мм и 195 мм от верхнего 
края страницы. Удерживание клавиши <Ctrl> позволит провести горизон-
тальную направляющую через весь разворот; 

 вытяните вертикальные направляющие и установите их точно на вертикаль-
ных линиях Margins (Полей). 

3. На левой странице разворота инструментом Type (Текст) создайте фрейм по 
высоте от направляющей 10 мм до направляющей 14 мм и по ширине — во всю 
ширину текстовой полосы. 

4. Наберите во фрейме текст: "Джеральд Даррелл. Гончие Бафута". 

5. Задайте тексту следующее форматирование: 

 Font Family = Minion Pro; 

 Font Style = Italic; 

 Font Size = 10 pt; 

 Leading = 12 pt; 

 Justification = Left. 

6. Словам "Гончие Бафута" установите Font Style = Semibold Italic. 

7. Скопируйте фрейм на правую сторону разворота и выделите весь текст инсту-
ментом Type (Текст). 

8. Вызовите правой кнопкой мыши контекстное меню текста и выберите команду 
Insert Special Character > Markers > Section Marker (Вставить специальный 
символ > Маркер > Маркер секции). Появится слово Section, задающее поле для 
сменной информации. 

9. Задайте выравнивание текста Justification = Right. 

10. Вдоль направляющей 15 мм проведите линию черного цвета толщиной 0,5 pt и 

длиной во всю ширину текстовой полосы. Скопируйте ее на вторую страницу 

разворота. 
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11. В нижней части левой страницы разворота между направляющими 190 мм и 
195 мм создайте текстовый фрейм для номера страницы, выровняв его по лево-
му краю текстовой полосы. 

12. Вызовите правой кнопкой мыши контекстное меню текста и выберите команду 
Insert Special Character > Markers > Current Page Number (Вставить специ-
альный символ > Маркер > Номер страницы). Появится метка номера стра- 
ницы. 

13. Отформатируйте текст: 

 Font Family = Minion Pro; 

 Font Style = Regular; 

 Font Sipe = 10 pt; 

 Leading = 12 pt; 

 Justification = Left; 

 скопируйте фрейм с меткой номера на правую страницу разворота и задайте 
копии Justification = Right. 

Основной шаблон готов. 

Дочерний будет отличаться от него только дополнительной линией разметки, 
позволяющей контролировать расположение верхнего края текста в начале ка-
ждой главы. 

14. В контекстном меню палитры Pages (Страницы) выберите New Master (Новый 
шаблон). 

15. В открывшемся окне сохраните префикс B, задайте имя "Начало главы" и в по-
ле Based on (Основан на...) укажите A-основной текст. 

16. При нажатой клавише <Ctrl> вытяните горизонтальную направляющую и уста-
новите ее на уровне 52 мм от верхнего края страницы. 

17. Щелчком при нажатых клавишах <Ctrl>+<Shift> выделите верхние колонтиту-
лы с обеих страниц разворота и удалите их. 

18. Шаблоны готовы. Можно приступать к работе со страницами и текстом. 

19. Перейдите к странице 1. Оставьте ее шаблон без изменений (None — без шаб-
лона). Это будет титульная страница. Создайте на ней текстовый фрейм и набе-
рите в две строки: "Джеральд Даррелл | Гончие Бафута". 

20. Задайте форматирование: 

Первая строка: 

 Font Family = Minion Pro; 

 Font Style = Regular; 

 Font Size = 24 pt; 

 Leading = 28 pt; 

 Justification = Center. 
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Вторая строка: 

 Font Family = Minion Pro; 

 Font Style = Semibold; 

 Font Size = 36 pt; 

 Leading = 42 pt; 

 Justification = Center. 

21. Запустите Adobe Bridge, откройте папку chapter7\project_bafoot, выберите файл 

african-mask.tif и перетащите мышью в документ. 

22. Разместите картинку в центре страницы ниже текста (см. файл 
chapter7\project_bafoot\bafoot_sample.indd). 

23. Страница 2 (оборотная к титулу) тоже обычно остается без шаблона. 

24. В контекстном меню палитры Pages (Страницы) выберите команду Apply 

Master to Pages (Применить шаблон к страницам). В диалоговом окне укажите 

шаблон A-основной шаблон и диапазон страниц 3—10. 

Теперь можно переходить к тексту. 

25. Импортируйте файл bafoot.doc. Щелчком при нажатой клавише <Shift> в пре-

делах текстовой полосы страницы 3 выполните автоматическую раскладку  

текста. 

26. Вызовите Story Editor (Текстовый редактор) (<Ctrl>+<Y>). 

27. С помощью команды Find & Change (Автозамена) — <Ctrl>+<F> — приведите 

текст в порядок (см. главу 6): 

 уберите лишние знаки абзаца; 

 уберите пробелы (имитацию "красной строки") в начале каждого абзаца; 

 уберите лишние пробелы; 

 замените знаки дефиса (-) на типографские тире ( — ). 

28. Закройте текстовый редактор (<Ctrl>+<Y>). 

29. Теперь можно переходить к форматированию текста. 

30. Поставив курсор внутрь текстового фрейма, выделите весь текст (<Ctrl>+<A>). 

31. Задайте основное форматирование: 

 Font Family = Minion Pro; 

 Font Style = Regular; 

 Font Size = 10 pt; 

 Leading = 12 pt; 

 Language = Russian; 

 Justification = Left Justify (выравнивание в оба края с левым расположением 
последней строки); 
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 Align to Grid (привязка к сетке) = On; 

 Hiphenate = On. 

Сетка базовых линий по умолчанию настроена на 12 pt, так что перенастраи-
вать ее сейчас для наших целей не требуется. 

32. Инструментом Type (Текст) выделите заголовок и задайте его формат: 

 Font Family = Minion Pro; 

 Font Style = Regular; 

 Font Size = 18 pt; 

 Leading = 21 pt; 

 Language = Russian; 

 Justification = Center; 

 Align to Grid (привязка к сетке) = Off; 

 Hiphenate = Off; 

 Space After (Отступ после абзаца) = 27 mm. 

33. Первому абзацу главы определите буквицу с помощью Контрольной панели 
или палитры Paragraph (Абзац): в полях Drop Cap (Буквица) задайте высоту 
буквицы, равную 3 строкам, и ширину, равную одной букве. 

34. Повторите форматирование заголовка и первого абзаца для всех глав. 

35. Регулируя маркерами габаритного контейнера положение нижнего края тексто-
вого фрейма последней страницы главы, добейтесь, чтобы каждая глава начи-
налась с новой страницы. 

36. К первым страницам глав примените шаблон B-начало главы (соответственно 
правую или левую страницу шаблона). При работе с отдельными страницами 
пиктограмму шаблона можно просто перетащить на пиктограмму страницы. 

37. Уберите лишние или добавьте недостающие страницы в конце документа. 

38. Перейдите на страницу 6. В контекстном меню палитры Pages (Страницы) вы-
берите команду Numbering & Section Options (Параметры нумерации и сек-
ций). 

39. Установите флажок в строке Start Section (Начать секцию). 

40. В поле Section Marker (Маркер секции) введите "ГЛАВА I. Жабы и танцую-
щие обезьяны". Теперь это название будет показано на всех правых страницах 
первой главы. 

41. Повторите операцию с соответствующими названиями для первых страниц 
всех глав. Обратите внимание, что первые страницы глав (начала секций) выде-
лились в палитре Pages черными треугольничками. 

В работе над этим проектом мы столкнулись с необходимостью множество раз на-

страивать одинаковое форматирование текста в повторяющихся типах абзацев. Оп-

тимизацию этого процесса мы рассмотрим в следующей главе. 
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Итоги 

Итак, вы уже можете работать с достаточно длинными документами и знаете, как 

заставить все страницы выглядеть единообразно без чрезмерной затраты сил. Осо-

бенно приятно, что при необходимости что-то изменить в постоянных элементах 

публикации вам достаточно внести минимальные правки в шаблон, не обращаясь  

к каждой странице в отдельности. Это существенно экономит время разработки 

макета, особенно при подготовке книг и журналов. 

Умение пользоваться шаблонами настолько важно, что имеет смысл попрактико-

ваться дополнительно. Например, вы можете создать макет альтернативного изда-

ния любимого романа или любого другого текста, имеющегося у вас в электронном 

виде. Чаще всего для книжной верстки используется формат А5, реже А4; для 

"карманных" изданий — А6. 

1. Выберите формат, который покажется вам подходящим. 

2. Создайте базовый шаблон и сменные названия глав ("плавающие" колонтиту-

лы), каждую новую главу начинайте с новой страницы. 

3. Заголовок отделяйте от основного текста главы с помощью отступа, заданного 

в палитре Paragraph (Абзац). 

Удачи! 

 



  

 

Глава 8 
 

 

СТИЛИ:  

СОЗДАНИЕ И ИСПОЛЬЗОВАНИЕ 

 
 

 
 

Вы этой главе вы узнаете: 

 что такое стили абзаца и символа и зачем они нужны; 

 как создать стиль абзаца и стиль символа, когда какой из них применять; 

 как создать красивые буквицы в начале текста; 

 как воспользоваться готовыми стилями из другого документа; 

 зачем нужны стили абзаца и символа. 

Стили абзаца и символа — мощное средство облегчения и ускорения работы во 
время верстки, для текста они играют примерно ту же роль, что и мастер-шаблоны 
для страниц: помогают собрать в один управляющий центр повторяющиеся эле-
менты, только на этот раз не объекты, а настройки. Работа над любым сложным 
макетом без них выльется в колоссальные затраты времени и труда, поэтому лучше 
с самого начала привыкнуть работать с текстом на основе стилей. 

Что же нам дают стили? 

Во-первых, стили позволяют применять единый набор настроек форматирования 
текста комплексно: единожды задав все необходимые параметры, вы потом сможе-
те применять их все разом, одним щелчком. 
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Во-вторых, стили очень удобны, если нужно быстро поменять во всем тексте неко-
торые параметры. Например, чтобы поменять шрифт во всех одинаковых заголов-
ках документа, достаточно будет изменить его в настройках стиля, вместо того, 
чтобы отыскивать все фразы, набранные этим шрифтом, и вручную их редакти- 
ровать. 

В-третьих, стили позволяют автоматически создавать оглавление. Эту тему мы рас-
смотрим в главе 11. 

В Adobe InDesign для работы со стилями используются палитры Paragraph Styles 
(Стили абзаца) и Character Styles (Стили символа). Как видно из их названий, па-
литры предназначены для хранения параметров форматирования абзаца (Paragraph 
Styles) и настроек внешнего вида отдельно взятого символа (Character Styles). 

Иерархические взаимоотношения разных ступеней настройки форматирования по-
добны иерархии дорожной информации: базовой является дорожная разметка, све-
тофоры и дорожные знаки имеют над ней приоритет (если они есть, то действуют 
они, а если нет — то разметка), а временные знаки и регулировщики имеют при-
оритет над всеми прочими. В работе над макетом роль дорожной разметки играет 
стиль абзаца, содержащий самый широкий набор настроек форматирования, роль 
знаков и светофоров — стиль символа, ограниченный настройками форматирова-
ния отдельных символов, а роль регулировщиков — ручное форматирование от-
дельных символов, слов или фраз. 

Отсюда следует, что начинать работу надо с палитры Paragraph Styles (Стили аб-
заца). 

Создание и применение стиля абзаца 

Палитра Paragraph Styles хранит информацию о настройках (стилях) абзацев. 

Абзацем считается часть текста между знаками конца абзаца. Таким образом,  
любой заголовок — это абзац, и ему тоже нужно назначить стиль. 

В любом документе может быть определено, как минимум, два стиля — для заго-
ловка и для основного текста. На самом деле, стилей обычно бывает больше, по-
скольку всевозможные сноски, примечания, вступительные слова и т. п. повто-
ряющиеся виды текста тоже оформляются каждый своим стилем. 

1. Создайте документ: 

 Print; 

 Facing Pages; 

 Master Text Frame; 

 Paper Size = А4; 

 Columns Number =1; 

 Margins = 20 мм по всем сторонам. 

2. Импортируйте файл Chapter8\Lord_Emsworth.doc. 

Это будет наш рабочий файл. 
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Палитра стилей вызывается из меню Window > 

Type&Tables > Paragraph Styles (Окно > Текст и табли-

цы > Стили абзаца) — <F11> (рис. 8.1). Это одна из тех  

ситуаций, где использование горячих клавиш способно 

очень заметно ускорить работу! 
 

 

 

 

Рис. 8.1. Палитра Paragraph Styles 

 

Для вызова настроек стиля нужно нажать на кнопку создания нового элемента в 

нижней части палитры или сделать двойной щелчок на строке существующего сти-

ля. Появится окно Paragraph Style Options (Настройки стиля абзаца). 

Рассмотрим основные вкладки и самые важные настройки. 

 General (Общие настройки) (рис. 8.2). 

Эта вкладка позволяет задать имя нового стиля и настроить иерархию стилей  

в документе (иерархия стилей аналогична иерархии мастер-шаблонов: при из-

менении базового (родительского) стиля соответствующие правки вносятся во 

все основанные на нем дочерние стили). 

Имя стиля вводится в поле Style Name. Как и при работе с шаблонами, лучше 

давать стилям осмысленные имена, чтобы в любой момент не только вы, но и 

ваши коллеги по рабочей команде могли в них разобраться. 

 

Рис. 8.2. Палитра Paragraph Style Options. Вкладка General 
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В выпадающем списке Based On (Основан на...) выбирается родительский 
стиль. Естественно, он должен уже существовать. Для самого первого стиля в 
документе в этом поле выбирается No Paragraph Styles (Нет стиля). Использо-
вание родительского стиля позволяет настраивать в новом стиле не все парамет-
ры, а только те, которые вы хотите изменить (остальные переходят в новый 
стиль из родительского). То, что введено во время настройки вручную, и будет 
отличать новый стиль от предыдущего. 

Если вы до начала работы потратили несколько минут, чтобы определить все 
необходимые стили и их взаимоотношения, вам практически придется настро-
ить только 1—2 стиля, а остальные, иерархически связанные с ними, потребуют 
изменения всего лишь небольшого количества параметров. Особенно такая тех-
нология работы с родительскими стилями будет удобна при работе, скажем,  
с заголовками и подзаголовками. Обычно они делаются одной гарнитурой и от-
личаются начертанием и кеглем. Стиль подзаголовков имеет смысл делать до-
черним для стиля заголовков. 

Выбор стиля из списка Next Style (Следующий стиль) позволяет указать, каким 
стилем следует набирать следующий абзац. Например, можно указать при на-
стройке стиля заголовка, что следующий абзац (это уже будет основной текст) 
следует набирать стилем для основного текста. Как и в предыдущем случае, 
нужно чтобы стиль уже существовал. 

Создайте для нашего документа стиль Main для основного текста. Поскольку до 
сих пор мы в этом документе никаких стилей не создавали, в поле Based On остав-
ляем No Paragraph Styles, в поле Next Style выбираем Same Style (Тот же самый). 

 Basic Character Formats (Основные параметры символа). 

Эта вкладка похожа на палитру Character (Символ). Действительно, параметры, 
собранные на этой вкладке, вы уже не раз настраивали, форматируя текст с по-
мощью палитры или соответствующих полей Контрольной панели (рис. 8.3). 

Здесь прежде всего настраиваются: 

 гарнитура и начертание (Font Family, Font Style); 

 кегль (Size); 

 интерлиньяж (Leading); 

 значение кернинга и трекинга (Kerning, Tracking); 

 при желании здесь же можно настроить регистр, текстовые эффекты и т. д. 

На этой вкладке установите своему стилю: 

 Font Family = Minion Pro; 

 Font Style = Regular; 

 Size = 10 pt; 

 Leading = 12 pt; 

 Kerning = Optical; 

 Tracking = 0. 
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Рис. 8.3. Палитра Paragraph Style Options. Вкладка Basic Character Formats 

 

 Advanced Character Formats (Дополнительные параметры символа) — в сущ-

ности, из всех параметров этой вкладки (рис. 8.4) имеет смысл всерьез говорить 

только об одном, но очень важном: выборе словаря (Language). На его основе 

происходит расстановка переносов, и при неправильно выбранном словаре рас-

ставить их корректно попросту не удастся. 

Остальные настройки (Horizontal / Vertical Scale — масштабирование симво-

лов, Scew — угол их наклона и Baseline Shift — перемещение базовой линии) 

как вы помните, все, кроме Baseline Shift, приводят к искажению рисунка 

шрифта, и пользоваться ими надо крайне осторожно. 

 Indents and Spacing (Отступы и отбивки). 

Эта вкладка практически в точности повторяет уже знакомую нам палитру 

Paragraph (рис. 8.5). Отступы слева, справа, на красную строку, до и после аб-

заца задаются так же, как в палитре Paragraph или в Контрольной панели. Здесь 

особое значение приобретают отступы (отбивки) до и после абзаца, особенно 

когда речь идет об отношениях основного текста и заголовка. Дело в том, что 

широко распространенная в текстовых редакторах практика задавать отбивку 

между абзацами дополнительным переводом строки (знаком абзаца) в серьезной 

верстке неприемлема, поскольку полностью зависит от кегля и интерлиньяжа и, 

к тому же, создает слишком большой разрыв между абзацами. Поэтому все от-

бивки, все межпараграфные расстояния должны задаваться именно здесь, в сти-

ле, и редактироваться для всего документа одновременно. 
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Рис. 8.4. Палитра Paragraph Style Options. Вкладка Advanced Character Formats 

 

Рис. 8.5. Палитра Paragraph Style Options. Вкладка Indents and Spacing 
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Важная особенность отбивок в стилях заголовков — необходимость рассчитать их так, чтобы заголовок 
был ближе к нижнему от него тексту (т. е. к тому содержанию, которое он открывает). Самая частая 
ошибка при верстке заголовков в колонках — расположение их строго посередине между текстовыми 
блоками или даже чуть выше, полностью отрывая их от "своего" текста. Если невозможно понять, явля-
ется ли надпись "Темная лошадка" подписью к фотографии действующего американского президента 
или заголовком репортажа о скачках, это сильно сбивает читателя с толку. 
 

 

Особое значение имеет поле Align to Grid (Выравнивание по сетке): здесь мож-

но задать выравнивание как всех строк текста, так и только первой или вообще 
отменить выравнивание. Выравнивать по сетке все строки имеет смысл в основ-

ном массиве текста, только первую линию — во всевозможных врезках и ком-
ментариях, оформляемых другим кеглем (чаще всего более мелким): тогда пер-

вая строка врезки будет лежать на одной из базовых линий шрифта, а остальные 

ее строки будут не слишком разрежены. Наконец, совсем не выравнивать по 
сетке — решение, подходящее для верстки газетных и журнальных заголовков, 

которые в противном случае будут плохо вписываться в отведенное для них 
пространство. 

Во вкладке Advanced Character Formats (Дополнительные параметры символа) 
в поле Language (Язык) выберите Russian (Русский). 

Во вкладке Indents and Spacing (Отступы и отбивки) установите Alignment 

(выравнивание) = Left Justify (в оба края с выключкой последней строки влево), 
абзацный отступ (красную строку — First Line Indent) = 8 мм. Это разумный 

отступ для книжной строки. В газетной колонке он был бы меньше, примерно 
5—6 мм. 

Задайте выравнивание по сетке для всех строк (Align to Grid = All lines). 

Рассмотренные вкладки содержат основные настройки для придалния абзацу фор-

мы и определения его внешнего вида. 

Дальше речь пойдет либо о специальных параметрах вроде табуляции, либо о более 
тонких настройках для добавления нашему стилю гибкости в урпавлении текстом. 

 Tabs (Линейка табуляции). 

Линейка табуляции (Tabs) связана с клавишей <Таb> на клавиатуре. Она ис-
пользуется для помещения текста во фрейме в определенную горизонтальную 

позицию: после нажатия клавиши <Таb> курсор перескакивает к отметке, ука-
занной на линейке табуляции (рис. 8.6). 

Линейка табуляции предназначена для решения двух основных задач: для вы-

равнивания столбцов текста без создания таблиц (например, в списках) и для 
создания отточия (заполнения пространства между элементами строки серией 

точек). Отточие чаще всего применяется для создания оглавления, поэтому при 
создании стилей, которые формируют внешний вид самого оглавления, вкладка 

Tabs используется непременно. 

Для того чтобы регулировать точку выравнивания текста в документе, вы може-

те воспользоваться линейкой табуляции как составной частью стиля параграфа. 

Это будет специальный стиль именно для работы со списками или таблицей. 
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Рис. 8.6. Палитра Paragraph Style Options. Вкладка Tabs 

Для того чтобы задать новую точку выравнивания, нужно, выбрав указатель 

(маленькую черную стрелку над линейкой), щелкнуть им по верхнему краю ли-

нейки (пустое белое поле над делениями линейки). В зависимости от направле-

ния изгиба стрелки в указателе, он служит для выравнивания по заданной пози-

ции левого края (стрелка влево-вниз), центра (стрелка строго вниз) и правого 

корая (стрелка вправо-вниз) текста. Устанавливая указатель, вы определяете по-

зицию курсора после нажатия клавиши <Таb>. 

Для получения отточия нужно выделить на линейке уже установленный указа-

тель выравнивания текста и при активном выделении поставить точку в поле 

Leader. Пустое пространство до выделенной отметки заполнится символом, 

введенным в поле Leader. 

 Paragraph Rules (Абзацные линии). 

Эта вкладка (рис. 8.7) позволяет отчеркнуть абзац линиями: одна над абзацем, 

другая под ним. Делать это следует далеко не всегда. Такой прием может быть 

вполне уместен для оформления, скажем, газетной врезки — краткого поясни-

тельного текста, который предваряет статью и набирается другим шрифтом или 

выделяется иным типографским способом (рис. 8.7). 

Показ линий разрешается флажком флажок Rule On (Показать линии). 

Разрешив показ линий, вы получите доступ к их настройкам (все установочные 

поля станут активными). Здесь доступны параметры, которыми обычно управ-
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ляет палитра Stroke (Линия), плюс выбор цвета во встроенной палитре Swatches 

(Образцы). Важная настройка абзацной линии — Offset — расстояние от текста 

до линии (рис. 8.8). 

 

 

Рис. 8.7. Палитра Paragraph Style Options. Вкладка Paragraph Rules 

 

 

Рис. 8.8. Пример применения абзацных линий 
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При переводе шрифта в контуры текст, имеющий в своих стилях абзацные линии, обязательно нужно 
выделять не инструментом Selection (Черная стрелка), а инструментом Type (Текст). В этом случае 
линии преобразуются вместе с текстом. При выделении инструментом Selection линии исчезнут, как 
исчезают в аналогичном случае прочие атрибуты текстового фрейма (см. главу 6). 
 

 

 Keep Options (Предотвращение разрывов). 

Эта вкладка (рис. 8.9) позволяет автоматически избегать появления в тексте не-

красивых разрывов абзацев. Например, всегда очень странно смотрится отрыв 

заголовка от текста, к которому он относится; особую проблему составляют ви-

сячие строки — последняя строка предыдущего абзаца в начале страницы или 

первая строка следующего абзаца — в конце (рис. 8.10). 

 

Рис. 8.9. Палитра Paragraph Style Options. Вкладка Keep Options 

Настройки, влияющие на тот или иной участок текста (заголовок, сноску, основ-

ной текст и т. п.), задаются в стиле для этого участка (стиля заголовка, стиля 

сноски, стиля основного текста). 

Поле Keep with Next используется для предотвращения отрыва заголовков от 

основного текста. 

Традиционно принято, что после заголовка на полосе должно помещаться еще 

как минимум три строки следующего абзаца, иначе у читателя появится ощуще-

ние висячих строк. Чаще всего в поле вводится именно 3, хотя иногда (напри-

мер, при верстке пьес) может быть и меньше (т. е. 2; 1 в качестве значения этого 

поля не используется). Одновременно исключается возможность разрыва заго-

ловка и текста. Этот параметр должен стать частью стиля форматирования заго-

ловков. 
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Рис. 8.9. Ошибки верстки: отрыв заголовка, висячие строки 

 

Поле Keep Lines Together используется для регулировки разрыва текущего аб-

заца. Имеет два режима работы: All Lines in Paragraph (Запрет разрывать абзац) 

и At Start/End of Paragraph (Предотвращение висячих строк). Первый режим 

(All Lines in Paragraph) вообще запрещает размещать части одного абзаца на 

разных страницах. Он используется для подрисуночных подписей, многостроч-

ных заголовков или сносок. На практике означает, что если абзац полностью не 

помещается на страницу, он будет целиком перенесен на следующую. Второй 

режим (At Start/End of Paragraph) позволяет автоматически избежать появле-

ния висячих строк. От нас при этом требуется указать в соответствующем поле 

количество строк абзаца, которое непременно должно остаться в конце страни-

цы или, соответственно, перейти на новую страницу. 

Например, установив значение полей Start и End равным 2, мы тем самым оп-

ределяем, что переносится/сохраняется, как минимум, две строки. В принципе, 

это уже не считается висячей строкой, хотя и находится на грани допустимого. 

Предотвращение висячих строк таким способом может привести к появлению 

несимметричных разворотов: количество строк слева и справа может оказаться 

разным. Если в журнальной верстке при выборе определенной стилистики и в 

некоторых видах книг (например, справочников) это в какой-то мере допустимо, 

то в газетной и в классической книжной верстке такое различие частей разворо-

та совершенно неприемлемо. В этом случае лучше избавляться от висячих строк 

вручную (прежде всего, за счет ручной подгонки количества символов в строке 

и расстановки переносов). 

Start Paragraph (Начало абзаца) — очень важный параметр, определяющий, где 

начать данный абзац по отношению к предыдущему (рис. 8.11). Например, вы-

брав из списка вариант On Next Page, вы определяете, что абзац начнется на но-

вой странице, In Next Column — в следующей колонке, и т. д. Особенно удобно 

использовать этот параметр при работе с книгами, где обычно каждая глава на-

чинается на новой странице. 
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Рис. 8.11. Список возможных вариантов начала абзаца 

 Hyphenation (Расстановка переносов) (рис. 8.12). 

Даже при правильном выборе словаря расстановка переносов — дело непростое 

и трудноавтоматизируемое. Нужно обеспечить необходимую гибкость и при 

этом не испортить вид нашего макета чрезмерным количеством идущих подряд 

переносов (строка, заканчивающаяся знаком переноса, выглядит укороченной, и 

если таких строк много, кажется, что весь фрагмент имеет отступ справа). 

Вкладка Hyphenation (Расстановка переносов) позволяет регулировать все па-

раметры расстановки переносов. Здесь можно задать правила расстановки пере-

носов в выбранном языке (например, в русском языке после переноса на каждой 

строке должно оказаться не меньше двух букв слова), допустимое количество 

идущих подряд переносов, область переносов — длину части строки, которая 

рассматривается при поиске возможных вариантов переноса, — и т. д. 

Автоматическая расстановка переносов — дело настолько сложное, что даже 

самая аккуратная настройка всех параметров этой вкладки не гарантирует, что 
все переносы будут сделаны правильно с точки зрения языка и обеспечат краси-

вый вид строки. Возможны как нарушения правил переноса, принятых в языке 
(например, среди букв, оставленных на строке, может не оказаться ни одной 

гласной), так и ухудшение вида строки (чрезмерно плотное размещение букв 

или слов или, наоборот, слишком большие пробелы из-за недостаточного коли-
чества символов в строке). Ошибки можно исправить вручную. Для ручной ус-

тановки переноса служит дискреционный перенос, который вызывается нажати-
ем клавиш <Shift>+<->. Это особенный знак переноса, который невидим до тех 
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пор, пока не возникает необходимость переносить слово. Если поставить символ 

дискреционного переноса в нужную точку слова, программа выполнит перенос, 
если он возможен (вписывается в допустимое количество идущих подряд пере-

носов, не слишком уплотняет следующую строку и т. д.). 

 

Рис. 8.12. Палитра Paragraph Style Options. Вкладка Hyphenation 

 Justfication (Регулировка выключки). 

Выключка (выравнивание) — распределение слов и символов в строке, позво-
ляющее зрительно выделить (выровнять) один из краев текстового блока или 
оба края сразу, либо расположить строки текста симметрично относительно его 
вертикальной оси. Общие настройки выравнивания задавались в самом начале 
работы над стилем, на владке Indents and Spacing (Отступы и отбивки), а здесь 
производятся довольно тонкие настройки, регулирующие поведение текста 
внутри строки (рис. 8.13). 

Правильный подбор этих настроек позволяет избежать как чрезмерно плотного 
размещения символов и слов в строке, так и "провалов" между словами или на-
бора отдельных слов "вразрядку" (рис. 8.14). 

Для каждого параметра здесь указывается три основных варианта: 

 минимально возможное значение (Minimum); 

 желаемое значение (Desired); 

 максимально возможное значение (Maximum). 

Основных параметров тоже три: 

 изменение ширины пробела (Word Spacing) (того, который получается нажа-
тием клавиши "Пробел"); 
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Рис. 8.13. Палитра Paragraph Style Options. Вкладка Justfication 

 

Рис. 8.14. Проблемы, возникающие при недостаточно гибкой настройке выключки 

 изменение межсимвольного расстояния (Letter Spacing) (включая кернинг и 

трекинг); 

 изменение пропорций текстовых символов (Glyph Scaling). 

Сочетание диапазона допустимых значений этих параметров с расстановкой  

переносов позволяет добиться равномерного, оптически выровненного и прият-

ного для чтения текста. 

 Bullets and Numbering (Нумерованные и маркированные списки). 

Оформление фрагмента текста в виде списка — очень популярное действие при 
работе над самыми разными макетами. Очень удобно настраивать параметры 
списка прямо в стиле абзаца (рис. 8.15), чтобы не тратить время на ручное 
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оформление каждого списка в отдельности. Если все же требуется создать спи-
сок без привязки к стилю абзаца (например, во всей публикации имеется всего 
один список), можно воспользоваться командой Bullets & Numbering на Кон-
трольной панели. 

 

Рис. 8.15. Палитра Paragraph Style Options. Вкладка Bullets and Numbering 

В пункте List Туре выбирается тип списка: маркированный или нумерованный. 
В зависимости от этого в окне отобразятся либо пункты настройки внешнего ви-
да цифр, либо настройки маркеров списка. 

Маркером списка может стать любой символ любого доступного шрифта. 

Для добавления новых маркеров нужно нажать на кнопку Add (Добавить) рядом 
с таблицей маркеров и, выбрав шрифт и символ, нажать Add. 

Поле Character After (Символ после маркера) определяет, каким именно обра-
зом маркер будет отделен от основного текста. Обычно это символ табуляции. 

Относительное расположение маркера и основного текста. Здесь Left Indent 
(Отступ слева) — расстояние до основного текста, First Line Indent (Абзацный 
отступ) — величина выдвижения маркера за край текста влево. Значение в по-
следнем поле может быть отрицательным, но не обльше (по модулю), чем левый 
отступ. Если модули этих отступов равны, то поле Tab Position (Величина табу-
ляции) становится неактивным. Если нет, величина табуляции может быть  
указана в диапазоне, образованном вычитанием ширины маркера из абсолютно-
го расстояния между левым краем маркера и левым краем основного текста 
(рис. 8.16). 
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Рис. 8.16. Отступы в маркированном списке 

Для нумерованного списка определяются тип нумерации (арабская, римская, бу-

квенная и т. д.) и взаимное расположение номера и текста, как для маркирован-

ного списка. 

 Character Color (Цвет текста). 

На этой вкладке устанавливается цвет текста для абзацев, оформленных выбра-

анным стилем. Ее настройки очень похожи на уже знакомую вам палитру 

Swatches (Образцы). Здесь можно настроить не только цвет символов, но и на-

значить им обводку и указать ее цвет и толщину (рис. 8.17). 

 

Рис. 8.17. Палитра Paragraph Style Options. Вкладка Character Color 

Мы не рассматривали здесь некоторые вкладки — например, разделение текста 

внутри абзаца на колонки или настройку линий подчеркивания текста, но это на-
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стройки настолько специфические и редко используемые, что к моменту обраще-

ния к ним вы уже сможете разобраться в их действии самостоятельно. 

Полностью настроив стиль абзаца, нажимаем OK и переходим к рассмотрению 

стилей символа. 

Создание и применение стиля символа 

Стиль символа отличается от стиля абзаца тем, что применяется к отдельным сим-

волам или их последовательностям, не претендуя на управление целым абзацем. 

Для того чтобы обеспечить такое ограниченное его действие, он настраивается и 

хранится в отдельной палитре Character Styles (Стили символа). Точно так же, как 

и в палитре Paragraph Styles (Стили абзаца), настройки вызываются кнопкой соз-

дания нового стиля или двойным щелчком на существующем. Эта палитра отчасти 

повторяет настройки, имеющиеся в палитре Paragraph Styles (Стили абзаца), — те, 

которые связаны с форматированием символа (рис. 8.18). 

 

Рис. 8.18. Палитра Character Style Options. Вкладка Basic Character Formats 

Пользуясь вкладкой Basic Character Formats (Основные настройки символа), соз-

дайте символьный стиль main_text: 

 Font Family = Minion Pro; 

 Font Style = Regular; 

 Size = 10 pt; 

 Leading = 12 pt; 

 Kerning = Optical; 

 Tracking = 0. 
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Вложенные стили и буквицы 

Буквица (инициал) — очень интересное, красивое и распространенное средство 

оформления начала текста (например, главы), идущее еще от традиций рукописной 

книги, когда первая страница текста украшалась крупной узорчатой буквой, часто 

содержавшей в себе иллюстрацию и привлекавшей внимание ко всему, что за ней 

следовало. 

В Adobe InDesign создание и настройка буквиц производятся на вкладке Drop Caps 

and Nested Styles (Буквицы и вложенные стили) палитры Paragraph Styles (Стили 

абзаца) (рис. 8.19). 
 

 

Рис. 8.19. Вкладка Drop Caps and Nested Styles палитры Paragraph Styles 

 

В принципе, буквица может быть атрибутом отдельно взятого абзаца, и тогда ее 

надо настраивать в Контрольной панели, но разумнее создать стиль "Первый абзац 

главы" и применить его ко всем абзацам такого типа. 

Как мы уже знаем, буквица характеризуется двумя параметрами: высотой в строках 

и количеством символов, которые будут включены в буквицу. Саму буквицу можно 

оформить с помощью стиля символа (в этом случае стиль "Буквица" нужно предва-

рительно создать в палитре Character Styles (Стили символа) — например, выбрать 
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для инициала какой-то акцидентный шрифт, задать нестандартное начертание 

и т. д.). 

В полях размера буквицы задается высота буквицы в строках и количество симво-

лов, считающееся буквицей. 

 

 

  

Ширину инициала лучше задавать равной 1, чтобы буквица была одна, а при желании как-то дополни-
тельно оформить первое слово надо воспользоваться вложенным стилем (Nested Style). 
 

 

В области Nested Style (Вложенный стиль) определяется стиль символа, которым 

предполагается оформить первые несколько букв или слов текста, как бы переход-

ных между буквицей и остальным набором. Естественно, стиль этот тоже надо за-

ранее подготовить в палитре Character Styles (Стили абзаца). 

Настройка вложенного стиля происходит следующим образом: 

1. В выпадающем списке стилей выбирается тот, который создан именно для этой 

цели. 

2. Определяется способ применения стиля — Up To (Применять до...) или Through 

(Применить к...) и область его применения — количество символов, слов или 

других элементов набора (рис. 8.20). 

 

Рис. 8.20. Выбор области применения вложенного стиля 

Область Nested Line Styles (Вложенные стили строки) позволяет задать вложенный 

стиль для одной или нескольких строк. Настройки здесь аналогичны области 

Nested Style (Вложенный стиль) и отличаются только областью применения: тут 

может быть указано только количество строк. 

Создадим стиль "Первый абзац" для нашего рабочего текста. 

1. В палитре Character Styles (Стили символа) создайте стиль Initial на основе 

стиля main_text, заменив в нем гарнитуру Minion Pro на Impact. 
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2. Там же создайте стиль First_word на основе стиля main_text, задав в поле Case 

(Регистр) значение Small Caps (малые прописные, так называемая капитель: 

символы имеют размер строчных букв, а форму прописных; часто используется 

для оформления первых слов набора в качестве "вводки" в текст). 

3. В палитре Paragraph Styles (Стили абзаца) создайте стиль First_paragraph, ос-

нованный на стиле main. 

4. Откройте вкладку Drop Caps and Nested Styles (Буквицы и вложенные стили). 

5. Задайте параметры буквицы: 

 Lines = 3; 

 Characters = 1; 

 Character Styles = Initial. 

6. Задайте параметры вложенного стиля: 

 Character Styles = First_word, примеименять в режиме Through, 2, Words. 

Наш вложенный стиль будет присвоен первым двум словам абзаца. 

7. Примените стиль First_paragraph к первому абзацу нашего текста (рис. 8.21). 
 

 

Рис. 8.21. Пример применения стиля с буквицей и вложенным стилем 

Редактирование стилей 

Для вызова редактирования стиля достаточно сделать двойной щелчок по его стро-

ке в палитре Paragraph Styles (Стили абзаца) или Character Styles (Стили симво-

ла), и появится уже знакомое нам окно настроек стиля. Редактировать стиль можно 

в любой момент, и все изменения сразу же применятся ко всем фрагментам текста, 

отформатированным с помощью этого стиля. 
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Загрузка стилей из другого документа 

Загрузить набор стилей из другого документа можно командой Load Character / 

Paragraph Styles (Загрузить стиль символа / абзаца) контекстного меню, соответст-
венно, палитры Character Styles (Стили символа) или Paragraph Styles (Стили аб-
заца). Обе эти палитры также содержат в контекстном меню строку Load All Text 

Styles (Загрузить все стили), позволяющую загрузить стили абзаца и символа за 
одно действие. Эта команда особенно полезна при работе с большими проектами 
(книгами, состоящими из нескольких отдельных документов: она позволяет сфор-
мировать набор стилей один раз и потом только подгружать в новые документы). 

После того как вы выберете файл с нужными стилями в стандартном окне управле-
ния файлами, откроется диалоговое окно, позволяющее выбрать те стили, которые 
нужны для использования в рабочем документе (рис. 8.22). 

 

Рис. 8.22. Выбор стилей в диалоговом окне загрузки стиля 

Для выделенного в списке стиля в нижнем поле окна появится описание всех его 
настроек. Останется только отметить нужные стили и нажать OK. Стили добавятся 
в соответствующие палитры. 

Проект "Обыкновенное чудо" 

Применение стилей текста и абзаца облегчает работу всегда, но особенно их по-
мощь заметна при верстке сложных текстов — пьес, справочников, учебников 
и т. д. 

Рассмотрим применение стилей абзаца и символа на примере верстки пьесы. 

Как обычно, начать работу надо с создания документа и определения шаблонов. 

1. Создайте документ: 

 Print; 

 Size = A5; 



192 Глава 8 

 Number of Pages = 10; 

 Facing Pages = On; 

 Master Text Frame = On; 

 Number of Columns = 1; 

 Margin-top = 16 mm; 

 Margin-inside = 12 mm; 

 Margin-outside = 20mm; 

 Margin-bottom = 24 mm; 

 Bleed = 5 mm. 

2. Создайте шаблон, содержащий верхние колонтитулы и нумерацию страниц. 

Можно повторить шаблон, предложенный в файле chapter8\project_shwarts\ 

shwarts_sample.indd, или разработать свой собственный. 

3. Прежде чем импортировать текст и начать его верстку, определим необходимые 

стили. В любой пьесе можно выделить, как минимум, следующие стили оформ-

ления текста: 

 заголовок действия; 

 имена действующих лиц; 

 реплики действующих лиц (основной текст); 

 ремарки, описывающие место действия; 

 ремарки, описывающие действия героев в рамках основного текста; 

 стиль символа для ремарок, описывающих действия героев в строке с именем 

(всевозможные "в зал", "к партнеру" и т. д.); этот стиль относится не ко всему 

абзацу, а только к одному или нескольким словам, поэтому настраивается от-

дельно и по настройкам форматирования символа совпадает со стилем абзаца 

для ремарок действия. 

Начнем. 

Как обычно, прежде всего настраивается самый "массовый" стиль — основной 

текст. 

4. С помощью палитры Paragraph Styles > New Paragraph Style (Стили абзаца > 

Новый стиль) создайте стиль main_text. 

 General: 

 в поле Based On (Основан на...) выберите No Paragraph Styles (Нет стиля); 

 в поле Next Style выберите Same Style (Тот же самый); 

 Basic Character Formats: 

 Font Family = Minion Pro; 

 Font Style = Regular; 
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 Font Size = 10 pt; 

 Leading = 12 pt; 

 Advanced Character Formats: Language = Russian; 

 Indents and Spacing (Отступы и отбивки): 

 Justification = Left; 

 Left Indent (Отступ слева) = 5 mm; 

 Align to Grid (привязка к сетке) = All lines. 

 Hiphenate = On. 

Теперь на основе этого стиля можно создавать остальные. 

5. Создайте стиль Characters: 

 General: 

 Based On = Main_text; 

 Next Style = Same Style; 

 Basic Character Formats: 

 Font Family = Minion Pro; 

 Font Style = Semibold; 

 Font Size = 10 pt; 

 Leading = 12 pt; 

 Advanced Character Formats: Language = Russian; 

 Indents and Spacing: 

 Justification = Left; 

 Space before (Отбивка перед абзацем) = 1 mm; 

 Align to Grid = All lines; 

 Hiphenate = On. 

6. Создайте стиль Main_remarks: 

 General: 

 Based On = Main_text; 

 Next Style = Same Style; 

 Basic Character Formats: 

 Font Family = Minion Pro; 

 Font Style = Regular; 

 Font Size = 8 pt; 

 Leading = 12 pt; 

 Advanced Character Formats: Language = Russian; 
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 Indents and Spacing: 

 Justification = Centre; 

 Align to Grid = First Line Only; 

 Hiphenate = On. 

7. Создайте стиль Action_remarks: 

 General: 

 Based On = Main_text; 

 Next Style = Same Style; 

 Basic Character Formats: 

 Font Family = Minion Pro; 

 Font Style = Italic; 

 Font Size = 9 pt; 

 Leading = 12 pt; 

 Advanced Character Formats: Language = Russian; 

 Indents and Spacing: 

 Justification = Left; 

 Left Indent = 5 mm; 

 Align to Grid = All lines; 

 Hiphenate = On. 

8. Создайте стиль Tytle: 

 General: 

 Based On = Main_text; 

 Next Style = Same Style; 

 Basic Character Formats: 

 Font Family = Minion Pro; 

 Font Style = Semibold; 

 Font Size = 14 pt; 

 Leading = 12 pt; 

 Advanced Character Formats: Language = Russian; 

 Indents and Spacing: 

 Justification = Centre; 

 Space After (отбивка после абзаца) = 10 mm; 

 Align to Grid = None; 

 Hiphenate = On. 
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9. Создайте стиль символа Action_rems: 

 Basic Character Formats: 

 Font Family = Minion Pro; 

 Font Style = Semibold; 

 Font Size = 14 pt; 

 Leading = 12 pt; 

 Advanced Character Formats: Language = Russian. 

10. Импортируйте файл Chapter8\project_shwarts\shwarts.doc с установкой Remove 

Styles and Formatting for Type and Tables (Удалить исходное форматирова-

ние) и щелчком в текстовой полосе при нажатой клавише <Shift> выполните 

автоматическое распределение текста по страницам. 

11. Инструментом Type (Текст) выделите весь текст (<Ctrl>+<A>) и примените 

к нему стиль Main_text. 

12. Примените стиль Tytle к заголовку и стиль Main_remarks к ремарке места дей-

ствия. 

13. Продвигаясь по документу, применяйте стили Characters, Action_remarks и 

Action_rems к соответствующим частям текста. 

14. Добавьте недостающие или уберите ненужные страницы в конце документа. 
 

 

Итоги 

Как мы выяснили, стили для текста подобны мастер-шаблонам для страниц. Они 

точно так же позволяют переформатировать все фрагменты текста, оформленные 

выбранным стилем, всего лишь изменив его настройки; точно так же имеют свою 

иерархию, позволяющую изменять целую серию стилей, внеся правки только в са-

мый первый их уровень; точно так же заметно ускоряют работу и улучшают внеш-

ний вид публикации, поскольку позволяют не обращаться непрерывно к палитрам 

форматирования текста и не держать постоянно в голове все значения параметров 

для всех принятых в публикации способов оформления текстовых фрагментов. 

Следует помнить, что для программы значимость стиля возрастает по мере умень-

шения области его применения. То есть стиль символа имеет приоритет над стилем 

абзаца, а ручное форматирование отдельного слова или буквы — над стилем сим-

вола. Поэтому самые общие настройки всегда задаются в стиле абзаца, частные из-

менения вида отдельных слов определяются стилем символа, а ручная тонкая на-

стройка отдельных букв для выбранного фрагмента заменит собой все стили. 

Для дополнительной практики неплохо попробовать создать макет публикации, 

содержащей несколько стилей — например, руководство пользователя любым 

серьезным прибором в вашем доме. 
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1. Создайте файл с количеством страниц, кратным 4 (это минимальное количество 

страниц для печати на листе с двух сторон). При желании распечатать готовый 

макет на домашнем принтере выберите формат издания А5. 

2. Создайте шаблон, включающий в себя колонтитул с названием, "плавающий" 

колонтитул с названием раздела и номер страницы (можно продумать дополни-

тельные оформительские элементы — линеечки, цветные или серые плашки для 

номеров страниц и т. д.). 

3. Создайте стили для основного текста, главного заголовка, заголовков разделов и 

отдельных пунктов руководства. 

4. Разместите текст в публикации и примените к нему стили. 

Удачи! 

 



  

 

Глава 9 
 

 

РАБОТА С ГРАФИКОЙ 

 

 

 

 
 
Вы этой главе вы узнаете: 

 какая бывает графика, для чего подходят разные ее виды; 

 как вставлять (импортировать) картинки в документ; 

 как поддерживать связь между картинками в документе и их оригиналами на 

диске; 

 как разумно воспользоваться эффектами прозрачности; 

 как спрятать ненужные части картинок, оставив только необходимое. 
 

Какая бывает графика? 

Какую бы публикацию мы ни готовили, будь то газета или листовка, книга или 

буклет, мы всегда имеем дело не только с текстом и оформительскими деталями, но 

и с иллюстрациями, созданными в других программах. Вставка изображений в до-

кумент InDesign называется импортом. Для того чтобы лучше понять, как поведут 
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себя в документе разные иллюстрации, давайте вспомним, какие вообще сущест-

вуют виды компьютерной графики. 

Векторная графика 

Векторные изображения состоят из линий, заданных математическими формулами, 
и параметров их оформления. Любой векторный объект — это контур, который де-
лит всю плоскость на две части: "внутри" и "снаружи". Главная особенность функ-
ций, определяющих векторные объекты, — то, что при одинаковом для всего вы-
ражения изменении коэффициентов (масштабировании) форма контуров не меня-
ется. В результате их края остаются четкими при изменении размера, печати на 
принтере PostScript, сохранении в PDF-файле и т. д. (рис. 9.1). К векторным объек-
там относится в том числе текст. Однако неизменно четкий край делает практиче-
ски невозможными фотографическую точность и многообразие плавных перехо-
дов: они неизбежно будут ступенчатыми. 

 

Рис. 9.1. Векторное изображение в масштабе 1:1 и при сильном увеличении 

Векторные изображения наилучшим образом подходят для иллюстраций, предъяв-
ляющих очень высокие требования к четкости краев объекта и сохранению качест-
ва в любом размере, но сравнительно нетребовательных к разнообразию внутрен-
него наполнения. Прежде всего, это, конечно, логотипы, надписи, узоры и т. д. 

При работе с векторными изображениями редактируются контуры. 

Основное достоинство векторной графики, помимо нечувствительности к измене-
нию размера, — компактность файла. Поскольку объем файла зависит не от линей-
ных размеров изображения, а от количества точек на контурах, даже очень боль-
шой макет (например, плакат во всю стену) будет иметь сравнительно малый  
объем. 

Растровая графика 

Растровая графика — простейший способ цифрового представления изображений. 
Нагляднейшее представление растровой графики — вышивка крестиком: все изо-
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бражение разбивается на прямоугольные кусочки — пикселы (pixel — picture 
element — элемент картинки) (рис. 9.2). Каждый пиксел имеет координаты на плос-
кости (в пределах картинки) и окрашен в свой собственный цвет. Пикселы стано-
вятся хорошо различимыми при большом увеличении — изображение рассыпается 
на квадратики, которые в мелком масштабе глазом не различаются, и изображение 
выглядит гладким. Так как соседние пикселы друг от друга не зависят, цветовые 
переходы между ними могут быть как сколь угодно плавными, так и резкими.  
В результате растровые изображения — самый распространенный способ передачи 
таких изображений, как фотографии или цифровые рисунки, поскольку он позволя-
ет наиболее эффективно передавать тонкие градации цвета и мелкие, на грани зри-
тельного восприятия, детали. 

 

Рис. 9.2. Схема построения растрового изображения 

При работе с растровыми изображениями редактируются пикселы. 

Растровые изображения содержат фиксированное количество пикселов и, следова-
тельно, чувствительны к изменению размера: при увеличении программа вынужде-
на "достраивать" недостающие элементы изображения, а при уменьшении — нахо-
дить подходящую замену удаляемым пикселам. Это приводит либо к образованию 
"ступенчатости" изображения, либо к чрезмерному сглаживанию и потере деталей 
(рис. 9.3). 

Растровое изображение, описывающее пиксел за пикселом, как правило, чрезвы-
чайно объемно. Для того чтобы представить, сколько места на диске займет рас-
тровый файл, нужно перемножить длину и ширину картинки в пикселах и полу-
ченное значение умножить на количество байт информации, отведенное для каждо-

го пиксела. Например, изображение размером 1 1 дюйм с разрешением 72 ppi 

(пикселов на дюйм) содержит 5184 пикселов (72 пиксела в ширину  72 пиксела в 

высоту = 5184). Изображение того же размера (1 1 дюйм) с разрешением 300 ppi 
будет содержать уже 90 000 пикселов. 

Разрешение растрового файла для импорта подбирается исходя из его будущего 
применения. 

В полиграфии используются изображения от 150 до 300 и более ppi в зависимости 
от разрешения печатной машины (dpi) и линиатуры растра (lpi). 
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Рис. 9.3. Растровое изображение в масштабе 1:1 и при большом увеличении 

При настольной печати, как правило, используются изображения от 72 ppi (для 
фотографий, которые выводятся на принтер с разрешением 300 ppi) до 150 ppi (для 
фотографий, которые выводятся на устройства с разрешением до 1000 ppi). 

Для публикации в Интернете обычно требуются изображения, которые должны 
умещаться на экране монитора. Поэтому здесь используются, как правило, рисунки 
не шире 500 пикселов и не выше 400 пикселов, чтобы на экране оставалось доста-
точно места для элементов управления окна браузера или для различных элементов 
макета — подписей, статей и т. д. Изображения с экранным разрешением 96 ppi 
выглядят в программе верстки примерно так же, как они будут выглядеть при про-
смотре через обычный веб-браузер. 

Импорт графических файлов 

Основной способ вставки (импорта) графических объектов в InDesign — команда 
Поместить: File > Place (Файл > Поместить) (<Ctrl>+<D>). 

Многие изображения можно импортировать в InDesign обычным методом копиро-
вания и вставки. Однако при выполнении вставки графический объект "включает-
ся" в документ: связь с исходным графическим файлом нарушается, изображение 
становится неотъемлемой частью документа. Поэтому обновление графического 
объекта из исходного файла становится невозможным, приходится редактировать 
оригинал и импортировать его снова. Для некоторых форматов (напрмер, при 
вставке графических объектов из программы Illustrator) сохраняется возможность 
редактирования их контуров в InDesign. 

Набор параметров, доступных при импорте графического файла, зависит от его ти-
па. Параметры отображаются в том случае, если в диалоговом окне Place (Помес-
тить) выбран параметр Show Import Options (Показать параметры импорта). 
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Имена помещенных (импортированных) графических объектов содержатся в па-
литре Links (Связи). 

 

 

  

Если копирование перетаскиванием или помещение графических объектов производилось со съемного 
носителя (например, компакт-диска), то связь с исходным файлом объекта при удалении этого носителя 
из системы будет нарушена. 
 

 

1. Создайте документ класса Print со следующими установками: 

 Number of Pages = 1; 

 Size = A4; 

 Number of Columns = 1; 

 Margins (All) = 20 mm. 

Подготовка к импорту. 

Для импорта изображения без предварительного создания фрейма нужно убе-
диться, что в документе ничего не выделено; для импорта изображения в суще-
ствующий фрейм — выделить его, для замены существующего изображения — 
выделить графический фрейм. 

2. В меню File > Place (Файл > Поместить) выберите один или несколько графиче-
ских файлов в папке Chapter9 (рис. 9.4). 

 

Рис. 9.4. Окно импорта файлов 
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Для замены выделенного объекта выбирается параметр Replace Selected Item 
(Заменить выделенный элемент). 

В процессе импорта можно добавить подпись на основе метаданных изображе-
ния, установив флажок Create Static Captures (Создать подписи). 

Для настройки импорта конкретного формата файлов включается флажок Show 

Import Options (Показать параметры импорта). 

После нажатия на кнопку Открыть, если только не выбран переход к парамет-
рам импорта, курсор программы примет вид миниатюры выбранного файла (для 
нескольких файлов — стопки миниатюр). 

3. Создайте фрейм для импортированного изображения, перетащив курсор по ра-
бочему полю, или щелкните значком загруженного графического объекта в том 
месте макета, где должен быть размещен его левый верхний угол. В этом случае 
изображение сохранит свой оригинальный размер. 

4. Последовательными щелчками мышью поместите в макет все выбранные кар-
тинки. 

Если существующий графический объект случайно заменен при помещении, доста-
точно нажать <Ctrl>+<Z>, чтобы восстановить во фрейме исходное изображение и 
снова отобразить значок импорта графического объекта. 

Параметры импорта графических объектов, вызываемые установкой флажка Show 

Import Options (Показать параметры импорта), различны для разных типов импор-
тируемых изображений. 

 Файлы TIFF (.tif). 

TIFF — гибкий растровый формат, поддерживаемый практически всеми прило-

жениями для рисования, обработки изображений и верстки. 

Формат TIFF поддерживает цветовые режимы CMYK, RGB, градации серого, 

Lab, индексированные цвета и альфа-каналы (прозрачность). При импорте воз-
можны настройки цветового профиля, обтравочного контура (Clipping Path) и 

прозрачности. 

 Файлы JPEG (.jpg). 

В формате JPEG обычно сохраняются фотографии и другие изображения для 
Интернета и прочих электронных публикаций. Формат JPEG поддерживает цве-

товые режимы CMYK, RGB и градации серого. При импорте возможны на-
стройки цветового профиля и обтравочного контура (Clipping Path). 

JPEG хорошо подходит для фотографий, однако используемый в нем алгоритм 

сжатия приводит к ухудшению изображения, особенно в обширных однотонных 
областях. Этот формат можно использовать как в электронных документах, так 

и в печатных (последнее — с осторожностью; лучше перед подготовкой к печа-
ти проконсультироваться с типографией). 

 Файлы GIF (.gif). 

Формат GIF предназначен прежде всего для Интернета. В InDesign его имеет 
смысл использовать только при подготовке электронных публикаций. Он хоро-



Работа с графикой 203 

шо подходит для изображений, содержащих небольшое число сплошных цве-
тов — например, логотипов, диаграмм и т. п., но не рассчитан на изображения, 
содержащие более 256 цветов, и потому не слишком эффективен при работе с 
фотографиями. 

 Файлы PNG (.png). 

Формат PNG (Portable Network Graphics) позволяет компактно сохранять растро-
вую графику без потери качества, сохраняет 24-битные фотографии или изобра-
жения со сплошными цветами; поддерживает прозрачность. Отлично подходит 
для электронных документов. 

 Encapsulated PostScript (.eps). 

Формат Encapsulated PostScript (EPS) предназначен для передачи изображений 
между разными приложениями и поддерживается большинством программ под-
готовки иллюстраций и верстки. Обычно EPS-файл содержит одну иллюстра-
цию или таблицу для размещения в макете, но может содержать и целую стра-
ницу. Файлы этого формата записываются на языке PostScript (языке управления 
типографскими печатными устройствами); файлы в формате EPS могут содер-
жать текст, векторные и растровые изображения. 

EPS очень удобен для предпечатной подготовки, не слишком хорош для web-
публикаций на HTML-страницах и вполне подходит для web-публикаций в фор-
мате PDF. 

Особенности импорта файлов, созданных 
в программах Adobe Photoshop и Adobe Illustrator 

Способ импорта графических объектов, созданных в Adobe Illustrator, зависит от 
того, какой объем редактирования будет к ним применяться после импорта. 

Обычный импорт (File > Place) помещает в макет изображение низкого разрешения 
(preview), недоступное для редактирования. Все изменения производятся в ориги-
нальном файле и отображаются в макете после обновления связи. 

1. Импортируйте файл Chapter9\Pumpkin.ai. 

Импорт графических объектов Illustrator, содержащих несколько монтажных об-
ластей, отличается возможностью указать, какую монтажную область следует 
импортировать. 

2. Откройте в программе Adobe Illustrator файл Chapter9\beer.ai. 

3. Для редактирования контуров и объектов в InDesign скопируйте меньшую из 
двух кружек и вставьте ее в документ InDesign. После вставки графического 
объекта в InDesign его цвет, контур и прозрачность могут быть изменены с по-
мощью предназначенных для этих целей инструментов InDesign. 

 

 

  

При копировании слишком сложных (многодетальных) объектов InDesign преобразует массив во встро-
енный EPS-файл, который недоступен для редактирования и может создать проблемы при печати (по-
пробуйте скопировать из Illustrator в InDesign большую из кружек — появится сообщение о невозможно-
сти загрузки такого сложного объекта и о создании встроенного EPS-файла). Такие иллюстрации лучше 
сохранять в обычный векторный EPS и редактировать как оригинал в Adobe Illustrator. 
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При вставке изображения из Illustrator графический объект отображается в 

InDesign в виде сгруппированного набора объектов. 

4. Выделите инструментом Direct Selection (Частичное выделение) любой контур в 

изображении меньшей из двух кружек и попробуйте внести изменения. Вы об-

наружите, что каждый конур вполне доступен для редактирования, как и в "род-
ной" программе (рис. 9.5). 

 

Рис. 9.5. Векторная иллюстрация в Illustrator и та же иллюстрация, вставленная в InDesign 

При вставке или перетаскивании иллюстрации из Illustrator в InDesign могут воз-

никнуть проблемы: 

 цвет: из-за несовпадения наборов поддерживаемых цветовых моделей при ко-
пировании из программы в программу возможно искажение цветов. Чтобы этого 

избежать, нужно настроить все участвующие в проекте программы на единую 
модель и профиль цвета; 

 градиенты: линейные и радиальные градиенты, созданные в Illustrator, обычно 

можно изменить в InDesign при помощи инструмента или палитры Градиент. 
Градиенты, содержащие несколько плашечных цветов или сложных узоров, мо-

гут оказаться в InDesign недоступными для редактирования. В некоторых случа-
ях градиентные заливки скопированных изображений могут искажаться при 

масштабировании или переводиться в растровый вид в процессе копирования.  
В целом, иллюстрации с градиентными заливками лучше импортировать обыч-

ным образом; 

 прозрачность: при вставке или перетаскивании иллюстрации Illustrator в 

InDesign просходит сведение прозрачности, т. е. преобразование области, со-
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держащей прозрачность, в набор непрозрачных векторных или растровых объ-

ектов); 

 стили графики: при вставке или перетаскивании графические стили Illustrator не 

превращаются в стили объектов InDesign; 

 узоры: объекты Illustrator, залитые или заштрихованные узорами, при вставке 

или перетаскивании в InDesign становятся встроенными изображениями EPS. 

Текст перед копированием иллюстрации в InDesign нужно переводить в контуры:  

в документе InDesign он для редактирования все равно недоступен, но информация 

о шрифте запоминается. После переноса на другой компьютер (в типографию)  

в случае несовпадения шрифтов при печати возникнет серьезная и трудноразреши-

мая проблема. 

Параметры импорта Acrobat (PDF) 

При импорте PDF и выборе в диалоговом окне Place (Поместить) параметра Show 

Import Options (Показать параметры импорта) появится новое диалоговое окно, 

содержащее следующие параметры: 

 Preview (Предварительный просмотр): если импортируется страница много-

страничного PDF-файла, здесь указывается номер страницы цифрами или при 

помощи кнопок со стрелками; 

 Pages (Страницы): выбор диапазона импортируемых страниц — область про-

смотра, заданный диапазон или все страницы; 

 Crop To (Кадрирование) определяет границы размещаемого изображения в за-

висимости от настроек оригинального документа и целей размещения файла 

в публикации; 

 прозрачный фон выбирается, чтобы в макете InDesign был виден текст или гра-

фический объект, находящийся под размещенной PDF-страницей, и отменяется 

для создания на основе PDF-страницы объекта с непрозрачным белым фоном. 

Если фрейм, содержащий графический объект PDF, имеет прозрачный фон, то 

его можно позже сделать непрозрачным, произведя заливку фрейма. 

Импорт файлов Adobe Photoshop (PSD) 

При импорте PSD файлов в InDesign настраиваются: 

 слои и композиции слоев: InDesign позволяет настроить видимость слоев и про-

сматривать композиции слоев. Изменение видимости слоя или композиции сло-

ев в InDesign не приводит к изменению исходного файла Photoshop; 

 контуры, маски и альфа-каналы: если в файле Photoshop сохранены контуры, 

маски и альфа-каналы, InDesign может пользоваться ими для удаления фона или 

для огибания графических объектов текстом. 

При импорте PSD-файлов Photoshop доступно управление видимостью слоев. На-
стройка видимости слоя в InDesign позволяет управлять отображением иллюстра-
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ции в зависимости от контекста. Например, для публикации на нескольких языках 
можно создать единственную иллюстрацию, включающую по одному текстовому 
слою для каждого из языков. 

Настроить видимость можно как при импорте файла, так и с помощью диалогового 
окна Object Layer Options (Параметры слоев объекта), вызываемого из контекст-
ного меню графического объекта (рис. 9.6). 

 

Рис. 9.6. Окно Object Layer Options 

Видимость слоя включается/выключается щелчком по пиктограмме Глаз. 

Импортируйте файл water.psd. Настройте видимость слоев с помощью окна Object 
Layer Options (Параметры слоев объекта). 

Работа с изображением в окне документа 

Кроме обычного импорта через меню File поместить графический объект в доку-
мент можно простым перетаскиванием его из программы Adobe Bridge или из лю-
бого другого файл-менеджера. При этом происходит обычный импорт файла с до-
бавлением изображений в палитре Links (Связи). 

 

 

  

Параметры импорта для файлов, копируемых в документ методом перетаскивания, задать нельзя. 
 

 

Запустите Adobe Bridge, откройте папку Chapter9. Найдите файл hen_legs.jpg и пе-
ретащите его в документ. После перетаскивания файла он появится в палитре Links 
(Связи). 
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При необходимости изменить размер изображения в макете можно воспользоваться 

несколькими способами: 

 в Контрольной панели задать новые размеры в точных единицах измерения или 

в процентах; 

 трансформировать изображение с помощью Bounding Box (Габаритного кон-

тейнера) при нажатой клавише <Ctrl>; 

 трансформировать изображение с помощью Bounding Box (Габаритного кон-

тейнера) при включенной опции Auto Fit (Автоматическая подгонка) на Кон-

трольной панели. 
 

Параметры отображения 

Обычно растровые изображения показываются в InDesign в низком разрешении 

(Fast Preview (Быстрое отображение) или Typical Preview (Стандартное качество 

отображения)) для снижения нагрузки на систему. При необходимости можно за-

дать просмотр в высоком разрешении: View > Display Performance > High Quality 

Performance (Просмотр > Режим отображения > Высокое качество отображения). 

Этот режим обеспечивает наивысшее качество отображения, но заметно снижает 

производительность работы. 

 

 

  

Параметры отображения изображения не влияют на выходное разрешение при печати или экспорте 
документа. При выводе на печатающее устройство с поддержкой PostScript, экспорте в XHTML, EPS или 
PDF выходное разрешение будет зависеть от параметров вывода, установленных в окнах печати или 
экспорта. 
 

 

Связанные и встроенные изображения 

При импорте графического объекта в документе создается ссылка на файл, а в ма-

кет помещается изображение низкого разрешения для предварительного просмот-

ра. Файл, размещенный таким образом, называется связанным (Linked). Файл, пол-

ностью включенный в документ, назывется встроенным (Embedded). 

Связанный графический объект хранится отдельно от документа, не увеличивая его 

размер. Он редактируется в программе, где был создан, после чего связь обновляет-

ся. При многократном использовании изображения в документе все связи можно 

обновить за один раз. При экспорте или печати исходное изображение извлекается 

из графического файла и создается конечный выходной файл с полным разрешени-

ем оригинала. 

Опасность использования связанных файлов состоит в возможности потерять изо-

бражение, хранящееся на диске отдельно от документа. Тем не менее очевидные 

преимущества (легкость редактирования и обновления, компактность файла доку-

мента, более высокая скорость обработки макета) делают этот способ работы с изо-

бражением очень популярным. 
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Встроенный графический объект копируется в документ в полном разрешении, 

приводя к увеличению его размеров. Обновление версии происходит только через 

команду Relink (Импортировать заново). 

Встроенный объект потерять невозможно, он становится частью документа, но при 

этом файл документа заметно увеличивается, и работа над ним замедляется. 

 

 

  

При перемещении документа в другую папку или на другой диск (например, при передаче в типографию) 
обязательно перенесите туда же связанные графические файлы. Копирование всех связанных файлов 
можно выполнять автоматически при помощи функций упаковки и предпечатной проверки. 
 

 

Палитра Links (Связи) 

Все импортированные файлы отображаются в палитре Links (Связи) (рис. 9.7). 

Если один графический объект появляется в документе несколько раз, связи груп-

пируются под треугольником раскрытия в палитре Links (Связи), и в информаци-

онной части строки отображается их количество. Щелчок на этом треугольнике 

служит для разворачивания списка одинаковых связей. 

Связанный файл может отображаться в палитре Links (Связи) следующим об- 

разом: 

 обновлен — никаких дополнительных меток нет; 

 изменен — традицонный предупреждающий треугольник сообщает, что ориги-

нальный файл отредактирован в своей исходной программе и сохранен в новой 

версии. Реакция на эту метку — выбор команды Update Link (Обновить связь) 

в контекстном меню палитры; 

 отсутствует — программа не может найти файл. Он может быть потерян или 

перемещен. Печать и экспорт документа с полным разрешением в этом случае 

невозможны. Необходимо либо вернуть перемещенный файл на прежнее место, 

либо с помощью команды Relink (Импортировать заново) указать новый путь 

к файлу; 

 встроен — втроенный объект не требует обработки связи. Его представление 

в палитре исключительно информационное. 

Палитра Links (Связи) вызывается из меню Window >Links (Окно > Связи). 

Для просмотра связанного графического объекта выберите строку в палитре Links 

(Связи) и нажмите кнопку Go to Link (Перейти к связанному элементу). Изображе-

ние помещается в центре экрана. 

Для сортировки связей в палитре нажмите название категории, по которой надо 

отсортировать связи, в верхней части палитры Links (Связи). 

В разделе Link Info (Информация о связи) отображается информация о выбранном 

связанном файле. 
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Рис. 9.7. Палитра Links 

Количество столбцов в палитре Links (Связи) и параметров связанного файла в 
разделе Link Info регулируется в диалоговом окне Panel Options (Параметры па-
литры) (рис. 9.8). 

Если связанный или встроенный файл содержит метаданные, их можно просмот-
реть в палитре Links (Связи). Редактирование или замещение метаданных, относя-
щихся к связанному файлу, невозможно. 

Встраивание связанного файла: 

1. Выделите файл Water.psd в палитре Links (Связи). 

2. Выберите в контекстном меню палитры команду Embed Link (Встроить ссылку). 

Файл остается в палитре Links (Связи) и помечается значком встроенной связи. 
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Рис. 9.8. Окно Panel Options 

Обтравочные контуры 

Обтравочный контур — это замкнутый контур, определяющий в изображении 
границы абсолютно непрозрачной области. Часть изображения, находящаяся внут-
ри обтравочного контура, будет 100% непрозрачной, а все, что находится снаружи, 
будет воспринято программой как полностью прозрачная область. 

Одна из самых популярных программ для создания обтравочного контура — Adobe 
Photoshop. Для сохранения созданного в нем контура с последующей вставкой 
в программу верстки чаще всего используются форматы TIFF и EPS. 

Алгоритм создания обтравочного контура  
в Adobe Photoshop 

Adobe Photoshop располагает всеми необходимыми средствами для работы с век-
торными контурами. Сам контур строится с использованием инструмента Pen, 
принцип работы которого точно такой же, как и в других программах Adobe. 

1. Откройте в Adobe Photoshop файл Chapter9\canon_camera.tif. 

2. Проверьте, чтобы инструмент Pen (Перо) был в режиме Path (Контуры) 
(рис. 9.9). 

 

Рис. 9.9. Переключение в режим работы Path, использующийся для создания контуров  
(в том числе обтравочных) 
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3. Инструментом Pen постройте контур вокруг объекта, который должен остаться 

непрозрачным. Используйте клавишу <Ctrl> для временного переключения во 

время работы с инструмента Pen на инструмент Direct Selection (Белая стрелка). 

Этот инструмент во всех программах Adobe используется для настройки вектор-

ных контуров. Используйте клавишу <Alt> для изменения типа опорной точки. 

 

Рис. 9.10. Создание контура инструментом Pen 

4. В палитре Path (Контуры) двойным щелчком по пункту Work Path (Рабочий 

контур) переименуйте его, задав значимое имя или согласившись с предложен-

ным программой Path1. Дело в том, что Work Path — временный контур, кото-

рый нельзя назначить обтравочным. Присвоение ему собственного имени авто-

матически сохраняет его как самостоятельный элемент изображения (рис. 9.11). 

Контур, созданный в Photoshop, не становится обтравочным автоматически. Ес-

ли просто сохранить файл с контуром, его придется специально настраивать по-

сле импорта. Гораздо разумнее сразу назначить его обтравочным прямо в 

Photoshop (рис. 9.12). Это делается командой Clipping Path (Обтравочный кон-

тур) контекстного меню палитры Path (Контуры). 

5. Укажите в открывшемся диалоговом окне значение параметра Flatness, отве-

чающего за гладкость воспроизведения контуров при печати (рис. 9.13). Этот 

параметр определяется размерами минимального печатного элемента (device 

pixel). Для полиграфической печати достаточно установить его равным 1. 

6. Сохраните файл с помощью команды File > Save as (Файл > Сохранить как) 

в формате TIFF. 

7. После того как файл сохранен, импортируйте его в InDesign, используя команду 

File > Place (Файл > Импорт). Если весь алгоритм был выполнен правильно, то  
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Рис. 9.11. Сохранение  
и переименование  

Work Path 

Рис. 9.12. Команда Clipping Path из контекстного меню  
палитры Path, использующаяся для назначения контура 

обтравочным 

 

Рис. 9.13. Диалоговое окно настройки параметра Flatness 

 

Рис. 9.14. Изображение фотоаппарата в обтравочном контуре 
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должно быть видно только то, что находится внутри обтравочного контура 

(рис. 9.14). 

Этот способ создания контура наиболее популярен, поскольку после импорта об-

травка (маскирование) объекта происходит автоматически. При необходимости 
контур можно отредактировать прямо в InDesign (для этого достаточно выделить 

его инструментом Direct Selection (Белая стрелка). 

Алгоритм создания обтравочного контура в InDesign 

Если подготовить контур в Photoshop по какой-то причине нет возможности, его 

можно создать прямо в InDesign. Для создания контура здесь также можно исполь-
зовать инструмент Pen (Перо). Технология работы с ним точно такая же, как в 

Photoshop. Удобнее всего вызвать палитру Layers (Слои) (<F7>) и расположить 
изображение и вновь создаваемый контур на разных слоях, временно заблокировав 

слой с изображением. Это удобно тем, что вы не сможете случайно сдвинуть изо-
бражение, вокруг которого строите контур (рис. 9.15). 

1. Импортируйте в документ файл Teapot.tif. 

2. Заблокируйте слой с фотографией. 

3. Создайте новый слой выше и на нем инструментом Pen (Перо) нарисуйте кон-
тур. 

 

Рис. 9.15. Создание контура в InDesign с использованием палитры Layers 

4. Разблокируйте слой с фотографией, вырежьте изображение (<Ctrl>+<X>). 

5. Выделите контур. Вызовите команду меню Edit > Paste Into (Редактирование > 
Вставить на то же место) (рис. 9.16). 
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Рис. 9.16. Изображение в обтравочном контуре 

Автоматическое создание обтравочного контура 

При автоматическом создании контура в InDesign результат будет менее точным, 

но более быстрым. Для этого служит специальная команда меню Object > Clipping 

Path > Detect Edges (Объект > Обтравочный контур > Определить границы). Луч- 
 

 

 

Рис. 9.17. Автоматический контур при разных значениях параметров Treshold и Tolerance  
команды Detect Edges 
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ше всего этот алгоритм действует на изображения с однотонным, желательно свет-

лым, фоном. 

Импортируйте в документ файл Chapter9\Sunflower.jpg. 

Варьируя значения параметров Treshold (Порог) и Tolerance (Допуск), добейтесь 

максимально точного построения обтравочного контура (рис. 9.17). 
 

Проект "Страница путеводителя" 

Путеводители обычно собирают все доступные авторам способы оформления: тут и 

простые импортированные фотографии, и обтравочные контуры, и огибание карти-

нок текстом, и достаточно вольное размещение графики с выходом за обрез... 

Обычно все это сочетается с простым и четким текстовым набором, позволяющим 

читателю максимально легко и удобно воспринимать информацию. 

Попробуем собрать страницу такого путеводителя. Наша задача — создать привле-

кательную, выразительную и информативную страницу, используя имеющиеся 

в наличии фотографии и готовый текст. 

1. Создайте документ: 

 Print; 

 Number of Pages = 1; 

 Size = A4; 

 Number of Columns = 3; 

 Gutter = 5 mm; 

 Margin-Top = 60 mm; 

 Margin-Bottom = 22 mm; 

 Margin-Left = 20 mm; 

 Margin-Right = 20 mm. 

Большой отступ сверху предназначен для крупной общей фотографии и заго-

ловка. 

Поскольку мы собираемся работать с одной страницей, можно работать на ней, 

не обращаясь к шаблону. В случае реальной подготовки путеводителя рассмот-

ренная структура может стать одним из шаблонов, предназначенным для первой 

страницы раздела, посвященного тому или иному городу. 

2. Задайте дополнительную разметку: расположите вертикальные направляющие 

точно по границам текстовой полосы (Margins) и горизонтальную направляю-

щую на расстоянии 10 мм от верхнего края страницы. 

3. Рассмотрим исходные материалы (chapter9\project_city_guide): у нас есть текст, 

одна крупная "обзорная" фотография для создания общего впечатления и не-

сколько снимков поменьше, подходящих для размещения внутри текста. 
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4. Импортируйте (<Ctrl>+<D>) файл top_pict.tif и расположите в верхней части 
страницы так, чтобы наружные края картинки совпали с метками припуска под 
обрез (рис. 9.18). 

 

Рис. 9.18. Расположение фоновой фотографии 

Служить фоновым изображением в полном смысле эта фотография не может, 
поскольку даже в нижней части, где нет ничего, кроме дробного отражения зда-
ний в воде, она содержит довольно много контрастных деталей. Эти детали бу-
дут ухудшать читаемость текста. 

5. Воспользуйтесь инструментом Gradient Feather (Градиентная растушевка). Вы-
берите его в инструментальной панели и проведите сверху вниз от линии берега 
до точки примерно на 1 см выше края фотографии. Произойдет постепенное вы-
светление изображения вплоть до полной прозрачности. 

Теперь в области, ограниченной полями текстовой полосы, можно спокойно 
располагать текст. 

6. Импортируйте текстовый файл Stockholm.doc и разместите его в три колонки. 

7. Создайте стиль main для основного текста: 

 Basic Character Formats: 

 Font Family = Minion Pro; 

 Font Style = Regular; 



Работа с графикой 217 

 Font Size = 11 pt; 

 Leading = 12 pt. 

 Advanced Character Formats: Language = Russian 

 Indents and Spacing: 

 Alignment = Left Justify; 

 Align to Grid = All lines. 

8. Примените этот стиль ко всему тексту. 

9. Создайте стиль little_tytle для внутренних заголовков: 

 General: 

 Based on = main. 

 Basic Character Formats: 

 Font Family = Minion Pro; 

 Font Style = Semibold; 

 Font Size = 11 pt; 

 Leading = 12 pt. 

 Advanced Character Formats: Language = Russian. 

 Indents and Spacing: 

 Alignment = Left; 

 Space Before = 3 mm; 

 Space After = 1 mm; 

 Align to Grid = None. 

10. Примените этот стиль к заголовкам внутри текста. 

11. Создайте текстовый фрейм размером 110 26 мм для главного заголовка и раз-

местите в левом верхнем углу страницы, выровняв по разметке (см. образец 

city_guide_sample.indd). 

12. Наберите в две строки: "Стокгольм: | между морем и небом". 

13. Отформатируйте первую строку: 

 Font Family = Minion Pro; 

 Font Style = Semibold; 

 Font Size = 37 pt; 

 Leading = 50 pt. 

14. Отформатируйте вторую строку: 

 Font Family = Minion Pro; 

 Font Style = Semibold; 
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 Font Size = 24 pt; 

 Leading = 28 pt. 

Текст разложен, теперь надо задать его взаимодействие с графикой. 

15. Импортируйте файл Street.tif и расположите "под обрез" в нижней части первой 

колонки. Задайте режим огибания текстом Jump Object (огибание сверху и 

снизу). Проследите, чтобы нижний край фотографии лег на метку припуска под 

обрез. При необходимости кадрируйте изображение, подтянув вертикальные 

границы габаритного контейнера к границам колонки. 

16. Импортируйте файл rathouse.tif и разместите в верхней части правой колонки  

с вылетом "под обрез" в правый край страницы. Задайте тот же самый режим 

огибания (рис. 9.19). 

 

Рис. 9.19. Расположение фотографий с вылетом "под обрез" 

Добавим странице "изюминку" — изображение характерной для Стокгольма 

современной скульптуры с обтравочным контуром и огибанием по форме. Для 

этого воспользуемся фотографией, в которой уже создан обтравочный контур 

при подготовке ее в Adobe Photoshop. 
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17. Импортируйте файл clipp.tif. Разместите его в нижней части текстовой полосы 

между второй и третьей колонками, задав режим огибания Warp around Object 

Shape (Огибание по форме объекта). Обратите внимание, что обтравочный 

контур, заданный в Photoshop, автоматически распознается и обрабатывается 

при импорте изображения в InDesign. 

18. Если в результате добавления картинок часть текста оказалась вытесненной (не 

поместилась во фреймы), посмотрите, что можно изменить в размещении или 

размерах фотографий. Например, можно кадрировать фотографию ратуши, 

"срезав" перемещением верхней и нижней границ ее габаритного контейнера 

часть воды и неба. Общее впечатление при этом не пострадает, а на полосе по- 

явится дополнительное пространство для текста. 

19. При работе учитывайте основные моменты, связанные с импортом: 

 изображения для печатной публикации готовятся в цветовой модели CMYK; 

 в предварительной верстке при поиске соотношения элементов макета мож-

но пользоваться изображениями любых размеров, но для окончательного 

макета размер картинки надо сделать 1:1 в Photoshop, его алгоритмы обеспе-

чивают пересчет размеров с наименьшими потерями; 

 обтравочные контуры лучше всего создавать и назначать таковыми в 

Photoshop, тогда они автоматически обрабатываются при импорте и не тре-

буют дополнительной настройки; 

 изображение с огибанием "по форме" или "по периметру" должно распола-

гаться между столбцами текста или на краю текстовой полосы, чтобы не 

создавать разрывов строк; 

 наиболее надежные форматы для сохранения изображений для полиграфи-

ческой верстки — EPS и TIFF. 

Итоги 

Практически ни одно современное издание не обходится без импортированной 

графики того или иного типа. Корректное использование таких картинок исключи-

тельно важно, поскольку неправильно подготовленная (в неверной цветовой моде-

ли или неподходящего размера), неправильно импортированная или плохо обтрав-

ленная иллюстрация не только портит внешний вид макета, но и может вызвать 

серьезные проблемы при печати. При этом, если ошибки в тексте может найти и 

исправить корректор издательства, то ошибки при работе с графикой никто, кроме 

вас, найти и исправить не может. Следовательно, здесь требуется особенная внима-

тельность и ответственность. 

Если говорить о графике в интерактивных публикациях, то тут тоже нужна акку-

ратность, ибо неправильная цветовая модель может некорректно отображаться в 

интернет-браузерах, а "не тот" размер способен "взломать" электронную страницу, 

заняв неподобающее ему место на экране при отображении "пиксел в пиксел". 
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Для дополнительной практики попробуйте сформировать листовку на любую тему 

(будь то отчет о последнем отпуске или реклама любимой электробритвы), исполь-

зуя импортированную графику, подготовленную в разных программах. 

1. Создайте файл подходящего формата. 

2. Сделайте разметку в соответствии со своей идеей. 

3. Наберите или импортируйте текст и разместите его на странице. 

4. Добавьте картинки, подготовленные с учетом того, что мы делаем печатную 

публикацию. 

Удачи! 

 



  

 

Глава 10 
 

 

РАБОТА С ТАБЛИЦАМИ 

 

 

 
 
Вы этой главе вы узнаете: 

 как создать таблицу в документе InDesign; 

 как преобразовать в таблицу импортированный текст; 

 как оформить таблицу, чтобы она стала красивой и легко читаемой; 

 как создать и использовать стили для всей таблицы или отдельных ячеек. 

Создание таблиц 

Таблица — это набор строк и столбцов, образующих ячейки. Ячейка напоминает 
текстовый фрейм, в который может быть добавлен текст, внутритекстовый графи-
ческий объект или другие таблицы. 

Создание таблицы обычным способом 

1. Создайте документ со следующими установками: 

 Print; 

 Number of Pages = 1; 
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 Size = A4; 

 Number of Columns = 1; 

 Margins (All) = 20 mm. 

2. Создайте текстовый фрейм. 

3. Поместите курсор инструмента Type (Текст) внутрь фрейма. 

4. Вызовите команду Table > Insert Table (Таблица > Вставить таблицу) 
(рис. 10.1). 

 

Рис. 10.1. Окно создания таблицы 

5. Укажите число строк и столбцов. 

6. Если таблица может растянуться на несколько страниц, задайте количество 
строк для верхних и нижних колонтитулов, отображаемых на каждой странице. 

7. При необходимости задайте стиль таблицы. 

Созданная таблица по ширине заполняет весь текстовый фрейм. 

Высота строки таблицы определяется выбранным стилем таблицы. Если стили 
ячеек содержат стили абзацев, высота строки будет определяться значением интер-
линьяжа в стиле абзаца. Если стили абзацев не используются, высота строки опре-
деляется интерлиньяжем введенного текста. 

Создание таблицы из существующего текста 

1. Импортируйте текстовый файл Chapter10\Table.doc. 

2. Перед преобразованием текста в таблицу подготовьте его: расставьте символы 
начала абзаца и табуляторы для разделения строк и столбцов. Можно использо-
вать и другие символы (запятые, точки с запятой и т. д.), но чаще всего для раз-
деления строк используются знаки абзаца, а для разделения столбцов — табуля-
торы. 

3. Инструментом Type (Текст) выделите текст, который надо преобразовать в таб-
лицу. 

4. Вызовите команду Table > Convert Text to Table (Таблица > Преобразовать 

текст в таблицу) (рис. 10.2). 
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Рис. 10.2. Окно преобразования текста в таблицу 

5. В полях Row Separator (Разделитель строк) и Column Separator (Разделитель 
столбцов) задайте символы разделения (знаки абзаца и табуляторы соответст-
венно) 

Если в строке элементов меньше, чем столбцов в таблице, оставшиеся ячейки оста-
нутся пустыми. 

В некоторых ячейках вместо отображения текста появится красная точка — метка 
переполнения ячейки. О работе с такими ячейками — чуть ниже. 

Встраивание одной таблицы в другую 

Для вставки таблицы в ячейку существующей таблицы достаточно поместить кур-
сор инструмента Type (Текст) в выбранную ячейку и вызвать команду Table > 
Insert Table (Таблица > Вставить таблицу). 

Импорт таблиц из других приложений 

При импорте электронной таблицы Microsoft Excel или документа Microsoft Word  
с таблицами с помощью команды Place (Поместить) данные импортируются в виде 
таблицы, доступной для редактирования. Форматирование таблицы настраивается 
в окне параметров импорта. 

Данные из электронной таблицы Excel или таблицы Word можно и напрямую 
вставлять в документы InDesign или InCopy. 

Для вставки текста из другого приложения в существующую таблицу в ней надо 
создать достаточное для его размещения число строк и столбцов и убедиться, что 
выделена хотя бы одна ячейка (кроме тех случаев, когда в ячейку надо вставить 
всю таблицу). 

Если нужно сохранить форматирование исходной таблицы, лучше произвести ее 
импорт командой Place (Поместить) с установкой Preserve Styles and Formatting 
from Text and Tables (Сохранять стили и форматирование текста и таблиц). 

Можно скопировать и вставить текст, разделенный символами табуляции, в диапа-
зон ячеек таблицы. Этим способом удобно заменять содержимое при необходимо-
сти сохранить форматирование. 

Предположим, надо обновить содержимое отформатированной таблицы в ежеме-
сячном журнале. В этом случае можно скопировать текст с табуляцией в буфер об-
мена, выделить диапазон ячеек в отформатированной таблице InDesign и вставить в 
него содержимое. 
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Добавление текста в таблицу 

1. Поместите курсор инструмента Type (Текст) в ячейку с текстом "Раб. давление, 

BAR" и замените сокращение "Раб." на слово "Рабочее". Набор текста внутри 

таблицы происходит так же, как в любом текстовом фрейме. 

2. Для создания нового абзаца внутри ячейки нажмите клавишу <Enter>. Разнесите 

таким способом по разным строкам параметры и единицы измерения: например 

"Вес" и "кг". 

Копирование текста между ячейками производится обычной парой команд 

<Ctrl>+<C> / <Ctrl>+<V>. Импорт текста или графики происходит в ту ячейку, где 

в этот момент находится курсор. 

При добавлении графического объекта в меньшую по размеру ячейку высота ячей-

ки будет увеличена, а ширина ячейки останется прежней, т. е. часть объекта может 

оказаться за правой границей ячейки. Если строка, в которую помещается графиче-

ский объект, имеет фиксированную высоту, а высота объекта превышает высоту 

строки, это приведет к вытеснению содержимого (переполнению) ячейки. Для ре-

шения проблемы надо поместить изображение за пределы таблицы, изменить его 

размеры, а затем вставить в ячейку таблицы. 
 

Добавление верхних и нижних колонтитулов 

Длинная таблица может растянуться на несколько страниц. Для прослеживания на-

званий колонок на всех заполненных таблицей страницах создаются колонтитулы 

(Header и Footer Elements). Это строки, содержимое которых повторяется на каж-

дой странице (рис. 10.3). 

 

Рис. 10.3. Таблица с колонтитулами 

Верхние и нижние колонтитулы можно добавить и настроить при создании табли-

цы или после, в диалоговом окне Table Options (Параметры таблицы). Можно пре-

образовать в них основные строки таблицы. 
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Преобразование существующих строк  
в верхние и нижние колонтитулы 

1. Для создания верхнего или нижнего колонтитула в рабочей таблице выделите, 

соответственно, верхнюю или нижнюю строку таблицы. 

2. Вызовите команду Table > Convert Rows > To Header / То Footer (Таблица > 

Преобразовать строки > В верхние колонтитулы / В нижние колонтитулы). 

3. Для изменения параметров верхних и нижних колонтитулов поместите курсор  

в таблицу и вызовите команду Table > Table Options > Headers and Footers 

(Таблица > Параметры таблицы > Головные и концевые строки). 

4. Задайте число строк для колонтитулов и режим отображения: информация из 

колонтитулов может отображаться в каждом столбце текста (если в текстовом 

фрейме несколько столбцов), один раз в каждом фрейме или один раз на каждой 

странице. Установите параметр Skip First (Кроме первой), чтобы информация из 

верхнего колонтитула не отображалась в первой строке таблицы, и Skip Last 

(Кроме последней), чтобы информация из нижнего колонтитула не отобража-

лась в последней строке таблицы. 

Для удаления колонтитулов достаточно вызвать Table > Convert Rows > To Body 

(Таблица > Преобразовать строки > В основные). 

Редактирование таблиц 

Для редактирования таблицы или отдельных ее элементов их сначала надо вы- 

делить. 

Текст внутри ячейки выделяется инструментом Type (Текст), как в обычном тек-

стовом фрейме. Если протянуть курсор от текста к краю ячейки, она выделяется 

целиком. Если протянуть курсор через несколько ячеек, они все окажутся выделен-

ными. Если повести курсор к левому краю строки или верхнему краю столбца, поя-

вится крупная черная стрелка, выделяющая строку/столбец целиком. Протянув эту 

стрелку через таблицу насквозь, получим выделение всей таблицы. 

Вставка строк и столбцов 

Для вставки строк и столбцов достаточно выделить нужный столбец/строку и пра-

вой кнопкой мыши вызвать команду контекстного меню таблицы Insert > Row / 

Column (Вставить > Строку / Столбец) (рис. 10.4). 

Новые ячейки будут отформатированы так же, как текст в строке, где находился 

курсор. 

Если курсор поставлен в последнюю ячейку, новую строку можно создать с помо-

щью клавиши <Tab>. 

Для удаления строки или столбца достаточно установить курсор на нижней или 

правой границе таблицы, чтобы появился значок двунаправленной стрелки, нажать  
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Рис. 10.4. Вставка строк в таблицу 

кнопку мыши, а затем, удерживая нажатой клавишу <Alt>, перетащить вверх (для 

удаления строк) или влево (для удаления столбцов). 

 

 

  

Если нажать клавишу <Alt> до нажатия кнопки мыши, появится инструмент Hand (Рука), поэтому кнопку 
мыши нужно нажать первой. 
 

 

Перемещаться по таблице можно с помощью клавиши <Tab> и клавиш-стрелок. 

Кроме того, можно перейти сразу на определенную строку таблицы, что особенно 

удобно при работе с большими таблицами. 

Клавиша <Tab> перемещает курсор в следующую ячейку, комбинация <Shift>+ 

+<Tab>  — в предыдущую. Если нажать клавишу <Tab> в последней ячейке табли-
цы, будет добавлена новая строка. При нажатии клавиш в первой ячейке таблицы 

курсор переместится в последнюю ячейку таблицы. Клавиши-стрелки перемещают 

курсор в соответствии со своим направлением. Если при нажатии клавиши < > 

(вправо) курсор расположен в конце последней ячейки строки, он перемещается  

в первую ячейку той же строки. Аналогично, если при нажатии клавиши < > (вниз) 

точка ввода находится в конце последней ячейки столбца, она перемещается в пер-
вую ячейку того же столбца. 

Переход к определенной строке таблицы производится командой Table > Go to 

Row (Таблица > Перейти к строке). 

Вырезание, копирование  
и вставка содержимого таблицы 

Для выделенного в ячейке текста операции вырезания, копирования и вставки ана-
логичны этим операциям для текста, находящегося вне таблицы. Кроме того, дос-

тупно вырезание, копирование и вставка ячеек и их содержимого. Если курсор на-
ходится в таблице, в которую нужно вставить содержимое, несколько вставленных 

ячеек будут выглядеть как таблица в таблице. Можно также копировать и переме-
щать таблицу целиком. 
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Преобразование таблицы в текст 

Для преобразования таблицы в текст курсор инструмента Type (Текст) устанавли-

вается внутрь таблицы, вызывается команда Table > Convert Table to Text (Табли-

ца > Преобразовать таблицу в текст) и указываюся разделители материала, который 

получится из строк и столбцов. 

Для столбцов и строк рекомендуется использовать разные разделители (например, 

табулятор для столбцов и знак абзаца для строк). 

При преобразовании таблицы в текст строки таблицы удаляются, а между их со-

держимым вставляются указанные разделители. 

Работа с таблицами  
в режиме текстового редактора 

При выборе меню Edit > Edit in Story Editor (Редактирование > Редактировать в 

текстовом редакторе) таблицы и их содержимое отображаются в окне текстового 

редактора. В нем можно работать, в том числе, и с таблицами (рис. 10.5). 

 

Рис. 10.5. Редактирование таблиц в режиме текстового редактора 

Для разворачивания или сворачивания таблицы в режиме текстового редактора 

служит треугольник слева от значка таблицы, расположенного в верхней части  

окна. 

Для определения типа сортировки таблицы — по строкам или столбцам — щелч-

ком правой кнопки мыши по значку таблицы вызывается контекстное меню и вы-

бирается команда Arrange by Rows (Упорядочить по строкам) или Arrange by 

Columns (Упорядочить по столбцам). 
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Для форматирования таблицы нужно вернуться в режим Layout (Макет). В тексто-

вом редакторе невозможно выделять столбцы или строки. 

Форматирование таблиц 

Для форматирования текста в таблице (как и за ее пределами) используется Кон-

трольная панель или палитра Character (Символ). Кроме того, для форматирования 
самой таблицы служат два основных диалоговых окна: Table Options (Параметры 

таблицы) и Cell Options (Параметры ячейки). Они позволяют изменять число строк 
и столбцов, рамку вокруг таблицы и заливку, задавать интервалы до таблицы и по-

сле, изменять верхние и нижние колонтитулы и добавлять другие элементы форма-
тирования. 

Для форматирования структуры таблицы используются палитра Table (Таблица) 

(рис. 10.6) и Контрольная панель или контекстные меню. 

 

Рис. 10.6. Палитра Table 

Для вызова контекстного меню таблицы в рабочей таблице выделите одну или не-

сколько ячеек и щелкните правой кнопкой мыши. 

Изменение размеров столбцов и строк 

Высоту строк и ширину столбцов можно задать параметрически (через диалоговое 
окно) или "на глаз" (перетаскиванием). Диалоговое окно вызывается командой Cell 

Options (Параметры ячеек) контекстного меню таблицы. Размер строк и столбцов 
звдается на вкладке Rows and Columns, где можно определить минимальную (At 

Least) и максимальную (Maximum) высоту строки и назначить единую ширину 
столбца. 

По умолчанию высота строки определяется стандартной высотой текущего шриф-

та. Таким образом, высота строки изменяется при изменении кегля текста во всех 
ячейках строки либо при изменении параметра высоты строки. 

В повседневной практике настройка размеров ячеек происходит вручную, "на глаз". 

1. Поместите курсор мыши на границу столбца, содержащего ячейку с красной 

точкой, таким образом, чтобы появилась двунаправленная стрелка, перетащите 
границу вправо для увеличения ширины столбца. При этом меняется размер 

только выделенного столбца, что приводит к изменению ширины таблицы. Это 
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изменение приходится компенсировать уменьшением ширины другого столбца 

(например, столбца "№") 

2. Для изменения высоты строки действия такие же, но в отношении горизонталь-
ной границы ячейки. 

Для изменения размеров строк или столбцов без изменения ширины таблицы нуж-
но при перетаскивании внутренней границы строки или столбца удерживать кла-
вишу <Shift>. При этом одна строка (столбец) станет больше, а другая меньше. 

Равномерное распределение столбцов и строк 

1. Выделите ячейки в столбцах или строках, для которых нужно задать одинако-
вую ширину или высоту. 

2. Вызовите команду Table > Distribute Rows / Columns Evenly (Таблица > Рас-
пределить столбцы / строки равномерно). 

Объединение ячеек 

Если в строке или столбце есть хотя бы две ячейки, их можно объединить в одну. 

1. С помощью инструмента Type (Текст) выделите последние две ячейки верхней 
строки. 

2. Правой кнопкой мыши вызовите контекстное меню таблицы. Выберите команду 
Merge Cells (Объединить ячейки). 

3. Того же результата можно добиться, нажав на кнопку Merge Cells (Объединить 
ячейки) на Контрольной панели. 

Разъединение ячеек 

Это операция, обратная объединению, и производится она командой  Table  > Split 

Cell Horizontally / Vertically (Таблица > Разделить ячейку по горизонтали / по вер-
тикали). 

Работа с ячейками с вытесненным содержимым 

Чаще всего при добавлении текста или графических объектов ячейка таблицы рас-
ширяется по вертикали. Но если задана фиксированная высота или ширина строки, 
а добавляемый текст или графический объект превосходит размеры ячейки, в ее 
нижнем правом углу появляется красная точка, показывающая вытеснение. 

В следующую ячейку вытесненный текст не переносится. Для решения проблемы 
нужно изменить размер содержимого или расширить ячейку таблицы. 

Изменение отступа до таблицы или после 

1. Поместите курсор в таблицу и выберите команду Table > Table Options > Table 

Setup (Таблица > Параметры таблицы > Настройка таблицы) (рис. 10.7). 
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Рис. 10.7. Диалоговое окно Table Setup 

2. В группе Table Spacing (Интервалы) укажите новые значения Space Before (Ин-
тервал до) и Space After (Интервал после). 

Разбивка таблиц по фреймам 

Если фрейм не вмещает все строки создаваемой таблицы, она называется вытес-
ненной. Для размещения вытесненной части таблицы создается новый фрейм, свя-
занный с исходным. Содержимое таблицы переносится в связанный фрейм по-
строчно; разделить одну и ту же строку по нескольким фреймам нельзя. Строки 
верхнего и нижнего колонтитула повторяются в каждом фрейме. 

Добавление текста перед таблицей 

Таблица привязана к абзацам непосредственно перед ней и после нее. Если она 
вставлена в начало текстового фрейма, поместить курсор перед таблицей можно 
только с помощью клавиш-стрелок. Аналогично, если таблица расположена в кон-
це текстового фрагмента, курсор устанавливается стрелками в позицию после таб-
лицы. В любом другом случае курсор устанавливается в конец предыдущего абзаца 
или в начало следующего за таблицей, и вводится текст. 

Форматирование текста таблицы 

В целом текст в таблице форматируется точно так же, как за ее пределами. 

Изменение выравнивания текста  
в пределах ячейки таблицы 

1. Инструментом Type (Текст) выделите первую строку таблицы. 

2. Вызовите команду Table > Cell Options > Text (Таблица> Параметры ячейки > 
Текст) (рис. 10.8). 
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Рис. 10.8. Диалоговое окно Cell Options, вкладка Text 

 

3. В поле Vertical Justification (Выравнивание по вертикали)  из настроек вырав-

нивания Align Top (Выравнивать по верху), Align Centre (Выравнивать по цен-

тру), Align Bottom (Выравнивать по низу) или Justify Vertically (Разгонка по 

вертикали) выберите Align Centre. Все надписи в строке выровняются относи-

тельно вертикального центра строки. 

 

 

  

Горизонтальное выравнивание текста внутри ячейки изменяется с помощью параметра выравнивания в 
палитре Paragraph (Абзац). 
 

 

Поворот текста в ячейке 

Предположим, нам понадобилось для более компактного размещения текста повер-

нуть содержимое ячеек первой строки на 90°. 

1. Выделите первую строку таблицы. 

2. Вызовите команду Table > Cell Options > Text (Таблица> Параметры ячейки > 

Текст). 

3. В поле Text Rotation (Поворот) введите 90°. 
 

Изменение отступа ячейки 

Зададим изменение расстояний от границ ячейки до текста. 

1. Выделите вторую строку таблицы. 

2. Откройте палитру Table (Таблица). 

3. В группе полей Cell Insets (Отступы ячейки) во все поля введите 2 (рис. 10.9). 
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Рис. 10.9. Настройка отступов в палитре Table 

 

 

  

Во многих случаях при увеличении отступа ячейки увеличивается высота строки. Если высота строки 
фиксирована, убедитесь, что с заданными значениями отступов текст не вытесняется. 
 

 

Отображение  
вытесненного содержимого ячейки 

Для показа вытесненного содержимого ячейки достаточно либо увеличить ячейку, 

либо отредактировать ее содержимое (например, сократить текст), либо изменить 

его форматирование (например, выбрать меньший кегль). 

Обводка и заливка таблиц 

Настроить обводку и заливку для таблицы можно несколькими способами. Изме-

нить рамку вокруг таблицы, добавить параметры обводки и заливки для столбцов и 

строк можно в диалоговом окне Table Setup (Параметры таблицы) — <Ctrl>+ 

+<Alt>+<Shift>+<B>. Для изменения обводки и заливки отдельных ячеек или ко-

лонтитулов служит диалоговое окно Cell Options (Параметры ячейки). 

По умолчанию форматирование, выбранное в диалоговом окне Table Setup (Пара-

метры таблицы), имеет более высокий приоритет, чем любые другие параметры 

форматирования, примененные к ячейкам таблицы. Однако если в диалоговом окне 

Table Setup (Параметры таблицы) выбран параметр Preserve Local Formatting 

(Сохранить локальное форматирование), параметры обводки и заливки, заданные 

для конкретных ячеек, изменяться не будут. 

Если для таблиц и ячеек используется одинаковое форматирование, разумным  

будет создать и применить соответствующие стили. 
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Параметры обводки и заливки таблиц 

При выборе обводки и заливки таблиц или ячеек используются следующие пара-

метры: 

 Weight (Толщина) — толщина линий границ таблицы или ячейки; 

 Type (Тип) — стиль линии, например, Толстая — Тонкая; 

 Colour (Цвет) — цвет границы таблицы или ячейки; 

 Tint (Оттенок) — процент указанной краски в обводке или заливке; 

 Gap Colour (Цвет пробелов) — цвет области между штрихами, точками или ли-

ниями. Этот параметр недоступен, если выбран сплошной тип линии; 

 Gap Tint (Оттенок пробелов) — оттенок области между штрихами, точками или 

линиями. Аналогично, этот параметр недоступен, если выбран сплошной тип 

линии; 

 Overprint (Наложение) — при выборе этого параметра нижележащие краски не 

будут маскироваться, а краска, выбранная в раскрывающемся списке Colour 

(Цвет), будет наложена поверх любого нижележащего цвета. 

Изменение рамки вокруг таблицы 

Внешнюю границу таблицы можно изменять при помощи диалогового окна Table 

Setup (Параметры таблицы). Выделите любую ячейку и вызовите команду Table > 

Table Options > Table Setup (Таблица > Параметры таблицы > Настройка таб- 

лицы). 

1. В группе полей Table Border (Рамка вокруг таблицы) настройте толщину, тип, 

цвет и прочие параметры линии, образующей рамку таблицы. 

2. При желании можно задать дополнительные настройки в поле Stroke Drawing 

Order (Последовательность обводки), позволяющем задать, что будет на перед-

нем плане при пересечении обводок разного цвета: 

 Best Joins (Наилучшие соединения) — обводка строк на переднем плане;  

в точках пересечения, например двойных линий, обводки стыкуются, а места 

пересечения соединяются; 

 Row Strokes in Front (Обводка строк на переднем плане) — строк отобража-

ется на переднем плане; 

 Column Strokes in Front (Обводка столбцов на переднем плане) — обводка 

столбцов отображается на переднем плане. 

Назначение ячейкам обводки и заливки 

Централизованное оформление ячеек обводками и заливками происходит во вклад-

ках Row Strokes (Обводки строк), Column Strokes (Обводки столбцов) и Fills (За-

ливки) диалогового окна Table Setup (Настройка таблицы). 
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Назначить обводку и заливку отдельно взятой ячейке или группе ячеек можно  

в диалоговом окне Cell Options (Параметры ячейки), вкладка Strokes and Fills (Об-

водки и заливки). 
 

Добавление обводки и заливки  
в диалоговом окне Cell Options (Параметры ячейки) 

1. Выделите верхнюю строку таблицы. 

2. Вызовите команду Table > Cell Options > Strokes and Fills (Таблица > Парамет-

ры ячейки > Обводка и заливка) (рис. 10.10). 

 

Рис. 10.10. Диалоговое окно Cell Options, вкладка Strokes and Fills 

 

3. Выбирая в окне предварительного просмотра нужные границы, задайте им тип, 

цвет, толщину и прочие параметры. 

4. При необходимости задайте цвет и оттенок заливки ячеек в поле Cell Fill (За-

ливка ячейки). При желании заливку ячеек можно сделать градиентной. Для это-

го нужно выйти из окна параметров ячейки, вызвать палитру Gradient (Гради-

ент), выделить нужные ячейки и задать им градиентную заливку, как обычным 

объектам InDesign, корректируя параметры градиента средствами изменения 

цвета (например, с помощью палитры Colour) и инструментом Gradient (Гра- 

диент). 
 

Добавление в ячейки диагональных линий 

Предположим, нам необходимо обозначить верхнюю левую ячейку таблицы как 

"пустую" и оформить ее диагональными линиями (задача, постоянно встречающая-
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ся при верстке турнирных таблиц, маршрутных листов и прочих структур, опреде-

ляющих взаимодействие двух независимых групп данных). 

1. Очистите содержимое верхней левой ячейки таблицы и оставьте курсор в ячейке. 

2. Вызовите команду Table > Cells Options > Diagonal Lines (Таблица > Парамет-
ры ячейки > Диагональные линии) (рис. 10.11). 

 

Рис. 10.11. Окно настройки диагональных линий 

3. Выберите нужный тип диагональной линии. Обычно угловая ячейка оформляет-
ся диагональю второго типа (сверху-слева вниз-вправо), а внутренние ячейки 
турнирных таблиц и т. п. — пересекающимися диагоналями четвертого типа. 

4. В группе полей Line Stroke (Параметры линии) задайте тип, толщину, цвет и 
прочие настройки линии. 

Если все-таки предполагается наполнить эту ячейку каким-либо содержимым, его 
взаимодействие с диагональю задается в поле Draw (Прорисовка) Content in Front 
(Содержимое на переднем плане) или, наоборот, Line in Front. 

Чередование обводки и заливки таблицы 

Для улучшения внешнего вида таблицы и облегчения ее восприятия очень удобно 
использовать чередование обводки и заливки (рис. 10.12). При этом чередование 
обводки и заливки в строках таблицы не влияет на строки ее верхнего и нижнего 
колонтитулов, а чередование обводки и заливки в столбцах влияет на строки  
колонтитулов. 

Параметры чередования обводки и заливки имеют более высокий приоритет, чем 
параметры обводки ячейки, кроме случая, когда в диалоговом окне Table Setup 
(Настройки таблицы) выбран параметр Preserve Local Formatting (Сохранить ло-
кальное форматирование). 
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Рис. 10.12. До (слева) и после (справа) применения чередования заливки таблицы 

Добавление чередующейся обводки к таблице 

Рассмотрим самый распространенный вариант оформления таблицы — чередова-
ние обводки строк. 

1. Поместите курсор в таблицу и выберите команду Table > Table Options > 
Alternating Row Strokes (Таблица > Параметры таблицы > Варианты обводки 
строк). 

2. В поле Alternating Pattern (Чередование) выберите необходимый тип шаблона. 
Чаще всего выбирается вариант Every Other Row (Чередовать через один). Дру-
гие варианты позволяют выбрать чередование через два или три ряда, а выбор 
значения Custom (Заказной) позволяет задать количество идущих подряд рядов 
с обводкой первого (First) и второго (Next) типа. Поэкспериментируйте с раз-
ными настройками шаблонов при включенном флажке Preview (Просмотр). 

3. Остальные поля вам хорошо знакомы и позволяют настроить тип, цвет, толщину 
и прочие параметры каждой из линий. 

4. Если требуется начать или закончить чередование в определенной строке таб- 
лицы, задайте нужное количество строк в полях Skip First (Пропустить первые) 
и Skip Last (Пропустить последние). 

 

 

  

Порядок чередования обводки и заливки строк в таблицах остается неизменным для всей таблицы, 
даже если она распространяется на несколько фреймов. 
 

 

Чередование обводки столбцов организуется аналогично, только вызвать надо  
команду Table > Table Options > Alternating Column Strokes (Таблица > Парамет-
ры таблицы > Варианты обводки столбцов). 

Добавление в таблицу вариантов заливки 

Чередование обводок само по себе — достаточно сильный оформительский ход, но 
наибольшую наглядность оно придает таблице в сочетании с чередованием за- 
ливок. 

1. Поместите курсор в таблицу и выберите команду Table > Table Options > 

Alternating Fills (Таблица > Параметры таблицы > Варианты заливок) 
(рис. 10.13). 
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Рис. 10.13. Окно настройки чередования заливок 

2. Выберите в поле Alternating (Чередование) шаблон, аналогично тому, как это 

делалось для обводок. 

3. В полях настройки цвета и оттенка задайте значения для чередующихся зали- 

вок. 

 

 

  

Если выбрать оттенок слишком плотным (больше 30%) при заданном темном цвете, текст на нем будет 

читаться плохо. Плотные оттенки темных цветов имеет смысл использовать, если предполагается 

оформлять текст "вывороткой" (белый на темном). В общем случае выворотка читается хуже, чем обыч-

ный темный текст на светлом фоне, поэтому пользоваться ею нужно осторожно. Вообще, подбор цве-
тов/оттенков заливки и цвета текста всегда должен производиться комплексно, с учетом необходимости 

обеспечить прежде всего легкость и удобство чтения таблицы. 
 

 

Для отключения чередования обводок или заливок достаточно в соответствующем 

диалоговом окне выбрать шаблон None (Нет чередования). 
 

Стили таблиц и ячеек 

Нам уже хорошо знакомо понятие стиля символа и стиля абзаца, их можно приме-

нять к тексту в таблице так же, как к обычному текстовому фрейму.  Но, кроме то-

го, можно создавать и использовать стили таблиц и ячеек. 

Стиль таблицы — это набор атрибутов форматирования таблицы (границ, обводки 

строк и столбцов и др.), который можно применить за одну операцию. 

Стиль ячейки включает форматирование ячейки: отступы, вертикальное выравни-

вание, обводки и заливки — словом, все рассмотренные выше настройки. При из-

менении стиля все таблицы и ячейки, к которым он применен, изменятся автомати-

чески. 
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Есть одно важное различие между стилями текста и стилями таблиц. Несмотря на то, что атрибуты всех 
стилей символов могут быть частью стиля абзацев, атрибуты стиля ячеек не могут составлять часть 
стиля таблицы. Например, нельзя использовать стиль таблицы для изменения цвета границы внутрен-
них ячеек. Для этого нужно создать стиль ячейки и включить его в стиль таблицы. 
 

 
Управление стилями таблиц и ячеек происходит с помощью палитр Table Styles 
(Стили таблицы) и Cell Styles (Стили ячеек). Аналогично палитрам Paragraph 

Styles и Character Styles, они представляют собой набор созданных стилей.  
Команда New Style (Новый стиль) создает новый набор настроек, двойной щелчок 
по существующему стилю вызывает его параметры (рис. 10.14). 

 

Рис. 10.14. Палитры Table Styles и Cell Styles 

По умолчанию все новые документы содержат стиль [Basic Table] (Базовая табли-
ца), который применяется к вновь создаваемым таблицам, и стиль [None] (Без сти-
ля), который может использоваться для удаления стилей, примененных к ячейкам. 
Ни переименовать, ни удалить эти стили нельзя. 

Стили сохраняются вместе с документом и отображаются в соответствующей па-
литре при каждом его открытии. Стили таблиц и ячеек можно объединять в груп-
пы, что упрощает управление ими. 

Палитра Table Styles (Стили таблицы) вызывается командой Window > Styles > 

Table Styles (Окно > Стили > Стили таблиц) и позволяет создавать и переименовы-
вать стили таблиц, а также применять их к существующим, создаваемым и импор-
тируемым таблицам. 

Для создания стиля на основе форматирования существующей таблицы или ячейки 
нужно поместить в нее курсор и вызвать команду New Style палитры Table Styles. 

На вкладке General (основные параметры) находятся уже знакомые нам поля Style 
Name (Имя стиля) и Based On (Основан на...). Для табличных стилей к ним добав-
лено поле Shortcut (Клавиатурное сокращение), позволяющее настроить быстрый 
вызов стиля с клавиатуры. Для назначения комбинации клавиш нужно поместить 
курсор в поле Shortcut, убедиться, что горит индикатор Num Lock на клавиатуре и, 
удерживая нажатой любую комбинацию клавиш <Shift>, <Alt> и <Ctrl>, нажать 
необходимую клавишу на цифровой клавишной панели. При назначении клавиа-
турных сокращений для стилей можно использовать только клавиши дополнитель-
ной цифровой клавишной панели. 
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Остальные вкладки полностью соответствуют уже рассмотренным диалоговым ок-

нам форматирования таблицы. 

Палитра Cell Styles (Стили ячеек) вызывается командой Window > Styles > Cell 

Styles (Окно > Стили > Стили ячеек) и позволяет создавать и переименовывать сти-

ли ячеек для самостоятельного использования или включения в стили таблиц. 

Вкладка General этой палитры (рис. 10.15) совершенно аналогична вкладке 

General палитры Table Styles, кроме одного дополнительного поля: она позволяет 

задать форматирование текста с помощью стиля абзаца (поле Paragraph Style). Ос-

тальные вкладки содержат уже знакомые нам диалоговые окна форматирования 

ячеек. 

 

Рис. 10.15. Палитра Cell Styles, вкладка General 

Загрузка (импорт) стилей таблиц  
из других документов 

При необходимости можно импортировать в документ стили таблиц и ячеек из дру-

гого документа InDesign. Во время импорта определяется, какие стили должны 

быть загружены, и то, что делать при конфликте (совпадении имен) загружаемых 

стилей и существующих в документе. 

Рассмотрим загрузку стиля таблицы. 

1. В контекстном меню палитры Table Styles (Стили таблиц) выберите команду 

Load Table style (Загрузить стили таблиц). 
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2. В окне импорта выберите документ, содержащий импортируемые стили 
(chapter10\project_train-table\ table_sample.indd). 

3. В диалоговом окне загрузки стилей установите флажки для стилей, которые 
предполагается импортировать (рис. 10.16). 

 

Рис. 10.16. Окно загрузки стилей 

4. При наличии совпадающих имен стилей выберите для параметра Conflict with 

Existing Style (Конфликт с существующим стилем) один из вариантов действий: 

 Use Incoming Definition (Использовать определение входного стиля). 

Заменяет существующий стиль загружаемым и применяет его новые атрибуты 
ко всем ячейкам текущего документа, где был использован старый стиль. Опре-
деления входных и существующих стилей отображаются в нижней части диало-
гового окна загрузки стилей, что позволяет сравнить их. 

 Auto-Rename (Автоматическое переименование). 

Переименовывает загружаемый стиль. Например, если в обоих документах при-
сутствует стиль Стиль таблицы 1, то загружаемому стилю присваивается имя 
Стиль таблицы 1 (копия). 

Применение стилей ячеек в стилях таблиц 

При создании стиля таблицы можно указать стили ячеек, применяемые к различ-
ным ее областям: строкам верхнего и нижнего колонтитула, левому и правому 
столбцам, а также строкам основной области (рис. 10.17). Например, для верхнего 
колонтитула может быть задан стиль ячеек, который применяет стиль абзаца, а для 
левого и правого столбца можно задать различные стили ячеек, реализующих зате-
ненный фон. 

Стили ячеек не обязательно должны включать все атрибуты, необходимые для 
форматирования выделенной ячейки. При создании стиля ячейки можно указать, 
какие из атрибутов будут в него включены (например, цвет заливки), при этом все 
остальные настройки останутся без изменений. 
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Рис. 10.17. Определение стилей ячеек для разных частей таблицы 

В отличие от стилей абзацев и символов, стили таблиц и ячеек не имеют общих ат-

рибутов, поэтому применение стиля таблицы не изменяет форматирования ячеек, а 

применение стиля ячеек не изменяет форматирования таблицы. По умолчанию при 

применении стиля ячеек удаляется предыдущий стиль ячейки, но остается ее руч-

ное форматирование. Аналогичным образом применение стиля таблицы отменяет 

предыдущий стиль таблицы, но все изменения, сделанные через диалоговое окно 

Table Setup (Настройки таблицы), сохраняются. 

Приоритеты настроек форматирования 

Приоритеты настроек форматирования расставляются аналогично приоритетам 

форматирования текста: самые общие значения задаются стилем таблицы, исполь-

зующим стили ячеек, они перекрываются стилем ячейки (если это разрешено на-

стройкой Preserve Local Formatting), а ручное форматирование перекрывает все 

общие настройки. 

Проект "Расписание поездов" 

Предположим, вам требуется для рекламных материалов турфирмы сформировать 

таблицу с расписанием поездов и типов вагонов в этих поездах (плацкартные, купе 

и т. д.). 

1. Создайте документ со следующими установками: 

 Print; 

 Number of Pages = 1; 

 Size = A4; 

 Number of Columns = 1; 

 Margins (All) = 20 mm. 
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2. Создайте текстовый фрейм. 

3. Импортируйте файл chapter10\project_train-table\ train_tab.doc. 

4. Выделите весь текст и вызовите команду Table > Convert to Table (Таблица > 

Преобразовать в таблицу). В качестве разделителей столбцов укажите знак та-

буляции, разделители строк — знаки абзаца. Сравните распределение столбцов 

и строчек с образцом: chapter10\project_train-table\ table_sample.indd. 

5. Создайте стиль абзаца Table для использования в таблице: 

 Font Family = Minion Pro; 

 Font Style = Regular; 

 Font Size = 9 pt; 

 Leading = 11 pt; 

 Align = Left; 

 Align to Baseline = None. 

6. Создайте стиль Header для верхнего колонтитула: 

 Based on = Table; 

 Font Style = Semibold. 

7. Создайте стиль ячеек Body для основной массы ячеек таблицы (рис. 10.18) с ис-

пользованием стиля абзаца Table. 

 

Рис. 10.18. Настройки стиля ячеек Body 
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Рис. 10.19. Стиль ячеек Header 

8. Создайте на основе стиля Body стиль ячеек Header для колонтитула (рис. 10.19) 
с использованием стиля абзаца Header. 

9. Создайте стиль таблицы Main_table с указанием стиля ячеек Body для основной 
массы ячеек, стиля Header для колонтитула и установок чередования заливки 
строк "через один" (рис. 10.20). 

 

Рис. 10.20. Настройка стиля таблицы 
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10. Примените к таблице стиль Main_table. 

11. Выделите последнюю строку таблицы и объедините все ячейки командой 

Merge cells (через вызов правой кнопкой мыши контекстного меню таблицы 

или через кнопку объединения ячеек Контрольной панели). 

Теперь, имея набор стилей для всех основных элементов таблицы, вы можете прак-

тически мгновенно настроить любое количество аналогичных таблиц в своем до-

кументе. 

Итоги 

Корректная и удобная работа с таблицами — замечательнейшее достижение 

InDesign CS5. До сих пор эта часть работы верстальщика по праву признавалась 

самой долгой и мучительной — при том, что задачи, связанные с использованием 

таблиц, в дизайнерской практике встречаются часто. 

Для закрепления полученных навыков создайте себе несколько план-календарей: 

ежедневник, еженедельник, план на месяц. 

1. Для каждого вида планировщика создайте свой файл подходящего формата. 

2. Создайте таблицы. 

3. Определите, где какие требуются заголовочные строки/столбцы, и создайте их. 

4. Задайте стили для всей таблицы и отдельных ячеек. 

5. По мере надобности распечатывайте готовые таблицы и используйте в повсе-

дневной работе. 

И пусть они всегда будут заполнены интересными и приятными делами! 
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КНИГИ И БИБЛИОТЕКИ 

 

 

 

 
 
Вы этой главе вы узнаете: 

 зачем собирать книгу из отдельных коротких документов-глав; 

 как задать номера страниц, последовательно переходящие из главы в главу; 

 как создать ссылки между главами; 

 как создать оглавление. 

Книга как система связанных документов 

Файл книги — это набор документов-глав, в которых могут использоваться одина-

ковые стили, образцы, страницы-шаблоны и другие элементы. В документах книги 

можно делать сквозную нумерацию страниц, печатать отдельные документы книги 

или экспортировать их в файлы PDF. Один документ может принадлежать несколь-

ким книгам. Таким образом, можно работать одновременно со сравнительно не-

большим документом и контролировать его соответствие всем остальным частям 

проекта с помощью инструментов управления книгой. 
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Один из документов, добавленных в файл книги, становится источником стилей. 

По умолчанию источником стилей является первый документ в книге, но в любой 

момент можно выбрать новый источник стилей, который будет задавать формати-

рование и взаимодействие всех частей книги. 

Рассмотрим этот процесс на примере книги из двух глав. 

1. Создайте документ со следующими установками: 

 Print; 

 Size = A5; 

 Numbers of Columns = 1; 

 Margins: 

 Inside = 12 mm; 

 Top = 16 mm; 

 Outside = 20 mm; 

 Bottom = 24 mm. 

2. Создайте простой шаблон с номерами страниц и колонтитулами: "Пелэм Грен-

вилл Вудхаус. Бландингская сага" и "Section" (плавающий колонтитул). 

3. Создайте 2 стиля: Body (для основного текста) и Header (Для заголовков). 

4. К первой странице примените настройку Numbering & Section Options; уста-

новите маркер секции: "Глава 1. Хранитель тыквы". 

5. Сохраните файл как шаблон (Save As > InDesign Template) под именем 

Blandings.indd. 

6. Импортируйте файл lord_emsworth.doc. 

7. Разместите и отформатируйте текст. 

8. Сохраните файл как документ под именем Glava1.indd. 

9. Создайте на базе шаблона новый документ. Все мастер-шаблоны и стили авто-

матически перенесутся в него из шаблона. 

10. Замените маркер секции на "Глава 2. Сви-оу-оу-эй!" 

11. Импортируйте файл pi-i-ggy.doc. 

12. Разместите и отформатируйте текст. 

13. Сохраните файл под именем Glava2.indd. 

14. Теперь можно начинать сборку книги. 

15. Выберите в меню File > New > Book (Файл > Новый > Книга). 

16. Введите имя книги — напрмер, Blandings. Нажмите кнопку Сохранить. 

17. Появится палитра Book (Книга) (рис. 11.1). Файл книги будет сохранен с рас-

ширением indb. 
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Рис. 11.1. Палитра Book 

Добавление документов в файл книги 

Палитра Book (Книга) — это рабочая область файла книги, где можно добавлять, 

удалять или упорядочивать документы. 

1. Нажмите кнопку со значком "+" в нижней части палитры. 

2. Выберите оба документа (Glava1 и Glava2) и нажмите кнопку Открыть. 

3. Для объявления документа источником стилей поставьте флажок рядом с име-

нем документа в палитре. 

Возникает вопрос: зачем объявлять документ источником стилей, если новый до-

кумент создается на базе шаблона, сохраняющего все установки первоначального 

документа? В процессе работы в новых документах могут появиться расхождения  

с первоначальным — новые стили, новые шаблоны, изменения в ранее созданных  
 

 

 

Рис. 11.2. Палитра Book с добавленными документами 
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шаблонах и т. д. Для приведения всех частей книги к единому виду и состоянию 

используется операция синхронизации, основанная на использовании набора уста-
новок из документа, объявленного источником стилей. 

Двойной щелчок на строке документа в палитре Book (Книга) открывает его для 

редактирования (рис. 11.2). 

Управление файлами книг 

Каждый открытый файл книги появляется на отдельной вкладке палитры Book 
(Книга). Если одновременно открыто несколько книг, щелкните соответствующую 

вкладку, чтобы перейти к этой книге и получить доступ к меню нужной палитры. 

Значки на палитре Book (Книга) показывают текущее состояние документа: от-
крыт, отсутствует (перемещен, переименован или удален), изменен (отредактиро-

ван, или номера страниц или разделов изменились при закрытии документа) или 
используется (документ открыт другим пользователем в рабочем процессе). 

Рядом с закрытыми документами значки не отображаются. 

Сохранение файла книги 

Файлы книг хранятся отдельно от файлов документов. Если выбрать команду Save 

Book (Сохранить книгу), InDesign сохранит изменения в книге, а не в документах 
книги. 

Для сохранения книги под новым именем в меню палитры Book (Книга) выбирает-

ся команда Save Book as (Сохранить книгу как). 

Для сохранения книги под тем же именем в меню палитры Book (Книга) выбирает-
ся команда Save Book (Сохранить книгу) или кнопка Сохранить в нижней части 

палитры Book (Книга). 

Удаление документов из книги 

Удаление документа из книги производится командой Remove Document контек-
стного меню или кнопкой "-" в нижней части палитры. Удаление документа из кни-

ги не означает удаления файла с диска, удаляется только ссылка на документ из 

файла книги. 

Синхронизация документов в книге 

Во время синхронизации документов в книге заданные элементы (стили, мастер-
шаблоны, нумерованные списки, образцы и т. п.) копируются из источника стилей 

в указанные документы в книге, заменяя элементы с совпадающими именами. 

Если элементы, присутствующие в источнике стилей, не обнаружены в синхрони-
зируемых документах, они добавляются. Если какие-то элементы отсутствуют в 

источнике стилей, соответствующие элементы в синхронизируемых документах 
остаются без изменения. 
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Выбор элементов для синхронизации 

1. В меню палитры Book (Книга) выберите команду Synchronize Options (Пара-

метры синхронизации) (рис. 11.3). 

2. Выберите элементы, которые нужно скопировать из источника стилей в другие 

документы книги — например, стили абзаца и мастер-шаблоны. 
 

 

Рис. 11.3. Диалоговое окно Synchronize Options 

Синхронизация документов в файле книги 

Можно синхронизировать книгу, не открывая входящие в нее документы. Про-

грамма InDesign открывает закрытые документы, вносит изменения, а затем сохра-

няет и закрывает документы. Документы, открытые на момент выполнения син-

хронизации, изменяются, но не сохраняются. 

1. В палитре Book (Книга) установите флажок рядом с документом Glava1. 

2. Убедитесь в том, что элементы, подлежащие копированию из источника стилей, 

выбраны в диалоговом окне Synchronize Options (Параметры синхронизации). 

3. Выберите документы, которые должны синхронизироваться с документом-

источником стилей. Если документы не выбраны, синхронизируется вся книга. 

4. В меню палитры Book (Книга) выберите команду Synchronize Book (Синхрони-

зировать книгу) или нажмите кнопку Synchronize (Синхронизировать) в нижней 

части палитры Book. 

Синхронизация мастер-шаблонов 

Мастер-шаблоны синхронизируются так же, как и другие элементы: мастер-

шаблоны с такими же именами, как в источнике стилей (например, A-Master), за-

меняются. Синхронизация шаблонов удобна для документов, в которых использу-
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ются одни и те же элементы оформления, например верхние и нижние колонти- 

тулы. 

Правильнее всего синхронизировать мастер-шаблоны только из одного источника 

стилей. При синхронизации из другого источника стилей измененные элементы 

мастер-шаблона могут потерять связь с шаблоном. 

Нумерация страниц, глав и абзацев в книге 

Для настройки сквозной нумерации страниц, глав и абзацев в книге служат коман-

ды Book Page Numbering Options (Параметры сквозной нумерации) и Update 

Numbering (Обновление нумерации). 

Диапазон страниц отображается рядом с именем каждого документа в палитре 

Book (Книга). По умолчанию InDesign обновляет нумерацию страниц и разделов 

при добавлении или удалении страниц в документах книги, а также при внесении 

изменений в файл книги, например при переупорядочении, добавлении или удале-

нии документов (рис. 11.4). Можно отключить параметр автоматического обновле-

ния номеров страниц и разделов и обновить нумерацию в книге вручную. 

 

Рис. 11.4. Отображение 
нумерации страниц в палитре 

Book 

Если документ отсутствует или его невозможно открыть, вместо диапазона страниц 

отображается вопросительный знак "?" от позиции, где должен находиться отсутст-

вующий документ, до конца книги. Это значит, что действительный диапазон стра-

ниц неизвестен. Прежде чем обновлять нумерацию, нужно удалить или заменить 

отсутствующий документ. Значок "Используется" рядом с именем документа пока-

зывает, что документ открыт другим пользователем в рабочем процессе; чтобы об-

новить нумерацию, этот пользователь должен закрыть документ. 

Начало нумерации с четной или нечетной страницы 

Нумерацию страниц в каждом документе можно начать с четной или нечетной 

страницы с помощью пункта Book Page Numbering Options (Параметры сквозной 

нумерации) меню палитры Book (Книга) (рис. 11.5). 

Здесь можно выбрать, будет ли нумерация производиться подряд либо начинаться 

всегда с четных или нечетных страниц (этот параметр очень полезен для верстки 

книг, у которых каждой главе предшествует шмуцтитул). 
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Рис. 11.5. Диалоговое окно Book Page Numbering Options 

Использование сквозной нумерации абзацев в книгах 

Для того чтобы использовать сквозную нумерацию для списков рисунков, таблиц 

или других элементов, надо сначала определить нумерованный список, используе-

мый в стиле абзаца. От определения нумерованного списка зависит, будет ли  

использоваться сквозная нумерация абзацев по всем документам книги. 

Для этого нужно: 

1. Открыть документ, используемый в качестве источника стилей для книги. 

2. Вызвать команду Type > Bulleted & Numbered Lists > Define Lists (Текст > 

Маркированные и нумерованные списки > Определить списки). 

3. Задать новый или отредактировать существующий список. 

4. Установить одновременно параметры Continue Numbers Across Stories (Про-

должить нумерацию между материалами) и Continue Numbers from Previous 

Document in a Book (Продолжить от предыдущего документа в книге). 

5. Задать стиль абзаца, в котором используется нумерованный список, и применить 

его к соответствующему тексту в каждом документе. 

Для синхронизации настроек списков и абзацев нужно выбрать соответствующие 

параметры в диалоговом окне Synchronise Options (Параметры синхронизации) и 

синхронизировать книгу. 

Печать или вывод файла книги 

Одно из преимуществ использования файла книги — возможность использования 

всего одной команды для вывода выбранных документов книги или всей книги. 

Для этого достаточно в контекстром меню палитры Book (Книга) выбрать команду 

Print Book (Печатать книгу) или выделить в палитре нужные документы и выбрать 

команду Print Selected Documents (Печатать выбранные документы). 

Создание оглавления 

Оглавление (TOC) может включать содержание книги, журнала или другой публи-

кации, отображать список иллюстраций, рекламодателей или авторов фотографий, 

содержать другую информацию, которая поможет читателю найти нужные сведе-
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ния в документе или книге. Одна книга может содержать несколько оглавлений, 

например список глав и список иллюстраций. 

Каждое оглавление — это отдельный материал, состоящий из заголовка и списка 
элементов, упорядоченных по номерам страниц или в алфавитном порядке. Эле-
менты оглавления, включая номера страниц, берутся прямо из содержимого доку-
ментов и могут быть обновлены в любое время. 

Для создания оглавления нужно выполнить три основных шага: 

1. Создать и применить стили для абзацев, которые станут основой для создания 
оглавления. 

2. Указать, какие (каким стилем оформленные) абзацы войдут в оглавление, и за-
дать стили для форматирования самого оглавления. 

3. Включить оглавление в документ. 

 

 

  

При составлении оглавления важно учитывать: 

 стили оглавления можно загрузить из других документов или книг, чтобы создать новое оглавление с 
такими же параметрами и форматированием (возможно, понадобится изменить импортированный 
стиль оглавления, если имена стилей абзацев в документе не совпадают с именами в документе-
источнике); 

 для форматирования оглавления надо создать стили абзацев для заголовка и элементов оглавле-
ния, включая позиции табуляции и префиксы; 

 можно создать стили символов для номеров страниц и символов, отделяющих номера страниц от 
элементов оглавления. Например, если нужно, чтобы номера страниц выделялись полужирным на-
чертанием, надо создать стиль символа, который включает атрибут Semibold (Полужирный), и вы-
брать этот стиль символа для номеров страниц при создании оглавления. 

 

 

Перед созданием оглавления книги или документа его нужно подготовить: 

1. Убедиться в том, что список документов в книге полон, все документы перечис-
лены в правильном порядке, все заголовки отформатированы в нужном стиле. 

2. Убедиться, что стили абзацев единообразны во всей книге: избегайте создания 
документов со стилями, которые имеют одинаковые имена, но разные парамет-
ры. В противном случае может возникнуть конфликт стилей, и будет использо-
ван текущий вариант стиля — не обязательно тот, который вы имели в виду. 

3. Синхронизировать книгу для уверенности, что все стили присутствуют во всех 
доукментах. 

Построение оглавления 

1. Прежде всего, определите типы абзацев, которые войдут в оглавление (заголов-
ки, подзаголовки и т. д.) и проверьте, чтобы их стили совпадали во всех доку-
ментах книги. В нашем случае это стиль Header. 

2. Добавьте в начало документа Glava1 или в конец документа Glava2 страницу для 
оглавления. При добавлении в начало книги его обычно называют "Оглавлени-
ем", в конце — "Содержанием". 

3. Вызовите Layout > Table of Contents (Макет > Оглавление) (рис. 11.6). 
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Рис. 11.6. Диалоговое окно Layout > Table of Contents 

Если стиль оглавления уже определен, его можно выбрать в списке TOC Style 
(Стиль оглавления). 

Title (Заголовок) — заголовок оглавления (например "Содержание" или "Список 
рисунков"). Для его форматирования выберите стиль в списке Style (Стиль) — ра-
зумеется, стиль должен быть заранее создан. 

Для создания единого оглавления для всех документов в книге установите флажок 
Include Book Documents (Включить документы книги). 

Cодержимое оглавления определяется добавлением нужных стилей из списка 
в правом поле области Styles in TOC (Стили в оглавлении) в левый. 

Элементы оглавления, естественно, должны форматироваться иначе, чем форми-
рующие их заголовки. Обычно стиль форматирования оглавления основывается на 
стиле основного текста, но может базироваться и на исходных заголовках, если 
общая стилистика книги это позволяет. В этом случае разные уровни оглавления 
будут отличаться от исходных заголовков и друг от друга, прежде всего кеглем и 
начертанием. Стиль для каждого внутреннего элемента оглавления выбирается в 
списке Entry Style (Стиль элемента). Здесь же задается, где будет находиться но-
мер страницы по отношению к элементу оглавления (чаще всего после) и какой 
символ будет заполнять промежуток между текстом и номером (обычно табуля-
ция). Здесь очень полезно в стиле внутренних элементов оглавления задать табуля-
цию с отточием — в поле Leader вкладки Tab палитры Paragraph Styles (Стили 
абзаца) ввести "точку". При необходимости можно указать заранее созданные сти-
ли для отточия и номеров страниц — например, выделить их полужирным или за-
дать им другой цвет. 

После нажатия кнопки ОК появится курсор загруженного текста. Щелчком мыши 
на нужной странице оглавление разместится в своем фрейме. 

 

 

  

По возможности не связывайте фрейм оглавления с другими фреймами в документе. При замене суще-
ствующего оглавления весь материал будет заменен обновленным оглавлением. 
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Создание стилей оглавления для нескольких списков 

Каждый набор настроек оглавления можно сохранить как стиль оглавления и ис-

пользовать, если понадобится создать разные оглавления в документе или книге. 

Например, можно использовать один стиль оглавления для содержания, а другой — 

для списка иллюстраций или авторов фотографий. Для создания стиля оглавления 

достаточно по окончании настройки всех параметров нажать на кнопку Save Style 

(Сохранить стиль) и задать имя стиля. 

Импорт стилей оглавления из другого документа 

Готовые стили из других документов импортируются нажатием кнопки Load (За-

грузить) диалогового окна Layout > Table of Contents Styles (Макет > Стили  

оглавления) (рис. 11.7). 

 

Рис. 11.7. Диалоговое окно Layout > Table of Contents Styles 

Обновление и редактирование оглавления 

Оглавление — это своего рода "снимок" содержимого документа. Если в документе 

изменились номера страниц, заголовки или другие элементы, связанные с элемен-

тами оглавления, необходимо обновить его — Layout > Update TOC (Макет > Об-

новить оглавление). 

Изменять само оглавление бессмысленно, поскольку оно формируется "на лету" и 

всего лишь отражает состояние документа (книги) и его настроек. 

Для изменения форматирования заголовка оглавления, элементов оглавления или 

номеров страниц нужно изменить связанные с ними стили абзацев или символов;  

для изменения нумерации страниц (например, 1, 2, 3 или i, ii, iii) соответствующие 

правки вносятся в документы книги. 

Каждое оглавление обновляется отдельно. 
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Создание указателя 

Указатель — непременный элемент любого справочного или тематического изда-
ния. Можно создать простой указатель (по ключевому слову) или сложный (под-
робный указатель информации книги). 

В документе или книге можно создать только один указатель. Для создания указа-
теля сначала нужно разместить маркеры указателя в тексте, затем связать каждый 
маркер указателя со словом, которое должно отображаться в указателе (так назы-
ваемой темой). 

При построении указателя (рис. 11.8) каждая тема выводится с указанием страниц, 
где ее можно найти. Темы сортируются в алфавитном порядке, обычно по заголов-
кам разделов (А, Б, В и т. д.). Элемент указателя состоит из темы (термина, кото-
рый ищет пользователь) и ссылки на страницу (номер страницы или диапазон) либо 
перекрестной ссылки. Перекрестная ссылка, начинающаяся со слов "См." или  
"См. также", указывает читателю другие элементы указателя. 

 

Рис. 11.8. Части указателя 

Создание хорошо спланированного и полного указателя может помочь читателям 
быстро сориентироваться в документе. 

 Продумайте, каким вы хотите видеть ваш указатель. Сколько уровней тем в нем 
будет? Будут ли в нем ссылки на другие похожие темы? Хватит ли простого ука-
зателя по ключевым словам или нужен более сложный, с перекрестными ссыл-
ками на смежные темы? 

 Представьте возможные способы, с помощью которых читатели могут искать 
нужную информацию: например, кто-то ищет информацию о животных по сло-
ву звери, а кто-то — по словам живая природа или фауна. 
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 Добавляйте элементы указателя в самом конце работы, когда содержимое доку-

мента уже практически не меняется. Если после добавления элементов указателя 

удалить большие фрагменты текста, часть работы по созданию указателя может 

быть потеряна. 

В хорошо спланированном указателе темы согласованы. Основные проблемы при 

создании указателя — использование заглавных и строчных букв (лорд и Лорд), а 

также использование единственного и множественного числа (лорд и лорды). Ис-

пользуйте список тем, чтобы сохранить согласованность терминов. 

Перед построением окончательного варианта указателя проверьте его несколько 

раз. Ищите повторяющиеся элементы, плохо освещенные предметные области, 

опечатки, несоответствия в использовании слов и заглавных букв. Например, 

InDesign рассматривает Замок, замок и замки как разные элементы. 

Процесс создания указателя 

1. Создание списка тем. Список тем поможет сохранить согласованность элемен-

тов указателя. 

2. Добавление маркеров указателя. Маркеры указателя добавляются на страницы, 

на которые должны ссылаться элементы указателя. 

3. Построение указателя. На этом шаге создается набор элементов для маркеров и 

соответствующих страниц. 

4. Размещение материала указателя. В большинстве случаев указатель начинается 

с новой страницы. 

Возможно, придется повторить эти шаги несколько раз, пока не будет найден наи-

лучший вариант. 

С помощью палитры Index (Указатель) (рис. 11.19) можно создавать, редактиро-

вать и просматривать указатели. Палитра работает в двух режимах: Reference 

(Ссылка) и Topic (Тема). В режиме Reference в области предварительного про-

смотра отображаются все элементы указателя для текущего документа или книги. 

В режиме Topic в области просмотра отображаются только темы без номеров стра-

ниц и перекрестных ссылок. Режим Topic используется в основном для создания 

структуры указателя, в то время как в режиме Reference можно добавлять элемен-

ты указателя. 

В режиме Topic элементы указателя сортируются в алфавитном порядке и делятся 

на разделы по буквам. 

Треугольники рядом с элементами позволяют развернуть или свернуть элемент, 

чтобы увидеть вложенные элементы, номера страниц и перекрестные ссылки. 

На месте перекрестных ссылок появляются коды, указывающие на элементы, кото-

рые не могут быть включены в создаваемый указатель. Для просмотра кодов может 

потребоваться выбор параметра Update Preview (Обновить экранную версию) 

в контекстном меню палитры Index (Указатель). 
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 МС: элемент указателя находится на монтажном столе за пределами страницы. 

Такие элементы не отображаются в указателе. 

 СС: элементы находятся в скрытом слое. 

 СТ: запись указателя в скрытом условии. Элементы указателя в скрытых усло-

виях не включаются в указатель. 

 PN: элементы указателя находятся в вытесненном тексте. Если добавить эти 

элементы в указатель, они появятся без номеров страниц. 

 Шаблон: элементы указателя находятся на мастер-шаблоне. Такие элементы не 

отображаются в указателе. 

 

Рис. 11.9. Палитра Index (<Shift>+<F8>) 

Отдельный элемент разворачивается и сворачивается щелчком на треугольнике 

сбоку от его строки. Все вложенные элементы внутри элемента открываются и за-

крываются щелчком по треугольнику при нажатой клавише <Alt>, все элементы 

одного уровня — щелчком по треугольнику при нажатой клавише <Ctrl>. 

Команда Update Preview (Обновить экранную версию) контекстного меню палит-

ры Index (Указатель) служит для обновления области предварительного просмотра. 

Этот параметр особенно полезен, если документ был сильно изменен или маркеры 

указателя были перемещены в окне документа. 

Рассмотрим этот процесс на примере первой главы нашей тренировочной книги. 

Создание списка терминов для указателя 

Список терминов можно создать или импортировать, чтобы использовать его как 

отправную точку для создания элементов указателя. Позже при добавлении эле-

ментов в указатель можно выбирать темы из списка (вместо того чтобы каждый раз 

вводить их), что обеспечивает согласованность информации в указателе документа 

или книги. 
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Список тем создается и редактируется в палитре Index (Указатель) в режиме Topic. 

Внесем в список основные действующие лица и главные объекты действия: лорда 

Эмсуорта и его сына, садовника Макалистера и мистера Дональдсона, дворецкого 

Биджа, констебля, тыкву и клуб консерваторов, также играющий немаловажную 

роль в сюжете. 

Для добавления слова в список тем достаточно выделить его в тексте и нажать кла-

виши <Ctrl>+<7>. 

1. Пролистайте весь документ и каждый раз, встречая впервые слово, относящееся 

к перечисленным темам, включайте его в список (рис. 11.10). 
 

 

Рис. 11.10. Окно добавления темы 

 

2. Обратите внимание, что некоторые темы содержат не одно описывающее их 

слово. Например, Эмсуорт описывается также словами "граф" и "лорд", и их то-

же надо включить в указатель как темы более низкого уровня (Level 2 в окне до-

бавления темы). Создавая тему второго уровня, поместите нужное слово в поле 

Level 2 (например, слово "граф"), а в поле Level 1 впишите основное определе-

ние (например, Эмсуорт). 

Темы из списка отображаются и в диалоговом окне New Cross-reference (Новая 

ссылка на страницу). Для создания элемента указателя достаточно выбрать тему и 

указать соответствующую страницу или перекрестную ссылку. 

Неиспользуемые темы (для которых не указан номер страницы или перекрестная 

ссылка) будут удалены при построении указателя. 

Создавать список тем перед добавлением элементов указателя желательно, но не 

обязательно. Каждый раз при создании элемента указателя соответствующая тема 

автоматически добавляется в список тем для использования в будущем. 

По умолчанию темы, которые добавляются в список тем, не отображаются в списке 

References, показывающем только темы, которым присвоена хотя бы одна ссылка 

на страницу. Для отображения тем в этом списке можно выбрать Show Unused 
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Topics (Показать неиспользуемые темы) из меню палитры Index (Указатель) в ре-

жиме Reference (Ссылка). 

Здесь же с помощью команды Import Topics (Импортировать темы) можно загру-
зить темы из другого документа. 

Редактирование темы указателя 

Элементы указателя редактируются в палитре Index (Указатель). Изменения, вне-
сенные прямо в указатель, удаляются при повторном его построении. 

Добавление элементов указателя 

Элементы указателя создаются в палитре Index (Указатель) в режиме Reference 
(Ссылка) (рис. 11.11). Элемент указателя состоит из двух частей: темы и ссылки. 
Темы могут быть заданы в любое время с помощью списка тем. Ссылками могут 
быть номера страниц или перекрестные ссылки на другие темы. 

 

Рис. 11.11. Палитра Index в режиме Reference 

Создадим ссылки на соответствующие страницы для каждого элемента списка тем. 
Для этого нужно создать маркеры указателя. 

Маркер указателя вставляется в начале нужного слова. Для просмотра маркеров 
указателя можно вызвать Type > Show Hidden Characters (Текст > Показать слу-
жебные символы). 

1. Инструментом Type (Текст) поместите курсор в то место, где должен находить-
ся маркер указателя (например, в начале слова "Бидж" на первой странице). 

2. В палитре Index (Указатель) в режиме  Reference (Ссылка) выберите команду 
New Page Reference (Новая ссылка на страницу) (<Ctrl>+<7>). 

3. В нижней части диалогового окна добавления элемента разверните список тем и 

двойным щелчком активизируйте нужную тему (она появится в поле Level 1 или 

Level 2). 
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4. Определите тип элемента указателя (рис. 11.12): 

 с номером страницы или диапазоном страниц (например, кошки 82–87) — 
в выпадающем списке Type (Текст) выберите параметр, определяющий диа-
пазон; 

 без номера страницы — в выпадающем списке Type (Текст) выберите 
Suppress Page Range (Исключить диапазон страниц). Хотя номер страницы 
не будет отображаться в указателе, он появится в скобках в палитре Index; 

 объект поиска, который ссылается на другой объект — выберите один из па-
раметров перекрестных ссылок (например, См. или См. также) в выпадаю-
щем списке Type (Текст), а затем введите имя объекта в поле Referenced 
(Указывает на объект) или перетащите в это поле существующий объект из 
списка в нижней части палитры. 

 

Рис. 11.12. Определение типа элемента указателя 

5. В нашем случае выберите Current Page (Текущая страница). 

6. Повторите операцию для всех элементов списка тем по всем страницам. 

Обратите внимание, что, поскольку маркеры расставляются вручную, а темы выби-
раются из списка, указатель получается согласованным: будь то "лорд" или "лор-
ды", "констебль" или "Констебли" — в указателе они обозначаются именительным 
прадежом единственного числа, как мы указали в списке. 

Автоматическое внесение каждого вхождения слова 

Параметр Add All (Добавить все) команды New Page Reference (Новая ссылка на 

страницу) — эффективный способ занесения в указатель всех появлений указанно-
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го термина, которые встречаются в документе или книге. При нажатии кнопки Add 

All (Добавить все) InDesign создает маркеры указателя для каждого появления вы-

деленных слов, встречающихся в документе (позже можно удалить элементы, ука-

зывающие на малозначимую информацию). 

При поиске появлений выделенного текста InDesign учитывает только слова цели-

ком, поиск ведется с учетом регистра. Например, если выделено слово "граф", сло-

ва "графы" и "Граф" в указатель не попадут. 
 

Добавление в указатель перекрестных ссылок  
"См." или "См. также" 

Перекрестные ссылки — это элементы указателя, которые указывают не на номера 

страниц, а на близкие по смыслу элементы. Они связывают распространенные тер-

мины с их эквивалентами, использующимися в документе или книге. Например, 

Граф. См. Аристократия. Элементы с такими перекрестными ссылками не содер-

жат ссылок на страницы, они просто указывают на похожие термины, имеющиеся 

в указателе. 

Иногда перекрестные ссылки указывают на другие элементы, связанные с нужной 

темой, но не эквивалентные ей, например, Лорд. См. также Граф. В этом случае 

элемент указателя, содержащий перекрестную ссылку, включает номера страниц. 

При создании перекрестной ссылки нужно в выпадающем списке типов элемента 

выбрать префикс перекрестной ссылки. 

See (См.) и See also (См. также) — это текст метки. При выборе See [also]  

(См. [также]) InDesign автоматически присваивает нужный префикс перекрестной 

ссылке при каждом построении указателя. 

 

 

  

Элементам с номерами страниц, вложенными элементами или тем и другим всегда присваивается пре-
фикс "См. также". 

Элементам без номеров страниц или вложенных элементов присваивается префикс "См.". 
 

 

Использование параметра "См. [также]" устраняет необходимость вручную обнов-

лять перекрестные ссылки при изменении документов книги. 

В поле Referenced (Указывает на тему) вводится тема (либо перетаскивается из 

списка тем в нижней части окна). 

Перекрестные ссылки появятся в палитре Index (Указатель) и в построенном указа-

теле, но не будут связаны с маркерами указателя в самом документе. 
 

Построение указателя 

Добавив элементы указателя и просмотрев их в палитре Index (Указатель), можно 

приступать к созданию указателя, чтобы потом поместить его в документ для пуб-

ликации. 
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Указатель может быть как отдельным документом, так и частью существующего 

документа. При создании указателя InDesign обновляет номера страниц в докумен-

те или книге. Если после этого в документе были добавлены или удалены элементы 

указателя или обновлена нумерация, указатель нужно создать заново. 

Если при построении указателя маркер указателя оказывается в вытесненном тек-

сте, будет выдан запрос о включении таких маркеров в указатель. Если выбрать 

"Да", элемент появится в указателе без номера страницы. 

1. Создайте новую страницу документа или новый документ в книге. 

2. В меню палитры Index выберите команду Generate Index (Построить указатель) 

(рис. 11.13). 

 

Рис. 11.13. Окно построения указателя 

3. Настройте будущий указатель: 

 Введите заголовок, который будет отображаться вверху указателя. Стиль 

форматирования заголовка выбирается в выпадающем списке Tytle Style 

(Стиль заголовка). 

 Поставьте флажок Replace Existing Index (Заменить существующий указа-

тель), чтобы обновить существующий указатель. Этот параметр недоступен, 

если указатель еще не строился. При снятом флажке можно создать несколь-

ко указателей. 

 Установите флажок Include Book Documents (Включить документы книги), 

чтобы создать единый указатель для всех документов в текущей книге и за-

ново пронумеровать страницы книги. Снимите этот флажок, если нужно по-

строить указатель только для текущего документа. 

4. Если флажок Replace Existing Index не установлен, появится значок загружен-

ного текста. Разместите указатель как обычный текст (рис. 11.14). 

Если изменить элементы прямо в готовом указателе, эти изменения будут потеряны 

при повторном создании указателя. Правильно будет изменить указатель в палитре 

Index, а затем построить его еще раз. 

Параметры форматирования указателя 

При нажатии кнопки More Options (Дополнительные параметры) в диалоговом ок-

не построения указателя отобразятся параметры форматирования, которые позво-

ляют определить стиль и внешний вид указателя (рис. 11.15). 



Книги и библиотеки 263 

 

Рис. 11.14. Готовый  
указатель 

 

Рис. 11.15. Окно форматирования указателя 

После создания указателя можно редактировать эти стили в палитрах Paragraph 

Styles (Стили абзацев) и Character Styles (Стили символов). 

 Nested (Ступенчатый) или Run-in (Сплошной): выберите вариант Nested (Сту-

пенчатый), если указатель должен быть отформатирован в стиле по умолчанию, 

и Run-in (Сплошной), если нужно, чтобы все уровни элемента отображались в 
одном абзаце. Параметры Entry Separators (Между элементами) определяют 

символы, разделяющие элементы. 

 Include Index Section Headings (Включить заголовки разделов указателя): уста-

новите этот флажок, чтобы при построении указателя озаглавить разделы бук-

вами алфавита (А, Б, В и т. д.). 
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 Include Empty Index Section (Включить пустые разделы указателя): установите 

этот флажок, чтобы создать разделы для всех букв алфавита, даже если в указа-

теле не будет элементов, начинающихся с некоторых букв. 

 Level Style (Стили уровней): для каждого уровня указателя выберите стиль аб-

заца, который будет применен к каждому уровню элемента в указателе. После 

создания указателя эти стили можно редактировать в палитре Paragraph Styles 

(Стили абзацев). 

 Section Heading (Заголовки разделов): выберите стиль абзаца, который опреде-

ляет внешний вид заголовков разделов указателя (А, Б, В и т. д.). 

 Page Number (Номер страницы): выберите стиль символа, который определяет 

внешний вид номеров страниц в указателе. 

 Cross-reference (Перекрестная ссылка): выберите стиль символа, определяющий 

внешний вид префиксов перекрестных ссылок в указателе (например, См. и См. 

также). 

 Cross-referenced Topic (Темы в перекрестных ссылках): выберите стиль симво-

ла для тем, на которые ссылаются перекрестные ссылки (например, живая при-

рода в ссылке См. также Живая природа). 

Группа параметров Entry Separators (Между элементами) задает символы, разде-

ляющие элементы: 

 Following Topic (После темы): символ, который будет разделителем между тек-

стом элемента и номером страницы (например Цветы  38). По умолчанию ис-

пользуются два пробела. 

 Between Page Numbers (Между номерами страниц): специальный символ для 

отделения одного номера или диапазона страниц от другого. По умолчанию ис-

пользуется запятая с последующим пробелом. 

 Between Entries (Между элементами): если выбран параметр Run-in (Сплош-

ной), здесь вводится специальный символ, который будет отделять элементы от 

вложенных элементов; если выбран параметр Nested (Ступенчатый), этот пара-

метр определяет, как две перекрестные ссылки одного элемента будут отделять-

ся друг от друга. 

 Before Cross-reference (Перед перекрестной ссылкой): специальный символ, 

который будет отделять ссылку от перекрестной ссылки, как в примере Цветы. 

См. также Живая природа. По умолчанию используется точка с последующим 

пробелом. 

 Page Range (Диапазон страниц): специальный символ, который будет разделять 

первый и последний номер страниц в диапазоне страниц (например, Растения 

38–43). По умолчанию используется короткое тире. 

 Entry End (Конец элемента): специальный символ, который будет использо-

ваться в конце элемента. 

По окончании настройки мы получим финальную версию указателя — четко струк-

турированного и легко воспринимаемого (рис. 11.16). 
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Рис. 11.16. Окончательный  
вид указателя 

Управление указателем 

После того как указатель настроен и в документ добавлены маркеры указателя, ука-
зателем можно управлять. Можно просмотреть все темы указателя в книге, удалить 
из списка темы, которые не используются в списке ссылок, найти элементы в спи-
ске Reference или Topic, удалить маркеры указателя из документа и т. д. 

Использование библиотек объектов 

Библиотеки объектов помогают упорядочить часто используемые графические объ-
екты, текст, страницы, направляющие, сетки, рисованные фигуры и сгруппирован-
ные изображения. Библиотек может быть много: для разных типов объектов, для 
разных проектов или заказчиков и т. п. 

Во время сеанса работы можно открыть столько библиотек, сколько поместится 
в памяти компьютера. 

Каждая библиотека в каждый момент времени может быть открыта только одним 
пользователем. Если библиотека включает текстовые файлы, необходимо убедить-
ся, что на всех системах, где она используется, имеются нужные шрифты. 

При добавлении в библиотеку объектов элемента (например, графического объек-

та) InDesign сохраняет все импортированные и примененные атрибуты. Например, 
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если при добавлении из документа InDesign графический объект добавляется  

в библиотеку, то это будет точная копия оригинала, включая информацию о связи, 

что позволяет обновлять графический объект при его изменении. 

Если объект удален из документа InDesign, его миниатюра будет по-прежнему ото-

бражаться в палитре Library (Библиотека), и вся информация о связи также оста-

нется без изменений. Если исходный объект перемещен или удален с диска, при 

помещении объекта в документ рядом с его именем в палитре Links (Связи) поя-

вится значок отсутствующей связи. 

Рассмотрим работу с библиотекой на примере графических элементов, использо-

ванных в проекте "Путеводитель" в главе 9. 

1. Откройте файл chapter9\project_city_guide\city_guide_sample.indd. 

2. Вызовите команду File > New > Library (Файл > Новый > Библиотека). Задайте 

имя и размещение новой библиотеки. Появится палита Library (Библиотека)  

с заданным именем. Добавление объектов со страницы в библиотеку происходит 

простым перетаскиванием (рис. 11.17). 

 

Рис. 11.17. Палитра Library с графическими объектами и текстовым фреймом 

В каждой библиотеке можно искать объекты по названию, дате добавления в биб-

лиотеку или по ключевым словам. Можно также просто просмотреть библиотеку 

объектов, отсортировав элементы в ней или выделяя их подмножества с помощью 

команды контекстного меню Show Subset (Показать подмножество) (рис. 11.18). 

При добавлении элемента в библиотеку объектов InDesign сохраняет все атрибуты 

страницы, текста и изображения и поддерживает взаимосвязи между библиотечны-

ми объектами и другими элементами страницы: 

 элементы, сгруппированные в документе InDesign при перетаскивании в палит-

ру Library (Библиотека), остаются сгруппированными и при перетаскивании 

в обратном направлении; 

 сохраняется форматирование текста; 
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Рис. 11.18. Окно настройки отображения элементов Show Subset 

 стили абзацев, шрифта и объектов, которые имеют те же имена, что и в целевом 

документе, преобразуются к его стилям; те, которые имеют собственные имена, 

добавляются в документ; 

 исходные слои объекта сохраняются, если установлен параметр Paste 

Remembers Layers (Вставить скопированные слои) в меню палитры Layers 

(Слои). 

При закрытии библиотеки она удаляется из текущего сеанса, однако ее файл при 

этом не удаляется. 

В библиотеку можно добавлять и удалять из нее объекты, выделенные страничные 

элементы и целые страницы. Можно также добавлять и перемещать объекты из од-

ной библиотеки в другую. 

Добавление элемента из библиотеки в документ производится перетаскиванием 

объекта из палитры Library на страницу или рабочее поле документа. 
 

Проект "Кодекс Вустеров" 

Рассмотрим процесс создания книги на примере сравнительно болшого произведе-

ния — романа П. Г. Вудхауза "Кодекс Вустеров". Исходный материал — 10 фай-

лов-глав, подготовленных в редакторе Microsoft Word. 

1. Создайте документ со следующими установками: 

 Print; 

 Size = A5; 

 Numbers of Columns = 1; 

 Margins: 

 Inside = 12 mm; 

 Top = 16 mm; 

 Outside = 20 mm; 

 Bottom = 24 mm. 
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2. Задайте простой шаблон, включающий обычные и "плавающие" колонтитулы и 
нумерацию. Дополнительно создайте на его основе шаблон для начальной стра-
ницы главы. Обратите внимание: если вы не рассчитываете начинать новую гла-
ву всегда только с четной или только с нечетной страницы (параметр Page 

Order в диалоговом окне Book Page Numbering Options), во втором шаблоне 
должны быть определены обе страницы разворота. При желании можно вос- 
произвести настройки, предложенные в образце (chapter11\project_j&w\ 
j&w_01.indd), или разработать свои собственные. 

3. Создайте стиль main для основного текста: 

 Basic Character Formats: 

 Font Family = Minion Pro; 

 Font Style = Regular; 

 Font Size = 10 pt; 

 Leading = 12 pt. 

 Advanced Character Formats: Language = Russian 

 Indents and Spacing: 

 Alignment = Left Justify; 

 Align to Grid = All lines. 

4. Создайте стиль tytle для заголовка: 

 General: 

 Based on = main. 

 Basic Character Formats: 

 Font Family = Minion Pro; 

 Font Style = Semibold; 

 Font Size = 14 pt; 

 Leading = 16 pt. 

 Advanced Character Formats: Language = Russian 

 Indents and Spacing: 

 Alignment = Centre; 

 Space After = 25 mm; 

 Align to Grid = None. 

5. В основном тексте, кроме собственно повествования, присутствуют разнообраз-
ные письма и телеграммы — создайте для них стиль, например letter, отличаю-
щийся от основного курсивным начертанием. 

6. Сохраните рабочий файл как шаблон (.indt). 

7. Импортируйте файл jeeves&wooster_01.doc с установкой Remove Styles and 

Formatting from Text fnd Tables (Удалить стили и форматирование текстов и  
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таблиц). Разместите текст в автоматическом режиме (при нажатой клавише 

<Shift>). Сохраните файл как обычный документ под именем j&w_01.indd. 

8. Для каждой очередной главы создайте файл на основе шаблона, импортируйте, 

разместите и отформатируйте текст. 

9. В каждой главе удалите лишние или добавьте недостающие страницы. 

10. Командой File > New > Book (Файл > Новый > Книга) создайте книгу. Задайте 

ей имя (например, jeeves&wooster.indb) и сохраните на жестком диске. 

11. С помощью кнопки <+> в нижней части палитры Book (Книга) включите в кни-

гу все главы. 

12. По умолчанию в книге синхронизируются все возможные параметры, в том 

числе стили и мастер-шаблоны. Командой Synchronise Book (синхронизиро-

вать книгу) контекстного меню палитры Book (Книга) проведите синхрониза-

цию всех входящих в нее документов. Даже если в процессе работы над каж-

дым документом в какие-то стили или мастер-шаблоны были внесены измене-

ния, теперь все элементы книги приведены к единому виду. 

13. Создайте оглавление: 

 Определите стиль TOC_tytle для заголовка оглавления. Он может быть  

основан на стиле tytle и отличаться только кеглем или даже совпадать. 

 Определите стиль ТОС_main для основной части оглавления. Пусть он бу-

дет основан на стиле main и отличается от него двумя настройками: 

 Size = 9 pt; 

 Во вкладке Tab  Leader = ".". 

 В файле последней главы добавьте в конце документа страницу для оглав- 

ления. 

 Вызовите диалоговое окно Layout > Table of Contents (Макет > Оглавле-

ние). 

 Задайте следующие значения настроек (рис. 11.19). 

14. При желании сохраните настройки (кнопка Save Style) — например, под име-

нем j&w. 

15. Нажмите ОК и разместите оглавление. 

16. Обратите внимание, что, поскольку мы разместили оглавление в конце книги, 

оно, в соответствии с отечественной традицией, называется "Содержание".  

Если бы оно было размещено в начале первого документа, оно так и называлось 

бы — "Оглавление". 

Что ж, наша книга практически готова. Осталось отшлифовать расположение тек-

ста на страницах — избавиться от "висячих строк" и проверить расстановку пере-

носов, — добавить иллюстрации, титул и выходные данные, определиться с облож-

кой и утрясти всевозможные организационные вопросы — и можно отдавать макет 

в издательство. 
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Рис. 11.19. Настройки оглавления 

Итоги 

Работа над книгой — дело весьма ресурсоемкое, особенно когда речь идет о маке-

тах сложной верстки — учебниках, толстых журналах, детских книгах со множест-

вом иллюстраций и т. д. В таких случаях публикация объемом более 100 страниц 

становится довольно "неповоротливой" и требует дополнительного времени на вы-

полнение любых команд. В этом случае имеет смысл разделить ее на отдельные 

документы меньшего объема, связанные между собой структурно и стилистически. 

Каждый документ будет достаточно компактен для быстрой обработки, работать с 

ними можно будет как одному верстальщику, так и группе, что в целом заметно 

ускорит работу. 

Для дополнительной практики рекомендуется создать свою собственную крупную 

книгу, уделяя особое внимание структурным элементам и оглавлению. 

1. Создайте отдельные текстовые файлы с главами книги. 

2. Создайте файл публикации для первой главы и сохраните его предустановки для 

использования в других главах. 

3. Задайте простой шаблон, включающий обычные и "плавающие" колонтитулы и 

сквозную нумерацию. 

4. Создайте стили для основного текста и заголовков в необходимом количестве. 
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5. Сохраните рабочий файл как шаблон. 

6. Разместите и отформатируйте текст. Сохраните файл как обычный документ. 

7. Для каждой очередной главы создавайте файл на основе шаблона. 

8. Подготовив таким образом основу, сверстайте каждую главу. 

9. Создайте книгу, включив в нее все документы-главы. 

10. Создайте оглавление. 

Удачи! 
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Глава 12 
 

 

ЭФФЕКТЫ И ХИТРОСТИ 

 

 

 

 
 
В этой главе вы узнаете: 

 как применять стандартные эффекты программы; 

 как разместить текст вдоль фигурной линии; 

 как создать макет с текстом на двух языках; 

 как поместить картинку во фрейм сложной формы — например, сделать ее про-
свечивающей сквозь буквы; 

 как определить части страницы, которые при печати будут покрыты лаком. 

Стандартные эффекты 

Для придания макету большей выразительности InDesign предлагает довольно ши-
рокий набор специальных эффектов. Один из них — градиентную растушевку — 
мы уже использовали в проекте "Путеводитель". Остальные эффекты также связа-
ны с прозрачностью. Разумеется, пользоваться ими нужно с осторожностью, помня, 
что прозрачность — одно из самых сложных для печати свойств объекта. Тем не 
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менее разумное использование эффектов может заметно усилить впечатление от 
макета. 

Доступ к стандартным эффектам происходит через палитру Effects (Эффекты), ко-

торая вызывается кнопкой fx на Контрольной панели (рис. 12.1). 

 

Рис. 12.1. Диалоговое окно Effects 

Для работы со стандартным эффектом нужно выделить объект и в диалоговом окне 

Effects выбрать область применения эффекта: Entire Object (Весь объект), Fill  

(Заливка) или Stroke (Обводка). Затем в списке эффектов выбрать нужный и перей-

ти к его настройкам двойным щелчком по его строке. 

 Drop Shadow (Падающая тень): добавляет тень позади выбранного элемента 

объекта. Для тени настраивается угол падения, смещение по обеим осям, цвет, 

прозрачность, режим наложения и степень растушевки (рис. 12.2). 

 Inner Shadow (Внутренняя тень): действует аналогично падающей тени, но рас-

полагается внутри объекта. 

 

Рис. 12.2. Эффект Drop Shadow 
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 Outer Glow и Inner Glow (Внешнее и внутреннее свечение): создает эффект 
светящихся границ, соответственно, внутрь объекта или наружу (эффект  
контражура). Настраиваются цвет, плотность, режим наложения, способ задания 
свечения и ширину светящейся области (рис. 12.3). 

 

Рис. 12.3. Эффект Outer Glow 

 Bevel and Emboss (Выдавливание и Рельефы): имитирует объем — в зависимо-
сти от настроек это может быть "выпуклость" или "вдавленность". Настраива-
ются область рельефности (внутри или снаружи), тип рельефа (выпуклый или 
вдавленный), жесткость боковых граней и глубина рельефа, угол освещения, 
цвета для освещенных и затемненных граней, режимы наложения и плотность 
света и тени (рис. 12.4). 

 

Рис. 12.4. Эффект Bevel and Emboss 

 Satin (Шелк): имитация шелковистой поверхности. Настраиваются цвет, режим 
наложения и плотность наложенных теней, их размещение и размеры (рис. 12.5). 

 Basic Feather, Directional Feather, Gradient Feather (Обычная растушевка, На-
правленная растушевка, Градиентная растушевка): смягчает границы объектов 
за счет плавного перехода к прозрачности (рис. 12.6). 
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Рис. 12.5. Эффект Satin 

 

Рис. 12.6. Эффект Directional Feather 

Основные параметры эффектов, связанных с прозрачностью: 

 Angle and Altitude (Угол и интенсивность) — угол падения света и его интен-

сивность. Для того чтобы угол освещенности был единым для всех объектов, 

нужно установить флажок Use Global Light (Использовать глобальное освеще-

ние); 

 Blending Mode (Режимы наложения) — определяет взаимодействие цвета, ис-

пользованного в настройках эффекта, с цветами нижележащих объектов. Чаще 

всего для теней используется режим Multiply (Суммирующее затемнение), а для 

освещенных участков — Screen (Суммирующее осветление); 

 Choke (Повышенная плотность) — определяет область вокруг объекта, в кото-

рой эффект сохраняет максимальную плотность. В сочетании со значением поля 

Size (Размер) задает степень жесткости цветового перехода; 

 Distance (Сдвиг) — определяет сдвиг результата применения эффекта относи-

тельно объекта — например, для эффекта Drop Shadow; 

 Noise (Шум) — задает "зашумление" цветового перехода мелкими частицами, 

расположенными случайным образом. 
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 Opacity (Плотность) — степень непрозрачности стартовой области цветового 
перехода. Используется обычно в сочетании с подходящим режимом наложения; 

 Size (Размер) — определяет ширину цветового перехода; 

 Technique (Способ применения эффекта) — имеет два значения: Softer (Мягкий 
переход) и Precise (Точный переход). Первое создает более мягкие, размытые 
границы, второе четко очерчивает область применения эффекта; 

 Offset (Смещение) — задает смещение эффекта относительно объекта по коор-
динатным осям. 

Для правильной обработки эффектов, связанных с прозрачностью, при выводе ма-
кета на печать нужно задать параметры сведения прозрачности: Edit > Trans-
parency Flattener Presets (Редактирование > Настройки сведения прозрачности). 
Для полиграфического воспроизведения нужно выбрать набор установок High 
Resolution (Высокое разрешение). В нижней части диалогового окна выводится 
описание набора установок (рис. 12.7). 

 

Рис. 12.7. Диалоговое окно Transparency Flattener Presets 

Размещение текста вдоль контура 

InDesign, как и многие другие графические программы, позволяет располагать 
текст вдоль контура. Контуры могут быть созданы различными способами, но чаще 
всего — инструментами Pen (Перо) или Pencil (Карандаш). Текст вдоль контура 
размещается инструментом Type on a Path (Текст по контуру), находящимся под 
кнопкой инструмента Туре (Текст) в панели инструментов. 

Нарисуйте контур (например, инструментом Pen) и поднесите к нему инструмент 
Type on a Path (Текст по контуру). В момент, когда у курсора появится знак плюса, 
можно щелкнуть мышью на контуре (появится мигающий текстовый курсор) и на-
чать ввод текста (рис. 12.8). 

Введенный текст можно выделять инструментом Туре и редактировать, как обыч-
ный текст, а контур — редактировать с помощью инструмента Direct Selection 
(Частичное выделение — белая стрелка). 
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Рис. 12.8. Ввод текста вдоль контура 

Текст вдоль контура размещается в особом "строчном" фрейме вдоль контура, 
имеющем привычную структуру: маркер входа и маркер выхода (рис. 12.9). 

 

Рис. 12.9. Структура фрейма текста вдоль контура 

Как и всякий текстовый фрейм, текст вдоль контура может переполниться и обра-
зовать вытесненный текст. 

Как с этим бороться? 

 Выделить контур инструментом Direct Selection и увеличить его, передвигая 
опорные точки. Появляется дополнительное пространство для размещения  
текста. 

 Поднести инструмент Direct Selection к правой вертикальной линии, символи-
зирующей границу текстового фрейма, и сдвигать ее вдоль контура, пока не 
пропадет знак переполнения (рис. 12.10). 

 

Рис. 12.10. Удлинение фрейма вдоль контура 

Перемещение начальной границы фрейма позволяет сдвинуть весь текст вдоль кон-
тура. 

Дополнительные настройки текста вдоль контура находятся в меню Туре > Type on 
a Path > Options (Текст > Текст по контуру > Настройки) (рис. 12.11). 
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Рис. 12.11. Диалоговое окно Type on a Path Options 

Поле Effect определяет положение символов по отношению к контуру. Обычное 

расположение — Rainbow (буквы перпендикулярны контуру), но возможны и дру-

гие варианты настроек, дающие интересные результаты (рис. 12.12). 

 

Рис. 12.12. Результат применения разных значений поля Effect 

Поле Alignment (Выравнивание) определяет взаимное расположение текста и кон-

тура: текст точно на контуре (Baseline), выше ("по нижним выносным элемен-

там" — Descender), ниже ("по верхним выносным элементам" — Ascender) или по 

центру (Centre). 
 

Билингва 

Говоря о создании документов и настройке мастер-шаблонов, мы обращали внима-

ние на такой объект, как мастер-фрейм — текстовый фрейм на мастер-шаблоне. 

Он исключительно полезен для размещения импортированного текста в автомати-
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ческом режиме, но, кроме того, он предоставляет и другие интересные возмож- 

ности. 

Давайте рассмотрим издание, в котором текст размещен в две колонки: левая — на 
иностранном языке, правая — на русском языке. Исходные тексты хранятся в двух 
разных файлах и импортируются по отдельности. Наиболее удачное решение такой 
задачи предоставляет мастер-фрейм. 

1. Создайте документ класса Print: 

 Size = А5; 

 3 страницы; 

 Margin-Inside = 12 mm; 

 Margin-Top = 15 mm; 

 Margin-Outside = 18 mm; 

 Margin-Bottom = 20 mm; 

 Number of Columns = 2. 

2. В данном случае создавать мастер-фрейм одновременно с документом не стоит, 
лучше задать его прямо в шаблоне. 

3. Мы будем размещать кусок пьесы, поэтому имеет смысл сразу создать стили 
для основного текста, персонажей и ремарок. Для быстроты процесса можно 
загрузить стили из проекта "Обыкновенное чудо" (контекстное меню палитры 
Paragraph Styles > Load All Text Styles > Chapter8\project_shwarts\shwarts_ 
sample.indd). 

4. Перейдите на мастер-шаблон. Задайте номера страниц и, при желании, допол-
нительное оформление. 

5. Создайте текстовые фреймы в каждой колонке разворота (в общей сложности 
4 фрейма). 

6. Щелчком по выходному маркеру левого фрейма на левой странице разворота и 
по входному маркеру левого фрейма на правой странице разворота свяжите эти 
фреймы. 

7. Повторите операцию для правых фреймов. 

8. Должны получиться две пары связанных фреймов (рис. 12.13). 

9. Перейдите на страницу 1. 

10. Импортируйте файл Chapter12\Chess_en.doc. Щелчком в левой колонке при на-
жатой клавише <Shift> разместите текст в автоматическом режиме. Программа 
добавит необходимое количество страниц и  расположит текст в левых ко- 
лонках. 

11. Проделайте аналогичную операцию для файла  Chapter12\Chess_ru.doc. Русский 
текст разместится в правых колонках. 

12. Теперь осталось только присвоить стили элементам текста, и наша билингва 
будет выглядеть вполне презентабельно (рис. 12.14). 
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Рис. 12.13. Две пары связанных фреймов на мастер-шаблоне 

 

Рис. 12.14. Результат форматирования билингвы 

 

Существует технически более простой способ работы с билингвой, подходящий 

для изданий небольшого формата: заливка разноязычными текстами соседних 

страниц (например, левая страница — на русском языке, правая — на иностран-

ном). В этом случае при создании документа устанавливается флажок Master Text 

Frame, а количество колонок задается равным 1. На мастер-шаблоне нужно "развя-

зать" изначально связанные фреймы (такими же точно щелчками по выходному и 

входному маркерам). Фреймы на соседних страницах станут независимыми друг от 

друга и выстроят каждый свою последовательность страниц. 
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Создание области лакировки 

Рассмотрим задачу создания макета, часть которого при печати должна быть по-

крыта лаком. Лаковое покрытие делается с отдельной печатной формы, в качестве 

краски для нее выбирается плашечный цвет. 

1. Создайте документ класса Print: 

 Size = 170 90 mm; 

 1 страница; 

 Margins = 5 mm со всех сторон; 

 Bleeds = 5 mm. 

2. Нарисуйте черный прямоугольник во весь размер документа (границы прямо-

угольника должны совпадать с границами припусков под обрез). 

3. Импортируйте файл Chapter12\Lilia.tif. В этом файле уже имеется созданный  

в Photoshop обтравочный контур, который будет автоматически применен при 

импорте. 

4. Создайте новый слой, назовите его "Лакировка" или каким-то подобным обра-

зом. 

5. Скопируйте импортированное изображение и вставьте его на новый слой  

командой Edit > Paste in Place (Редактирование > Поместить на то же место). 

6. Преобразуйте обтравочный контур во фрейм: Object > Clipping Path > Convert 

Clipping Path to Frame (Объект > Обтравочный контур > Преобразовать обтра-

вочный контур во фрейм). 

7. Щелчком на полупрозрачном круге в центре им-

портированного изображения переносим фокус  

с фрейма на фотографию и удаляем ее. На слое 

"Лакировка" остается только контур (рис. 12.15). 

 
 
 
 
 

 

Рис. 12.15. Палитра Layers  
с базовым слоем и слоем "Лакировка" 

 

 

8. Создайте новый образец в палитре Swatches (Образцы): в окне свойств образца 

в поле Colour Mode (Цветовая модель) выберите Pantone Solid Coated (цвет из 

библиотек Solid будет добавлен к печатным формам как дополнительная крас-

ка). В списке образцов  выберите цвет по своему вкусу. 

9. Задайте контуру на слое "Лакировка" заливку вновь созданным цветом и на-

значьте ему атрибут Overprint Fill: Window > Output > Attrbutes  (Окно > Вы-

вод > Атрибуты) (рис. 12.16). 
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Рис. 12.16. Контур, залитый Spot (плашечным) цветом и с атрибутом Overprint 

10. Откройте палитру Separations Preview: Window > Output > Separations 

Preview (Окно > Вывод > Просмотр цветоделения). К четырем основным крас-

кам добавилась пятая — PANTONE. В сопроводительных документах к публи-

кации надо будет указать, что эту печатную форму нужно печатать UF-лаком. 

11. Включите просмотр наложений: View > Overprint Preview (Вид > Просмотр 

наложений) для проверки совпадения изображения и лакировки. 

12. Предположим, что фотография на нижнем слое должна быть напечатана вся, а 

лакированная область ограничена контуром. Для того чтобы отобразить фото- 
 

 

 

Рис. 12.17. Фотография и область лакировки на ней 
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графию целиком, надо выделить ее (например, щелчком по квадратику в строке 
изображения в палитре Layers) и вызвать настройки обтравочного контура: 
Object > Clipping Path > Options (Объект > Обтравочный контур > Настрой-
ки). В выпадающем списке типов контура выбираем None (Без обтравки).  
Теперь мы имеем полностью видимую фотографию, часть которой при печати 
будет покрыта лаком (рис. 12.17). 

13. Выделите одновременно фотографию и лакировочный контур и разместите на 
макете, как показано на образце (Chapter12\uf_sample.indd). 

Маскирование изображения текстом 

После того как текст переведен в контуры (Type > Create Outlines), он может слу-
жить фреймом, например, для импортированного изображения. 

1. Создайте текстовый фрейм. Наберите слово SUMMER и выберите для него ка-
кой-нибудь крупный, "тяжелый" шрифт (например, Impact). Задайте кегль 36 pt. 

2. Преобразуйте текст в контур (Type > Create Outlines). 

3. Выделите получившийся объект и импортируйте файл chapter12\apples.tif. Изо-
бражение разместится в объекте, как в обычном фрейме. Двойным щелчком на 
содержимом фрейма его можно выделить и переместить или как-то иначе 
трансформировать при необходимости (рис. 12.18). 

 

Рис. 12.18. Размещение импортированного изображения во фрейме, созданном на базе надписи 

4. Для размещения в новом фрейме заранее импортированного изображения ис-
пользуется способ, который мы рассматривали при создании обтравочного кон-
тура: 

 Выделить изображение и вырезать его (Cut — <Ctrl>+<X>). 

 Выделить фигурный фрейм. 

 Вставить изображение командой Edit > Paste Into (Редактирование > Вста-
вить внутрь). 

5. Разверните полученное маскированное изображение на 90° и поместите на тем-
ном поле в левой части макета. 
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Проект "Рекламный каталог" 

В этом проекте мы по возможности применим все рассмотренные алгоритмы, кро-

ме, разве что, билингвы. 

1. Создайте файл класса Print: 

 8 страниц; 

 Size = 120 210 mm; 

 Number of Columns = 1; 

 Margin-Inside = 10 mm; 

 Margin-Top = 90 mm; 

 Margin-Outside = 15 mm; 

 Margin-Bottom = 14 mm; 

 Bleeds = 5 mm. 

2. Откройте файл Chapter12\Project_catalog\Catalog_sample.indd и используйте его 

в качестве образца. 

3. На первой и последней страницах нарисуйте черные прямоугольники во весь 

размер страницы, включая припуски под обрез. 

4. На страницы 2 и 3 импортируйте файлы home_office_left.tif и home_office_ 

right.tif. Разместите их на страницах в качестве фоновых изображений. Обрати-

те внимание, что края изображений должны совпасть с краями припусков под 

обрез. Припуски по линии сгиба (середина разворота) уберите за счет передви-

жения границы фрейма. 

5. Аналогично импортируйте и разместите на страницах 4—5 файлы style_left и 

style_right. 

6. На расстоянии 85 мм от верхнего края страницы на всех внутренних разворотах 

проведите горизонтальные линии и задайте им стиль "двойная, 3 pt". Назначьте 

линиям на стр. 2—3 и 4—5 белый цвет, на стр. 6—7 — черный. 

7. Импортируйте в свой документ текстовые стили из файла-образца (контекстное 

меню палитры Paragraph Styles > Load All Text Styles > Chapter12\project_ 

catalog\catalog_sample.indd). 

8. Основа подготовлена. 

9. Импортируйте файл Samsung_white.eps и разместите на первой и последней 

страницах по образцу. 

10. На последнюю страницу добавьте интернет-адрес www.samsung.ru. 

11. На первую страницу импортируйте файл 11_Monitor_explanationImg.tif и раз-

местите по образцу. 
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12. Создайте область лакировки: 

 Создайте слой "Лакировка". 

 Скопируйте изображение и вставьте его на новый слой командой Edit > 

Paste in Place (Редактирование > Вставить на то же место). 

 Преобразуйте обтравочный контур во фрейм (Object > Clipping Path > 

Convert Clipping Path to Frame). 

 Удалите изображение, оставив только контур. 

 Создайте в палитре Swatches образец Spot-цвета из библиотеки PANTONE 

Solid Coated. 

 Назначьте контуру заливку созданным цветом и атрибут Overprint (Win-

dow > Output > Attributes > Overprint Fill). 

 Включите Overprint Preview (View > Overprint Preview) для просмотра ре-

зультата. 

13. К изображению на нижнем слое примените эффект Outer Glow (fx на Кон-

трольной панели > Выбрать в списке Outer Glow) со стандартными настройка-

ми (при желании поэкспериментируйте со значениями параметров и подберите 

более интересное их сочетание). 

14. На стр. 2 импортируйте файл bx2240_front.tif и расположите по образцу. 

15. Создайте область лакировки аналогично стр. 1. Проверьте, чтобы лакировоч-

ный контур лежал на слое "Лакировка". 

16. На стр. 5 импортируйте файл bx2335-04.tif. Расположите по образцу и создайте 

область лакировки. 

17. На стр. 6 импортируйте файл MD230X6_feature05.tif. Расположите по образцу и 

создайте область лакировки. 

18. На стр. 7 импортируйте файл x6_right.tif и разместите по образцу. 

Теперь займемся текстом. 

19. На стр. 1 импортируйте файл samsung_all.doc. Примените стили и разместите 

части текста по страницам, ориентируясь на образец. 

20. На стр. 2 инструментом Pen (Перо) создайте дугообразный контур и с по- 

мощью инструмента Type on a Path (Текст по контуру) наберите вдоль него 

надпись "Для дома и офиса". Примените к нему стиль Tytle2 и увеличьте кегль 

до 24. 

21. На стр. 5 инструментом Pen (Перо) создайте контур, соответствующий рисунку 

волны на фоновом изображении. С помощью инструмента Type on a Path 

(Текст по контуру) наберите вдоль него надпись "Стильные решения". Приме-

ните к нему стиль Tytle2 и увеличьте кегль до 24. 

22. На стр. 2—3 импортируйте файл BX2240 LED.doc. Примените стили и распо-

ложите по образцу. 
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23. На стр. 4—5 импортируйте файл BX2335 LED.doc. Примените стили и распо-

ложите по образцу. 

24. На стр. 6—7 импортируйте файл md230x6.doc. Примените стили и расположите 

по образцу. 

25. Проверьте, чтобы все лакировки лежали на одном слое, а весь остальной мате-

риал — на другом. С помощью палитры Separations Preview убедитесь, что для 

лакировки создана дополнительная краска. 

26. Традиционное финальное действие перед сдачей макета в типографию — пере-

вод текста в контуры. 

Каталог — публикация, с одной стороны, жестко структурированная и требующая 

очевидной преемственности всех элементов, с другой — дающая некоторую свобо-

ду творчества в деталях, что и было использовано при подготовке этой публикации. 
 

 

Итоги 

В этой главе мы рассмотрели возможности программы, на первый взгляд, не обяза-

тельные, но придающие нашим макетам некую дополнительную "изюминку".  

У каждого опытного верстальщика есть своя "копилка секретов" — алгоритмов, 

придающих индивидуальность его работам, своего рода "фирменный стиль".  

Вы тоже по мере накопления опыта будете находить новые и интересные способы 

решать поставленные перед вами задачи. Запоминайте свои находки, записывайте 

их и используйте по мере необходимости: превратив рутинные операции в тех- 

нологию, вы освободите себе время и создадите настроение для настоящего твор-

чества! 
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Глава 13 
 

 

ОСОБЕННОСТИ  

ПЕЧАТНЫХ ПУБЛИКАЦИЙ 

 

 

 
 
В этой главе вы узнаете: 

 какие основные правила надо соблюдать при подготовке публикации к печати; 

 как проверить, нет ли в макете ошибок; 

 как правильно подготовить публикацию к передаче в типографию; 

 как сделать "виртуальную контрольную распечатку"; 

 как записать и проверить PostScript-файл (файл, готовый к обработке принтером 

или устройством фотовывода). 

Перед началом работы с материалом этой главы установите в системе виртуальный 

PostScript-принтер: 

1. В Панели управления системы найдите вкладку Принтеры и факсы (для 

Windows 7 — Устройства и принтеры). 

2. Выберите команду Установить принтер. 
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3. Из возможных вариантов установки выберите Установить локальный прин-

тер, в списке портов — File (Файл). 

4. Если в списке доступных драйверов вашей системы есть драйвер Scitex Dolev, 

выберите его (любую модель, в имени которой есть пометка L2 — уровень язы-

ка PostScript). 

5. Если такого драйвера в списке нет, нажмите кнопку Установить с диска и в от-

крывшемся окне выберите на компакт-диске папку Chapter13\driver. Откроется 

список из двух версий драйвера — для 32-битной системы и для 64-битной.  

Выберите тот, который соответствует системе, установленной на вашем компь-

ютере. 

Что необходимо учитывать,  
готовя публикацию к печати? 

Один из самых важных этапов работы над макетом — подготовка к печати. Именно 

в этот момент определяется, будет ли готовый печатный продукт выглядеть именно 

так, как его задумал дизайнер. Поэтому очень важно внимательнейшим образом 

проверить нашу верстку на наличие ошибок. 

Ошибки бывают двух видов: 

 нарушение общепринятых правил подготовки макета; 

 невыполнение конкретных требований типографии. 

Бо́льшая часть ошибок первого вида отыскивается и исправляется с помощью  
автоматических средств проверки макета. 

Ошибки второго вида — всегда результат недостаточного взаимопонимания дизай-

нера и работников типографии. 

 

 

  

Начиная подготовку к печати, обязательно свяжитесь с типографией и выясните ее технические требо-
вания. Постарайтесь получить файлы драйвера печатной машины и цветового профиля — это поможет 
правильно настроить цвета в макете и даст гарантию правильного вывода печатных файлов. 
 

 

Есть также несколько важных моментов, на которые необходимо обращать особое 
внимание в любом случае. 

 Размер страницы, указанный в программе верстки, должен точно соответст-
вовать окончательному обрезному формату издания. При этом предусматрива-

ется запас на обрез 2–5 мм (Bleed): все элементы макета, вплотную прилегаю-

щие к краю страницы, должны быть увеличены и выведены за край на это рас-
стояние. 

 Один из основных параметров печатного процесса — линиатура растра (опре-
деляет размер точек на цветных формах, сочетание отпечатков с которых и соз-

дает цветное пятно на бумаге). Средняя линиатура, которую могут обеспечить 
современные печатные машины — около 150 lpi (линий на дюйм). 
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Достаточным разрешением растровых изображений считается значение линиа-
туры, умноженное на 1,5 (например, для издания, которое печатается с линиату-
рой растра 150 линий на дюйм, достаточным разрешением изображения будет 
225 ppi). На сегодня считается разумным увеличивать разрешение растровых 
изображений до удвоенной линиатуры (т. е. до 300 ppi), но повышать разреше-
ние сильнее не имеет смысла: это никак не влияет на качество изображения, а 
лишь загружает процессор машины. 

 Разрешение штриховых (строго черно-белых) изображений должно быть в пре-
делах от 600 до 1200 ppi, потому что при меньшем разрешении в штриховых 
изображениях становятся видны зазубренные края линий и объектов. 

 Все цветные растровые изображения должны быть переведены в цветовое про-
странство CMYK. Все черно-белые растровые изображения сохраняются в цве-
товой модели Grayscale, а все штриховые изображения — в цветовом простран-
стве Bitmap (Строго черно-белое). 

 Оптимальные форматы графических файлов  — TIFF, PSD, AI, PDF или EPS. 

 К файлу с версткой прилагаются использованные в документе шрифты и пол-
ный набор иллюстраций. Для упрощения подготовки набора шрифтов и иллюст-
раций используется команда Package (Упаковка), собирающая все необходимое 
в специально создаваемых для этого папках. 

 Из палитры Swatches нужно удалить все неиспользованные цвета с помощью 
команды Select All Unused (Выбрать неиспользуемые) и проверить, чтобы ос-

тавшиеся образцы были цветами CMYK, если не предусмотрена печать специ-
альными красками из библиотек PANTONE. 

 Линии и контуры должны быть толщиной не менее 0,25 pt, поскольку иначе они 

могут получиться с разрывами или вообще не пропечататься. 

Шрифты 

Шрифт — один из самых важных и капризных элементов макета. Современные 

программы верстки чрезвычайно чувствительны к качеству шрифтов и требуют 
очень внимательного к ним отношения. 

Шрифты, используемые в полиграфии, обычно принадлежат к одному из двух ос-
новных форматов: TrueType и PostScript. 

PostScript-шрифты описаны на языке PostScript (языке описания страниц в настоль-

ных издательских системах), чем выгодно отличаются от более раннего способа 
записи — TrueType, который медленно, но верно теряет позиции в печатной инду-

стрии. Современный стандарт PostScript-шрифтов — Open Type — имеет расши-
ренную кодовую таблицу, позволяющую описать в рамках одного шрифтового 

файла множество дополнительных знаков, вплоть до существования в одном 
шрифтовом файле всех основных мировых алфавитов (латинского, кириллическо-

го, арабского и т. д.). 

PostScript-шрифты состоят из двух (в общем случае) файлов (файла начертания, 

имеющего расширение pfb, и файла метрик, имеющего расширение pfm). Для кор-
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ректной печати публикации нужно предоставить в типографию обе шрифтовые 

компоненты. 

 

 

  

Существует множество разнообразных проблем, возникающих из-за использования некачественных 
шрифтов, начиная от неверного отображения отдельных литер и межбуквенных расстояний и заканчи-
вая наличием в типографии шрифта с тем же названием, но заметно отличающимся рисунком букв. Для 
защиты от этих и других неожиданностей постарайтесь использовать только проверенные шрифты; в 
идеале вся шрифтовая библиотека вашего компьютера должна состоять исключительно из лицензион-
ных шрифтов надежных производителей — например, "ПараТайп" или "Леттерхед". 
 

 

Проверка и работа над ошибками верстки 

Большинство ошибок, серьезно влияющих на качество печати, сводится к сравни-

тельно небольшому списку. Это потеря связи с изображением, вставленным в пуб-

ликацию, неправильная цветовая модель, потерянный шрифт, вытесненный 

текст и т. д. Для автоматической проверки публикации на такие ошибки служат 

команды Preflight (Предпечатная проверка) и Package (Упаковка). 

Команда Preflight (Предпечатная проверка) доступна постоянно в окне документа, 

и при появлении особенно грубых ошибок — таких, как потеря связи с изображе-

нием или пропажа шрифта, — в ее микроокне появляется красный сигнал и сооб-

щение об ошибке. Двойной щелчок по сообщению вызывает окно Preflight, в кото-

ром находится описание ошибки и информация о ее расположении в документе. 

Переход по ссылке в окне Preflight приведет вас к месту ошибки, чтобы вы могли 

оперативно ее исправить (см. рис. 3.21 и 3.22). 

Команда Package (Упаковка) вызывается из меню File > Package (Файл > Упако-

вать) (рис. 13.1). 

Эта команда предоставляет общие сведения о документе или структурном списке 

публикаций (book) на первой вкладке Summary. При обнаружении ошибок возле 

соответствующей строки появляется желтый треугольник с восклицательным зна-

ком — сигнал о проблеме. Расшифровку сигнала можно найти на соответствующей 

вкладке. 

 Fonts (Шрифты). Здесь можно увидеть полный список шрифтов, использо-

ванных в документе или документах, если речь идет о проверке книги. Указы-

ваются даже шрифты, внедренные в EPS-, AI- и PDF-файлы, и проверяется на-

личие необходимых для правильного отображения документа шрифтов (рис. 13.2). 

Включив флажок Show Problems Only (Показывать только проблемы), вы уви-

дите только сведения о найденных ошибках. Информация общего характера по-

казываться в этом случае не будет. 

Missing Fonts — шрифты, которые используются в публикации, но не уста-

новлены на данном компьютере. Это одна из самых частых ошибок — пользова-

тель забывает, что набор шрифтов, имеющихся у него, может отсутствовать на 

других машинах. Если при проверке документа вы получаете сообщение о поте- 
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Рис. 13.1. Окно команды Package 

 

Рис. 13.2. Вкладка Fonts 

 

 

рянных шрифтах (missing fonts), то обязательно должны на это отреагировать, 

поскольку это очень серьезная проблема. Следует либо установить недостаю-

щий шрифт на компьютер, на котором вы просматриваете документ, либо вы-

полнить замену шрифта. Самым удобным способом выполнения замены шрифта 

в документе является использование команды Find Font  (Найти шрифт). Ее 

можно вызвать, нажав кнопку Find Font на вкладке Fonts. Она работает по 



294 Глава 13 

принципу автозамены, т. е. выполняет во всем документе поиск и замену ука-

занного шрифта. 

При получении сигнала о потере шрифта: 

 нажмите кнопку Find Font (Найти шрифт); 

 в диалоговом окне (рис. 13.3) выберите из списка Fonts in Document (Шриф-

ты документа) имя шрифта, который надо заменить; 

 внизу диалогового окна из списка Replace With (Заменить на...) выберите 

шрифт, который будет использоваться вместо проблемного; 

 нажмите кнопку Find First (Найти первый), затем кнопку Change Аll (Заме-

нить все). 

 

Рис. 13.3. Окно замены шрифтов 

Замена шрифтов может производиться не только с помощью команды Package. 

Как самостоятельная команда она может быть вызвана из меню Type > Find 

Font (Текст > Найти шрифт). 

 Links and Images (Изображения и связи). Эта вкладка предоставляет информа-

цию обо всех изображениях, размещенных в документе или книге (рис. 13.4). 

Для того чтобы увидеть дополнительную информацию о каждом изображении, 

нужно выделить в списке пункт, соответствующий этому изображению. Если  

с ним имеются какие-либо проблемы (потеряна связь, были измененения после 

вставки в верстку, неправильная цветовая модель), то исправить их можно с по-

мощью кнопок, появляющихся в этом диалоговом окне. Название кнопки зави-

сит от типа проблемы. Например, если изображение было изменено после встав-

ки в верстку и связь с ним нуждается в обновлении, мы увидим кнопку Update. 

Кнопка Repair All позволяет обновить связь сразу со всеми проблемными изо-

бражениями. 
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Рис. 13.4. Вкладка Links and Images 

 

При обнаружении изображений в цветовой модели RGB их нужно конвертиро-

вать в CMYK в программе редактирования изображений (Например, Photoshop) 

и обновить связь. 

 Colors and Inks (Цвета и краски) — информация об использованных цветах и 

настройке печатных форм. Здесь же отображаются дополнительные плашечные 

цвета, если планируется использовать их при печати. 

 Print Settings — информация о настройках печати. 

 External Plug-ins — использованные внешние модули, если имеются. 
 

Упаковка файлов публикации  
для типографии 

Команда Package (Упаковка) позволяет после проверки документа выполнить 

сборку (package) всех необходимых для отправки в типографию материалов. К ним 

относятся шрифты, изображения и сам файл публикации. 

Собственно команда упаковки Package вызывается соответствующей кнопкой диа-

логового окна Package. Первое, что надо сделать при вызове этой команды, — за-

полнить электронную форму, на основе которой будет создан текстовый файл с со-

проводительной информацией (что нужно напечатать, как вас найти и т. д.). 

Далее следует только указать место на диске, где нужно сохранить папку со всеми 

материалами публикации. В папке будет находиться последняя версия файла пуб-

ликации и две подпапки — Document Fonts (Использованные шрифты) и Links 

(Связанные изображения). 
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Просмотр  
результатов цветоделения (Separations Preview)  
и наложения цветов (Overprint Preview) 

При подготовке к печати очень важно контролировать количество краски, попа-

дающей на каждый участок бумаги. Для этого служат палитра Separations Preview 
(Просмотр результатов цветоделения) (рис. 13.5) — Window > Output > 

Separations Preview (Окно > Вывод > Просмотр результатов цветоделения) и  
команда Overprint Preview (Просмотр наложения цветов) — View > Overprint 

Preview (Вид > Просмотр наложения цветов). 

 

Рис. 13.5. Палитра  
Separations Preview в режиме 

Separations 

Палитра Separations Preview показывает, сколько какой краски (в процентах) на-

носится на ту или иную точку страницы. Каждая типография непременно указывает 
в технических условиях предельно допустимую сумму процентов красок, при пре-

вышении которой возможно ухудшение качества печати и даже разрыв бумаги. Для 
выявления участков с превышением предела по сумме красок палитра Separations 

Preview переводится в режим Ink Limit (Предельная сумма красок) и в поле суммы 
ставится значение, полученное от типографии. Все участки макета, на которых об-

щее количество краски больше установленного предела, выделяются красным цве-
том (рис. 13.6). 

 

Рис. 13.6. Палитра Separations Preview в режиме Ink Limit 
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Команда Overprint Preview показывает взаимодействие цветов перекрывающихся 

объектов. Обычно у перекрывающихся объектов при печати скрытые участки  

нижнего объекта вырезаются, и остается только видимая часть изображения 

(рис. 13.7). 

В этом есть своя опасность: при малейшем смещении пленок относительно друг 

друга по краям цветовых пятен могут появиться пробелы — участки незапечатан- 
 
 

 

 

  

Рис. 13.7. Схема обычного вазимодействия 
перекрывающихся объектов 

Рис. 13.8. Объект с атрибутом  
Overprint 

 

ной бумаги. Поэтому для тонких контуров, мелких текстов и т. п. деталей, чаще 

всего имеющих черный цвет, обычно устанавливается атрибут Overprint (Наложе-

ние) — Window > Output > Attributes > Overprint (Окно > Вывод > Атрибуты > 

Наложение). В этом случае цвет этого объекта будет печататься поверх остальных 

(рис. 13.8). 

При правильном использовании этот атрибут исключительно полезен, но если слу-

чайно присвоить его обычному цветному объекту, это может сыграть с нами злую 

шутку. Верхний цвет смешается с нижним, и в результате напечатается совсем не 

то, что ожидалось (рис. 13.9). Например, "очень эффектно" выглядит белый лого-

тип с атрибутом Overprint на черном фоне (реальный пример из практики, в таком 

виде предоставляет для работы свой логотип одна крупная фирма — производитель 

компьютерных комплектующих). 

 "Электронная контрольная распечатка"  
в формате PDF 

Электронная контрольная распечатка в формате PDF служит для проверки верстки 

как на механические (расположение элементов, потери связей), так и на цветовые 

ошибки (превышение предела суммы красок, потенциально опасные цветовые ре-

шения — например, составной черный цвет у мелкого текста и т. д.). Сегодня мно-

гие печатники принимают в работу готовый макет прямо в виде файла PDF, не тре- 
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Рис. 13.9. Команда Overprint Preview и результат смешения цветов перекрывающихся объектов 

 

Рис. 13.10. Окно экспорта в PDF 

- 
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буя отдельно публикацию и файл PostScript, но это встречается далеко не всегда и 

требует обязательного уточнения в вашей типографии. 

Файл PDF может быть создан из публикации двумя путями: 

 из PostScript-файла с помощью программы Adobe Distiller (мы рассмотрим ее 

чуть ниже); 

 прямо из публикации с помощью команды меню File > Export (Файл > Экспорт). 

При экспорте в выпадающем списке типов файла нужно выбрать Adobe (Print). 

Откроется диалоговое окно экспорта в PDF (рис. 13.10). 
 

 

Основные настройки, о которых нужно помнить 

 Режим создания файла. Чаще всего используются следующие режимы: 

 Smallest File Size (Минимальный размер) — компактная запись для передачи 

и просмотра через Интернет; 

 High Quality (Высокое качество) — для печати на принтерах офисного класса; 

 Press Quality (Полиграфическое качество) — для отправки в типографию; 

 Совместимость выставляется в соответствии с требованиями типографии, ис-

ходя из версии программы Acrobat, имеющейся в ее распоряжении. 
 

 

Рис. 13.11. Вкладка Marks and Bleeds 
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 Количество страниц — все или заданный диапазон; при необходимости можно 

поставить флажок Spreads (Развороты) и вывести макет в виде набора разво- 

ротов. 

При выводе PDF прямо для типографии нужно зайти во вкладку Marks and Bleeds 

(Метки и припуски) и выбрать необходимые метки — обреза, совмещения цветов 

и т. д. (рис. 13.11). Здесь же определяется вид и расположение этих меток, а также 

Bleeds (Припуски под обрез) — можно использовать установки, введенные при 

создании документа, или задать их прямо в полях этого окна. 

Контрольная распечатка  
на лазерном или струйном принтере 

Обычно типографии требуют контрольную распечатку на бумажном носителе — на 

лазерном или струйном принтере. Говорить о точности передачи цвета в такой рас-

печатке обычно не приходится, но она позволяет проконтролировать правильность 

вывода всех элементов макета, убедиться, что ничего не сместилось и не пропало. 

Подписанная заказчиком и представителем типографии распечатка свидетельствует 

о том, что дальнейшую ответственность за качество тиража несет уже типография, 

а вы свое дело сделали как следует. 
 

Спуск полос 

Спуск полос — это размещение страниц публикации на печатных листах так, как 

они будут печататься. Дело в том, что в электронной версии публикации мы видим 

страницы последовательно, как они будут идти в книге: первая, затем вторая, тре-

тья и т. д. Но при печати страницы должны располагаться иначе: вторая — на обо-

роте первой, четвертая — на обороте третьей и т. д., чтобы после фальцовки (сги-

ба), брошюровки (соединения в книжку) и обрезки листов получилось полноценное 

издание с правильно пронумерованными страницами. 

Приходится еще учитывать то, что обычно печатные листы имеют достаточно 

большой размер, и на одном листе располагается 8, 16, а то и 32 страницы. И нуж-

но, чтобы, когда напечатанный лист сложат по линиям соединения страниц, все они 

оказались на своих местах. Сложенный лист образует тетрадь — минимальный 

блок страниц, зависящий от размера печатного листа и формата издания. Чем 

больше страниц помещается на печатном листе, тем сложнее алгоритм. 

Например, брошюру формата А5 можно распечатать на листах А4, на обычном 

офисном принтере, и тогда тетрадь будет состоять из 4 страниц — двух на внешней 

стороне листа и двух на внутренней. Такой "спуск" можно рассчитать и самостоя-

тельно, хотя и это непросто. Если же речь пойдет о распечатке такой брошюры на 

листе формата А1, тут понадобится участие специалиста (рис. 13.12). 

Для спуска полос в Adobe InDesign CS5 имеется специальный встроенный модуль 

Print Booklet, вызываемый командой File > Print Booklet. 
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Рис. 13.12. Результат выполнения спуска полос 

 

Рис. 13.13. Окно модуля Print Booklet 
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Print Booklet создает печатные развороты, предназначенные для профессиональ-
ной печати, и предлагает пять типов спусковых макетов, с помощью которых мож-
но выполнять спуск полос для разных типов изданий (рис. 13.13). 

Типы спусковых макетов 

Существует несколько стандартных типов спусковых макетов, встречающихся не 
только в Print Booklet. Каждый тип используется в зависимости от объема издания, 
для которого выполняется спуск полос, и характеризуется объемом тетради и, со-
ответственно, размером печатного листа. Например, как мы уже наблюдали, из 
двух страниц формата А5 составится один разворот формата А4. 

 2-Up Saddle Stitch (Спуск полос брошюрой). Используется для небольших из-
даний, которые действительно можно после печати согнуть пополам и прошить 
в корешок скрепкой. В этом случае на листе первая страница располагается вме-
сте с последней, вторая — с предпоследней и т. д. (рис. 13.14). 

 

Рис. 13.14. Схема спуска полос с использованием типа макета 2-Up Saddle Stitch 

При выполнении такого спуска полос для проверки правильности размещения 
страниц можно использовать несложную формулу: сумма номеров страниц на 
каждом развороте минус 1 должна быть равна количеству страниц в публика-
ции. Например, для брошюры в восемь страниц, если суммировать 4 и 5, 3 и 6, 
2 и 7, получится 9 (как раз на единицу больше, чем количество страниц), что 
вполне соответствует формуле. 
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 2-Up Perfect Bound (Книга). Разумеется, книгу вряд ли удастся согнуть пополам 

и прошить в корешок (представьте себе, к примеру, "Войну и мир"...) Поэтому 

книга разбивается на тетради с небольшим количеством страниц в каждой, спуск 

полос выполняется внутри каждой тетради, а затем все они собираются в общий 

переплет (рис. 13.15). 

 

Рис. 13.15. Схема спуска полос с использованием типа макета 2-Up Perfect Bound 

Для того чтобы выполнить спуск полос в этом случае, нужно определить, сколь-

ко страниц будет входить в каждую тетрадь. Print Booklet предлагает сле-

дующие размеры тетрадей: 4, 8, 12, 16, 32. 

 2-Up Consecutive, 3-Up Consecutive, 4-Up Consecutive (Буклет-"гармошка"). Ис-

пользуется для создания из отдельных страниц разворотов буклета, который по-

лучается в результате сгиба (фальцовки) листа (рис. 13.16). Цифры в названии 

спускового макета означают количество страниц каждого разворота после фаль-

цовки. 

Для создания двух-, трех-, четырехсгибного буклета можно также использовать со-

всем другую технологию, при которой вам не придется обращаться к спуску полос. 

Речь идет о создании электронного документа, состоящего из двух страниц (лице-

вой и оборотной), на которых направляющими линиями обозначены будущие сги-

бы. Именно таким образом строится евробуклет — лист формата А4, сложенный 

в два сгиба (рис. 13.17). 
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Рис. 13.16. Схема спуска полос с использованием типа макетов Consecutive 

 

Рис. 13.17. Евробуклет 

Процесс выполнения спуска полос 

Рассмотрим диалоговое окно Print Booklet поподробнее. Оно имеет три вкладки: 
Setup (Настройки), Preview (Предпросмотр) и Summary (Сводка). Вкладка Setup 
используется для настройки параметров спуска полос, вкладка Preview — для 
предварительного просмотра, Summary традиционно выводит всю информацию 
о настройках и состоянии проекта. 

Кнопка Print Setup открывает доступ к настройкам печати, которые мы рассмот-
рим в разд. "Запись PostScript-файла". 

Наша главная задача — согласовать настройки печати и тип выводимого буклета. 

1. Откройте файл chapter12\project_catalog\catalog_sample.indd. 

2. На вкладке Setup: 

 В выпадающем списке Booklet Type (Тип буклета) выберите тип 2-up Saddle 

Stitch. 
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 В поле Creep (Сползание) обычно ставится значение, полученное в типо-
графии, для корректировки размещения страниц с учетом толщины бумаги. 
Для восьмистраничного (двухлистного) буклета оставьте в этом поле 0 мм. 

 В полях Margins (Поля) определите пространство вокруг документа, на кото-
ром будут размещены печатные метки и другая служебная информация. 
Здесь очень удобно воспользоваться флажком Automatically Adjust to Fit 

Marks and Bleeds (Определить автоматически). 

 Поля Space Between pages (Расстояние между страницами) и Bleed Between 

Pages (Припуски между страницами), определяющие размещение страниц в 
переплете, для выбранного нами макета недоступны. 

 Поле Signature Size (Количество страниц в тетради) также доступно только 
для макета 2-UP Perfect Bound (Спуск полос для книги). Здесь определяется 
размер тетрадей, из которых будет собираться книга. 

С помощью кнопки Print Setup заходим в настройки печати — в частности опреде-
ляем размер печатного листа, типографские метки и т. д. Эту часть процесса мы 
рассмотрим в разд. "Запись PostScript-файла". 

В процессе работы необходимо отслеживать сигналы, поступающие от других 
вкладок. В частности, если размер печатного листа не подходит для выбранного 
типа спуска полос, появляется уже знакомый нам желтый треугольник на вкладке 
 

 

 

Рис. 13.18. Вкладка Preview и сообщение о несовпадении макета и размера бумаги 
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Preview и сообщение, что макет не соответствует выбранному размеру бумаги 

(рис. 13.18). 

После исправления настроек предупреждение пропадет, и мы сможем нормально 

просмотреть все стороны всех печатных листов, созданных для документа. Здесь 

будут отображены не только сами страницы, но и все метки, которые мы установи-

ли в настройках печати. 

 

 

  

Если количество страниц публикации не кратно числу страниц в тетради, программа добавляет пустые 
страницы. Поэтому лучше учесть кратность еще во время работы над макетом. Например, при спуске 
полос для книги количество страниц должно быть кратно количеству страниц в тетради, при спуске по-
лос для брошюры — четырем. Для заполнения пустот в конце книги издатели обычно формируют рек-
ламный блок, но можно найти им и другое применение — например, в справочной литературе удобно 
сделать несколько страниц "для заметок" или разместить дополнительную информацию. 
 

 

Отправка документа на печать производится нажатием на кнопку Print. Если  
в установках печати был выбран PostScript-файл, начнется запись файла, если 

обычный принтер — печать. 

Запись PostScript-файла 

Финальный этап работы — запись PostScript-файла, который есть не что иное, как 

текстовый файл с описанием того, как должна выглядеть публикация при печати. 
PostScript-файл необходим для вывода цветоделенных пленок, которые использу-

ются как схема нанесения краски на бумагу, и для спуска полос в типографии. На-
конец, это лишний шанс проверить верстку до того, как она будет напечатана. 

Запись PosrScript-файла производится с помощью команды меню File > Print 

(Файл > Печать), которая также используется для печати документа. Настройки 
диалогового окна Print могут меняться в зависимости от требований типографии. 

Мы постараемся рассмотреть основные настройки, которые обычно следует вы-
полнять при записи PostScript-файла. 

Как вы помните, мы зашли в это окно нажатием на кнопку Print Settings модуля 

Print Booklet. 

 Вкладка General (Основные настройки) показана на рис. 13.19. 

 Для того чтобы с помощью команды Print записать PostScript-файл, а не на-
печатать документ, выберите в выпадающем списке принтеров (Printer) ва-

риант PostScript File. 

 Для записи конкретного PostScript-файла выберите в списке PPD (под спи-
ском принтеров) наш виртуальный принтер, который был установлен в нача-

ле работы над этой главой. 

 

 

  

PPD (PostScript Printer Description) — это файл описания особенностей PostScript-устройства. Он содер-
жит разную специфическую информацию о том, какие шрифты загружены в принтер, какие размеры и 
ориентация бумаги возможны для использования и т. д. 



Особенности печатных публикаций 307 

В реальной практике для корректной записи PostScript-файла надо получить PPD-файл в типографии и 
использовать его при установке драйвера нужного принтера с помощью команды Принтеры и Факсы 
(Устройства и принтеры) в Управляющей панели системы, после чего он станет доступен в выпадающем 
списке PPD. 
 

 

 

Рис. 13.19. Диалоговое окно Print, вкладка General 

 Задайте диапазон страниц, выводимых на печать. Часто требуется вывести 
каждую страницу отдельно. В этом случае в поле Range следует указать но-
мер страницы, для которой записывается PostScript-файл. В нашем случае  
установите значение All (Все). 

 Вкладка Setup (Установки печати) (рис. 13.20). 

На этой вкладке настраиваются параметры, связанные с размером бумаги и ва-
шего документа, расположением на печатном листе. 

В выпадающем списке Paper Size выберите формат вывода. Для нашей задачи 
подойдет формат А4 Extra. 

 

 

  

При выборе формата учитывайте тот факт, что после размещения разных меток, необходимых для пе-
чати, документ будет занимать на листе больше места. Форматы бумаги, доступные для выбора в выпа-
дающем списке, определяются как раз PPD печатного устройства, поэтому содержимое списка может 
меняться в зависимости от его типа. Существуют специальные форматы бумаги, размер которых равен 
стандартному формату плюс поле для размещения печатных меток. Такие форматы в своем названии 
имеют приставку Extra, например А4 Extra. Если вы работали с документом нестандартного размера или 
если форматов Extra в списке нет, выбирайте ближайший больший формат. 
 

- 
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Рис. 13.20. Диалоговое окно Print, вкладка Setup 

В группе настроек Options (Дополнительные настройки) выберите в выпадаю-

щем списке Page Position вариант расположения на листе Centered. Работая на 

этой вкладке, следует удостовериться, что не включено автоматическое масшта-

бирование публикации. Убедитесь, что в полях Scale установлены значения 

100%. Функции Thumbnails и Tile при выводе PS-файлов не используются. 

 Вкладка Marks and Bleed (Метки и припуски) (рис. 13.21). 

На этой вкладке определяются наличие и состав типографских меток, используе-

мых при печати документа. Для постановки всех возможных меток сразу вклю-

чается флажок All Printer's Marks. 

Мы поставим все метки, кроме Bleed Marks — меток припусков под обрез. 

Включите флажки: 

 Crop Marks — обрезные метки, которые устанавливаются по формату стра-

ницы. Особые параметры этих меток — их толщина (Weight) и расстояние от 

метки до края листа (Offset), которые устанавливаются в этой же группе на-

строек. Обычно можно оставлять параметры по умолчанию, но в некоторых 

случаях типография требует задать другое расстояние от метки до края листа. 

Этот вопрос всегда имеет смысл уточнить перед окончательным выводом 

файла. 

 Registration Marks — метки совмещения цветов в виде крестов. 
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Рис. 13.21. Диалоговое окно Print, вкладка Marks and Bleed 

 Colour Bars — шкалы контроля цвета и экспозиции при печати. 

 Page Information — информация о полосе (номер, цвет, дополнительная ин-
формация). 

В группе Bleed and Slug задайте припуски под обрез. Посколльку мы определи-
ли припуски при создании документа, просто включите флажок Use Document 
Bleed Settings (Использовать настройки документа). 

 Вкладка Output (Вывод) (рис. 13.22). 

Эта вкладка определяет параметры цветоделения документа. В зависимости от 
требований типографии может понадобиться цветоделенный PostScript-файл  
(в котором записана информация о каждой краске в отдельности) или полно-
цветный (так называемый композитный) файл. 

 В выпадающем списке Colour выберите Composite CMYK. В этом  
поле нужно выбирать тот вариант, который сообщит вам типография. Для 
офсетной печати чаще всего используются варианты In-RIP Separarions, 
Composite CMYK или Separations. Варианты In-RIP Separarions и Com-
posite CMYK используются для получения композитного файла, Separa-
tions — для цветоделенного. 

 Установки Trapping (Наложение краев), Flip (Зеркальное отображение), Inks 
(Управление печатными формами) оставьте по умолчанию. О необходимости 
изменений в этих полях вам также сообщит типография. 
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Рис. 13.22. Диалоговое окно Print, вкладка Output 

 

 

  

Вы можете определить состав красок, использующихся для печати вашего документа (щелчком по знач-
ку принтера можно убрать ту или иную краску). Если нужно разложить дополнительную краску (spot-
краску) на триадные составляющие, следует воспользоваться окном Ink Manager. Первая колонка таб-
лицы Ink Manager отвечает за перевод дополнительных цветов в CMYK. Если надо разложить на триад-
ные компоненты все spot-цвета, установите флажок All Spots То Process. 
 

 

 Вкладка Graphics (Графика) (рис. 13.23). 

Используется для настройки параметров загрузки в PostScript-файл графики и 

шрифтов. 

 В поле Send Data выберите All. Это поле используется для указания про-

грамме, сколько информации о размещенных в рабочей области растровых 

изображениях отправлять на принтер: для качественной печати на типограф-

ской печатной машине требуется большее количество данных, чем для печа-

ти на обычном офисном принтере. Регулируя количество информации,  

отправляемой на печать, вы регулируете не только скорость печати, но и ка-

чество. 

 В разделе Fonts в выпадающем списке Download выберите Complete. Здесь 

регулируется загрузка шрифтов в PostScript-файл. Для экономии на размере 

файла можно загрузить шрифтовой файл не полностью, а только ту часть его 

символов, которая использовалась в документе. Эта на первый взгляд без-
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обидная технология нередко приводит к различным ошибкам, поэтому реко-

мендуется выбирать Complete. В этом случае шрифты в PostScript-файл бу-

дут записаны полностью. 

 Установите флажок Download PPD Fonts. Он используется для загрузки  
в PostScript-файл даже тех шрифтов, которые предположительно загружены 
в принтер, во избежание любых недоразумений и расхождений. 

 В списке Data Format выберите Binary. Если выбрать ASCII, файл сохра-
нится в текстовом представлении и будет занимать гораздо больше места на 

диске, чем файл, кодированный способом Binary. 

В выпадающем списке PostScript  можно выбрать уровень языка, если устрой-
ство вывода — последнего поколения (Level 3). В нашем случае этот список за-

блокирован. В реальной работе, если будет возможность выбора, лучше уста-
навливать Level 3, это улучшит обработку прозрачных областей, воспроизведе-

ние шрифтов и т. д. 

 

Рис. 13.23. Диалоговое окно Print, вкладка Graphics 

 Вкладка Colour Management позволяет выбрать цветовой профиль устройства. 

Для гарантии качественного вывода цветов, особенно в фотографиях, нужно пе-

ред началом работы над макетом, получив цветовой профиль из типографии, на-

строить цветовые пространства всех участвующих в работе программ (Illustrator, 

Photoshop, InDesign) на один и тот же профиль. 
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 Вкладка Advanced (Дополнения) (рис. 13.24). 

На ней настраиваются дополнительные специфические настройки. Очень важ-
ный пункт, влияющий на качество конечного продукта, — настройка парамет-
ров печати прозрачных областей в изображении. При обработке прозрачных об-
ластей программой производится довольно сложная работа по разбиению их на 
отдельные мелкие составляющие, часть из которых остается векторной, а часть 
растеризуется. 

В поле Transparency Flattener (Обработка прозрачности) выберите High 

Resolution. 

 

Рис. 13.24. Диалоговое окно Print, вкладка Advanced 

Итак, мы прошлись по основным настройкам вкладок диалогового окна Print. 
Полную информацию о выполненных настройках можно посмотреть на по-
следней вкладке Summary, на которой перечисляются все выполненные поль-
зователем настройки. 

 Вкладка Summary (Сводка) (рис. 13.25). 

После окончательного ознакомления с выполненными настройками имеет смысл 
сохранить их, чтобы в следующий раз при записи PostScript-файла для такого же 
проекта не нужно было снова идти по всем вкладкам. 

1. Нажмите на кнопку Save Preset, задайте группе настроек имя и добавьте их та-

ким образом в список Print Preset. Теперь их можно выбрать в списке Print 
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Preset в верхнем поле диалогового окна Print. Кнопка Save Preset доступна на 

любой вкладке (не только на вкладке Summary), однако использовать ее имеет 

смысл только тогда, когда все настройки выполнены и проверены. 

2. Для возвращения в модуль Print Booklet нажмите ОК; для сохранения 

PostScript-файла из команды Print надо будет нажать на кнопку Save в нижнем 

правом углу диалогового окна и указать путь до места на диске, куда программа 

должна сохранить файл. 

 

Рис. 13.25. Диалоговое окно Print, вкладка Summary 

Проверка PostScript-файла 

Как уже не раз отмечалось, PostScript-файл — это текстовый файл, описывающий 

содержимое страницы. На его основе будет выполняться печать документа. Но 

обычно у нас нет стопроцентной уверенности в том, что в PostScript-файле все за-

писано правильно, и при печати будет воспроизведен абсолютно тот же вид стра-

ницы, который мы видели на экране. Для проверки результата вывода PostScript-

файла имеет смысл сделать виртуальную контрольную распечатку, подобную опи-

санной ранее, но уже для файла PostScript. 



314 Глава 13 

Самый распространенный способ превращения PostScript-файла в PDF — исполь-

зование программы Acrobat Distiller с последующим просмотром полученного ре-

зультата в программах Acrobat или Acrobat Reader. 

Вместе с программой Acrobat устанавливается программа Acrobat Distiller, которая 

выводит на экран небольшое диалоговое окно (рис. 13.26). 

 

Рис. 13.26. Окно программы Acrobat Distiller 

Прежде чем выполнить превращение PostScript-файла в PDF, установите в выпа-

дающем списке Default Settings уровень проверки файла и качество генерируемого 

PDF-файла. Для последующей печати файла в типографии подойдет вариант Press 

Quality. 

Откройте PostScript-файл с помощью команды Filе > Open (Файл > Открыть). Про-

цесс открытия файла и является процессом виртуальной печати. В результате, если 

все в порядке, вы получите сообщение End of Job (Конец работы) и сможете от-

крыть PDF-файл для просмотра содержимого. 

Как вы помните, PostScript-файлы делятся на композитные и цветоделенные. То, 

что вы увидите в PDF-файле, зависит от того, с какими настройками записывался 

PostScript-файл. В цветоделенных файлах каждая краска представлена отдельной 

страницей. Например, если для печати файла предполагается использовать четыре 
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основных цвета (Cyan, Magenta, Yellow, Black), вы увидите четыре черно-бе- 

лых изображения, являющихся картами нанесения каждой краски на бумагу 

(рис. 13.27). 

 

Рис. 13.27. Результат обработки цветоделенного PostScript-файла 

Композитные PostScript-файлы оставляют файл полноцветным, т. е. не разде-

ленным на цветовые составляющие. Предполагается, что разделение произойдет на 

выводном устройстве. 

Итоги 

Стадия предпечатной подготовки макета — пожалуй, самая важная часть работы. 

Любые ошибки, допущенные в процессе верстки, на этом этапе можно исправить. 

Но если он проведен неправильно, все огрехи проявятся в готовом тираже и пере-

черкнут остальную работу — и блестящую идею, и качественную типографику, и 

красивые картинки, и отличную композицию. Более того, огрехи предпечатной 

подготовки могут привести к порче тиража на таком уровне, что его будет вообще 

невозможно использовать — например, к прорыву бумаги в местах со слишком 

большой плотностью краски или к обрезке значимых элементов макета при не-
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удачном расположении меток обреза. Поэтому к процессу подготовки и вывода  

печатных форм надо относиться предельно аккуратно. 

Для дополнительной практики рекомендуется проводить полный предпечатный 

цикл — Preflight (проверку верстки на ошибки), Package (упаковку), создание вир-

туальной распечатки, вывод и проверку PostScript-файла — для всех своих бли-

жайших учебных и рабочих проектов, независимо от того, будут ли они потом пе-

чататься в типографии или на офисном принтере. Позже, когда все эти действия 

станут привычными,  можно будет ограничиваться только макетами, действительно 

предназначенными для полиграфического исполнения. 

И помните: предпечатная подготовка макета должна происходить в теснейшем  

сотрудничестве с типографией! Большинство испорченных тиражей — результат 

недостаточного взаимопонимания между дизайнером и печатником. 

 

 



  

 

Глава 14 
 

 

ОСОБЕННОСТИ  

ЭЛЕКТРОННЫХ ПУБЛИКАЦИЙ 

 

 

 
 
В этой главе вы узнаете: 

 чем отличаются электронные документы от печатных; 

 как добавить в документ всевозможные мультимедиа-материалы; 

 как сделать свою публикацию интерактивной; 

 как превратить печатную публикацию в электронную; 

 в чем различие вывода электронной публикации в формат PDF и SWF. 
 

Особенности электронных документов 

Как уже говорилось, электронная публикация отличается от бумажной, прежде все-

го, виртуальностью. Она не зависит ни от качества бумаги, ни от типографских 

машин. На пространстве, ограниченном экраном воспроизводящего устройства, мы 

можем предоставить читателю множество дополнительных средств передачи  

информации: моментальные переходы к нужной дополнительной информации  
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(гиперссылки), музыкальные и видеофрагменты, удобный интерфейс с кнопками, 

как в обычных программах, анимацию страниц... 

Электронная публикация может либо основываться на макете, первоначально 
предназначенном для печати, либо сразу создаваться как интерактивная. В этой 
главе мы рассмотрим разные варианты. 

Самый простой в исполнении вариант электронной публикации — электронная 
книга. 

Для начала рассмотрим публикацию, предназначенную для обычного чтения, но 
дающую читателю дополнительную свободу получения информации: пусть это бу-
дет текст с добавленными к нему гиперссылками. В этом случае мы размещаем и 
форматируем текст как обычно, с той только разницей, что документ лучше созда-
вать не с разворотами, а с последовательными страницами, и название произведе-
ния необязательно вводить в мастер-шаблон: его можно вывести в название доку-
мента. 

В качестве рабочего примера рассмотрим файл j&w_inter.indd. 

Гиперссылки 

Гиперссылка — это команда, позволяющая переходить от выбранного слова или 
фрагмента текста к другим страницам в этом же документе, к другим документам 
или выходить на веб-сайты. Любая гиперссылка состоит из двух частей: источника 
и привязки. 

Источник — текст или фрейм (текстовый либо графический) с привязанной к нему 
гиперссылкой. 

Привязка — URL-адрес, файл, адрес электронной почты, фрагмент текста и т. д. — 
словом, цель, на которую указывает гиперссылка. Из одного источника можно пе-
рейти только к одной привязке, но одна и та же привязка может быть указана для 
любого количества источников. 

Добавление гиперссылок 

Управление гиперссылками происходит с помощью палитры Hyperlinks (Гипер-
ссылки), которая вызывается традиционно: Window > Interactive > Hyperlinks 
(Окно > Интерактивные элементы > Гиперссылки) (рис. 14.1). 

Гиперссылки могут указывать на страницы, URL-адреса, текстовые привязки, адре-
са электронной почты и файлы. При создании гиперссылки на страницу или тек-
стовую привязку в другом документе важно, чтобы пути к файлу от документа 
InDesign и от готовой публикации совпадали. 

Для отображения/скрытия гиперссылок служит команда View > Extras > 

Show/Hide Hyperlinks (Вид > Вспомогательные элементы > Показать/Скрыть ги-
перссылки). 

 

 

  

При экспорте гиперссылки включаются в файлы Adobe PDF и SWF, если в соответствующем диалоговом 
окне экспорта установлен флажок в поле Hyperlinks (Гиперссылки). 
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Рис. 14.1. Палитра Hyperlinks 

Создание гиперссылки на веб-страницу (URL-адрес) 

Ссылка на URL-адрес запускает выбранный по умолчанию в системе web-браузер и 

вызывает сайт. При указании URL-адреса можно использовать любой допустимый 

протокол доступа к ресурсам Интернет: http://, file://, ftp:// или mailto://. 

Гиперссылку можно оформить в виде кнопки или создать для нее стиль символов 

(Character Style). Например, гиперссылки часто отображаются подчеркнутым 

шрифтом синего цвета. 

1. Откройте файл chapter14\j&w_inter.indd. 

2. Обратите внимание, что в палитре Character Styles (Стили символа), кроме сти-

ля для обычного текста, есть еще и стиль Link для гиперссылок — традиционно 

синий и подчеркнутый. При желании измените стиль по своему усмотрению. 

3. Выделите слово "Дживс" в первом диалоге. Это будет наша первая гиперссылка. 

4. В палитре Hyperlinks (Гиперссылки) выберите New Hyperlink (Новая гипер-

ссылка). В открывшемся диалоговом окне (рис. 14.2) в поле Link to (Связать с) 

выберите URL, введите в поле URL адрес http://wodehouse.ru/ и задайте пара-

метры оформления. 

Параметры оформления гиперссылки определяют оформление гиперссылки в гото-

вом файле PDF или SWF. Они отображаются в документе при выборе команды 

View > Extras > Show/Hide Hyperlinks (Вид > Вспомогательные элементы > Пока-

зать / Скрыть гиперссылки). 

 Style (Стиль шрифта) — в выпадающем списке выберите стиль Link. Этот пара-

метр доступен, только если гиперссылка привязана к тексту, а не к изображению 

или кнопке. 

 Type (Тип) — отображение прямоугольника, ограничивающего источник гипер-

ссылки на странице публикации. Выберите Invisible Rectangle (Невидимый 

прямоугольник). 
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Рис. 14.2. Окно настройки гиперссылки 

 Highlight (Выделение) — оформление гиперссылки при щелчке на ней в файле 

PDF или SWF. Возможные варианты: Invert (Инверсия), Outline (Рамка), Inset 

(Вставка) или None (Нет). 

 Если требуется, чтобы в момент щелчка по гиперссылке появлялся видимый 

прямоугольник, можно выбрать, соответственно, Visible (Видимый) и задать ему 

цвет, толщину и стиль обводки. 

Создание гиперссылки на файл 

Ссылка на файл запускает приложение, предназначенное для работы с этим фай-

лом. Например, файлы *.doc открываются в программе Microsoft Word. 

Обеспечивайте доступ к указываемому файлу для всех пользователей, открываю-

щих готовую публикацию. Файл должен быть либо на том же мобильном носителе, 

что и публикация, либо на общедоступном сервере. 

Создание ссылки на файл отличается от создания ссылки на URL-адрес выбором 

значения File в поле Link to (Связать с) и вводом пути к файлу в поле Path (Путь). 

Создание гиперссылки на страницу 

Гиперссылка на страницу создает переход на указанную страницу с теми настрой-

ками размещения в окне, которые будут указаны (рис. 14.3). 

1. Выделите в тексте фамилию "Финк-Ноттл". Для нее мы создадим ссылку на 

страницу с описанием этого персонажа. 

2. Вызвав команду New Hyperlink (Новая ссылка) в поле Link to (Связать с), вы-

берите Page, в поле Document (Документ) выберите целевой файл. Обычно это 

активный файл, поскольку этим типом ссылок удобнее пользоваться в пределах 

одной публикации. 
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Рис. 14.3. Создание гиперссылки на страницу 

 

3. В поле Page (Страница) введите 9. 

4. В поле Zoom Setting (Масштаб) выберите подходящий масштаб просмотра (на-

пример, Fit Width — по ширине страницы). Другие возможные варианты мас-

штаба: 

 Fixed (Фиксированный) — масштаб и положение страницы на момент созда-

ния ссылки; 

 Fit View (Текущий вид) — видимая часть текущей страницы; 

 Fit in Window (По размеру окна) — страница целиком; 

 Fit Height (По высоте) — размещение страницы в окне по высоте; 

 Fit Visible (По содержимому) — во весь размер окна только текст и графика, 

без полей. 

Аналогично можно задать гиперссылку на сообщение электронной почты, тексто-

вый фрагмент и т. д. 

Преобразование URL-адресов в гиперссылки 

Если в документе есть URL-адреса (например, www.jeeves.com), их можно преоб-

разовать в гиперссылки. Для этого в меню палитры Hyperlinks (Гиперссылки)  

выбирается команда Convert URLs to Hyperlinks (Преобразовать URL-адреса 

в гиперссылки) (рис. 14.4). 

В поле Search (Диапазон) указывается область поиска: весь документ, текущий 

связанный текст или выделенный фрагмент. При необходимости ссылке можно на-

значить стиль символа, выбрав его в поле Apply to Hyperlink > Character Style 

(Назначить стиль гиперссылке). 
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Рис. 14.4. Окно преобразования URL-адресов в гиперссылки 

 

Дальнейшие действия привязаны к кнопкам: 

 Find (Найти) — поиск следующего URL-адреса; 

 Convert (Преобразовать) — преобразование текущего URL-адреса в гиперссылку; 

 Convert All (Преобразовать все) — преобразование всех URL-адресов в гипер-

ссылки. 
 

Управление гиперссылками 

Для редактирования гиперссылки сделайте двойной щелчок по нужному эле- 

менту в палитре Hyperlinks (Гиперссылки): появится уже знакомое нам окно на-

строек. 

После удаления гиперссылки текст и графика, применяемые в качестве источника, 

сохраняются. 

При переименовании гиперссылки в палитре Hyperlinks (Гиперссылки) источник 

в тексте публикации не меняется. 

1. Выберите в палитре Hyperlinks (Гиперссылки) элемент "Финк-Ноттлом". 

2. В меню палитры Hyperlinks (Гиперссылки) выберите команду Rename 

Hiperlink (Переименовать гиперссылку) и введите "Гасси Финк-Ноттл". 

Название ссылки изменится только в палитре, а в тексте останется прежним. 

Для проверки работы гиперссылки можно воспользоваться командами Go to Source 

(Перейти к источнику) или Go to Destination (Перейти к точке привязки). Если 

привязка — URL-адрес, будет запущен веб-браузер, если ссылка на текст или стра-

ницу — произойдет переход к ним. 

При импорте документа Microsoft Word, содержащего гиперссылки, вокруг гипер-

ссылок (например, www.adobe.com) появляется поле или рамка. Документ InDesign 

наследует синий образец под названием Word_R0_G0_B255 и стиль символов под 

названием "Гиперссылка" (подчеркнутый шрифт синего цвета). 

Оформление таких ссылок можно отредактировать в окне настроек гиперссылки, 

вызываемом двойным щелчком на строке ссылки, либо заранее создать стиль сим-

волов с именем "Гиперссылка" в документе InDesign. При импорте документа Word 

стиль InDesign, имеющий то же имя, используется по умолчанию. 
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Перекрестные ссылки 

Перекрестные ссылки полезно использовать при написании руководств или спра-

вочных документов, они позволяют выполнять переход из одной части документа 
в другую. 

Пример: Дополнительную информацию см. в статье "Бландингская сага" на 

стр. 249. 

Можно указать, из какого фрагмента берется текст перекрестной ссылки: например, 
из стиля заголовка или из специально созданной привязки к тексту. Также задается 

формат перекрестной ссылки. В частности можно включить отображение только 
номера страницы или полный заголовок абзаца и номер страницы. 

Вставка перекрестных ссылок 

Перекрестная ссылка вставляется в документ командой Insert Cross-Reference 

(Вставить перекрестную ссылку) палитры Hyperlinks (Гиперссылки) (рис. 14.5). 

 

 

  

При экспорте перекрестные ссылки включаются в файлы Adobe PDF и SWF, если в соответствующем 
диалоговом окне экспорта установлен флажок в поле Hyperlinks (Гиперссылки). 
 

 

1. Поместите курсор в то место, где должна находиться перекрестная ссылка. 

2. Вызовите команду Insert Cross-Reference (Вставить перекрестную ссылку) па-

литры Hyperlinks (Гиперссылки). 

3. В диалоговом окне создания перекрестной ссылки выберите стиль main_txt  
(в правой части окна появится текст, оформленный этим стилем) и найдите там 

нужную фразу. В нашем случае это "Характеру Вустеров присуща несгибаемая 
твердость...". 

 

Рис. 14.5. Окно создания перекрестной ссылки 
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4. Выберите формат ссылки. Это может быть вставка в текст всего целевого абза-

ца, номера страницы и т. д. Нажатие на кнопку "редактировать" (карандаш) по-
зволяет создать собственный формат (рис. 14.6). 

 

Рис. 14.6. Редактирование формата ссылки 

В рассмотренном примере собственный формат создан на основе формата Page 

Number (Номер страницы). К стандартному коду формата добавлена надпись  

"см. также стр." и скобки, в поле Character Style for Cross-Reference выбран стиль 
для оформления ссылок (рис. 14.7). 

 

 

  

Если требуется восстановить форматы перекрестных ссылок по умолчанию в документе после удаления 
или изменения форматов, это можно сделать командой Load Cross-Reference Formats (Загрузить фор-
маты перекрестной ссылки) в меню палитры, загрузив документ с неизмененными форматами. Можно 
также синхронизировать форматы перекрестных ссылок по всей книге (см. главу 13). 
 

 

В готовой публикации при нажатии на ссылку произойдет переход к нужному аб-
зацу на нужной странице. 

 

 

  

Работа с форматами ссылок — увлекательный процесс, позволяющий создавать сложные алгоритмы — 
например, вводить в ссылку название целевой главы, номер страницы и часть абзаца до заявленного 
символа (тире или двоеточия) и т. п. Но подробное изучение кодов форматов ссылок не входит в нашу 
задачу на нынешнем этапе изучения программы. 
 

 

При загрузке форматов перекрестной ссылки из другого документа загружаемые 
форматы заменяют собой все существующие форматы с тем же именем. 

Формат перекрестной ссылки, уже примененный к документу, удалить нельзя. Не-
используемый формат удаляется кнопкой "-" в окне настройки форматов. 

После вставки перекрестной ссылки в начале абзаца привязки отображается маркер 

привязки к тексту, который можно увидеть в режиме показа служебных символов  
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Рис. 14.7. Результат создания своего формата перекрестной ссылки 

(Type > Show Hidden Characters). Если этот маркер перемещен или удален, пере-
крестная ссылка работать не будет. 

Обновление перекрестных ссылок 

Значок "Обновление" показывает, что текст привязки для перекрестной ссылки из-
менился или что исходный текст перекрестной ссылки был отредактирован. Пере-
крестную ссылку можно легко обновить. Если привязка перемещается на другую 
страницу, перекрестная ссылка обновляется автоматически. 

При обновлении перекрестной ссылки все изменения форматирования, внесенные  
в текст источника, удаляются. В процессе вывода команды проверки верстки вы-
дают уведомление об устаревших или недействительных перекрестных ссылках. 

Для обновления перекрестной ссылки достаточно выбрать ее в палитре Hyperlinks 
(Гиперссылки) и вызвать команду Update Cross-Reference (Обновить перекрест-
ную ссылку). 

Для обновления всех перекрестных ссылок в книге в меню палитры Воок (Книга) 
выбирается пункт Update All Cross-References (Обновить все перекрестные ссыл-
ки). Будет выдано уведомление о неработающих перекрестных ссылках. 

После удаления перекрестной ссылки источник перекрестной ссылки преобразуется 
в обычный текст. 

Добавление анимации, видео  
и дополнительных интерактивных 
возможностей 

Рассмотрим более сложный интерактивный документ, содержащий кнопки, муль-
тимедийные элементы и анимацию. Такие публикации обычно используются в Ин-
тернете, при создании интерактивных фильмов и медиа-версий книг. 
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При создании документа в этом случае разумно выбирать макет класса Web, что 

сразу даст нам возможность задать экранный формат, определить пикселы в каче-

стве единиц измерения и использовать изображения в модели RGB. 

Для работы с интерактивными документами удобнее всего использовать рабочее 

пространство (Workspace) Interactive (Интерактивные элементы). 

Рассмотрим процесс создания интерактивной версии известной книги — например, 

сделаем главу знаменитого романа "12 стульев" с возможностью управлять воспро-

изведением с помощью кнопок и ссылок, а также добавим видеоверсию особенно 

ярких моментов. 

1. Создайте документ типа web со следующими установками (рис. 14.8). 

2. Импортируйте файл chapter14\project_12chairs \12chairs.doc. 

 

Рис. 14.8. Создание интерактивного документа 

3. Задайте стили для заголовка, текста и ссылок, ориентируясь на образцы в файле 

chapter14\project_12chairs \12chairs_sample. 

Фильмы и звуковые файлы 

Добавленные в документ видео- и аудиоклипы будут воспроизводиться после экс-

порта документа в формат Adobe PDF. 

InDesign допускает импорт видеофайлов в видеоформате Flash (.FLV и .F4V), MP4 

и SWF. Аудиофайлы можно импортировать в формате MP3. Видеофайлы форматов 
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QuickTime (.MOV), AVI и MPEG поддерживаются в экспортированных интерак-

тивных файлах PDF, но не поддерживаются в файлах SWF и FLA. Поэтому лучше в 

качестве исходных использовать форматы FLV, F4V, SWF, MP4 и MP3. 

Как и при работе с изображениями, здесь также необходимо следить за расположе-

нием файла мультимедиа. Если путь к нему изменился, надо его обновить; если до-

кумент InDesign с импортированным мультимедиа-файлом передается на другой 

компьютер, мультимедиа-файл тоже должен быть к нему приложен. 

Импорт фильма или звукового файла 

Импорт фильма или звукового файла происходит так же, как импорт любого друго-

го материала: File > Place (Файл > Поместить). После помещения в документ 

фильма или звукового файла во фрейме отображается объект мультимедиа, связан-

ный с файлом мультимедиа. Изменяя размер объекта, можно устанавливать размер 

области воспроизведения, аналогично изменению размера изображения во время 

верстки обычной публикации. 

 

 

  

Если центральная точка фильма выходит за пределы страницы, этот фильм в готовую публикацию не 
попадет и воспроизводиться не будет. 
 

 

На стр. 6 импортируйте и в правом нижнем углу разместите щелчком (это позволит 

использовать собственный размер кадра фильма) файл chapter14\project_12chairs 

\12chairs_mp4.mp4 (рис. 14.9). 

Для предварительного просмотра файла мультимедиа и для изменения настроек 

служит окно Media: Window > Interactive >Media (Окно > Интерактивные элемен-

ты > "Мультимедиа"). 

 

Рис. 14.9. Размещение импортированного видеофайла в макете 
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Рис. 14.10. Палитра Media для видеофайла 

 

Здесь определяются основные настройки воспроизведения фильма (рис. 14.10). 

 Play on Page Load (Воспроизвести при загрузке страницы) запускает фильм сра-

зу при загрузке страницы. В нашем случае это не требуется, читатель должен 

иметь возможность запустить ролик самостоятельно, когда он этого захочет. 

Флажок не ставим. 

 Loop (Циклическое повторение — доступно только при экспорте в SWF) — ста-

вится только если нужно, чтобы ролик повторялся непрерывно, пока читатель 

находится на странице. Может иметь смысл для аудиофайлов. 

 Poster (Афиша) — изображение, которое станет "заставкой" фильма, пока не 

началось воспроизведение. Это может быть первый кадр ролика, выбранный 

кадр или совершенно отдельное изображение. Для выбора кадра навигационный 

бегунок ставится в нужную точку, в поле Poster выбирается From Current 

Frame (На основе текущего кадра) и нажимается кнопка "Обновить" справа от 

этого поля. 

 Controller (Элементы управления) — если импортированное видео — файл 

формата Flash (FLV или F4V) или файл, созданный с использованием алгоритма 

H.264, здесь можно задать элементы управления, позволяющие пользователю 

приостановить, запустить или остановить воспроизведение видеоклипа разными 

способами. Если выбрать None (Не управлять), фильм будет показываться от 

начала до конца. При выборе параметра Show Controller on Rollover (Показы-

вать элементы управления при наведении курсора) элементы управления появ-

ляются только при наведении курсора мыши на мультимедийный объект. 
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Для проверки результата воспользуйтесь палитрой Preview (Просмотр) 
(Window > Interactive > Preview) или экспортируйте страницу в формат PDF, 
выбрав в установках экспорта PDF (Interactive). 

 Navigation Points (Точки навигации) позволяют начать воспроизведение видео с 
определенной точки. Для создания точки навигации достаточно перейти к нуж-
ному кадру и нажать <+>. Например, при создании кнопки для воспроизведения 
видео можно задать кадр, с которого начнется воспроизведение, с помощью па-
раметра Play from Navigation Point (Воспроизвести с точки навигации). 

На первую страницу импортируйте файл chapter14\project_12chairs\12chairs_ 
music.mp3. 

В макете появляется квадратный маркер аудиообъекта. Разместите его в левом 
верхнем углу и задайте размер, соответствующий ширине серой полосы на левом 
краю страницы (рис. 14.11). 

 

Рис. 14.11. Размещение в макете маркера аудиофайла 

После экспорта аудиофайл будет воспроизводиться в соответствии с установками, 
определенными в палитре Media: 

 Play on Page Load (Воспроизвести при загрузке страницы) запускает файл сразу 
при загрузке страницы. Если при этом поставить флажок в поле Loop (Цикличе-
ское повторение), музыка будет повторяться все время, пока читатель имеет де-
ло с этой публикацией; 

 Stop on Page Turn — остановка воспроизведения при переходе на другую стра-
ницу. 

После экспорта в PDF появится элемент управления проигрыванием: панель с 
кнопками "Старт", "Стоп", линейкой воспроизведения и настройкой громкости. 
Размер этого элемента соответствует размеру маркера аудиообъекта в макете. 

 

 

  

Маркер аудиообъекта при экспорте в PDF создает для панели управления квадратную плашку с залив-
кой 60% Black. Для того чтобы готовая страница смотрелась достаточно симпатично, имеет смысл учи-
тывать эту особенность и вписывать этот квадрат в макет — например, размещать его на таком же фоне 
(см. образец). 
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Анимация 

Эффекты анимации позволяют создавать движущиеся объекты в экспортируемых 

файлах SWF. Например, можно создать эффект изменения кнопки при наведении 

курсора или эффект переворачивания страниц. 

Анимация доступна только при экспорте в SWF. 

Создание анимации 

Рассмотрим создание анимации на примере появления оформительского элемента в 

заголовке. Пусть при загрузке первой страницы и при щелчке по тексту справа вы-

езжает серая полоска и останавливается, дойдя до серой полосы в левой части 

страницы. 

1. Создайте прямоугольник размером 662 16 px, залейте серым цветом (10% 

Black) и разместите его на первой странице на уровне заголовка, на самом ниж-

нем уровне в стопке. Создайте белый прямоугольник 235 30 px и расположите 

его в стопке между серым прямоугольником и текстом (рис. 14.12). 

 

Рис. 14.12. Размещение объекта для последующей анимации 

2. Вызовите палитру Animation (Анимация): Window > Interactive > Animation 

(Окно > Интерактивные элементы > Анимация) и задайте для серого прямо-

угольника следующие значения (рис. 14.13): 

 Preset (Готовый стиль) — Fly in from Right (Вылет справа); 

 Events (событие, в результате которого происходит анимация) — On Page 

load или Button Event (Щелчок на странице, щелчок на кнопке). В качестве 

"кнопки" у нас будет выступать текстовый фрейм. Для присвоения ему этой 

роли щелкните по значку "кнопка" справа от поля Events, а потом — на тек-

стовом фрейме в макете. Откроется палитра Buttons (Кнопки), где надо за-

дать момент начала анимации: On Release (При отпускании мыши); 

 Duration (Длительность) — оставляем 1 с. Этого вполне достаточно; 
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 Play (Воспроизведение) — 1 раз, если 

нам не нужно, чтобы наш объект летал 

туда-сюда многократно; 

 Animate (Настройка перемещения) — To 

Current Location (До текущего местопо-

ложения). В этом случае наш объект ос-

тановится в том положении, которое за-

фиксировано для него в макете; 

 Opacity (Плотность) — Fade in (Усили-

вать). Объект начнет движение как про-

зрачный, а закончит с полной плот- 

ностью. 

 
 

 

 

 

 

 

Рис. 14.13. Палитра Animation 

 

 

  

Готовые стили движения InDesign полностью соответствуют стилям в Adobe Flash CS5 Professional. При 

желании можно импортировать любой заказной набор настроек движения, созданный в Flash 
Professional, а также сохранить набор созданных вами настроек движения и использовать их в InDesign 

или Flash Professional. 

Функции анимации поддерживаются только при экспорте в Adobe Flash Player (.SWF). Для того чтобы 

добавить эффекты анимации в файл PDF, нужно экспортировать выделенные объекты из InDesign в 

файл SWF, а затем поместить этот файл SWF в документ InDesign. 
 

 

3. Для проверки результата экспортируйте страницу в файл SWF со стандартными 

настройками. 

Для удаления эффектов анимации достаточно выделить объект и нажать значок 

Удалить (Корзина) в палитре Animation. 
 

Преобразование выделенных объектов  
в траекторию движения 

Анимация может быть создана путем выделения объекта и контура и преобразова-

ния их в движение по траектории. При выделении двух замкнутых контуров, на-

пример двух прямоугольников, верхний контур становится траекторией движения. 

1. Рассмотрим появление рядом с заголовком подходящей картинки. Импортируй-

те файл chapter14\project_12chairs \audio_poster.jpg и разместите его в серой по-

лосе на уровне светло-серого анимированного прямоугольника (рис. 14.14). 

2. Нарисуйте линию, начинающуюся за пределами страницы и заканчивающуюся 

в центре импортированного изображения. 

3. Выделите оба объекта. 
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Рис. 14.14. Размещение картинки и контура для анимации 

 

4. В контекстном меню палитры Animation выберите команду Convert to Motion 

Path (Преобразовать в траекторию движения). Если требуется поправить полу-

чившуюся траекторию (начало, направление и т. д.), по ней надо щелкнуть инст-

рументом Direct Selection (Частичное выделение) и отредактировать контур. 

 

 

  

Одновременно можно преобразовать не более двух выбранных объектов. 
 

 

5. Задайте параметры движения. 

 Preset (Готовый стиль) — Custom (Заказной). 

 Events (События) — On Page load. 

 Duration (Длительность) — 1 с. 

 Play (Воспроизведение) — 1 раз. 

 Animate (Настройка перемещения) — To Current Appearance (До текущего 

состояния). Здесь учитываются все параметры состояния объекта — положе-

ние, прозрачность и т. д. 

 Opacity (Плотность) — None (Не менять). 

Теперь у нас в макете целых три объекта, которым в качестве стартового собы-

тия задано On Page Load (При загрузке страницы): музыка, прямоугольник в за-

головке и картинка. Как они будут взаимодействовать? По умолчанию очеред-

ность воспроизведения объектов соответствует их появлению в процессе работы 

над макетом. В нашем случае — сначала музыка, потом графические элементы. 

Но мелодия длится больше двух минут! Такая задержка появления остальных 

объектов нас совершенно не устроит. 

Исправить ситуацию можно с помощью палитры Timing (Распределение време-

ни) (рис. 14.15): Window > Interactive > Timing (Окно > Интерактивные эле-

менты > Распределение времени). 
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Рис. 14.15. Палитра Timing 

6. Выделите все анимированные объекты на странице. Они появятся в палитре 

Timing. Обратите внимание, что для них всех задано событие On Page Loading 

(При загрузке страницы). 

7. Захватывая мышью элементы списка, переместите их так, чтобы первым появ-

лялся прямоугольник в заголовке, потом картинка, потом начинала звучать  

музыка. 

8. Если хочется, чтобы несколько анимированных объектов воспроизводились од-

новременно, выберите элементы в списке и нажмите кнопку Воспроизвести 

вместе ("Цепочка" в правом нижнем углу палитры), чтобы связать элементы 

друг с другом. Как обычно, диапазон элементов выделяется при нажатой клави-

ше <Shift>, а несмежные элементы — при нажатой клавише <Ctrl>. Соседняя 

кнопка отменяет совместное воспроизведение. 
 

Переходы страниц 

Переходы страниц в документах, экспортируемых в форматы SWF или PDF, позво-

ляют отобразить при переворачивании страниц декоративные эффекты, например 

"растворение" или "стирание". Можно назначить разные переходы для отдельных 

страниц или задать один переход для всех страниц. Переходы страниц особенно 

полезны при создании слайд-шоу в формате PDF или SWF. Переходы страниц по-

являются при экспорте документа InDesign в формат PDF или SWF. 

 

 

  

Переходы страниц не применяются к разным страницам внутри одного разворота или к страницам-
шаблонам. 
 

 

Зададим нашей интерактивной книге переходы страниц. Наиболее интересный 

и естественный тип перехода — "перелистывание". 

1. В палитре Pages (Страницы) выберите развороты для применения перехода 

страниц. В нашем случае выделим все развороты. 

2. Вызовите палитру Page Transitions (Переходы страниц): Window > Inter-

active > Page Transitions (Окно > Интерактивные элементы > Переходы стра- 

ницы). 
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3. В выпадающем списке Transition (Переход) выберите Page Turn (Переворачи-

вание страниц). В окне миниатюры схематически отобразится действие этого 

перехода. 

4. Поля Direction (Направление) и Speed (Скорость) позволяют настроить соответ-

ствующие параметры перехода. Для перехода "Перелистывание" они недоступ-

ны, но в процессе экспериментов с другими переходами вы можете добиться ин-

тересных и нестандартных результатов. 

5. Примените переход ко всем выделенным разворотам кнопкой Apply to All 

Spreads (Применить ко всем разворотам) в правом нижнем углу палитры. 

6. После применения перехода страницы к развороту рядом с разворотом в палитре 

Pages (Страницы) появится значок перехода страниц. 

7. Для предварительного просмотра переходов страниц экспортируйте документ 

в формат SWF со стандартными установками. 

Для удаления переходов нужно выбрать страницы и в палитре Page Transitions вы-

брать None (Нет) в поле Transition (Переход). Для удаления переходов из всех раз-

воротов служит пункт Clear All (Очистить все) контекстного меню палитры Page 

Transitions (Переходы страниц). 
 

Кнопки 

В документе, предназначенном для экспорта в формат SWF или PDF, можно созда-

вать кнопки, управляющие выполнением определенных действий. Например, мож-

но создать кнопку для перехода на другую страницу или открытия веб-сайта. 

Настроим кнопки для показа фильма в документе PDF и для вызова web-страницы 

с комментарием к рассматриваемой главе. 

Для создания кнопок служит палитра Buttons (Кнопки): Window > Interactive > 

Buttons (Окно > Интерактивные элементы > Кнопки). 

Кнопку можно создать из самостоятельно подготовленного объекта или воспользо-

ваться набором готовых кнопок Sample Buttons (Готовые кнопки) из контекстного 

меню палитры Buttons (Кнопки). Свой собственный объект может быть геометри-

ческой фигурой, текстовым фреймом, импортированным изображением или груп-

пой — главное, чтобы он по стилистике соответствовал остальному оформлению 

страницы. Медиаобъекты в кнопки не преобразуются. 

В нашем учебном проекте для удобства воспользуемся готовыми кнопками. 

1. Вызовите команду Sample Buttons (Готовые кнопки) из контекстного меню па-

литры Buttons (Кнопки). 

2. Выберите образец № 7 (вытянутый объемный черный прямоугольник со скруг-

ленными углами). 

3. Вытяните на первую страницу два экземпляра этого образца и расположите друг 

под другом в боковой серой полосе (например, под маркером аудио). Первая 

кнопка будет служить для перехода к веб-странице с комментарием к рассмат-
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риваемой главе, вторая — для перехода к странице, содержащей видеофрагмент 

(рис. 14.16). 

 

 

  

Прямая ссылка на проигрывание видео или аудио работает только при расположении кнопки и медиа-
объекта на одной странице. С учетом того, что для медиаобъектов параметры воспроизведения задают-
ся другими способами, дублировать их кнопкой особого смысла нет. Эти элементы списка действий 
предназначены для создания интерактивных кнопок — например, можно разместить на странице звук 
щелчка и присвоить его как действие On Click (при нажатии) каждой имеющейся кнопке. Тогда читатель 
будет в прямом смысле "щелкать кнопками" в процессе просмотра вашей публикации. 
 

 

 

Рис. 14.16. Расположение кнопок на странице 

4. В первой кнопке двойным щелчком на блике выделите его и, вызвав инструмент 

Type (Текст), напишите "Комментарий". Во второй кнопке аналогично напиши-

те "Видеофрагмент". При необходимости измените параметры шрифта, чтобы 

надписи хорошо вписывались в кнопки. 

5. Для первой кнопки в палитре Buttons (Кнопки) в поле будет уже заранее указа-

но имя кнопки — Button № (его имеет смысл изменить на значимое — напри-

мер, "Комментарий", — чтобы потом не запутаться в номерных именах), собы-

тие — On Release (По щелчку) и действие — GoTo URL (Перейти к веб-

странице). Если понадобится изменить событие, надо выбрать нужный вариант в 

выпадающем списке событий, а для назначения другого действия — нажать 

кнопку "+" и выбрать нужное. Для того чтобы удалить лишнее действие, надо 

выбрать его и нажать "-". В поле URL введите нужный адрес: http://lib.web-

malina.com/getbook.php?bid=2123&page=73 (скопируйте его из палитры 

Buttons любого из файлов 12chairs_sample.indd). 

 

 

  

После экспорта в SWF проигрыватель может потребовать приостановить выполнение перехода на 
внешний сайт. В этом случае надо настроить параметры проигрывателя, разрешив выход в Интернет 
для своих SWF-файлов. Acrobat Reader (или Adobe Acrobat), в котором воспроизводятся файлы PDF,   
обычно просто выдает запрос на соединение с Сетью и, получив разрешение, дальше уже действует 
нормально. 
 



336 Глава 14 

6. В поле Appearance (Оформление) обратите внимание на образцы внешнего ви- 

да кнопки при разных действиях мышью: Normal — обычное состояние, 

Rollover — при наведении курсора. При выделенном состоянии Normal щелк-

ните по "глазу" при строке Click (Щелчок) — оформление скопируется для это-

го состояния. При желании что-то изменить выделите нужный элемент кнопки 

при активном состоянии, требующем изменения (например, Click, если требу-

ется изменить цвет кнопки в момент щелчка) и внесите все необходимые прав-

ки. В конце работы над кнопкой вернитесь в состояние Normal, иначе после 

экспорта кнопка так и будет отображаться в последнем активном состоянии. 

 

 

  

Для создания кнопки из собственного объекта служит команда Interactive > Convert to Button (Интерак-
тивные элементы > Преобразовать в кнопку) контекстного меню объекта. Дальнейшие действия анало-
гичны уже рассмотренным. Для добавления своей кнопки в набор готовых образцов достаточно выбрать 
команду Add Item (Добавить элемент) контекстного меню набора образцов Sample Buttons. 
 

 

Для второй кнопки понадобится небольшая подготовительная работа. 

7. Выделите кнопку с надписью "Видеофрагмент". 

8. Правой кнопкой мыши вызовите контекстное меню объекта и выберите коман-

ду Interactive > New Hyperlink (Новая ссылка). В окне настройки ссылки вы-

берите в качестве привязки Page (Страница) и задайте номер страницы 6. По-

ставьте флажок Name with Page Number (Именовать по номеру страницы), 

чтобы не заботиться об имени ссылки. 

9. В палитре Buttons (Кнопки) нажатием на 

кнопку "-" удалите стандартное для этого 

образца действие перехода к веб-странице 

и выберите новое ("+"): Go to Destination 

(Перейти к привязке). 

10. Проверьте, чтобы в поле Document стояло 

имя вашего рабочего документа, в поле 

Page — Page 6 (рис. 14.17). 

11. Если нужный номер страницы не появился 

в списке, проверьте привязку — например, 

командой Interactive > New Hyperlink 

Destination (Интерактивные элементы > 

Новая привязка) контекстного меню объ- 

екта. 

12. Масштаб отображения страницы настройте 

по желанию. 

13. Настройте оформление кнопки аналогично 

первой. 
 

 

Рис. 14.17. Настройка перехода к привязке  
в палитре Buttons 
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14. Теперь создадим кнопки перехода со страницы на страницу. Поскольку они 

должны повторяться на каждой странице, их имеет смысл расположить на шаб-

лоне. 

15. Перейдите на мастер-шаблон. 

16. В наборе готовых образцов выберите кнопку № 41 (черная стрелка влево) и 

№ 42 (черная стрелка вправо). При желании можно выбрать другие кнопки-

стрелки, которые покажутся вам более подходящими к оформлению страницы. 

17. Расположите кнопки в нижней части боковой серой полосы на уровне нижнего 

края текстового поля (рис. 14.18). 

 

Рис. 14.18. Размещение кнопок перехода по страницам 

18. Обратите внимание, что в палитре Buttons этим кнопкам уже заданы действия: 

Go to Previous Page и Go to Next Page (Переход на предыдущую / следующую 

страницу). 

19. Настройте оформление по своему усмотрению. 

20. При желании такие кнопки можно создать и из своих собственных объектов — 

например, нарисовать двойные треугольнички, обращенные соответственно 

вправо и влево, и задать им указанные действия. 
 

Типы событий 

 On Release (При отпускании кнопки мыши после щелчка) — самое распростра-

ненное событие, поскольку оно дает пользователю последнюю возможность от-

вести курсор от кнопки и не активизировать действие. 

 On Click (При нажатии кнопки мыши). Это событие удобно использовать для 

каких-то интерактивных настроек кнопки — например, воспроизведения звука 

щелчка. В обычных же случаях лучше применять событие On Release, посколь-

ку оно позволяет отменить выбранное действие. 

 On Roll Over (При наведении курсора мыши на область, ограниченную рамкой 

кнопки). Самый частый пример этого события — изменение вида кнопки при 

наведении курсора. 

 On Roll Off — в момент, когда курсор мыши покидает область кнопки. 

 On Focus — кнопка в файле PDF получает фокус в результате нажатия кнопки 

мыши или клавиши <Tab>. 

 On Blur — фокус перемещен на другую кнопку или на другое поле формы в 

файле PDF. 
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Последние два типа событий встречаются несколько реже и характерны, в основ-

ном, для сложных интерактивных форм в файлах PDF. 
 

Типы действий 

 Go to Destination (Переход к точке привязки) — переход к указанной текстовой 

привязке, созданной с использованием палитры Hyperlinks (Гиперссылки). 

 Go to First / Last / Next / Previous Page (Переход к первой / последней / сле-

дующей / предыдущей странице) — переход к соответствующей странице. 

 Go to URL (Перейти по URL-адресу) открывает web-страницу по указанному 

URL-адресу. 

 Show / Hide Buttons (Показать / Скрыть кнопки) — переключение между пока-

зом и скрытием указанных кнопок в готовом файле PDF или SWF. Например, 

если требуется появление одной кнопки, когда курсор наводится на другую 

кнопку, можно скрыть первую кнопку до наступления соответствующего собы-

тия и создать действие, которое будет отображать ее при наведении курсора на 

заданный объект. Используется, например, при разработке flash-сайтов для соз-

дания выпадающих меню. 

 Video (Видео) позволяет воспроизводить, приостанавливать и останавливать 

выбранный фильм, а также возобновлять его воспроизведение. 

 Audio (Звук) позволяет воспроизводить, приостанавливать и останавливать вы-

бранный звуковой клип, а также возобновлять его воспроизведение. 

Действия, которые экспортируются только в SWF: 

 Animation (Анимация) позволяет воспроизводить, приостанавливать и останав-

ливать выбранную анимацию, а также возобновлять ее воспроизведение. 

 Go to Page (Перейти к странице) — переход к указанной странице файла SWF. 

 Go to State (Перейти в состояние) — переход к определенному состоянию для 

объекта, имеющего несколько состояний. Например, если объект с несколькими 

состояниями содержит различные изображения в качестве состояний, этим дей-

ствием можно воспользоваться для отображения определенного изображения. 

Применяется, например, при создании фотоальбомов. 

 Go to Next / Previous State (Перейти в следующее/предыдущее состояние) — 

переход к следующему или предыдущему состоянию для объекта, имеющего 

несколько состояний. Эти параметры оказываются особенно полезными при 

управлении слайд-шоу. 

Действия, которые экспортируются только в PDF. 

 Go to Next / Previous View (Перейти к следующему / предыдущему виду) — пе-

реход к следующей странице после перехода к предыдущему виду. Аналогично 

кнопке Вперед в веб-браузере, которая становится доступной только после того, 

как пользователь нажмет кнопку Назад, переход к следующему виду  становит-

ся доступным, только если пользователь переходил к предыдущему виду. 



Особенности электронных публикаций 339 

 Open File (Открыть файл) запускает приложение и открывает указанный файл. 
Если указан файл, отличный от PDF, для успешного открытия этого файла пона-
добится приложение, предназначенное для работы с файлами этого типа. 

 View Zoom (Масштаб просмотра) — отображение страницы в соответствии с 
параметрами инструмента Масштаб. 

 

 

  

Поскольку некоторые действия поддерживаются как в файлах PDF, так и в файлах SWF, другие — толь-
ко в файлах PDF или SWF, при выборе действия для кнопки обращайте внимание на ограничения по 
экспорту, заявленные в списке возможных действий. 
 

 

Создание объектов с несколькими состояниями 

Состояние — это версия элемента страницы. Объект, который содержит несколько 
состояний, называется объектом с несколькими состояниями. 

В палитре Object States (Состояния объекта) не 
существует ограничений на количество состояний, 
которые можно создать для одного объекта. Каж-
дый раз при создании нового состояния создается 
новая версия элемента страницы. 

В каждый момент на странице отображается только 
одно состояние. При печати и экспорте в PDF ис-
пользуется только активное состояние. 

Для работы с разными состояниями объекта служит 
палитра Object States (Состояния объекта) 
(рис. 14.19). 

 
 
 
 
 
 
' 

 
 

Рис. 14.19. Палитра Object States 

Проект "Слайд-шоу" 

Одно из самых частых использований объекта с несколькими состояниями — 
слайд-шоу, которое позволяет просматривать файл PDF или SWF как набор изо-
бражений. Допустим, нужно создать слайд-шоу из 10 изображений, не размещая их 
на 10 различных страницах. 

1. Создайте документ типа web со следующими настройками (рис. 14.20). 

2. Импортируйте все фотографии из папки chapter14\project_show, расположив их 
строго друг над другом (рекомендуется использовать команду Paste in Place и 
импорт с заменой изображения). 
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Рис. 14.20. Настройки документа для слайд-шоу 

 

3. Выделите все изображения в стопке и откройте палитру Object States (Состоя-

ния объекта): Window > Interactive > Object States (Окно > Интерактивные 

элементы > Состояния объекта) и нажмите кнопку создания нового элемента 

в правом нижнем углу палитры. Назначьте объекту имя. 

4. Изображения отобразятся как состояния в палитре Object States (Состояния 

объекта), вокруг стопки появится пунктирная граница. 

5. Создайте оформление страницы и кнопки навигации, которые активируют дей-

ствия Go to Next State (Перейти в следующее состояние) и Go to Previous State 

(Перейти в предыдущее состояние) при отпускании кнопки мыши. Можно вос-

пользоваться готовыми кнопками или придумать свои собственные. 

6. Для проверки результата экспортируйте документ в формат SWF со стандарт-

ными установками. 

Для изменения состояния его надо выбрать в палитре Object States (Состояния 

объекта) и отредактировать. Можно изменить его атрибуты, задать ему анима-

цию и т. д. 

7. Выделите состояние № 2. В палитре Animation (Анимация) назначьте ему дей-

ствие Fade Out (Постепенное исчезновение). Обратите внимание, что для объ-

ектов, являющихся основным элементом состояния, возможны только два стар-

товых события: On Click (Self) и On Rollover (Self). Это значит, что  для запуска 

анимации в готовом SWF-файле надо будет щелкнуть по фотографии. 
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Теперь добавим каких-нибудь деталей в одно из состояний. 

8. Выберите состояние № 3. Нарисуйте два длинных узких прямоугольника, за-

лейте их белым цветом и расположите в нижней части фотографии (рис. 14.21). 

Выделите все три объекта и нажмите кнопку Add Objects to Visible State (До-

бавить объекты в видимое состояние) в правом нижнем углу палитры. 

 

Рис. 14.21. Размещение дополнительных объектов в состоянии 

9. Двойным щелчком по каждому из прямоугольников выделите их и задайте им 

анимацию: одному — Fly in from Left, другому — Fly in from Right (Вылет 

слева и вылет справа соответственно). Обратите внимание, что им автоматиче-

ски назначается стартовое событие On State Load (При загрузке состояния). 

10. Для добавления объекта как состояния в существующий объект с несколькими 

состояниями нужно выбрать оба объекта и щелкнуть по кнопке создания ново-

го элемента в правом нижнем углу палитры. 

11. Для удаления состояния его нужно выбрать и щелкнуть по кнопке Корзина. 
 

Создание активной области кнопки 

Иногда бывает нужно, чтобы область кнопки ("активная область" или "ссылка") не 

отображалась до тех пор, пока на нее не будет наведен курсор мыши. Например, 

при наведении указателя на кнопку карты может появляться изображение, соответ-

ствующее определенному региону, а после выхода указателя за пределы участка 

карты это изображение будет исчезать. 

В экспортированном файле PDF наведение курсора на активную область приводит 

к появлению изображения. 
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Один из способов достижения эффекта "активной области" — применение некото-

рого изображения к состоянию Rollover (Курсор над кнопкой) в палитре Buttons 

(Кнопки). Для этого состояния создается вид кнопки, содержащий изображение, 

которое должно появляться при наведении курсора. Остальные состояния кнопки 

при этом остаются неизменными. 
 

Отображение другой кнопки при наведении курсора 

Можно создать активную область, в которой щелчок или наведение курсора на 

объект вызовут отображение другого объекта. Создадим таким образом переходы к 

первому и последнему состоянию нашего объекта (первому и последнему кадрам 

слайд-шоу). Пусть при наведении курсора на фотографию появляются дополни-

тельные кнопки перехода, а при щелчке по фотографии — исчезают. 

1. Поверх объекта с фотографиями нарисуйте прямоугольник точно такого же раз-

мера, задайте ему пустую заливку и пустую обводку и в контекстном меню объ-

екта вызовите Interactive > Convert to Button (Интерактивные элементы > Пре-

образовать в кнопку). 

2. С помощью инструмента Многоугольник создайте двойные треугольнички, ко-

торые обычно обозначают быстрый переход. Залейте подходящим цветом и 

сгруппируйте. Скопируйте группу щелчком по кнопке зеркального отражения 

в Контрольной панели при нажатой кнопке <Alt>. 

3. Для каждой группы в контекстном меню объекта вызовите Interactive > Convert 

to Button (Интерактивные элементы > Преобразовать в кнопку). 

4. Задайте действие: стрелкам вправо — Go to State с выбором в поле Object 

(Объект) значения Summer Show, в поле State (Состояние) — State 10. Стрел-

кам влево, соответственно, State 1. 

5. Установите обеим кнопкам флажок Hidden Until Triggered (Скрыть до запуска). 

6. Задайте кнопкам имена Go_to_first и Go_to_last соответственно. 

7. Расположите кнопки рядом с кнопками перехода между состояниями, ближе 

к середине страницы (рис. 14.22). 

8. Кнопке, которая будет управлять этими кнопками (той, что создана на осно- 

ве большого прямоугольника с пустыми атрибутами), задайте следующие на-

стройки: 

 по событию On Rollover (При наведении курсора) — действие Show / Hide 

Buttons (Скрыть / Показать кнопки). В списке кнопок включите "глаз" (Пока-

зать) у именованных кнопок Go_to_first и Go_to_last; 

 по событию On Release (При отпускании мыши) — действие Show / Hide 

Buttons (Скрыть / Показать кнопки). В списке кнопок включите "перечеркну-

тый глаз" (Скрыть) у именованных кнопок Go_to_first и Go_to_last. 

9. Проверьте работу кнопок в палитре Preview (Предварительный просмотр). 
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Рис. 14.22. Расположение скрытых кнопок 

Экспорт в формат PDF 

Рассмотрим поближе окно экспорта в формат PDF (Interactive) (рис. 14.23). 

 Pages (Страницы): укажите диапазон страниц. При выборе параметра Range 

(Диапазон) укажите номера страниц, например 1-7, 9. 

 View after Exporting (Просмотр после экспорта) открывает вновь созданный 
PDF-файл в приложении по умолчанию для просмотра PDF. 

 

Рис. 14.23. Окно экспорта в Interactive PDF 
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 Embed Page Thumbnails (Встроить миниатюры страниц): cсоздает миниатюру 

для предварительного просмотра каждой экспортируемой страницы или по од-

ной миниатюре на каждый разворот, если выбран параметр Spreads (Развороты). 

Миниатюра отображается в диалоговых окнах Open (Открыть) и Place (Помес-

тить) в InDesign. Добавление миниатюр увеличивает размер PDF-файла. 

 Create Acrobat Layers (Создать слои программы Acrobat): сохраняет в PDF ка-

ждый слой InDesign как слой Acrobat. Полностью поддерживается навигация по 

слоям, что позволяет пользователям Acrobat 6.0 и более поздних версий созда-

вать несколько версий одного PDF-файла. 

 Create Tagged PDF (Создать PDF-файл с тегами): в процессе экспорта автома-

тически добавляет в материал теги на основе тегов Acrobat, поддерживаемых 

программой InDesign, например распознавание абзацев, форматирование текста, 

списков и таблиц. 

 View (Вид) — масштаб просмотра PDF при открытии. 

 Layout (Макет) — настройки отображения страниц при открытии PDF-файла. 

 Presentation (Презентация) — Open in Full Screen Mode (Открыть в полноэк-

ранном режиме) — позволяет задать отображение документа PDF в Adobe 

Acrobat или Adobe Reader без меню и панелей. Для автоматического перевора-

чивания страниц выберите Flip Pages Every (Переворачивать страницы каждые) 

и введите количество секунд, отведенных на отображение каждой страницы. 

 Page Transitions (Переходы страниц) позволяет выбрать один переход, который 

будет применен ко всем страницам в процессе экспорта. Если переходы были 

заданы в палитре Page Transitions (Переходы страницы), выбирается значение 

From Document (Из документа). 

 Buttons and Media (Кнопки и медиафункции): для полноценного воспроизведе-

ния всех интерактивных элементов устанавливается флажок Include All (Вклю-

чить все). 

 Compression (Сжатие) позволяет записать файл максимально компактно, но 

приводит к некоторому ухудшению качества импортированной графики. Обыч-

но выбирается JPEG (Lossy) — JPEG с потерей качества — для уменьшения 

размера файла. При необходимости максимально сохранить качество изображе-

ний выбирается JPEG 2000, сохраняющий файл без потерь. 

 JPEG Quality (Качество JPEG) задает уровень сжатия изображений. Чем выше 

качество, тем больше размер файла. Этот параметр недоступен, если для сжатия 

изображения был выбран параметр JPEG 2000 (без потери качества). 

 Resolution (Разрешение) — разрешение растровых изображений в экспортиро-

ванном PDF. Выбор высокого разрешения особенно важен для просмотра рас-

тровых изображений в файле PDF при крупном масштабе. Надо помнить, что 

чем выше разрешение, тем больше размер файла. 
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Экспорт в форматы Flash 

Интерактивные документы для Flash могут быть выведены в двух форматах: 

FLA — для последующего редактирования в Adobe Flash Professional и SWF для 

воспроизведения с помощью Adobe Flash Player — отдельно или в рамках веб-

страницы. 

Рассмотрим экспорт в формат SWF (рис. 14.24) нашего слайд-шоу. 

Основное отличие SWF от FLA заключается в том, что файлы SWF готовы к про-

смотру и не могут быть изменены, а файлы FLA предназначены для дальнейшего 

редактирования в Adobe Flash Professional и напрямую в плеере воспроизводиться 

не могут. 
 

 

Рис. 14.24. Окно экспорта в формат SWF 

 

 Export (Экспорт) — диапазон страниц. Выбор параметра Selection (Выделение) 

полезен, если требуется сохранить файл SWF для вставки в макет, экспортируе-

мый в PDF. При выборе параметра Range (Диапазон) укажите диапазон страниц, 

например 1-9. 

 Generate HTML File (Генерировать файл HTML) — создание HTML-страницы 

для воспроизведения файла SWF. Этот параметр удобен для быстрого просмотра 

файла SWF в веб-браузере. 

 View SWF after Exporting (Просмотр SWF после экспорта) — немедленный за-

пуск файла SWF в веб-браузере по умолчанию. Этот параметр доступен только 

в случае создания HTML-файла. 
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 Size (Размер (пикс.)) — размер области воспроизведения готового файла. Здесь 

можно указать процентное изменение масштаба файла SWF, подгонку под ука-

занный размер экрана, либо задать ширину и высоту вручную. 

 Background (Фон) — выбор фона документа SWF. При выборе параметра 

Transparency (Прозрачный) отключаются параметры Page Transitions (Перехо-

ды страниц) и Include Interactive Page Curl (Включить интерактивное перево-

рачивание страниц). 

 Interactivity and Media (Интерактивность и мультимедиа) — для полноценного 

воспроизведения интерактивных элементов устанавливается флажок Include All  

(Включить все). 

 Page Transitions (Переходы страниц) — выбор одного перехода, который будет 

применен ко всем страницам в процессе экспорта. Если переходы были заданы  

в палитре Page Transitions (Переходы страницы), выбирается значение From 

Document (Из документа). 

 Include Interactive Page Curl (Включить интерактивное переворачивание стра-

ниц) — аналог перехода Page Turn в палитре Page Transitions. Если требуется 

оформить всю публикацию таким переходом, его можно задать прямо во время 

экспорта. 

 Вкладка Advanced позволяет задать более тонкие настройки качества изображе-

ния и воспроизведения — например, частоту кадров или степень сжатия импор-

тированных изображений. Чаще всего здесь используется группа полей 

Compression (Сжатие), аналогичная такой же группе в окне экспорта в PDF. 

В результате экспорта в SWF с созданием HTML создается папка Resources, где 

хранятся необходимые медиафайлы (видео и аудио) для вызова их в нужный  

момент в процессе воспроизведения. 
 

Итоги 

Современный мир все больше уходит в виртуальность и интерактивность. Многие 

периодические издания создают свои электронные версии — не только сетевые, но 

и предназначенные для оффлайн-восприятия с экрана ноутбука или iPad. Элек-

тронные книги приобретают все большую популярность, хотя и не заменяют в пол-

ной мере книги обычные. Все это говорит об одном: электронные публикации — 

это целый мир, и будет ли он живым, теплым и уютным или пустым, скучным и 

холодным, зависит от дизайнера. InDesign предоставляет достаточно средств для 

создания красивых, удобных в обращении и понятных электронных публикаций.  

Средства эти не только можно, но и необходимо активно использовать в повсе-

дневной практике. 

 



  

 

Глава 15 
 

 

АВТОМАТИЗАЦИЯ И КООРДИНАЦИЯ 

РАБОТЫ С ДОКУМЕНТАМИ 

 

 

 
 
Здесь мы бегло рассмотрим возможности взаимодействия программы InDesign  

с другими программами при работе с переменными данными и групповом редакти-

ровании документа. 

Автоматизация 

Многие рутинные операции в InDesign можно автоматизировать с помощью сцена-

риев. Сценарий — это набор команд, которые программа выполняет как некий еди-

ный алгоритм. Сценарий может быть простым или сложным, готовым или создан-

ным самостоятельно. 

InDesign содержит две палитры для работы со сценариями: Scripts (Сценарии) и 

Script Label (Ярлык сценария). 

Палитра Scripts (Сценарии) вызывается традиционно: Window > Utilites > Scripts 

(Окно > Вспомогательные элементы > Сценарии). В ней отображаются сценарии, 

расположенные в подпапках Scripts папки приложения InDesign и в пользователь- 
 



348 Глава 15 

ских папках "Установки" (рис. 15.1). Чтобы сце-

нарий появился в палитре Scripts, после создания 

или получения его необходимо поместить в папку 

Scripts Panel. 

Для быстрого перехода к папке Script Panel доста-

точно щелкнуть по сценарию в палитре Scripts 

(Сценарии) правой кнопкой мыши и выбрать 

пункт Reveal in Explorer (Показать в Провод- 

нике). 

Для выполнения сценария достаточно сделать 

двойной щелчок по нему в палитре Scripts (Сце-

нарии). 

Палитра Script Label (Ярлык сценария) позволяет 

задавать ярлыки для элементов страницы: тексто-

вых фреймов, фигур и др. Задание ярлыков для 

элементов страницы особенно полезно при напи-

сании собственных сценариев. 
 

 

 

 

 

 

 

Рис. 15.1. Палитра Scripts 

 

 

Стандартные сценарии InDesign 

 AddGuides — добавление направляющих вокруг выбранного объекта. 

 AddPoints — добавление точек в контур выбранного объекта. 

 AdjustLayout — перемещение объектов на указанное расстояние на правых или 

левых страницах. 

 AlignToPage — выравнивание объектов в указанном месте на странице. 

 AnimationEncyclopedia — автоматическое создание кнопок с различными свой-

ствами анимации. 

 BreakFrame — удаление выбранного текстового фрейма и его содержимого из 

материала. 

 CornerEffects — перерисовка контура выбранного элемента с использованием 

различных типов углов. Типы углов могут быть применены к выбранным точкам 

контура. 

 CreateCharacterStyles — определение полного стиля символа на основе вы-

бранного текста. 

 CropMarks — добавление меток обреза или меток приводки вокруг выбранного 

объекта. 
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 ExportAllStories — экспорт всех материалов документа в несколько текстовых 
файлов. 

 FindChangeByList — выполнение нескольких операций по поиску и замене тек-
ста на основе файла с разделителями-табуляциями. 

 ImageCatalog — размещение всей графики в определенной папке. 

 MakeGrid — создание сетки путем разделения или дублирования выбранного 
объекта. 

 PathEffects — изменение положения точек контура на выбранном объекте для 
добавления художественного эффекта. 

 PlaceMultipagePDF — импорт всех страниц файла PDF. 

 SelectObjects — выбор объектов на активном развороте по типу. 

 SortParagraphs — сортировка всех абзацев выбранного фрагмента в алфавит-
ном порядке. 

 SplitStory — разделение текстовых фреймов в выбранном материале на отдель-
ные несвязанные текстовые фреймы. 

 TabUtilities — применение табуляции и отступа к выбранному тексту. 

Внешние модули 

Внешние модули InDesign — это программы, разработанные компанией Adobe 
Systems либо другими разработчиками программного обеспечения совместно с 
Adobe, которые добавляют новые функции к приложениям Adobe. Несколько 
внешних модулей, отвечающих за импорт, экспорт, автоматизацию и дополнитель-
ные эффекты, входят в комплект поставки программы и автоматически устанавли-
ваются в папку Plug-Ins. В сущности, большинство функций программы InDesign 
реализованы в виде внешних модулей. 

После установки внешние модули появляются в виде параметров в различных ме-
ню, диалоговых окнах или палитрах. 

Следуйте инструкциям по установке, поставляемым вместе с внешним модулем. 
Если для него предусмотрена программа установки, следует воспользоваться ею. 
Если нет — скопировать модуль в папку Plug-Ins, вложенную в каталог приложе-
ния InDesign. 
 

 

  

Можно также воспользоваться любым коммерческим внешним модулем, разработанным для работы в 
InDesign. Служба технической поддержки Adobe поможет решить любые проблемы, связанные с внеш-
ними модулями. Однако если оказалось, что проблема связана непосредственно с внешним модулем, 
созданным другой компанией, то для получения поддержки следует обратиться в эту компанию. 
 

 

Использование менеджера расширений  
для настройки внешних модулей 

Приложение Extension Manager (Менеджер расширений) используется для про-
верки и настройки набора установленных внешних модулей. Например, оно позво-
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ляет получать подробные сведения об установленных внешних модулях, создавать 
заказные наборы внешних модулей для различных задач или рабочих групп, а так-
же изолировать их во время поиска неисправностей или отключать внешние моду-
ли (рис. 15.2). 

 

Рис. 15.2. Менеджер расширений 

Менеджер расширений вызывается через меню Help > Manage Extensions 
(Справка > Управлять расширениями). 

Более подробные сведения об использовании менеджера расширений содержатся 
в справке приложения Extension Manager (Менеджер расширений). 

Объединение данных 

Для создания стандартных писем, конвертов или почтовых ярлыков производится 
объединение файла источника данных с целевым документом. Объединение дан-
ных называют также "объединением почты". 

Файл источника данных содержит сведения, которые различаются в разных экзем-
плярах целевого документа — например, имена и адреса получателей в стандарт-
ном письме. Файл источника данных состоит из полей и записей. 

Поля содержат данные — например, имена компаний или почтовые индексы. 

Записи — это строки с полным набором данных: именем компании, адресом, горо-

дом, областью и почтовым индексом. Источником данных может быть, например, 
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текстовый файл с разделителями-табуляциями, где поля данных разделены симво-

лами табуляции. 

Целевой документ — документ InDesign, который содержит заполнители полей 
данных и содержимое шаблона (текст и другие элементы, которые должны быть 
одинаковыми во всех объединенных документах). 

Объединенный документ — итоговый документ InDesign, содержащий шаблонные 
элементы целевого документа, которые повторяются столько раз, сколько нужно 
для обработки всех записей в источнике данных. 

1. Создайте документ класса Print, формата А5, в одну колонку, с полями, напри-
мер по 15 мм со всех сторон. 

2. Импортируйте файл chapter15\projest_merge\base_letter.doc. 

3. Задайте тексту форматирование по своему усмотрению. 

4. Очевидно, что сменная информация будет содержаться в строках "Куда", "Ко-
му", в окончании слова "Уважаемый/ая", в зависимости от пола адресата, и в 
собственно обращении. Эти поля и заданы в первой строке в файле Source.txt: 
Адрес (Куда), Адресация (Кому), Обращение (ый/ая) и Имя, Отчество (собст-
венно обращение к адресату). Значения полей в каждой строке (записи) разделе-
ны знаками табуляции. При сохранении файла в формате TXT выберите коди-
ровку Unicode, тогда InDesign сможет использовать его без искажений. 

5. Вызовите палитру Data Merge (Объединение данных): Window > Utilites > Data 
Merge (Окно > Вспомогательные элементы > Объединение данных). 

6. В контекстном меню палитры выберите команду Select Data Source (Выбрать 
источник данных) и загрузите файл Source.txt. Поля из источника данных по- 
явятся в палитре (рис. 15.3). 

 

Рис. 15.3. Палитра Data Merge 

7. Вставьте поля источника данных в документ (поставьте курсор в нужную точку 
и щелкните по строке поля в палитре). Поля могут быть добавлены как на стра-
ницу документа, так и на страницу-шаблон. 

8. Установите флажок Preview (Просмотр) в левом нижнем углу палитры и про-
листайте записи, чтобы убедиться, что целевой документ будет выглядеть так, 
как планировалось. 

9. Объедините целевой документ с исходным файлом данных командой Create 

Merged Document (Создать объединенный документ) контекстного меню па-
литры (рис. 15.4). 



352 Глава 15 

 

Рис. 15.4. Окно создания объединенного документа 

Здесь особенно важно обратить внимание на следующие настройки: 

 Records to Merge (Записи для объединения) — можно выбрать All (все); 

 Records per Document Page (Записей на странице) — одна или несколько. 

Обычно для писем характерно размещение одной записи на странице, но для не-

больших посланий (приглашений, расчетных листков и т. д.) можно выбрать не-

сколько записей на странице. В этом случае программа предложит выбрать по-

рядок размещения готовых посланий; 

 Generate Overset Text Report With Document Creation (Создать отчет о пере-

полнении текстовых фреймов) — в случае переполнения текстового фрейма при 

вставке слишком длинного значения в какое-либо из полей будет сформировано 

предупреждающее сообщение; 

 Alert When Images Are Missing (Предупреждать о потере изображений) — име-

ет смысл, если в шаблоне присутствуют импортированные изображения, напри-
мер в праздничных поздравительных рассылках. 

Можно также экспортировать документ в файл PDF (команда Export to PDF кон-

текстного меню). Появится сначала уже рассмотренное окно объединения данных, 
а потом — обычное окно экспорта в PDF (Print), которое мы рассматривали в гла-

ве 13. 

Добавление полей изображений в файл источника данных 

При добавлении полей изображений в файл источника данных можно сделать так, 

что в каждой из объединенных записей будет помещено отдельное изображение. 
Например, при создании документов, содержащих сведения о различных компани-

ях, можно поместить в файл логотип каждой из них. 
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Для этого в файле источника данных нужно в начале имени поля (в первой строке) 

ввести символ @ для вставки путей, указывающих на файлы изображений. 

Символ @ необходим только в первой строке; остальные строки должны содержать 

пути к изображению (рис. 15.5). 

 

Рис. 15.5. Файл источника данных с полями вставки изображений 

 

 

  

При появлении сообщения об ошибке во время ввода символа @ в начале поля нужно ввести апостроф 
(') перед символом @ (например, '@Фотографии) для разрешения такой записи. В некоторых приложе-
ниях (например, в Microsoft Excel) символ @ зарезервирован для обозначения функций. 
 

 

Вставка поля данных изображения в целевой документ 

Поле изображения вставляется в документ так же, как текстовое поле: щелчком по 

строке в палитре при установленном положении курсора внутри текстового фрейма 

(в этом случае изображение встроится в текст) или перетаскиванием поля изобра-

жения в пустой фрейм или существующий графический фрейм (в этом случае по- 

явится "плавающее" поле изображения, существующее отдельно от текста шаб- 

лона). 

Заполнители поля изображения отображаются в виде фреймов, содержащих имена 

полей. 

Если вставить заполнители полей данных на страницы-шаблоны, появятся допол-

нительные возможности, которые недоступны при вставке заполнителей на стра-

ницы документа: 

 результирующий объединенный документ содержит на страницах-шаблонах ис-

ходные заполнители, а на страницах документа — результаты объединения в 

виде измененных элементов страницы-шаблона; 

 объединенный документ сохраняет связь с источником данных, поэтому при из-

менении записей в источнике данных содержимое объединенного документа 

может быть обновлено по команде Update Data Source (Обновить содержимое в 

полях данных). Эта функция особенно полезна при изменении компоновки объ-

единенного документа и последующем добавлении новых данных в источник 

данных; 

 параметры диалогового окна Create Merged Document (Создать объединенный 

документ) идентичны используемым в целевом документе, поэтому текущий 
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документ может быть быстро создан заново в таком же виде. Кроме того, эти 

общие параметры могут быть использованы для создания идентичного докумен-

та с другим источником данных или для создания нового документа с немного 

измененным макетом. 

 

 

  

Размещать поля данных и на страницах-шаблонах, и на страницах документа нельзя. Для правильной 

работы функции объединения содержащий поля данных шаблон должен быть применен к первой стра-

нице документа. Если появляется сообщение об ошибке, указывающее, что InDesign не может произве-

сти объединение документа из-за отсутствия заполнителей, возможно, они были добавлены на левую 

страницу-шаблон одностраничного документа. Страница 1 формируется на основе правой страницы-

шаблона, поэтому заполнители следует добавлять к правой странице-шаблону. 
 

 

Обновление, удаление  
и замена файлов источников данных 

Для управления источниками данных служат команды контекстного меню Update 

Data Source (Обновить источник данных), Remove Data Source (Удалить источ- 

ник данных) и Select Data Source (Выбрать источник данных). Эти команды позво-

ляют выполнить все операции по обновлению или удалению существующей связи  

с источником данных и при необходимости установления связи с новым источ- 

ником. 

Обновление полей данных 

После объединения документа с заполнителями данных, расположенными на стра-

ницах-шаблонах, компоновка объединенного документа может быть изменена, при 

этом возможность обновления значений полей в источнике данных сохранится. 

Функция Update Data Source (Обновить поля данных) позволяет обновлять поля 

данных с сохранением компоновки документа. Этот параметр доступен только в 

объединенном документе, где заполнители данных находятся на страницах-

шаблонах. 

Отчеты о переполнении текстовых фреймов 

Отчет о переполнении текстовых фреймов выводится, если в диалоговом окне 

Create Merged Document (Создать объединенный документ) выбран параметр 

Generate Overset Text Report With Document Creation (Создать отчет о перепол-

нении текстовых фреймов) и одно или несколько полей после объединения содер-

жат вытесненный текст. 

Отчет содержит записи о каждом случае вытеснения текста в виде нумерованного 

списка с указанием номера страницы, числа вытесненных символов и слов, а также 

фрагмента вытесненного текста. Соответственно, нужно выбрать путь решения 

проблемы: например, увеличить размер текстового фрейма, уменьшить размер 

шрифта или отредактировать текст. 
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Параметры размещения содержимого 

Строка контекстного меню Content Placement Options (Параметры размещения 
содержимого) вызывает соответствующее диалоговое окно (рис. 15.6). 

 

Рис. 15.6. Диалоговое окно Content Placement Options 

Это окно позволяет задать дополнительные настройки размещения содержимого 
полей — текста и изображений: 

 Fitting (Подгонка) — полностью соответствует командам группы Fitting меню 

Object (Объект) и служит для взаимной подстройки изображения и предназна-
ченного для него фрейма; 

 Centre in Frame (Центрировать во фрейме) — выравнивает центр изображения 

по центру фрейма; 

 Link Images (Связать изображения) — создает связь с исходным файлом изо-
бражения (путь к файлу). Если этот параметр не выбран, изображения целиком 

встраиваются в документ InDesign; 

 Remove Blank Lines for Empty Fields (Удалить пустые строки в пустых по-
лях) — удаляет символы начала нового абзаца, вставленные для пустых полей. 

Это особенно полезно при отправке сообщений электронной почты, когда име-
ется дополнительное поле адреса. Если строка содержит любые символы, в том 

числе пробелы, она не будет удалена; 

 Record Limit per Document (Максимальное число записей в документе) — за-
дает максимальное количество записей для каждого объединенного документа. 

При достижении порогового значения создается новый документ с необходи-
мым для размещения оставшихся записей количеством страниц (не более уста-

новленного лимита записей на документ). Этот параметр доступен только в том 
случае, если выбрано значение Single Record (Одна запись) параметра Records 

Per Document Page (Записей на странице). 

Обмен данными с программой InCopy 

Модули рабочих процессов Adobe InCopy LiveEdit позволяют авторам и редакто-

рам создавать копию в InCopy и работать с ней, пока дизайнеры готовят макеты в 
Adobe InDesign. При этом работа идет с контейнерными файлами, которые назы-
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ваются подборками и используются для группирования связанных фрагментов  

содержимого, а также с инструментами блокировки файлов и уведомлениями для 
обмена файлами и их обновления в InCopy или InDesign. Файлы могут передавать-

ся по локальной сети или в виде сжатых пакетов по электронной почте. 

В совместных рабочих процессах пользователи InDesign экспортируют текст и изо-
бражения в общую папку файловой системы. Файлы в этой папке становятся дос-
тупными пользователям InCopy, которые могут записывать и редактировать содер-
жимое. Выбранные текстовые и графические фреймы экспортируются либо в под-
борку, либо в виде отдельных файлов InCopy, где они становятся частью 
управляемого процесса и связаны с документом InDesign с помощью ссылок. Эти 
общие файлы называются управляемыми файлами. 

Когда кто-то работает в файле подборки или в файле InDesign на локальном серве-
ре, изменения соответствующего макета или содержимого передаются всем поль-
зователям, участвующим в рабочих процессах по этому документу. 

Один и тот же файл содержимого может быть одновременно открыт несколькими 
пользователями InCopy или InDesign, так же как и файл подборки может быть од-
новременно открыт несколькими пользователями InCopy, однако в каждый момент 
времени только один пользователь может извлечь с сервера (check out) файл InCopy 
для изменения. Другие пользователи могут просматривать файл в режиме "только 
для чтения". 

Пользователь, извлекающий управляемый файл InCopy для изменения, может ра-
ботать с ним одновременно с другими пользователями, сохранив файл на общем 
сервере или вернув его пользователю InDesign, но другие пользователи не могут 
вносить изменения в этот файл до тех пор, пока файл не будет возвращен в общее 
пользование (check in). Эта система позволяет нескольким пользователям обра-
щаться к одному и тому же файлу без риска, что кто-то случайно уничтожит изме-
нения, внесенные другим пользователем. 

Способы работы с содержимым в InCopy 

Содержимое — это либо основной текст, расположенный в одном или нескольких 
фреймах, либо импортированную графику. Есть пять основных способов работы 
с содержимым в программе InCopy: 

 открыть файл подборки; 

 открыть пакет подборки; 

 открыть связанный файл InCopy; 

 открыть файл InDesign со связанными файлами InCopy; 

 создать все содержимое в InCopy. 

Открытие файлов подборки, созданных в InDesign 

Пользователи InDesign могут создать файл подборки и определить содержимое для 
совместного использования. Этот метод позволяет связать соответствующие ком-
поненты (заголовок, основной текст, графику, подписи и т. д.), а затем назначить их 
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разным пользователям InCopy для записи и редактирования. Другие пользователи 
InCopy открывают файл подборки и работают только с теми компонентами, кото-
рые были им назначены. В режиме быстрого просмотра пользователи InCopy могут 
видеть, как их отредактированная копия связана с макетом InDesign, и для этого не 
нужно открывать весь документ InDesign. Однако если макет меняется, пользова-
тель InDesign должен обновить подборки, чтобы уведомить пользователей InCopy 
об изменениях. Файлы подборки можно совместно использовать на сервере или 
с помощью пакетов подборки. 

Подборка и ее компоненты представлены на палитре Assignments (Подборки) и 

могут быть открыты в InCopy (рис. 15.7). 

 

Рис. 15.7. Файл подборки в InDesign и InCopy 

Открытие пакетов подборки 

Использование пакетов подборок особенно удобно в тех случаях, когда дизайнеры 

и авторы текстов работают над одним проектом, но не имеют доступа к локальному 

серверу. В таких случаях пользователь InDesign может создать один или несколько 

пакетов и отправить сжатые файлы назначенным пользователям InCopy по элек-

тронной почте. Пользователи InCopy могут открыть пакеты подборки, отредакти-

ровать их содержимое и вернуть эти пакеты пользователю InDesign, который затем 

может обновить документ. 

Открытие документов InDesign со связанными файлами InCopy 

Для того чтобы видеть все элементы страницы в контексте всего макета, пользова-

тели InCopy могут открыть и редактировать документ InDesign в InCopy. Это может 

быть удобно при редактировании и вгонке текста, если пользователю важно видеть 

весь макет, а также в случаях, когда редактируются почти все материалы в доку-

менте. По окончании редактирования пользователь InDesign может обновить связи 
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с измененными файлами. Если пользователь InDesign меняет макет, пользователь 

InCopy получает уведомление об этом в момент сохранения документа InDesign. 

Создание всего содержимого в InCopy 

В программе InCopy можно создавать содержимое, не связанное с файлом InDesign. 

Эти автономные документы допускают ввод текста, назначение шрифтов и стилей, 

а также импорт графики из других приложений (таких как Adobe Illustrator и Adobe 

Photoshop) для улучшения текста. Это хороший вариант для редакционного рабоче-

го процесса, где содержимое создается раньше структуры. Для автономных доку-

ментов InCopy можно также задать и изменить текстовую область, размер страни-

цы и ориентацию. Однако если позже материал связывается с документом InDesign, 

настройки, используемые в InCopy, заменяются настройками InDesign. 

Управляемые файлы 

Чтобы сделать файл управляемым, надо включить его в файл подборки, экспорти-

ровать из InDesign в качестве содержимого InCopy или разместить как содержимое 

InCopy в InDesign. Управляемые файлы информируют как о состоянии содержимо-

го, так и о владельце. С помощью управляемых файлов можно: 

 блокировать и разблокировать материалы для сохранения целостности файлов; 

 уведомлять коллег об устаревании макета InDesign; 

 определить пользователя, работающего с файлом; 

 уведомлять о том, что файл содержимого InCopy устарел, используется кем-то 

или доступен для редактирования. К методам уведомления относятся предупре-

ждения, значки фреймов, значки состояния в палитре Links (Связи) и значки со-

стояния в палитре Assignments (Подборки). 

Файлы "только для чтения" 

Если файл содержимого получил статус управляемого, он доступен всем участни-

кам рабочих процессов в режиме "только для чтения". Вносить изменения в файл 

может только пользователь, извлекший этот файл для изменения. Когда пользова-

тель извлекает файл содержимого для изменения, программный модуль создает 

файл блокировки (*.idlk), предоставляя этому пользователю исключительный кон-

троль над внесением изменений. 

Особенности режима "только для чтения": 

 пользователь InCopy не может вручную форматировать текст в этом файле, но, 

если тексту были присвоены стили шрифта или абзаца, пользователь InDesign 

может изменить определение этих стилей и таким образом изменить формати-

рование текста, даже если файл был извлечен для изменения кем-то еще. Эти 

изменения будут заметны в тексте, как только пользователь InDesign обновит 

файл; 

 ни пользователь InCopy, ни пользователь InDesign не могут менять в заблокиро-

ванном содержимом такие объекты, как текст и применяемые стили. Некоторые 
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объекты, например стили символов или абзаца, используются только этим со-

держимым. Например, в заблокированном содержимом нельзя изменить способ 

применения стиля символа к объектам, но можно изменить сам символьный 

стиль, изменив таким образом внешний вид текста; 

 пользователь InDesign может изменить поля и колонки текстового содержимого, 

его форму, размещение и количество текстовых фреймов, занимаемых материа-

лом; 

 пользователь InDesign может изменить геометрию и форматирование графиче-

ского фрейма, не извлекая графику для изменения. Пользователь InCopy не мо-

жет изменить графический фрейм или формат фрейма. Но для изменения самой 

графики (например, чтобы повернуть или масштабировать ее) и пользователь 

InDesign, и пользователь InCopy должны извлечь с сервера графический фрейм 

для изменения. 

Рекомендации по работе с управляемыми файлами 

 Храните файлы подборки на сервере, доступном для всех членов команды. Если 

члены команды не имеют доступа к серверу, можно создать и распределить па-

кеты подборки. 

 При создании подборки создается специальная папка для хранения файла под-

борки. Используйте эти папки для хранения файлов подборки и файлов содер-

жимого. Они облегчают управление общими файлами в рабочей группе и обес-

печивают открытие пользователями правильных файлов. 

 В InCopy открывайте файл подборки вместо отдельного материала InCopy. 

 В InDesign, если требуется удалить файлы из рабочих процессов (например, при 

переходе к новому проекту), можно удалить связи с этими файлами или отме-

нить пакет подборки. 

Идентификация пользователя 

У каждого пользователя, участвующего в рабочих процессах, должно быть имя. 

Эта идентификация позволяет выяснить, кто извлек конкретный файл для измене-

ния, и сделать эту информацию доступной для других пользователей. Идентифика-

ция необходима и для того, чтобы извлечь с сервера файл для изменения. 

Если вы уже указали имя пользователя, но хотите его изменить, необходимо преж-

де вернуть все извлеченное вами содержимое. В противном случае, изменив свой 

идентификатор пользователя во время сеанса редактирования, вы не сможете ре-

дактировать излеченное содержимое, т. к. оно будет заблокировано под другим 

именем пользователя. 

Идентификация пользователя зависит от конкретного приложения. Ни один поль-

зователь не может иметь несколько идентификаторов для одного приложения. 

 

 

  

Функции InCopy Примечания и Отслеживание изменений используют указанное имя, чтобы опреде-
лить автора примечания или отслеженного изменения. 
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Идентификатор задается командой User (Пользователь) контекстного меню 

Assignments (Подборки): Window > Editorial > Assignments > User (Окно > Редак-

тирование > Подборки > Пользователь). В поле User Name (Имя пользователя) 

вводится уникальное имя, которое потом используется в рабочем процессе. 
 

 

  

Выпадающий список Colour (Цвет) в этом диалоговом окне предназначено для идентификации редакци-
онных примечаний и отслеженных изменений. 
 

 

Обмен содержимым.  
Экспорт содержимого из InDesign 

При экспорте содержимого из InDesign в InCopy между двумя приложениями уста-

навливается связь. Для экспорта текстовых фреймов, графических фреймов и дру-

гого содержимого InDesign в InCopy можно использовать любой из следующих ме-

тодов. 

 Создать файл контейнера (подборки, *.icma) и включить в эту подборку соот-

ветствующие группы элементов документа (например, текст и графику материа-

ла), чтобы работать над ними вместе. Содержимое в подборках экспортируется 

в виде файлов *.icml. 

 Экспортировать текст и графические фреймы по отдельности (включая шаблон-

ные фреймы) с помощью команд меню Edit > InCopy > Export (Редактирова- 

ние > InCopy > Экспорт). Экспортированное содержимое сохраняется в виде 

файлов *.icml. 

После выполнения экспорта содержимого в верхнем левом углу экспортированных 

фреймов в InDesign и InCopy и в палитре Assignments (Подборки) появляются спе-

циальные значки. Связь с экспортированным файлом появляется на палитре Links 

(Связи). Эти значки показывают состояние управляемых фреймов и позволяют от-

личить управляемые фреймы от тех, которые не входят в рабочие процессы. Все 

экспортированное содержимое отображается в палитре Assignments (Подборки). 

Содержимое, экспорт которого выполнялся с помощью команд меню Edit, отобра-

жается в палитре Assignments (Подборки) в разделе Unassigned InCopy Content 

(Неназначенное содержимое InCopy). Оба метода устанавливают управляемое со-

единение между содержимым InCopy и документом InDesign, но для оптимальной 

организации совместной работы лучше использовать файлы подборки. 

Палитра Assignments 

Основным инструментом для работы с подборками является палитра Assignments 

(Подборки): Window > Editorial > Assignments (Окно > Правка > Подборки)  

в InDesign и аналогичная палитра в InCopy. В этой палитре отображаются файлы, 

экспортированные из активного документа InDesign, а значок показывает их со-

стояние. В меню палитры содержатся команды для контроля версии импорта и 

функций управления файлами между InCopy и InDesign (рис. 15.8). 
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Рис. 15.8. Палитра Assignments 

 

 

  

Все содержимое, экспортированное в программу InCopy или добавленное в подборку, отображается на 
палитре Links. Хотя некоторые задачи управления рабочими процессами можно выполнять через эту 
палитру (например, извлекать содержимое для изменения и возвращать его), рекомендуется использо-
вать для этого палитру Assignments. 
 

 

Файлы подборки 

Файлы подборки в программе InDesign — это контейнеры для организации наборов 

элементов страницы. 

Например, требуется выбрать все дополнительные элементы в материале (заголо-

вок, имя автора, копирайт, графику и подписи) и назначить их одному пользовате-

лю InCopy. Включение всех этих элементов в подборку — удобный способ предос-

тавить пользователям InCopy доступ только к тому содержимому, за которое они 

отвечают. 

Файлы подборки (*.icma) отображаются в файловой системе, в палитре материалов 

InCopy и в сообщениях состояния. Создавать файлы подборки могут только поль-

зователи InDesign, открывать — только пользователи InCopy. 

Файлы подборки включают: 

 связи и указатели на соответствующие элементы страницы, включая шаблонные 

фреймы. Эти элементы позволяют пользователю InCopy открыть отдельный 

файл в InCopy и получить доступ к нескольким элементам страницы для редак-

тирования; 

 любые трансформации графики, включенные в подборку, например перемеще-

ние, масштабирование, поворот или наклон; 

 геометрию страницы, чтобы пользователи InCopy могли видеть макет фрейма, 

содержимое которого они редактируют, не открывая весь файл InDesign; 

 цветовое кодирование назначенных фреймов в документе. 

Создание подборок и добавление содержимого 

Для создания пустого файла подборки нужно выбрать команду New Assignment 

(Новая подборка) в палитре Assignments (Подборки). 

В диалоговом окне (рис. 15.9) задаются параметры файла подборки. 

Для добавления содержимого в существующие подборки нужно выделить тексто-

вые и графические фреймы, которые требуется добавить в подборку, и в меню па- 
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Рис. 15.9. Диалоговое окно создания подборки 

 

литры Assignments (Подборки) выбрать команду Add to Assignment (Добавить 

в подборку), а затем выбрать подборку из выпадающего списка. 

При создании или изменении файла подборки могут быть заданы следующие пара-

метры: 

 Assignment Name (Имя подборки) — уникальный идентификатор подборки на 

палитре, например "Ocean article"; 

 Assigned to (Назначен) — уникальный идентификатор пользователя, которому 

назначены файлы. Имя пользователя отображается на палитре Assignments 

в круглых скобках после имени подборки; 

 Colour (Цвет) отображает список цветов, которыми подсвечиваются фреймы 

текущей подборки в окне документа и имена подборок на палитре Assignments; 

 Change (Изменить) определяет местоположение папки подборки. По умолчанию 

папки подборок создаются в той же папке, что и файл InDesign; 

 Placeholder Frames (Шаблонные фреймы) позволяют пользователям InCopy ви-

деть текстовые и графические фреймы в подборке и прямоугольные поля (или 

другие формы), представляющие все остальные фреймы на этих страницах 

InDesign. Все фреймы и шаблоны точно отражают размер, форму и размещение 

исходных фреймов InDesign. Шаблонные фреймы — это пустые фигуры, не ото-

бражающие никакое содержимое документа InDesign. Параметр Placeholder 

Frames (Шаблонные фреймы) обеспечивает наименьшую точность и, следова-

тельно, самую высокую производительность. В программе InCopy шаблонные 

фреймы видны только в представлении "Макет"; 

 Assigned Spreads (Назначенные развороты): на таком развороте пользователи 

InCopy могут видеть все назначенные фреймы и все содержимое других фрей-

мов, не входящих в подборку. Содержимое фреймов, не являющихся частью 
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подборки, не может редактироваться в программе InCopy и становится видимым 

только в режиме "Макет"; 

 All Spreads (Все развороты): все содержимое документа InDesign экспортирует-

ся в файл подборки. Этот параметр обеспечивает максимальную точность, но 

его производительность самая низкая, поскольку в файле подборки отображают-

ся структура и макет каждой страницы, включая те, которые не имеют отноше-

ния к редактируемому разделу; 

 Linked Image Files When Packaging (Включение связанных изображений в па-

кет): в пакет подборки включаются копии связанных файлов изображений. Вы-

бор этого параметра обеспечивает пользователям InCopy доступ к изображени-

ям, но увеличивает размер файла пакета. 

Пакеты подборки 

В идеальных условиях все пользователи InDesign и пользователи InCopy, участ-

вующие в проекте, имеют доступ к серверу, где хранятся файлы подборок. Но если 

один или несколько пользователей не имеют доступа к общему серверу, можно 

создавать и распространять сжатые пакеты подборок. Закончив работу с подбор-

кой, пользователь InCopy заново упаковывает ее и возвращает для интеграции 

в документ InDesign. 

Пакетные файлы, созданные в InDesign, имеют расширение .icap. Возвращаемые 

пакетные файлы, созданные в InCopy, имеют расширение .idap. 

Создание пакетов подборок 

Для создания пакетов файлов есть две команды: Package for InCopy (Пакет для 

InCopy) и Package for InCopy and E-mail (Упаковать и отправить по e-mail) кон-

текстного меню палитры Assignments (Подборки). 

Первая из этих команд служит для создания сжатого пакета, который можно затем 

распространять вручную, а вторая — для создания сжатого пакета, который авто-

матически прикрепляется к сообщению электронной почты. 

Для создания пакета в палитре Assignments (Подборки) определяется нужная под-

борка, в контекстном меню выбирается команда в зависимости от планируемых 

дальнейших действий и задается местоположение пакета. В случае использования 

команды Package for InCopy and E-mail (Упаковать и отправить по e-mail) сжатый 

пакет подборок создается и прикрепляется к сообщению электронной почты почто-

вого приложения, используемого по умолчанию. 

Получение и открытие пакетов (InCopy) 

Пакет может быть получен от пользователя InDesign, создавшего пакет, или от дру-

гого пользователя InCopy. Пакет подборок открывается двойным щелчком на паке-

те в почтовом приложении или в Проводнике. В процессе открытия пакет распако-

вывается, и его содержимое копируется в новую подпапку в папке подборок 

InCopy. 
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Теперь можно редактировать материалы, содержащиеся в пакете. В начале  работы 
над материалом программа предлагает извлечь с сервера содержимое фрейма для 
изменения. По окончании редактирования все содержимое пакета сохраняется, и 
пакет возвращается обратно. 

Возврат пакета или пересылка другому пользователю (InCopy) 

Файлы пакета, созданные для других пользователей InCopy, имеют расширение 
.icap; файлы возвращаемого пакета, созданные для пользователей InDesign, имеют 
расширение .idap. 

Для возврата пакета в палитре Assignments в InCopy выбирается одна из команд 
вывода содержимого: 

 Forward for InCopy (Передать в InCopy) — cоздает пакет для другого пользова-
теля InCopy. Здесь указывается имя и местоположение файла пакета, а затем 
к нему предоставляется доступ другому пользователю InCopy; 

 Forward for InCopy and E-mail (Передать в InCopy по e-mail) — создает пакет 
для другого пользователя InCopy с пересылкой его по электронной почте. Пакет 
прикрепляется как вложение к новому сообщению в почтовом приложении, ис-
пользуемом по умолчанию; 

 Return For InDesign (Вернуть в InDesign) — создает пакет для возврата пользо-
вателю InDesign; 

 Return For InDesign And Email (Вернуть в InDesign по e-mail) — создает пакет 
для пользователя InDesign с пересылкой его по электронной почте. Пакет при-
крепляется как вложение к новому сообщению в почтовом приложении, исполь-
зуемом по умолчанию. 

Получение возвращенных пакетов (InDesign) 

Возвращенный пакет открывается двойным щелчком на файле пакета в почтовом 
приложении или в Проводнике. 

При открытии пакета программа предлагает обновить все связи. После того как ма-
териалы в файлах возвращены и разблокированы, можно извлечь их с сервера и 
редактировать содержимое. 

Открытие общего содержимого 

После открытия пакета подборок имена подборок и их содержимое отображаются 
на палитре Assignments (Подборки). 

Извлечение содержимого с сервера (сheck out) 

Для извлечения содержимого с сервера нужно выбрать в палитре нужную подборку 
и воспользоваться командой Check Out (Извлечь) контекстного меню. Когда эле-
мент извлекается с сервера для изменения, в файловой системе появляется скрытый 
файл блокировки (.idlk). После извлечения содержимого пользователь приобретает 
монопольный контроль над ним, и другие пользователи уже не могут вносить из-
менения. 
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При попытке закрыть документ InDesign, в котором есть один или несколько фай-

лов содержимого InCopy, извлеченных для изменения, программа предложит вер-

нуть все содержимое. Если закрыть документ, не вернув файлы содержимого, при 

следующем открытии документа InDesign эти файлы все еще будут заблокированы. 

При сохранении документа InDesign автоматически сохраняются все редактируе-

мые файлы содержимого InCopy. 

Обновление содержимого 

Для того чтобы всегда работать только с новейшими версиями содержимого, необ-

ходимо следить за появлением значков Out of Date (Устарело) в палитре 

Assignments и обновлять содержимое. При обновлении файла подборки InCopy и 

его содержимого (или отдельных файлов содержимого) данные копируются из са-

мой последней сохраненной копии. Обновление не требует операций извлечения и 

возврата файлов и не предоставляет прав редактирования. 

Для обновления содержимого в палитре Assignments (Подборки) выбирается  со-

держимое, требующее обновления, и вызывается команда Update Selected / All 

Assignments (Обновить выделенное / все содержимое) в контекстном меню. 
 

Итоги 

Если ваша работа в основном связана с созданием отдельных разноплановых маке-

тов, вы можете не особенно задумываться об автоматизации рабочего процесса. Но 

если вы приступаете к большой серии однотипных проектов, имеет смысл изучить 

возможности готовых сценариев и научиться создавать свои, чтобы автоматизиро-

вать как можно больше рутинных операций. И даже те, кого слово "программиро-

вание" и все, что с этим связано, приводит в ужас, оценят возможности быстрой и 

удобной работы с переменными данными. 

Одно из главных достоинств InDesign CS5 — расширенные возможности команд-

ной работы, когда художник, верстальщик и редактор могут работать с макетом 

параллельно, не мешая друг другу и обновляя публикацию "на лету". Если вы — 

фрилансер-одиночка, получающий подробное ТЗ и сдающий готовую работу, то 

этот раздел вам не особенно интересен. Но если вы постоянно работаете в команде 

в режиме жесткого графика выдачи готового продукта и в постоянном цейтноте, то 

вы оцените полезные возможности новой версии. 
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Приложение 1 
 

 

НОВОЕ РАСПОЛОЖЕНИЕ КОМАНД 

ГЛАВНОГО МЕНЮ 

  

InDesign CS4  InDesign CS5  — новое расположение 

File > Export For Digital Editions File > Export For > EPUB 

File > Export For Dreamweaver File > Export for > Dreamweaver 

Object > Lock Position Object > Lock 

Object > Unlock Position Object > Unlock All On Spread 

Object > Interactive > Movie Options / Sound 
Options 

Media panel 

Object > Paths > Convert Point > Line End / 
Corner / Smooth / Smooth Symmetrical 

Object > Convert Point > Plain / Corner / Smooth / 
Symmetrical 

View > Show/Hide Hyperlinks, Show/Hide Text 
Threads, Show/Hide Frame Edges, Show/Hide 
Assigned Frames, Show/Hide Notes 

View > Extras > Show/Hide Hyperlinks, Show/Hide 
Text Threads, Show/Hide Frame Edges, 
Show/Hide Assigned Frames, Show/Hide Notes 

Window > Assignments Window > Editorial > Assignments 

Window > Attributes Window > Output > Attributes 

Window > Automation > Data Merge / Script 
Label / Scripts 

Window > Utilities > Data Merge / Script Label / 
Scripts 

Window > Color Window > Color > Color 

Window > Gradient Window > Color > Gradient 

Window > Object Styles Window > Styles > Objects Styles 

Window > Swatches Window > Color > Swatches 

Window > Tags Window > Utilities > Tags 

Window > Type & Tables > Notes Window > Editorial > Notes 

Window > Type & Tables > Cell Styles / Cha-
racter Styles / Paragraph Styles > Table Styles 

Window > Styles > Cell Styles / Character Styles / 
Paragraph Styles > Table Styles 

Help/InDesign > Configure Plug-ins Help/InDesign > Manage Extensions 

 



  

 

Приложение 2 
 

 

КЛАВИАТУРНЫЕ СОКРАЩЕНИЯ 

 

 

Меню File (Файл) 

Browse in Bridge (Просмотреть в Bridge) <Ctrl>+<Alt>+<O> 

Close (Закрыть) <Ctrl>+<W> 

Document Setup (Настройка документа) <Ctrl>+<Alt>+<P> 

Exit (Выход) <Ctrl>+<Q> 

Export (Экспорт) <Ctrl>+<E> 

File Info (Информация о файле) <Shift>+<Ctrl>+<Alt>+<I> 

New: Document (Создать: документ) <Ctrl>+<N> 

Open (Открыть) <Ctrl>+<O> 

Package (Упаковка) <Shift>+<Ctrl>+<Alt>+<P> 

Place (Поместить) <Ctrl>+<D> 

Print (Печать) <Ctrl>+<P> 

Save (Сохранить) <Ctrl>+<S> 

Save As (Сохранить как) <Shift>+<Ctrl>+<S> 

Save a Copy (Сохранить копию) <Ctrl>+<Alt>+<S> 

Меню Edit (Редактирование) 

Clear (Очистить) <Backspace> 

Copy (Копировать) <Ctrl>+<C> 

Cut (Вырезать) <Ctrl>+<X> 

Deselect All (Снять выделение) <Shift>+<Ctrl>+<A> 

Duplicate (Дублировать) <Shift>+<Ctrl>+<Alt>+<D> 

Edit in Story Editor (Текстовый редактор) <Ctrl>+<Y> 

Find Next (Найти следующий) <Ctrl>+<Alt>+<F> 

Find/Change (Автозамена) <Ctrl>+<F> 

Paste (Вставить) <Ctrl>+<V> 

Paste Into (Вставить в…) <Ctrl>+<Alt>+<V> 
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Paste in Place (Вставить на то же место) <Shift>+<Ctrl>+<Alt>+<V> 

Paste without Formatting (Вставить без 
форматирования) 

<Shift>+<Ctrl>+<V> 

Preferences: General (Предпочтения: Основные) <Ctrl>+<K> 

Quick Apply (Быстрое применение) <Ctrl>+<Enter> 

Redo (Повторить действие) <Shift>+<Ctrl>+<Z> 

Select All (Выделить все) <Ctrl>+<A> 

Spelling: Check Spelling (Проверка орфографии) <Ctrl>+<I> 

Step and Repeat (Повторить с заданным шагом) <Ctrl>+<Alt>+<U> 

Undo (Отменить действие) <Ctrl>+<Z> 

Update Content (Обновить содержимое) <Ctrl>+<F5> 

Меню Layout (Макет) 

First Page (Первая страница) <Shift>+<Ctrl>+<Page Up> 

Go Back (Перейти назад) <Ctrl>+<Page Up> 

Go Forward (Перейти вперед) <Ctrl>+<Page Down> 

Go to Page (Перейти к странице) <Ctrl>+<J>  

Last Page (Последняя страница) <Shift>+<Ctrl>+<Page Down> 

Next Page (Следующая страница) <Shift>+<Page Down> 

Next Spread (Следующий разворот) <Alt>+<Page Down> 

Pages: Add Page (Добавить страницу) <Shift>+<Ctrl>+<P> 

Previous Page (Предыдущая страница) <Shift>+<Page Up> 

Previous Spread (Предыдущий разворот) <Alt>+<Page Up>  

Меню Type (Текст) 

Create Outlines (Преобразовать текст в контуры) <Shift>+<Ctrl>+<O> 

Create outlines without deleting text (Преобразовать в 
контуры с сохранением текста) 

<Shift>+<Ctrl>+<Alt>+<O> 

Insert Break Character: Column Break (Вставить разрыв 
колонки) 

 Num<Enter> 

Insert Break Character: Forced Line Break (Вставить 
разрыв строки) 

<Shift>+<Enter> 

Insert Break Character: Frame Break (Вставить разрыв 
фрейма) 

<Shift>+<N>um<Enter> 

Insert Break Character: Page Break (Вставить разрыв 
страницы) 

<Ctrl>+<N>um<Enter> 

Insert Break Character: Paragraph Return (Вставить 
разрыв абзаца) 

<Enter> 
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Insert Special Character: Hyphens and Dashes: 
Discretionary Hyphen (Специальный символ: 
дискреционный перенос) 

<Shift>+<Ctrl>+<-> 

Insert Special Character: Hyphens and Dashes: Em Dash 
(Специальный символ: длинный перенос) 

<Shift>+<Alt>+<-> 

Insert Special Character: Hyphens and Dashes: En Dash 
(Специальный символ: короткий перенос) 

<Alt>+<-> 

Insert Special Character: Hyphens and Dashes: 
Nonbreaking Dash (Специальный символ: неразрывный 
перенос) 

<Ctrl>+<Alt>+<-> 

Insert Special Character: Markers: Current Page Number 
(Специальный символ: номер страницы) 

<Shift>+<Ctrl>+<Alt>+<N> 

Insert Special Character: Other: Indent to Here 
(Специальный символ: точка левого отступа) 

<Ctrl>+<\> 

Insert Special Character: Other: Right Indent Tab 
(Специальный символ: точка правого отступа) 

<Shift>+<Tab> 

Insert Special Character: Other: Tab (Специальный 
символ: табуляция) 

<Tab> 

Insert Special Character: Quotation Marks: Double Left 
Quotation Marks (Специальный символ: двойные левые 
кавычки) 

<Alt>+<[> 

Insert Special Character: Quotation Marks: Double Right 
Quotation Marks (Специальный символ: двойные правые 
кавычки) 

<Shift>+<Alt>+<[> 

Insert Special Character: Quotation Marks: Single Left 
Quotation Mark (Специальный символ: левая кавычка) 

<Alt>+<]> 

Insert Special Character: Quotation Marks: Single Right 
Quotation Mark (Специальный символ: правая кавычка) 

<Shift>+<Alt>+<]> 

Insert Special Character: Quotation Marks: Straight 
Single Quotation Mark (Apostrophe) (Специальный 
символ: апостроф) 

<Alt>+<‘> 

Insert Special Character: Symbols: Bullet Character 
(Специальный символ: маркер списка) 

<Alt>+<8> 

Insert Special Character: Symbols: Copyright Symbol 
(Специальный символ: знак Копирайт) 

<Alt>+<G> 

Insert Special Character: Symbols: Ellipsis 
(Специальный символ: эллипс) 

<Alt>+<;> 

Insert Special Character: Symbols: Paragraph Symbol 
(Специальный символ: знак абзаца) 

<Alt>+<7> 

Insert Special Character: Symbols: Registered 
Trademark Symbol (Специальный символ: знак 
зарегистрированной торговой марки) 

<Alt>+<R> 

Insert Special Character: Symbols: Section Symbol 
(Специальный символ: метка секции) 

<Alt>+<6> 

Insert Special Character: Symbols: Trademark Symbol 
(Специальный символ: знак торговой марки) 

<Alt>+<2> 
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Insert White Space: Em Space (Em-пробел) <Shift>+<Ctrl>+<M> 

Insert White Space: En Space (En-пробел) <Shift>+<Ctrl>+<N> 

Insert White Space: Nonbreaking Space (Неразрывный 
пробел) 

<Ctrl>+<Alt>+<X> 

Insert White Space: Thin Space (Узкий пробел) <Shift>+<Ctrl>+<Alt>+<M> 

Notes: Notes Mode (Режим заметок) <Ctrl>+<F8> 

Show Hidden Characters (Показать скрытые символы) <Ctrl>+<Alt>+<I> 

Tabs (Настройки табуляции) <Shift>+<Ctrl>+<T> 

Track Changes: Next Change (Отслеживание правок: 
следующая правка) 

<Ctrl>+<Page Down> 

Track Changes: Previous Change (Отслеживание 
правок: предыдущая правка) 

<Ctrl>+<Page Up> 

Меню Object (Объект) 

Arrange: Bring Forward (На шаг выше) <Ctrl>+<]> 

Arrange: Bring to Front (На передний план) <Shift>+<Ctrl>+<]> 

Arrange: Send Backward (На шаг ниже) <Ctrl>+<[> 

Arrange: Send to Back (На задний план) <Shift>+<Ctrl>+<[> 

Clipping Path: Options (Параметры обтравочного 
контура) 

<Shift>+<Ctrl>+<Alt>+<K> 

Effects: Drop Shadow. (Эффекты: тень) <Ctrl>+<Alt>+<M> 

Fitting: Centre Content (Подгонка: центрировать 
содержимое) 

<Shift>+<Ctrl>+<E> 

Fitting: Fill Frame Proportionally (Пропорциональная 
подгонка фрейма) 

<Shift>+<Ctrl>+<Alt>+<C> 

Fitting: Fit Content Proportionally (Пропорциональная 
подгонка содержимого) 

<Shift>+<Ctrl>+<Alt>+<E> 

Fitting: Fit Content to Frame (Подогнать содержимое под 
фрейм) 

<Ctrl>+<Alt>+<E> 

Fitting: Fit Frame to Content (Подогнать фрейм под 
содержимое) 

<Ctrl>+<Alt>+<C> 

Group (Группировка) <Ctrl>+<G> 

Hide (Скрыть) <Ctrl>+<3> 

Lock (Заблокировать) <Ctrl>+<L> 

Paths: Make Compound Path (Создать составной контур) <Ctrl>+<8> 

Paths: Release Compound Path (Разобрать составной 
контур) 

<Shift>+<Ctrl>+<Alt>+<8> 

Select: Container (Выбрать фрейм) <Escape> 

Select: Content (Выбрать содержимое) <Shift>+<Escape> 
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Select: First Object Above (Выбрать верхний объект) <Shift>+<Ctrl>+<Alt>+<]> 

Select: Last Object Below (Выбрать нижний объект) <Shift>+<Ctrl>+<Alt>+<[> 

Select: Next Object Above (Выбрать объект выше) <Ctrl>+<Alt>+<]> 

Select: Next Object Below (Выбрать объект ниже) <Ctrl>+<Alt>+<[> 

Show All on Spread (Показать все содержимое 
разворота) 

<Ctrl>+<Alt>+<3> 

Text Frame Options (Параметры текстового фрейма) <Ctrl>+<B> 

Ungroup (Разгруппировка) <Shift>+<Ctrl>+<G> 

Unlock All on Spread (Разблокировать все на развороте) <Ctrl>+<Alt>+<L> 

Меню Table (Таблица) 

Cell Options: Text (Параметры ячейки: Текст) <Ctrl>+<Alt>+<B> 

Delete: Column (Удалить столбец) <Shift>+<Backspace> 

Delete: Row (Удалить строку) <Ctrl>+<Backspace> 

Insert Table (Вставить таблицу) <Shift>+<Ctrl>+<Alt>+<T> 

Insert: Column (Вставить столбец) <Ctrl>+<Alt>+<9> 

Insert: Row (Вставить строку) <Ctrl>+<9> 

Select: Cell (Выбрать ячейку) <Ctrl>+</> 

Select: Column (Выбрать столбец) <Ctrl>+<Alt>+<3> 

Select: Row (Выбрать строку) <Ctrl>+<3> 

Select: Table (Выбрать таблицу) <Ctrl>+<Alt>+<A> 

Table Options: Table Setup (Параметры таблицы: 
Настройка таблицы) 

<Shift>+<Ctrl>+<Alt>+<B> 

Меню View (Вид) 

Actual Size (Масштаб 1:1) <Ctrl>+<1> 

Display Performance: Fast Display (Быстрое 
отображение) 

<Shift>+<Ctrl>+<Alt>+<Z> 

Display Performance: High Quality Display 
(Отображение с высоким разрешением) 

<Ctrl>+<Alt>+<H> 

Display Performance: Typical Display (Стандартное 
отображение) 

<Ctrl>+<Alt>+<Z> 

Entire Pasteboard (Вся рабочая область) <Shift>+<Ctrl>+<Alt>+<0> 

Extras: Hide Frame Edges (Скрыть границы фреймов) <Ctrl>+<H> 

Extras: Show Text Threads (Показать связи текстовых 
фреймов) 

<Ctrl>+<Alt>+<Y> 

Fit Page in Window (Страница во все окно) <Ctrl>+<0> 
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Fit Spread in Window (Разворот во все окно) <Ctrl>+<Alt>+<0> 

Grids & Guides: Hide Guides (Скрыть направляющие) <Ctrl>+<;> 

Grids & Guides: Lock Guides (Заблокировать 
направляющие) 

<Ctrl>+<Alt>+<;> 

Grids & Guides: Show Baseline Grid (Показать сетку 
базовых линий) 

<Ctrl>+<Alt>+<‘> 

Grids & Guides: Show Document Grid (Показать сетку 
документа) 

<Ctrl>+<‘> 

Grids & Guides: Smart Guides ("Умные" направляющие) <Ctrl>+<U> 

Grids & Guides: Snap to Document Grid (Привязать к 
сетке документа) 

<Shift>+<Ctrl>+<‘> 

Grids & Guides: Snap to Guides (Привязать к 
направляющим) 

<Shift>+<Ctrl>+<;> 

Hide Rulers (Скрыть линейки) <Ctrl>+<R> 

Overprint Preview (Просмотр наложений) <Shift>+<Ctrl>+<Alt>+<Y> 

Structure: Show Structure (Показать структуру) <Ctrl>+<Alt>+<1> 

Zoom In (Увеличить) <Ctrl>+<+>  

Zoom Out (Уменьшить) <Ctrl>+<-> 

Меню Window (Окно) 

Color: Colour (Цвет) <F6> 

Color: Swatches (Образцы) <F5> 

Control (Контрольная панель) <Ctrl>+<Alt>+<6> 

Effects (Эффекты) <Shift>+<Ctrl>+<F10> 

Interactive: Preview (Интерактивность: просмотр) <Shift>+<Ctrl>+<Enter>  

Layers (Слои) <F7> 

Links (Связи) <Shift>+<Ctrl>+<D> 

Object & Layout: Align (Выравнивание) <Shift>+<F7> 

Output: Preflight (Предпечатная проверка) <Shift>+<Ctrl>+<Alt>+<F> 

Output: Separations Preview (Просмотр цветоделения) <Shift>+<F6> 

Pages (Страницы) <F12> 

Stroke (Обводка) <F10> 

Styles: Character Styles (Стили символа) <Shift>+<F11> 

Styles: Object Styles (Стили объекта) <Ctrl>+<F7> 

Styles: Paragraph Styles (Стили абзаца) <F11> 

Text Wrap (Огибание текстом) <Ctrl>+<Alt>+<W> 

Type & Tables: Character (Символ) <Ctrl>+<T> 
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Type & Tables: Glyphs (Глифы) <Shift>+<Alt>+<F11> 

Type & Tables: Index (Указатель) <Shift>+<F8> 

Type & Tables: Paragraph (Абзац) <Ctrl>+<Alt>+<T>, :<Ctrl>+<M> 

Type & Tables: Table (Таблица) <Shift>+<F9> 

Utilities: Scripts (Сценарии) <Ctrl>+<Alt>+<F11> 

Меню Help (Справка) 

InDesign Help (Вызов справки) <F1> 

Работа с объектами 

Decrease scale by 1% (Уменьшить на 1%) <Ctrl>+<,> 

Decrease scale by 5% (Уменьшить на 5%) <Ctrl>+<Alt>+<,> 

Increase scale by 1%  (Увеличить на 1%) <Ctrl>+<.> 

Increase scale by 5% (Увеличить на 5%) <Ctrl>+<Alt>+<.> 

Select all Guides (Выделить все направляющие) <Ctrl>+<Alt>+<G> 

Меню палитр 

Character Styles: Redefine Style (Стиль символа: 
переопределить стиль) 

<Shift>+<Ctrl>+<Alt>+<C> 

Character: All Caps (Все прописные) <Shift>+<Ctrl>+<K> 

Character: Small Caps (Малые прописные — капители) <Shift>+<Ctrl>+<H> 

Character: Strikethrough (Зачеркнутый текст) <Shift>+<Ctrl>+</> 

Character: Subscript (Нижний индекс) <Shift>+<Ctrl>+<Alt>+<+> 

Character: Superscript (Верхний индекс) <Shift>+<Ctrl>+<+> 

Character: Underline (Подчеркнутый текст) <Shift>+<Ctrl>+<U> 

Index: New (Добавить элемент указателя) <Ctrl>+<7> 

Pages: Override All Master Page Items (Восстановить 
мастер-элементы) 

<Shift>+<Ctrl>+<Alt>+<L> 

Paragraph Styles: Redefine Style (Стиль абзаца: 
переопределить стиль) 

<Shift>+<Ctrl>+<Alt>+<R> 

Paragraph: Drop Caps and Nested Styles (Буквицы и 
вложенные стили) 

<Ctrl>+<Alt>+<R> 

Paragraph: Justification (Выключка) <Shift>+<Ctrl>+<Alt>+<J> 

Paragraph: Keep Options (Связанные строки) <Ctrl>+<Alt>+<K> 

Paragraph: Paragraph Rules (Линии абзаца) <Ctrl>+<Alt>+<J> 
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Preview: Preview Document (Предварительный 
просмотр документа) 

<Shift>+<Ctrl>+<Alt>+<Enter> 

Tags: Autotag (Автоматическая расстановка тегов) <Shift>+<Ctrl>+<Alt>+<F7> 

Навигация по структуре XML 

Collapse element (Свернуть элемент) <Left Arrow> 

Collapse element and child elements (Свернуть 
дочерние элементы) 

<Alt>+<Left Arrow> 

Expand element (Развернуть элемент)  <Right Arrow> 

Expand element and child elements (Развернуть 
дочерние элементы) 

<Alt>+<Right Arrow> 

Scroll structure pane down one screen (Прокрутить 
панель структуры на 1 экран вниз) 

<Page Down> 

Scroll structure pane up one screen (Прокрутить панель 
структуры на 1 экран вверх) 

<Page Up> 

Select first XML node (Выделить первую XML-точку)   <Home> 

Select last XML node (Выделить последнюю XML-точку)   <End> 

Select through first XML node (Выделить все до первой 
XML-точки)   

<Shift>+<Home> 

Select through last XML node (Выделить все 
до последней XML-точки) 

<Shift>+<End> 

View next validation error (Показать следующую ошибку)  <Ctrl>+<Right Arrow> 

View previous validation error (Показать предыдущую 
ошибку)  

<Ctrl>+<Left Arrow> 

Текст и таблицы 

Align centre (Выровнять по центру) <Shift>+<Ctrl>+<C> 

Align force justify (Выровнять строго по формату) <Shift>+<Ctrl>+<F> 

Align justify (Выровнять по формату) <Shift>+<Ctrl>+<J> 

Align left (Выровнять влево) <Shift>+<Ctrl>+<L> 

Align right (Выровнять вправо) <Shift>+<Ctrl>+<R> 

Align to baseline grid (Выровнять по сетке базовых 
линий) 

<Shift>+<Ctrl>+<Alt>+<G> 

Apply bold (Жирный) <Shift>+<Ctrl>+<B> 

Apply italic (Курсивный) <Shift>+<Ctrl>+<I> 

Apply normal (Обычный) <Shift>+<Ctrl>+<Y> 

Auto leading (Автоинтерлиньяж) <Shift>+<Ctrl>+<Alt>+<A> 

Auto-hyphenate on/off (Автоматическая расстановка 
переносов) 

<Shift>+<Ctrl>+<Alt>+<H> 
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Decrease baseline Shift (Уменьшить сдвиг базовой 
линии) 

<Shift>+<Alt>+<Down Arrow> 

Decrease kerning/tracking (Уменьшить кернинг/трекинг) <Shift>+<Alt>+<Left Arrow> 

Decrease leading (Уменьшить интерлиньяж) <Alt>+<Up Arrow> 

Decrease word space (Уменьшить пробел) <Ctrl>+<Alt>+<Backspace> 

Delete (Удалить) <Delete> 

Delete one character to the left (Удалить один символ 
слева) 

<Backspace> 

Delete one character to the right (Удалить один символ 
справа) 

<Delete> 

Delete one word to the left (Удалить одно слово слева) <Ctrl>+<Backspace> 

Delete one word to the right (Удалить одно слово 
справа) 

<Ctrl>+<Delete> 

Find Next (Найти следующее) <Shift>+<F2> 

Increase baseline Shift (Увеличить сдвиг базовой линии) <Shift>+<Alt>+<Up Arrow> 

Increase kerning/tracking (Увеличить кернинг/трекинг) <Shift>+<Alt>+<Right Arrow> 

Increase leading (Увеличить интерлиньяж) <Alt>+<Down Arrow> 

Increase word space (Увеличить пробел) <Ctrl>+<Alt>+<\> 

Move Down (Шаг вниз) <Down Arrow> 

Move Left (Шаг влево) <Left Arrow> 

Move Right (Шаг вправо) <Right Arrow> 

Move Up (Шаг вверх) <Up Arrow> 

Move down one line (Шаг вниз на одну строку) <Down Arrow> 

Move to First Cell in Column (Переход к первой ячейке 
столбца) 

<Alt>+<Page Up> 

Move to First Cell in Row (Переход к первой ячейке 
строки)  

<Alt>+<Home> 

Move to First Row in Frame (Переход к первой ячейке 
фрейма) 

<Page Up> 

Move to Last Cell in Column (Переход к последней 
ячейке столбца) 

<Alt>+<Page Down> 

Move to Last Cell in Row (Переход к последней ячейке 
строки) 

<Alt>+<End> 

Move to Last Row in Frame (Переход к последней ячейке 
фрейма) 

<Page Down> 

Move to Next Cell (Переход к следующей ячейке) <Tab> 

Move to Previous Cell (Переход к предыдущей ячейке) <Shift>+<Tab> 

Move to beginning of story (Переход к началу 
связанного текста) 

<Ctrl>+<Home> 

Move to end of story (Переход к концу связанного текста) <Ctrl>+<End> 
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Move to the end of the line (Переход к концу строки) <End> 

Move to the left one character (Переход на один символ 
влево) 

<Left Arrow> 

Move to the left one word (Переход на одно слово влево) <Ctrl>+<Left Arrow> 

Move to the next paragraph (Переход к следующему 
абзацу) 

<Ctrl>+<Down Arrow> 

Move to the previous paragraph (Переход к 
предыдущему абзацу) 

<Ctrl>+<Up Arrow> 

Move to the right one character (Переход на один 
символ вправо) 

<Right Arrow> 

Move to the right one word (Переход на одно слово 
вправо) 

<Ctrl>+<Right Arrow> 

Move to the start of the line (Переход к началу строки) <Home> 

Move up one line (Переход на одну строку вверх) <Up Arrow> 

Reset kerning and tracking (Восстановить кернинг и 
трекинг) 

<Ctrl>+<Alt>+<Q> 

Select Cells Above (Выделить ячейки выше) <Shift>+<Up Arrow> 

Select Cells Below (Выделить ячейки ниже) <Shift>+<Down Arrow> 

Select Cells to the Left (Выделить ячейки слева) <Shift>+<Left Arrow> 

Select Cells to the Right (Выделить ячейки справа) <Shift>+<Right Arrow> 

Select line (Выделить строку) <Shift>+<Ctrl>+<\> 

Select one character to the left (Выделить один символ 
слева) 

<Shift>+<Left Arrow> 

Select one character to the right (Выделить один символ 
справа) 

<Shift>+<Right Arrow> 

Select one line above (Выделить одну строку выше) <Shift>+<Up Arrow> 

Select one line below (Выделить одну строку ниже) <Shift>+<Down Arrow> 

Select one paragraph before (Выделить один абзац до) <Shift>+<Ctrl>+<Up Arrow> 

Select one paragraph forward (Выделить один абзац 
после) 

<Shift>+<Ctrl>+<Down Arrow> 

Select one word to the left (Выделить одно слово слева) <Shift>+<Ctrl>+<Left Arrow> 

Select one word to the right (Выделить одно слово 
справа) 

<Shift>+<Ctrl>+<Right Arrow> 

Select to beginning of story (Выделить все до начала 
текста) 

<Shift>+<Ctrl>+<Home> 

Select to end of story (Выделить все до конца текста) <Shift>+<Ctrl>+<End> 

Select to the end of the line (Выделить все до конца 
строки) 

<Shift>+<End> 

Select to the start of the line  (Выделить все до начала 
строки) 

<Shift>+<Home> 

Update missing font list (Обновить список потерянных 
шрифтов) 

<Shift>+<Ctrl>+<Alt>+</> 



378 Приложение 2 

Инструменты 

Add Anchor Point Tool (Добавить опорную точку) <+> 

Apply Colour (Применить цвет) <,> 

Apply Gradient (Применить градиент) <.> 

Apply None (Пустой атрибут) </> 

Apply fill and stroke colours (Стандартные установки 
атрибутов) 

<D> 

Convert Direction Point Tool (Изменение типа точки) <Shift>+<C> 

Delete Anchor Point Tool (Удаление опорной точки) <-> 

Direct Selection Tool (Частичное выделение) <A> 

Ellipse Tool (Эллипс) <L> 

Eyedropper Tool (Пипетка) <I> 

Free Transform Tool (Свободная трансформация) <E> 

Gap Tool (Просвет) <U> 

Gradient Feather Tool (Градиентная растушевка) <Shift>+<G> 

Gradient Swatch Tool (Градиент) <G> 

Hand Tool (Рука) <H> 

Line Tool (Линия) <\> 

Measure Tool (Измеритель) <K> 

Page Tool (Страница) <Shift>+<P> 

Pen Tool (Перо) <P> 

Pencil Tool (Карандаш) <N> 

Rectangle Frame Tool (Прямоугольный фрейм) <F> 

Rectangle Tool (Прямоугольник) <M> 

Rotate Tool (Поворот) <R> 

Scale Tool (Размер) <S> 

Scissors Tool (Ножницы) <C> 

Selection Tool (Выделение) <V>, Text:<Escape> 

Shear Tool (Наклон) <O> 

Swap fill and stroke activation (Смена активности 
атрибутов) 

<X> 

Swap fill and stroke colours (Перемена местами цветов 
атрибутов) 

<Shift>+<X> 

Toggle Text and Object Control (Управление текстом или 
фреймом) 

<J> 

Toggle view setting between and preview (Выбор 
режима просмотра) 

<W> 
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Type Tool (Текст) <T> 

Type on a Path Tool (Текст по контуру) <Shift>+<T> 

Zoom Tool (Масштаб) <Z> 

Просмотр и навигация 

200% size <Ctrl>+<2> 

400% size <Ctrl>+<4> 

50% size <Ctrl>+<5> 

Close all (Закрыть все) <Shift>+<Ctrl>+<Alt>+<W> 

Close document (Закрыть документ) <Shift>+<Ctrl>+<W> 

First Spread (Первый разворот) <Shift>+<Alt>+<Page Up>  

Fit Selection in Window (Выделение во все окно) <Ctrl>+<Alt>+<+> 

Go to first frame in thread (Переход к первому 
из связанных фреймов) 

<Shift>+<Ctrl>+<Alt>+<Page Up> 

Go to last frame in thread (Переход к последнему 
из связанных фреймов) 

<Shift>+<Ctrl>+<Alt>+<Page Down> 

Go to next frame in thread (Переход к следующему 
связанному фрейму) 

<Ctrl>+<Alt>+<Page Down> 

Go to previous frame in thread (Переход к предыдущему 
связанному фрейму) 

<Ctrl>+<Alt>+<Page Up> 

Last Spread (Последний разворот) <Shift>+<Alt>+<Page Down>  

Next window (Следующее окно) <Ctrl>+<Tab> 

Open context menu (Контекстное меню) <Shift>+<F10> 

Previous window (Предыдущее окно) <Shift>+<Ctrl>+<Tab> 

Save all (Сохранить все) <Shift>+<Ctrl>+<Alt>+<S> 

Scroll down one screen (Прокрутка на один экран вниз) <Page Down> 

Scroll up one screen (Прокрутка на один экран вверх) <Page Up> 

Show Black plate (Показать черную печатную форму) <Shift>+<Ctrl>+<Alt>+<4> 

Show Cyan plate (Показать голубую печатную форму) <Shift>+<Ctrl>+<Alt>+<1> 

Show Magenta plate (Показать пурпурную печатную 
форму) 

<Shift>+<Ctrl>+<Alt>+<2> 

Show Yellow plate (Показать желтую печатную форму) <Shift>+<Ctrl>+<Alt>+<3> 

Show all plates (Показать все печатные формы) <Shift>+<Ctrl>+<Alt>+<`> 

Show/Hide all panels (Показать/скрыть палитры) <Tab> 

Show/Hide all panels except toolbox (Показать/скрыть 
палитры, кроме инструментальной) 

<Shift>+<Tab> 

 



  

 

Приложение 3 
 

 

КРАТКОЕ ОПИСАНИЕ CD 

 

 

На диске находятся файлы для выполнения упражнений (рабочие файлы для прак-

тического освоения материала каждой главы и файлы, необходимые для работы над 

проектами). 

Файлы скомпонованы в папки, каждая из которых названа в соответствии с номе-

ром главы, к которой она относится. Рабочие файлы для первоначального изучения 

материала главы находятся в корневой части папки; файлы, необходимые для вы-

полнения проектов, сгруппированы в подпапки, имена которых соответствуют 

именам проектов. 

 

 



  

 

 
 

 

ПРЕДМЕТНЫЙ УКАЗАТЕЛЬ 

 

 

A 

Align 70 

Animation 23, 330, 340 

Arrange 68 

Assignments 357, 360, 365 

Auto-Fit 20 

B 

Bevel and Emboss 275 

Bleed 104 

Book 248 

Bounding Box 15, 64 

Brightness 84 

Buttons 334, 342 

Buzzword 25 

C 

Character 110, 122 

Character Styles 172, 187, 319 

Check Out 364 

CIE L*a*b 81 

Clipping Path 202 

CMYK 83 

Colour Mode 93 

Colour 86, 90 

Colour Picker 85 

Column 225 

Columns 103, 129 

Composite CMYK 309 

Convert Shape 59 

Convert Table to Text 227 

Convert to Button 342 

Create Merged Document 353 

D 

Data Merge 351 

Direct Selection 278 

Display Performance 207 

Distribute Objects 71 

Distribute Spacing 71 

Document Grid 48 

Drop Shadow 274 

E 

Effects 274 

Ellipse Tool 55 

Embedded 207 

Export 360 

Extension Manager 349 

F 

Feather 275 

Find/Change 132 

Flash 345 

Formatting 107 

Free Transform Tool 66 

G 

Gap Tool 17 

Generate Index 262 

Gradient 93 

Guides 49 

H 

Hide frame edges 16 

HSB 84 

Hue 84 

Hyperlinks 318, 321 

Hyphenation 182 

I 

InCopy 355, 364 

Index 256, 261 
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Inner Glow 275 

Insert Pages 164 

L 

LAB 84 

Layers 14, 73, 213 

Leading 113 

Library 266 

Line Tool 55 

Linked 207 

Links 27, 206, 208 

Load Table style 239 

M 

Margins 103 

Media 23, 329 

Mini Bridge 21 

N 

Nested Style 189 

Numbering & Sections Options 156 

O 

Object States 340 

On-line просмотр 25 

Open Path 63 

Open Type 291 

Orientation 103 

Outer Glow 275 

Overprint 297 

Overprint Preview 296 

P 

Package 291, 295 

Page Tool 14 

Page Transitions 333 

Pages 146, 160 

PANTONE 93, 282 

 Metallic 93 

 Pastel 93 

 Process 93 

 Spot 93 

Paragraph 110, 123, 175 

Paragraph Styles 172, 190 

Path 211 

Pathfinder 56 

PDF 205, 343 

Pen 211 

Place 200, 223 

Plug-Ins 349 

Polygon Tool 55 

PostScript 291 

Preflight 44, 292 

Presentation Mode 25 

Preview 24, 27 

Print 306 

Print Book 251 

Print Booklet 302 

Print Setup 304 

Printing and Proofing 35 

R 

Rectangle Tool 54 

Registration 89 

Reverse Path 63 

RGB 82 

Rollover 342 

Row 225 

Rows and Columns 228 

S 

Satin 275 

Saturation 84 

Save Book 248 

Script Label 347 

Scripts 347 

Selection 65 

Separations Preview 296 

Slug 104 

Smart Guides 51 

Spot 91 

Story Editor 131, 166, 227 

Stroke 63 

Swatches 87 

Synchronize Options 249 

T 

Table 222 

Table of Contents 252 

Table Options 228 

Table Setup 232 

Table Styles 238 

Tabs 177 

Text Frame Options 18 

Text Wrap 136 
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Timing 23, 332 

Tint 89 

Tool Hints 26 

Track Text Changes 25 

Transform 64, 67 

TrueType 291 

Type 223 

Type on a Path 277 

Typography 35 

U 

Update Data Source 354 

URL-адрес 318 

X 

XHTML 25 

 

 

 

А 

Абзацный отступ 118 
Автозамена 132 
Анимация 330 

Антиква 111 
Атрибуты объекта 61 

Б 

Базовая сетка 48 
Библиотеки объектов 265 

Буквица 121, 188 

В 

Векторная графика 198 
Выбор словаря 116 
Выключка 183 

Г 

Гарнитура 110 
Гиперссылка 318 
Главное меню 34 
Глобальный цвет 91 
Градиент 204 

Гротеск 112 
Группировка объектов 68 

Д 

Действие 338 

И 

Идентификация пользователя 359 
Импорт текста 106 
Инструментальная панель 40 

Интерлиньяж 113 
Источник 318 

К 

Кегль 113 

Кернинг 114 
Книга 245 
Кнопка разворачивания/сворачивания 39 
Кнопки 334 
Колонтитул 147, 224 
Колонцифры 147 
Контекстное меню 39 

Контрольная панель 35, 43 

Л 

Линейки 49 
Линиатура растра 290 

М 

Маркер списка 185 
Мастер-фрейм 279 
Мастер-шаблон 146 
Масштаб просмотра 46 
Материал 125 
Миниатюры страниц 22 

Модель  

 CMYK 83 

 HSB 84 

 L*a*b 84 

 RGB 82 

Н 

Направляющие 49 
Начертание 113 

Нумерация страниц 154 
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О 

Область  

 заголовка 39 

 лакировки 282 

Обтравочный контур 210, 282 

Объединенный документ 351 

Окно документа 44 

П 

Палитра настроек 40 

Палитра-набор 40 

Панель инструментов 34 

Перекрестные ссылки 323 

Переходы страниц 333 

Печатная публикация 29 

Плашечный цвет 84 

Поля данных 354 

Привязка 318 

 к направляющим 51 

Прозрачность 204 

Р 

Рабочая область и страницы 35 

Растровая графика 198 

Режим презентации 25 

С 

Событие 338 

Состояние 339 

Спуск полос 300 

Стиль  

 символа 187 

 таблицы 237 

 ячейки 237 

Т 

Таблица 221 

Таблица символов 134 

Текст вдоль контура 277 

Текстовый  

 редактор 131 

 фрейм 105 

Трекинг 114 

У 

Указатель 255 

Управляющая палитра 43 

Ф 

Файл источника данных 350 

Формат  

 DOC 107 

 DOCX 107 

 EPS 203 

 GIF 202 

 JPEG 202 

 PDF 343 

 PSD 205 

 RTF 107 

 SWF 345 

 TIFF 202 

Форматирование текста 110 

Ц 

Цветовая модель 81 

Целевой документ 351 

Ш 

Шрифт 291 

Э 

Экспорт 360 

Электронная  

 книга 318 

 публикация 29, 317 

Электронные документы 317 
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